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Module overview 
Description 
Database concepts are all around you and you probably don’t notice them until you 
analyze your surroundings. For example, when you consider a store, a school, or a 
restaurant, someone there is probably working with a database. Users typically work 
with databases on computers to store and work with data, request information from 
data, and process outputs from that data. A database is an information warehouse that 
includes a digital structure of tables containing records, which is similar to a traditional 
warehouse that has aisles and shelves that organize products. 

An example that helps you relate the two concepts is that of a supermarket. A 
supermarket selling cereal needs to know how many boxes of cereal are available, prior 
to making their next order request. If they request and process a query, which is a 
question about the data, then that query will provide results that inform store personnel 
about the number of boxes on the shelves. This module builds your foundational 
knowledge and understanding of the uses of a database. You’ll learn about the 
Microsoft Access 2019 environment, database organization, data sources, and the basics 
of designing a database. 

The following table outlines the lessons in this module and their corresponding 
Microsoft Office Specialist (MOS) exam objectives. 

Lesson Learning objective MOS exam 
objective(s) 

Overview of 
databases 

Understand the purpose of a database, 
define database terms, and explore data 
sources 

None 

Designing 
databases 

Understand database design principles and 
plan tables 

None 

Understanding 
Access basics 

Identify the parts of the Access interface and 
the items in an Access file, hide and display 
objects in the Navigation Pane, and open 
tables, queries, forms, and reports 

1.1.3 

  



Introduction to databases and Microsoft Access 
 

 
5 

Lesson Learning objective MOS exam 
objective(s) 

Cornerstone: 
Evaluate the 
design of an 
Access 
database, and 
identify 
database and 
Access 
elements 

Assess a database for its design and identify 
database components and their purpose and 
function 

1.1.3 

Table 1: The objectives by lesson 

Scenario 
The Community Supported Agriculture (CSA) program at Munson’s Pickles and 
Preserves Farm is exploding in popularity. With the growth of the program, there’s also 
an increase in information and the number of tasks that the CSA team needs to manage. 
One of these tasks is to ensure that members’ contact information and preferences are 
kept current, especially with details such as allergy information. Some other tasks 
include efficiently and correctly filling boxes to match member orders, and tracking 
which produce is available for each farm box. You and the CSA team recognize that 
Munson’s is still running the program operations the same way they always have, when 
the program was much smaller. There are paper checklists and calendars, lists in Excel 
spreadsheets, index cards, and other information is scattered on everyone’s desks. This 
makes the planning and running of the CSA program very labor-intensive and prone to 
mistakes. 

With the Munson’s plan to use Access databases for managing data, you realize it would 
be useful for the CSA team to have an Access database to streamline the many tasks. 
From your time as an intern with the harvesting team at Munson's, you recall that they 
had an Access database to track the harvesting data. You plan to connect with the 
harvesting team to review how they initially planned their database, how they use it, and 
what they’ve learned along the way that can help you. But before you talk with the 
harvesting team, you’ll need to understand some of the basics about databases and 
Access. 
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Cornerstone 
This module concludes with a Cornerstone project, in which you’ll apply the concepts 
you learned in this module to assess a database for use of good design. You’ll also 
identify database components, and their purpose and function. In addition, you’ll use 
database features to demonstrate your knowledge of the Microsoft Access interface and 
workflow. 
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Lesson 1: Overview of databases 
Overview 
In this lesson, you'll learn the basics about using and organizing a database. Gaining this 
knowledge will enhance your ability to perform simple data management tasks before 
you move on to complex and multiple-table operations later in the course. Building this 
skill set will help you make informed decisions and become aware of certain anomalies 
within the data for Munson's Pickles and Preserves Farm. 

Warm-up 
Use these questions to find out what you already know about this lesson’s topics: 

1. Which of the following are types of databases? 

Select all that apply. 

a. Field 

b. Relational 

c. Queries 

d. Flat 

2. _________________________ is the process of applying rules to a database design to 
check for correct table structure. 

Fill in the blank space. 

3. A relational database: 

Select all that apply. 

a. Can join tables to make a connection. 

b. Provides meaningful information. 

c. Stores data in rows inside tables. 

d. Stores data without a structured table. 

4. Microsoft Access is used to manage _________________________ databases. 

Fill in the blank space. 



Introduction to databases and Microsoft Access 
 

 
8 

Topic 1: Understand the purpose of a 
database 
Think about some of the uses of data in your life. When you last arrived at school and 
checked into your class, that instance created a data transaction. Your teachers might 
analyze the correlation between your attendance record and the degree of your 
academic success. That analysis accompanies a story, which is typically, "Students who 
attend school regularly are more successful academically." 

Think about the last time you purchased a beverage from a machine. That was a data 
transaction. If you purchased a specific flavor, you’re providing information to the 
person who owns that vending machine. This information tells that person that you and 
those who purchase from the vending machine prefer certain beverages over the others. 
Simple decisions follow that data analysis: provide what the consumers want. 

At Munson's, think about all the orders that everyone is filling manually, by using cards, 
notes, paper invoices, and phone calls. All of this is considered data; however, storing 
and maintaining data in this manner makes you prone to mistakes. It also leads to a 
failure to recognize and respond to trends and reduces the ability to meet customer 
requirements. Establishing a database with a designed protocol of entering names, 
orders, addresses, delivery frequency, preferences of produce, and billing information is 
crucial to Munson’s growth and future success. This will empower Munson's to prepare, 
communicate, and serve their customers in an efficient manner. 

 

Additional information 

For more information on the purpose and use of databases, refer to: 
What is a database? 

 

Video 

To review the video on database concepts, refer to: Organizing with 
databases 

https://aka.ms/what-is-a-database
https://aka.ms/video-organizing-with-databases
https://aka.ms/video-organizing-with-databases
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Did you know? 

Prior to 1960, database systems were developed for the use of public 
organizations such as hospitals, libraries, and governmental agencies. 
Some of their concepts are still considered and used within current 
systems. 

What is a database? 
A database is a collection of organized information that provides efficient retrieval of 
data. Databases often begin as a list of items that are relevant. As that list grows to a 
second list with relevant data, you might find redundancies. Organizing such lists is 
helpful and aids in the process of adding a retrieval mechanism without inconsistencies 
or redundancies. A database management system (DBMS) facilitates the organization of 
information for quick and efficient retrieval of data. 

Why do you need databases? 
A database allows users to efficiently store and retrieve large volumes of information. 
After establishing the structure of the database, users can continue to add items to their 
tables. They can also remove data; for example, they can remove the details of previous 
customers or discontinued products. A database helps users review information from 
different perspectives within a company and share discoveries easily to promote better 
decision-making. 

 

Did you know? 

One of the benefits of the digital transformation age is the 
widespread availability of data to the general public. The internet can 
give you access to databases with all kinds of intriguing information 
to explore. Examples include pop culture and entertainment data such 
as movies and music, family and genealogy data including historical 
records and DNA tracing, scientific information for everything from 
astronomy to zoology, and even a database that is an archive of the 
internet itself! 
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Caution 

This course uses database files that follow a general storyline for the 
CSA program at Munson’s Pickles and Preserves Farm. These 
database files are the Learning Activity Resource files that you’ll use 
to work on each module’s activities and try-its. Each Learning Activity 
Resource file contains the data and objects, such as tables, queries, 
forms, and reports, that you need to complete a corresponding 
activity. 

Due to this course’s modular nature, the objects and data in these 
files might vary across activities or try-its. Therefore, it’s important 
that you start your activities or try-its only with the designated files, 
as per applicable instructions. You also should note that screenshots 
in the topic content are for illustration purposes only and might 
appear different than those that are in the Learning Activity Resource 
files. 

Activity: Think-pair-share 
In this activity, the teacher will play the video on database concepts, Organizing with 
databases. After reviewing the video, pair up with a classmate and begin identifying 
objects around you and your life that could form datasets for potential databases. Then, 
share your findings with another pair of classmates or with the entire class. 

Resources required 
• None 

Activity instructions 
Participate in the activity by following these instructions: 

1. Find a classmate to discuss possible databases that are part of your everyday lives. 

2. Share your responses with the teacher to check if there are similarities or 
redirections. 

3. Participate in further discussions with other classmates on their descriptions of 
databases. 

  

https://aka.ms/video-organizing-with-databases
https://aka.ms/video-organizing-with-databases
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Try-it: Understand the purpose of a database 
 Gaining a foundational knowledge of a database will enhance your ability to use 

data to influence your decisions. In this standalone try-it activity, you’ll identify objects 
around you that could form datasets for potential databases. 

Resources 
You’ll need the following resources for this try-it: 

• None 

Instructions 
The following are the general tasks that you need to perform during this try-it: 

1. Review the lists in the following table. 

Object Properties 

School • Grades 
• Courses 
• Teachers 
• Class periods 
• Students 
• Attendance 
• Graduation years 
• Classroom locations 
• Required courses/elective courses 

Clothes • Types of clothing 
• Sizes 
• Colors 
• Availability/in stock 

Music • Artists 
• Genres 
• Durations 
• Albums 
• Release dates 
• Composers 
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Object Properties 

Vehicles • Makes 
• Models 
• Years 
• Colors 
• Trims 
• Extra features 

Frozen 
desserts 

• Type 
• Add-ins 
• Cone types 
• Size 

Table 2: Datasets 

2. Identify the list that is most familiar to you. 

3. With the list you selected, consider why and how a database with this information 
might be important and the ways in which you can use it. Make note of your ideas. 

4. Be ready to share your ideas with the class about the purpose of a database for your 
selected list. 

Topic 2: Define database terms 
You want to identify Munson's least popular vegetable. You’re aware of the database, 
but don’t know what term you should use to discover the answer to your question, 
“Which vegetable gets the least number of orders?” In this topic, you’ll define key terms 
and identify some features connected to each term. All of these terms are also in the 
module glossary. 

Common terms around databases 
In its most basic definition, a database is a collection of information organized to 
provide efficient retrieval and use of data. Databases often begin as a list of items that 
have similar pieces of information and might even be non-computerized; for example, 
because they’re handwritten on paper. A single list, also known as a flat database, 
includes all the information about each item in a record, and is usually presented in a 
single row. Each piece of information, or value, is stored in a field, and is usually 
presented as a column. This layout of information is also commonly referred to as a 
table. A table has many similarities to a spreadsheet. Refer to the following screenshot 



Introduction to databases and Microsoft Access 
 

 
13 

for an example of a table named tblCropHarvesting with records (rows) and fields 
(columns) in Access: 

 
Figure 1: An example of a table with records (rows) and fields (columns) in Access 

To review the records and fields in tblCropHarvesting in table format, refer to the 
following table. 

HarvestID HarvestDate HarvesterFirstName HarvesterLastName Crop  

1 1/30/2020 Marcos  Serna  Apples  

2 1/30/2020 Danielle Gousse  Beans  

3 1/30/2020 Fernando  Vasquez  Honey  

4 1/30/2020 Hilary Brennan  Tomatoes  

6 1/30/2020 Fen Long  Strawberries  

7 1/31/2020 Danielle Gousse  Apples  

8 1/31/2020 Marcos Serna  Beans  

9 1/31/2020 Fen Long  Apples  

Table 3: The records and fields in tblCropHarvesting 
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For example, you might start a list to keep track of the farm boxes the members of 
Munson's CSA program purchase. At first, it might be a simple list such as the one in the 
following table. 

Member 
Name 

Member 
Phone 

Purchase Date Farm Box 
Purchased 

Farm Box 
Contents 

Akia Kassis 555-0101 2/1/2020 Large Tomatoes, 
apples, beans, 
strawberries 

Alain Margand 555-0199 2/1/2020 Medium Beans, apples, 
tomatoes 

Table 4: A simple list of farm box purchases by members 

As a list grows in either the number of records or the number of fields, or both, it can 
become more difficult to manage, because redundancies and inconsistencies might start 
to appear. Even if you computerize a list, adding and editing it can become labor-
intensive, and finding data can be challenging and limited in options. In the previous 
table, imagine entering the information for numerous purchases on the same day. This 
would be repetitive, inefficient, and highly prone to errors. It would also be difficult to 
retrieve answers from the list. For example, consider the following scenarios: 

• How many times would you need to enter the word "medium" or the word 
"tomatoes" and what are the chances you'd misspell them at least once? 

• How would you sort the list by customer last name alphabetically? 
• How would you count how many customers purchased apples? 

When a list becomes difficult to manage because of its large size, it's a good idea to 
transfer or convert the data into a relational database. In a relational database, the 
information is divided into separate, subject-based tables. You can then form 
relationships between the tables, based on shared key fields that bring the information 
together as needed when you’re retrieving data. 

  



Introduction to databases and Microsoft Access 
 

 
15 

Later modules will cover in more detail the practice of adding specific information to 
tables. For now, think of a table that contains only the data about the members. Each 
member record could contain values in the fields for first name, last name, address, 
phone, email, and other specific information that pertains to that member. In another 
table, you could store data in records for each farm box that's available. This could be in 
fields for farm box name, size, or contents, and include quantities of each fruit and 
vegetable, and other relevant information. Each table would only store information 
about its own items; for example, you wouldn't put any farm box information in the 
table containing members. 

The previous topic introduced you to the term, database management system (DBMS). 
A DBMS is used to manipulate, retrieve, and manage data within the database structure. 
When you create a table, the DBMS identifies the data within the table and submits it to 
the rules within the database when running other transactions. The term Relational 
Database Management System (RDBMS), is simply the more specific term for a program 
or application that relational databases use. Access is both a DBMS and an RDBMS and 
has parts within it that are governed by those rules. 

In a DBMS such as Access, a database file is technically a container of objects, or 
components, that are used to store, add, edit, find, present, and otherwise manage the 
data inside a database. Tables that store data are one type of object. The other types of 
objects are as follows: 

• Queries. To help you ask questions of data, queries have a common function to 
retrieve specific data from one or more tables within the database to provide the 
answers. When data is spread across multiple tables, a query returns related data 
from each table that the user requests by following the relationships between the 
tables. Query results are presented in Datasheet view, similar to the usual view of a 
database table. Using queries can provide excellent detail for actionable items. For 
example, Munson's could find them especially useful when setting up delivery routes 
and harvesting schedules, identifying members who match certain criteria, 
summarizing produce quantities, and performing other useful tasks. 
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• Forms. Entering data in a table's Datasheet view with one horizontal row for each 
record is usually not the easiest method. For an interface that is user-friendly and 
controllable when entering data, you can create forms. Most database users prefer to 
use forms for reviewing, entering, and editing data in the tables. Forms can have 
names that are specific to the data that is being entered and edited, such as 
"Members Form". You can also design forms to provide more guidance to the user 
to help them enter data correctly. Refer to the following screenshot for an example 
of an Access form for data entry: 

 
Figure 2: Example of an Access form for data entry 
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• Reports. You can use a report to present a summary of the data that might or might 
not include the detailed records. When you’re generating a report, you can retrieve 
data from one or more tables. Typically, you can do this by basing a report on a 
query. You can then configure the report to present the data in an easy-to-use 
format and include design elements such as borders, colors, graphic objects, and 
page numbering. Refer to the following screenshot for an example of an Access 
report: 

 
Figure 3: An example of an Access report 

• Macros. You can create macros with a simplified programming tool to add 
functionality to your database; for example, to automate tasks. Macros are an 
advanced topic outside the scope of this course. 

• Modules. Similar to macros, modules add functionality to your database. You can 
create modules in Visual Basic Applications (VBA) programming language. A module 
is a collection of procedures, statements, and declarations that are stored together 
as a unit. Modules are an advanced topic outside the scope of this course. 
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Additional information 

For more information on database objects, refer to: The parts of an 
Access database 

 

Video 

To review the video on getting started with databases, refer to: Get 
started with databases 

Activity: Terminology matching 
In this activity, you’ll work with a classmate to determine your familiarity with the 
database terms. 

Resources required 
• Module 1 Glossary 

Activity instructions 
Think about the new terms you’ve learned, and how they play a role within a database. 
Making connections between the terms will support your continued learning 
throughout the remaining modules. 

Participate in the activity by following these instructions: 

1. Partner with a classmate. 

2. Take turns stating a term or a definition. Ask your partner to match the term to the 
definition or the definition to the term. 

3. Switch partners and repeat one additional practice each. Share and discuss the terms 
that still seem misunderstood. 

Try-it: Define database terms 
 Gaining a foundational knowledge of a database begins with knowing and 

properly identifying concepts within the database environment. In this try-it activity, 
you’ll identify terms within databases in association with the lists in the following table. 
You might need to work with a partner to check if you both correctly identify the use of 
the terms with a selected list. 

https://aka.ms/Database-basics-the-parts-of-an-Access-database
https://aka.ms/Database-basics-the-parts-of-an-Access-database
https://aka.ms/video-get-started-with-databases
https://aka.ms/video-get-started-with-databases
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Resources 
You’ll need the following resources for this try-it: 

• None 

Instructions 
The following are the general tasks that you need to perform during this try-it: 

1. Review the lists in the following table. 

Object Properties 

School • Grades 
• Courses 
• Teachers 
• Class periods 
• Students 
• Attendance 
• Graduation years 
• Classroom locations 
• Required courses/elective courses 

Clothes • Types of clothing 
• Sizes 
• Colors 
• Availability/in stock 

Music • Artists 
• Genres 
• Durations 
• Albums 
• Release dates 
• Composers 

Vehicles • Makes 
• Models 
• Years 
• Colors 
• Trims 
• Extra features 
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Object Properties 

Frozen 
desserts 

• Type 
• Add-ins 
• Cone types 
• Size 

Table 5: Datasets 

2. Identify which of the lists is most familiar to you. 

3. Incorporating the terminology included within this topic, create a structure, or 
suggest where the items in the list and any related information would belong within 
a database. Consider the following terms: 

o Field 
o Value 
o Record 
o Table 

4. Share your list and matching terms with a partner to examine similarities. 

5. Be prepared to share results with the class and also to explain your rationale. 

Topic 3: Explore data sources 
Data comes in many different forms. Think of all the pieces of data that influence your 
life directly or indirectly, such as phone contact lists, music playlists, a soccer game, or a 
ballet performance. Data, when you’re aware of it, can cause humans to evaluate 
circumstances and behavior and possibly make changes. For example, pedometers are 
part of many devices that keep track of the steps you take throughout the day. The data 
that a person’s pedometer records might inspire that person to take more steps each 
day. What type of data is Munson's currently collecting? How is the data collected and 
stored? What changes in data collection can Munson's make to improve their services? 

What are data sources? 
In Access, you input data in a digital environment. However, the method to collect the 
data prior to input might be different. Munson's might count bushels of a produce 
during a certain harvesting activity. The process of getting that data into Access evolves 
from the person counting, to recording the counts in a paper notepad, to inputting data 
in a Microsoft Excel spreadsheet, and then inputting or importing that data into Access. 
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You can also collect and track data through community sources. Community sources 
provide data about things like weather, illnesses, and population, and all these items 
could play a role in a farm like Munson's. Being aware of the data you want to collect 
and how that data will influence your decisions is a critical part of designing your 
database. There are many ways to collect data and the data sources for Munson’s have 
mostly remained the same, but they might require some initial testing. 

For example, in a database for a restaurant, you might have the following existing and 
potential data sources and database input methods. 

Subject Existing data sources Potential data sources 

Employees • Job application form (paper, 
manual data entry) 

• New employee forms (paper, 
manual data entry) 

• Employee online portal for 
self-entry (import into 
database) 

Food 
products 

• Food items on the shelves 
(paper, manual data entry) 

• Handwritten inventory list 
(paper, manual data entry) 

• Excel spreadsheets (import into 
database) 

• Downloaded data from 
supplier websites of available 
products (import into 
database) 

Customers • Reservation book (paper, 
manual data entry) 

• Completed customer 
satisfaction cards (paper, 
manual data entry) 

• Loyalty program membership 
forms (paper or on website, 
manual data entry or import 
into database) 

Table 6: Possible data sources for a restaurant 
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Did you know? 

Data collection has been happening for centuries. Some of the most 
prolific data sources include history in story form, poems, birth 
records, and immigration documents. Many of these records are 
added to databases to track human movement throughout the ages. 

A recently popular data source has been that of DNA testing, which 
involves the collection of samples of DNA (perhaps through saliva). To 
link people to where their ancestors originated, DNA testing maps 
their DNA strands back to where the most prominent levels of that 
strand were found. 

Activity: Discuss and learn 
In this activity, follow along as the teacher leads a discussion about where and how data 
has been collected. What sources are you aware of that have not yet been mentioned? 

Resources required 
• None 

Activity instructions 
Think about the new discoveries that are being made daily. Here’s an example that 
might inspire you. In recent years, scientists have begun to use mosquitoes as data 
collection agents, turning them into allies, to potentially prevent outbreaks of diseases. 
Describe what data they might source for this and how they collected it. Use this 
example as a foundation for other ideas that your classmates or teacher might 
introduce. 

Participate in the activity by following these instructions: 

1. Observe your teacher’s description of a data source that is intriguing. 

2. Partner with a classmate and begin to discuss other methods of collecting data and 
through what means you can source the data. 

3. With your partner, collaborate by thinking of at least two additional innovations 
where data is collected to improve your local community. 

4. Participate in the discussion by sharing what you and your partner have observed. 
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Try-it: Explore data sources 
 Gaining a foundational knowledge of data entry and collection within a database 

can be helpful when you’re designing a database or performing database management 
tasks. In this try-it, you’ll recognize and identify existing or potential data sources, 
including how the data could be collected and prepared for entry into the database. 

Resources 
You’ll need the following resources for this try-it: 

• None 

Instructions 
The following are the general tasks that you need to perform during this try-it: 

1. Review the lists in the following table. 

Object Properties 

School • Grades 
• Courses 
• Teachers 
• Class periods 
• Students 
• Attendance 
• Graduation years 
• Classroom Locations 
• Required courses/elective courses 

Clothes • Types of clothing 
• Sizes 
• Colors 
• Availability/in stock 

Music • Artists 
• Genres 
• Durations 
• Albums 
• Release dates 
• Composers 
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Object Properties 

Vehicles • Makes 
• Models 
• Years 
• Colors 
• Trims 
• Extra features 

Frozen desserts • Type 
• Add-ins 
• Cone types 
• Size 

Table 7: Datasets 

2. Choose one of the lists most familiar to you. 

3. With your selected list, make a list of possible existing and potential sources for the 
data in that list. 

4. For each data source in your list, identify and add how you might add that data to a 
database. 

5. Be prepared to share your list with the class and explain your rationale. 

Wrap-up 
Use these questions to check what you learned in this lesson: 

1. What is a database? 

Select the correct option. 

a. A collection of information stored for effective retrieval 

b. A table of values used to test formulas 

c. A contact list that allows easy integration to social media 

d. A computer program to create spreadsheets 

2. In a database, list data is stored in a _________________________ and arranged in rows 
and columns. 

Fill in the blank space. 
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3. Each row in a list contains information for one list item and is referred to as a
_________________________.

Fill in the blank space.

4. Pieces of information about each list item are stored in _________________________
which are arranged in columns.

Fill in the blank space.

5. Data can be found in many forms, which are referred to as data sources. Which of
the following could potentially be used as data sources?

Select all that apply.

a. Index cards containing student information

b. Labels on products in a store

c. Computer monitors in an office

d. A document created in Microsoft Word
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Lesson 2: Designing databases 
Overview 
In this lesson, you'll learn the correct design steps to create an effective database that 
will serve your data needs. You’ll analyze the value of a good database design and how 
it’ll help you assist database owners in making decisions from the data that is displayed. 
You’ll review key items needed when working with tables, queries, forms, and reports. 
You'll understand the importance of a primary key when setting up a table and also the 
concept of relationships between tables. 

A good database design is important to help ensure a simple user experience to find 
complex information. Some of the preliminary items to consider when designing a 
database are: 

• Naming conventions (how you name objects such as tables, or fields such as
MemberName)

• Longevity and scalability (capacity for growth) of your database
• Normalization (organizing the data to maintain data integrity and avoid redundancy

of entries)
• Practice of desired outcomes through testing of your database queries

Warm-up 
Use these questions to find out what you already know about this lesson’s topics: 

1. A well-designed database has the following steps completed during the design of
the database:

Select all that apply.

a. As much data as possible included in the initial table

b. Information grouped and divided into tables

c. Primary key fields identified

d. Table relationships determined

e. The same information included in multiple tables
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2. Storing information in its _________________________ logical part is useful when 
retrieving individual facts later. 

Select the correct option. 

a. Smallest 

b. Largest 

c. Valued 

d. Calculated 

3. Certain principles guide the database design process. The first principle is that 
_________________________ is bad, because it wastes space and increases the likelihood 
of errors and inconsistencies. 

Select the correct option. 

a. Redundant data 

b. Correctness of information 

c. Completeness of information 

d. Using subject-based tables 

4. Good database design recommends: 

Select all that apply. 

a. Subject-based tables with a unique identifier for each record 

b. Use of naming conventions 

c. Multiple tables with repeated data 

d. Applying of normalization rules  

e. Testing or practice of the desired results 

  



Introduction to databases and Microsoft Access 
 

 
28 

Topic 1: Overview of database design 
guidelines 
As with most things that you build, creating and following a good design plan is 
essential to a successfully completed project. Consider what might happen if you simply 
start nailing boards together when you want to build a house, rather than preparing a 
design beforehand. A properly designed database provides you with access to up-to-
date, accurate information with the least amount of effort needed to build and maintain 
it. A good design is essential to achieving your goals in working with a database, so 
spending the time to learn the principles of good design makes sense. In the end, you’re 
much more likely to end up with a database that meets your needs and can easily 
accommodate change. 

Designing a good database 
Certain principles guide the database design process. The first principle is that duplicate 
information (also called redundant data) is bad, because it wastes space and increases 
the likelihood of errors and inconsistencies. The second principle is that the correctness 
and completeness of information is important. If your database contains incorrect 
information, any reports that pull information from the database will also contain 
incorrect information. As a result, any decisions you make that are based on those 
reports will then be misinformed. 

Therefore, a good database design is one that: 

1. Divides your information into subject-based tables to reduce redundant data. 

2. Provides Access with the information it requires to join the information in the tables 
together as needed. 

3. Helps support and ensure the accuracy and integrity of your information. 

4. Accommodates your data processing and reporting needs. 
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The database design process 
Any database design should follow a logical series of steps. This helps ensure that you 
include all the required considerations to enable the best possible outcome with a 
minimum of backtracking and rework. It's important to note that you need to complete 
all of these steps in the design phase, before you even open Access. You can do this on 
paper, whiteboard, or whatever tool you use that allows for easy editing. Ideally, this 
process also includes input from and collaboration with at least one or more key people 
who will be using the database. To design your database: 

1. Establish your database’s purpose and intended uses. This will be the foundation for 
all your design decisions. 

2. Search for, find, and arrange the data that you need. Collect all the types of 
information you might want to include in your database in their current and 
potential formats. This might include information such as employee addresses on 
index cards or in an Excel workbook and categories of produce on signs or labels. 

3. Sort the information into tables. Sort your information items into main subjects, such 
as Produce or Employees. These subjects will be the basis for the tables in your 
database. 

4. Convert data items into fields. Decide what data belongs in each table, based on the 
subject of the table. Access will display each field as a column in the table. For 
example, an Employees table might include fields such as First Name and Date of 
Hire, and any fields about crops belong in the Crops table. 

5. Assign primary keys. Each table must have a field (or combination of fields) 
designated as a primary key, which is the information that uniquely identifies each 
item in the table, or record. If a primary key doesn’t already exist, you can have 
Access create one for you. Product ID and Order Number are possible examples of 
primary keys. 

6. Determine the table relationships. Review the tables in your database design and 
identify how the data in these tables relate to each other. You might have to clarify 
these relationships by adding fields to your tables or creating new tables, as needed. 
For example, you might add a Customer ID as a field in an Orders table to relate 
each order to a customer in a Customers table. 

7. Review and polish your design. Analyze your design for errors. It might help to create 
the tables and add a few records of sample data. Do you get the results you want 
from your tables? Do you need to adjust the design? 
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8. Apply data integrity and normalization rules. The basic rules for correct table 
structure include ensuring that: 

o Each table contains fields about only one subject. 
o Fields store the smallest logical piece of information. 
o Redundancy and repetition don’t occur in the data. 

To check for correct table structure, apply the data normalization (normal form) 
rules. If the tables are not structured correctly, you need to adjust them. 

So far in this module, you’ve been preparing for steps 1 and 2 in this list. In the next 
topic of this lesson, you’ll start steps 3 and 4, which are the basic steps for forming 
tables. You'll learn more about the remaining steps in later modules.  

 

Additional information 

For more information on the database design process, refer to: 
Database Design Basics 

Activity: K-W-L 
In this activity, you’ll create a three-column table. In the “K” column, you’ll record what 
you currently know about designing a good database. In the “W” column, you’ll record 
what you wonder about designing a good database. In the “L” column, you record what 
you need to learn to be proficient in designing a good database. 

Resources required 
• A table or a datasheet that has three columns 

Activity instructions 
Think about what you’ve learned in Lesson 1 and what you have just learned in this 
topic. Participate in the activity by following the prompts: 

1. Create a three-column table with a K, W, and L in the column names (fields). 

2. In the “K” column, record what you currently know about designing a good 
database. 

3. In the “W” column, record what you wonder about designing a good database. 

4. In the “L” column, record what you need to learn to be proficient in designing a 
good database. 

5. Be ready to explain what you record in the "K" column. 

https://aka.ms/Database-design-basics
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6. Be attentive to others as they share their list within the "K" column as it might 
provide answers to your "W" column. 

7. Seek opportunities to ask questions about your "L" column throughout this lesson. 

Try-it: Overview of database design guidelines 
 Many amazing structures around the world started out as concepts. Then, they 

were designed and constructed correctly. Similarly, the design and construction of your 
database need to unite with the concept if you want to create an effective database. In 
this try-it activity, you’ll understand and define the steps of the database design process 
and then apply that understanding. 

Resources 
You’ll need the following resources for this try-it: 

• The links in the Additional information callout immediately preceding this topic’s 
activity 

• L2_T1_try_design_steps.docx in this lesson’s Learning Activity Resources folder 
• L2_T1_sample_database_design.docx in this lesson’s Learning Activity Resources 

folder 

Instructions 
The following are the general tasks that you need to perform during this try-it: 

1. Review the lists in the following table. 

Object Properties 

School • Grades 
• Courses 
• Teachers 
• Class periods 
• Students 
• Attendance 
• Graduation years 
• Classroom Locations 
• Required courses/elective courses 
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Object Properties 

Clothes • Types of clothing 
• Sizes 
• Colors 
• Availability/in stock 

Music • Artists 
• Genres 
• Durations 
• Albums 
• Release dates 
• Composers 

Vehicles • Makes 
• Models 
• Years 
• Colors 
• Trims 
• Extra features 

Frozen 
desserts 

• Type 
• Add-ins 
• Cone types 
• Size 

Table 8: Datasets 

2. Review the information on good database design on the resource webpages. 

3. Open L2_T1_try_design_steps.docx. In the table in this document, provide a brief 
description in your own words of each step in the database design process. Your 
teacher will provide directions. 

4. Refer to the lists of datasets in the table, or any other database idea of your choice, 
and add some information to help illustrate your description. For example, in the 
case of the restaurant database: 

o For step 1, the example purpose might be, "To store data about employees, food 
products, and customers to enable tracking and reporting on restaurant 
operations. This will include shift scheduling, inventory management, and 
customer communications." 
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o For step 3, some table ideas could be employees, food products, customers, and 
work shifts. 

o For step 5, an example could be Employee Number for the employees table. 
5. Open L2_T1_sample_database_design.docx and review this example of a 

completed database design plan to improve your understanding of the database 
design process. If necessary, make any adjustments to your completed 
L2_T1_try_design_steps.docx. 

Topic 2: Develop table plans 
The design process includes a few steps while planning. Planning takes much of the 
labor out of the actual setup and often can be greatly beneficial to the overall goals of 
the individuals who are conducting the data design. If needed, refer to Topic 1 and 
review the list of design steps to follow when designing a database. In this topic, you’ll 
be focusing on design steps 3, 4, and 5 while exploring the concepts of building and 
developing table plans. The process of developing plans for the tables you’ll have in 
your database becomes simpler by applying design steps 3, 4, and 5. Review these steps 
in the following list: 

• Step 3: Sort the information into tables. Sort your information items into main 
subjects, such as Produce or Employees. These subjects will be the basis for the 
tables in your database. 

• Step 4: Convert data items into fields. Decide what data belongs in each table, based 
on the subject of the table. Access will display each field as a column in the table. For 
example, an Employees table might include fields such as First Name and Date of 
Hire, and any fields about Crops belong in the Crops table. 

• Step 5: Assign primary keys. Each table must have a field (or combination of fields) 
designated as a primary key, which is the information that uniquely identifies each 
item in the table or record. If a primary key doesn’t already exist, you can have 
Access create one for you. Product ID and Order Number are examples of primary 
keys. 
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Forming tables 
When you’re working on step 3 to divide into tables the information you want to include 
in your database, you need to think about deciding on a subject for each table. You can 
then start to identify patterns and groupings by selecting possible table subjects and 
understanding how each piece of information fits in. For example, if your collection of 
information includes facts about the produce at Munson’s and the employees 
harvesting that produce, you might propose a table about produce. However, when you 
review information about the employees, you realize that subject doesn't belong in a 
table about produce, so you’d add the subject of employees as another potential table. 

To apply step 4 to forming tables, one goal you’ll work toward is making each field 
contain the smallest logical part of the information that is meaningful. Consider the use 
of people's names as an example. If you were to include both first and last names in the 
same column, you would be unable to apply certain features, such as sorting by using 
last name or using the greeting, "Dear Mr. Hurtado," when personalizing a letter. 

Remember that each record in a table represents one item in a list and will need to be 
uniquely identified by one of its fields. It can be helpful to identify possible unique 
identifiers early in this process, so that you can ask yourself if a piece of information 
describes that unique identifier. Within this same table of people's information, you 
wouldn’t include the name of fruit or the order frequency because those items do not 
describe the subject, which is the people's data. The name of the fruit or vegetable sold 
would be in a separate table. 

Use the following table as a guide during steps 3 and 4. If you can answer "yes" to each 
of the following questions, then your table development plan is efficient enough to 
accurately process your information. 

Will each fact only be stored once? Yes 

Does every table contain fields about only one subject? Yes 

Will each field store the smallest logical part of information? Yes 

Is every field non-repetitive within a table? Yes 

Table 9: A question guide 
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Activity: One step back, two forward 
In this activity, you’ll think about what you’ve learned within the context of this topic 
and in previous topics and lessons. You’ll then predict where that knowledge will take 
you in the current topic. 

Resources required 
• A note card, piece of paper, or a digital method to record thoughts 

Activity instructions 
Think about what you’ve learned in Lesson 1 and what you just learned in Lesson 2, 
Topic 1. Participate in the activity by following the prompts. Respond to the following 
questions: 

• What was the most important thing you learned or performed in the previous lesson 
or topics? 

• List two things you think you might learn in this topic. 

Try-it: Develop table plans 
 Tables are the foundation of a relational database. Becoming familiar with their 

purpose and structure is paramount to comprehending the overall database function. In 
this try-it, you’ll practice planning tables and fields. Refer to steps 3, 4, and 5 in the 
database design process. 

Resources 
You’ll need the following resources for this try-it: 

• A way to record your results from the instructions 
• L2_T2_sample_database_design.docx in this lesson’s Learning Activity Resources 

Instructions 
The following are the general tasks that you need to perform during this try-it: 

1. Use an idea from the following list of database project ideas, or an idea of your own 
to complete the try-it. Compare your results to your classmates when finished. 
Consider creating a database: 

o For an animal shelter to track animals taken in, food and supplies, and adoptions. 
o For a food bank to manage inventory, recipients, or volunteers. 
o For a school cafeteria to manage menu planning, food and supplies, employee 

shifts, and student accounts. 
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o For an organization to manage their vending machines and stock them with 
items. 

o For a community radio station to organize their music collection and playlists. 
o For a school to track courses and course details and to produce a catalog. 
o For a clothing exchange or store to track donations or purchases of merchandise, 

recipients or customers, and transactions. 
o For a youth sports league to track players and other people, fields or venues, 

games, and tournaments. 
o For a sports team to manage their inventory of sporting equipment by tracking 

information such as members’ equipment, issue dates, and return dates. 
o For a family business to manage employees, products or services, customers, 

sales, and equipment. 
o For a charity to manage fundraising operations with donors and volunteers. 
o For a referral service that helps people experiencing homelessness find and 

contact resources. 
o For a water conservation agency to manage, analyze, and report on the impact of 

the community's efforts to save water. 
o For a parks and recreation organization to manage their resources and public 

programs. 
o For you or a public library to organize a book collection. 
o For you to track something for another class; for example, homework 

assignments, history data, or science experiments. 

2. For the database project idea that you selected, identify groupings of information by 
subject that could be the basis for tables. Refer to step 3 of the database design 
process. 

3. Identify information that could become fields for the tables from the last instruction. 
Refer to step 4 of the database design process. 

4. Identify a unique identifier field for each table that could be the primary key. Refer to 
step 5 of the database design process. 

5. Share your work with your classmates to compare your results. 
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Wrap-up 
Use these questions to check what you learned in this lesson: 

1. A _________________________ contains data about one aspect of the table subject, such 
as first name or email address. 

Fill in the blank space. 

2. Each table in a relational database should store data about one subject. Select the 
appropriate examples: 

Select all that apply. 

a. A customers table that lists a company’s customers and their addresses 

b. An employees table that tracks the customer orders taken by each employee 

c. A products table that lists the products that you sell, including prices and pictures 
for each item 

d. A products table that lists the products ordered by each customer 

3. A _________________________ key consists of one or more fields that uniquely identify 
each record that you store in the table. 

Fill in the blank space. 

4. Keeping data separated in related tables produces the following benefits: 

Select all that apply. 

a. Consistency 

b. Efficiency 

c. Comprehensibility 

d. Redundancy 
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Lesson 3: Understanding Access 
basics 
Overview 
In this lesson, you’ll explore the elements of the Access environment, and work with the 
database interface and tools. You’ll also discover how Access presents objects and data 
in a database, and how you can interact with them. 

Warm-up 
Use these questions to find out what you already know about this lesson’s topics: 

1. The Navigation Pane in Access provides a list of the _________________________ 
contained in a database file, which can include tables, queries, forms, and reports. 

Fill in the blank space. 

2. For a table, the view that you use to add data is called: 

Select the correct option. 

a. Design view 

b. Datasheet view 

c. SQL view 

d. Layout view 

3. The view that you use to specify the data being requested for a query is called: 

Select the correct option. 

a. Design view 

b. Datasheet view 

c. Form view 

d. Print view 
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4. For a form, the view that you use to review, add, and edit data is called: 

Select the correct option. 

a. Design view 

b. Form view 

c. Layout view 

d. Print view 

5. The different views that are used to configure the presentation of data in a report are 
called: 

Select all that apply. 

a. Design view 

b. Report view 

c. Layout view 

d. Print Preview 

Topic 1: Explore the Access 
environment 

 The Access interface has some similarities to other Microsoft Office apps that you'll 
likely recognize, such as: 

• The Backstage view where you can create new database files or open existing ones. 
• The Quick Access Toolbar that you can customize. 
• The ribbon with familiar tabs such as File, Home, and Help, and other tabs that are 

specific to the Access app, such as Create, External Data, and Database Tools. 
Similar to other Office apps, Access also provides contextual tabs when you’re 
working on particular tasks or functions. You’ll also find familiar commands such as 
Cut, Copy, Spelling, and Text Formatting. 

• The Status Bar that provides contextual information as you work in the program. 

Unlike the other apps, you cannot use Access to create a single document in a file. Each 
file in Access is actually a container for one or more objects, such as tables, queries, 
forms, reports, macros, and modules. Remember that this course does not cover using 
macros and modules. 
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Navigation Pane 
Within a database file, the objects it contains are listed in the Navigation Pane. The 
Navigation Pane is where you can browse between certain parts of your database as 
you analyze data. Your tables, queries, forms, reports, modules, and macros are all 
objects that you can find in the Navigation Pane. By default, these objects are grouped 
by object type. 

The Navigation Pane also contains a Search box, which is helpful for databases that 
contain many objects. Another feature that is helpful for large databases is the ability to 
hide objects in the Navigation Pane. Hiding an object or group can also be a better 
option than deleting it when the object or group is not in use, or you want to restrict 
access to it. The following screenshot depicts the Navigation Pane in Access: 

 
Figure 4: The Navigation Pane in Access 

Some tips for working with the Navigation Pane include: 

• If you open an Access database and the Navigation Pane is not available, select the 
F11 key on your keyboard. 

• You can expand or collapse each object group heading by selecting it. This can 
reduce the need for repeated scrolling through the object list. 
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• There is a "hidden" menu for changing how the Navigation Pane behaves and is 
presented. To access this menu, right-click or access the context menu for the title 
bar of the Navigation Pane. 

• For instructions on common tasks and hiding and displaying objects and groups, 
refer to the links in the following callout for additional information. 

 

Additional information 

For more information on using the Navigation Pane in Access, refer 
to: 

Use the Navigation Pane > Common Tasks 

Use the Navigation Pane > Hide and unhide objects and groups 

Activity: Each one, teach one 
In this activity, you’ll reach out to a classmate and use the resources to learn how to 
perform certain actions by using the Navigation Pane in Access. 

Resources required 
You’ll need the following resources for this try-it: 

• L3_T1_act_harvest_tracking.accdb in this lesson’s Learning Activity Resources 
folder 

• The links in the Additional information callout immediately preceding this activity 

Activity instructions 
1. Open L3_T1_act_harvest_tracking.accdb. 

2. Review the material from the links in the Additional information callout. 

3. Find a partner. 

4. Teach your partner something new that you learned. 

5. Allow your partner to teach you something new that they learned. 

Try-it: Explore the Access environment 
 In this standalone try-it activity, you’ll explore the Access environment by using a 

sample database. 

https://aka.ms/use-the-navigation-pane-common-tasks
https://aka.ms/use-the-navigation-pane
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Resources 
You’ll need the following resources for this try-it: 

• L3_T1_try_harvest_tracking.accdb in this lesson’s Learning Activity Resources 
folder 

Instructions 
The following are the general tasks that you need to perform during this try-it: 

1. Start Access and open the database L3_T1_try_harvest_tracking.accdb. 

2. Note the groupings and objects listed in the Navigation Pane and answer the 
following questions: 

o First group header: _________________________ 
How many of those objects? _________________________ 

o Second group header: _________________________ 
How many of those objects? _________________________ 

o Third group header: _________________________ 
How many of those objects? _________________________ 

o Fourth group header: _________________________ 
How many of those objects? _________________________ 

3. In the Navigation Pane, select the title bar or the drop-down arrow to open the 
Navigate To Category and Filter By Group menus. What are the selected options 
for each menu? 

a. Navigate To Category: _________________________ 

b. Filter By Group: _________________________ 

4. Select a different option in the Navigate To Category section of the menu. 

a. Note the changes to the Filter By Group section of the menu. 

b. Identify what items have moved or have been rearranged. 

5. Repeat step 4, selecting each of the other options in the Navigate To Category 
section. 

6. In the Navigate To Category and Filter By Group menus, restore the settings to 
what you noted in step 3. 

7. In the Navigation Pane title bar, select the Shutter Bar Open/Close Button. 
Identify what changed in the Access interface. 

8. Reverse the action by selecting the Shutter Bar Open/Close Button again. 
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Topic 2: Explore an Access file 
 Now that you know where to find the Navigation Pane and how to use it to 

identify and locate the objects contained in a database file, you can continue to explore 
the harvesting team's database and its objects and data. You’ll identify what an 
employee might be working on when they first begin to enter crop harvesting data and 
other important duties that the harvesting team performs. 

Earlier in this module, you learned about the different types of objects in an Access 
database. In this topic, you’ll review and understand these objects specifically from an 
Access perspective, and how you can identify objects and their meaning or purpose. 

Naming conventions 
You won't be naming objects until later in the course, when you create those objects. 
However, it's important to have an awareness of naming conventions now, as you start 
to explore an Access database. This is a general term in the digital world for the 
recommended practice of naming things to a designated standard. This helps users to 
identify items more easily, especially when they are out of context. For example, with 
Access, you might find a reference to an object in a design document. It's much simpler 
and shorter to identify "tblProducts" than "a table called Products", or worse, something 
just called "Products." It's also clearer when there is the potential to have items with the 
same name, such as "tblProducts" and "frmProducts." 

You might encounter or already have your own naming conventions for folders, files, 
objects in Access, worksheet tabs in Excel, and more. These could be specific to a team, 
an organization, or an industry. Typically, with Access, you will use prefixes for object 
names and keep the rest of the name concise and clean. This means no spaces, no 
characters other than letters, digits, and underscores, and limited use of hyphens and 
suffixes. With Access databases, you might find various levels and differences in naming 
conventions in the real world. However, the most important thing to remember about 
naming conventions is to be as consistent as possible. 

Tables 
Tables are the only objects in a database that contain, or store, data. Access will present 
tables in a format called a datasheet, which is similar to a spreadsheet with rows and 
columns. Each row represents a record and each column represents a field. Basic naming 
conventions will typically have table names with a "tbl" prefix. 
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Queries 
Queries are primarily used to select data, which means that they search the tables to find 
and display the data that is stored in those tables. Queries are how you ask questions of 
the data. In Access, you'll learn later that in a query, you can specify from which tables 
you want to retrieve which fields and usually, the conditions for which records you want 
to include in the query results. For example, from a table about employees, you want 
first name and last name for any employee who lives in a specific city. 

You can also use queries to not only select the data but also summarize it. For example, 
you can find a total of sales amounts for all orders placed by each customer. You can 
use other types of queries for more complex results, or to perform actions such as 
adding, updating, and deleting records, or making new tables. 

Basic naming conventions will usually have query names with at least a "qry" prefix. 
Specifically, you could use "qsel" for select queries, "qsum" for summary queries, and 
others for the action queries such as "qdel" for a delete query. 

Forms 
You can use forms to facilitate the process of data entry, editing, and review. Forms help 
you: 

• Present the data in a more user-friendly manner. 
• Protect existing data. 
• Control and validate the data as it's entered. 
• Combine data from related tables to enable users to get complete information about 

the data. 

For example, you might come across forms for customers' information that also include 
the ability to enter and edit each customer's orders. Basic naming conventions will 
usually have form names with at least a "frm" prefix. You might also encounter a prefix 
of "frmsub" or "fsub" for a subform, which is a form inside another form. You’ll learn 
more about these objects later in this course. Sometimes you'll come across an object 
name that has a suffix, such as "_datasheet" or "_split" that further identifies a type or 
purpose of the form. 

Reports 
Reports provide a way to present data from the database in many ways, from simple 
lists or labels, to complex detailed and summarized reports, including charts. You can 
design reports for on-screen review, printing, or exporting to a format such as PDF. 
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Basic naming conventions will usually have report names with at least a "rpt" prefix. You 
might also encounter a prefix of "rptsub" or "rsub" for a subreport, which is a report 
inside another report, much like a form and subform. 

Macros and modules 
Macros and modules are objects that help you automate tasks and add functionality in 
an Access database. Basic naming conventions would use the prefixes of "mcr" and 
"mod." For the purposes of this course, that's all you need to know, but be sure to put it 
on your list for future, advanced learning of Access. 

 

Additional information 

For more information on the Access database objects, refer to: 
Database Basics > The parts of an Access database 

 

Video 

To review the video on database objects, refer to: Get to know 
database objects 

Activity: Rapid fire quiz 
In this activity, your teacher will divide your class into teams and pose several questions. 
The goal for you and your teammates is to answer the questions as fast as you can. 

Resources 
You’ll need the following resources for this try-it: 

• L3_T2_act_harvest_tracking.accdb in this lesson’s Learning Activity Resources 
folder. 

Activity instructions 
1. Open the database file. 

2. Review each of the features within the file.  

3. Recall the definitions found earlier within this module. 

4. Respond as a group to the teacher's rapid-fire quiz questions. 

  

https://aka.ms/Database-basics-the-parts-of-an-Access-database
https://aka.ms/video-get-to-know-database-objects
https://aka.ms/video-get-to-know-database-objects
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Try-it: Explore an Access file 
 Gaining a foundational knowledge of the Access interface can enhance your ability 

to perform various tasks within a database. However, the DBMS and the application of a 
good database design are what make a database exceptional when you’re running 
reports, queries, and adding data. In this standalone try-it activity, you’ll identify certain 
features that you’ll use throughout all the modules of this course. Identifying the 
features is your goal for now, and in upcoming modules, you’ll get a chance to use, 
apply, and become proficient with these features. 

Resources 
You’ll need the following resources for this try-it: 

• Open the L3_T2_try_harvest_tracking.accdb in this lesson’s Learning Activity 
Resources folder. 

Instructions 
The following are the general tasks that you need to perform during this try-it: 

1. Open the database file. 

2. Select each ribbon tab and explore the groups and commands within each one. 

3. When you have explored each of the tabs, return to the Home tab. 

Take note of the groups and commands on the Home tab and answer the following 
questions: 

1. On the Home tab, many of the commands are not available because 
_________________________ 

Fill in the blank space. 

2. Which commands on the Home tab are for working with records? 

Select all that apply. 

a. Spelling 

b. Form 

c. New 

d. Totals 
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3. What other command groups are included in the Home tab? 

Select all that apply. 

a. Reports 

b. Find 

c. Views 

d. Design 

e. Sort & Filter 

Select the Create tab. Note the groups and commands on this tab and answer the 
following questions. 

1. Which command group on the Create tab contains commands to help you ask 
questions of the database? 

Select the correct option. 

a. Templates 

b. Tables 

c. Queries 

d. Forms 

e. Reports 

2. How many tools on the Create tab enable you to create reports? 

Select the correct option. 

a. 4 

b. 2 

c. 3 

d. 6 
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Select the External Data tab. Note the groups and commands on this tab and answer 
the following question. 

1. Which of the following options on the External Data tab enable you to share data 
from the database? 

Select all that apply. 

a. Email 

b. Saved Imports 

c. PDF or XPS 

d. Excel 

e. PowerPoint 

Select the Database Tools tab. Note the groups and commands on this tab and answer 
the following question. 

1. Which command on the Database Tools tab do you think might help you identify 
how tables are connected to each other? 

Select all that apply. 

a. Compact and Repair Database 

b. Run Macro 

c. Analyze Performance 

d. Relationships 

 

Did you know? 

Database functions and structure are integrated to help ensure 
accuracy in manipulating data. 

 

Additional information 

To learn more about the features within an Access database, refer to: 
Learn the structure of an Access database 

https://aka.ms/Learn-the-structure-of-an-Access-database
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Topic 3: Open Access objects 
 In Access, you can work with each of the four main types of objects in at least two 

modes. One mode is for creating and configuring the object, and the other is for using 
the object. These modes are called views. Every object has a Design view, which is for 
creating and configuring the object. The active view might also provide different ribbon 
tabs and change the enabled commands within the ribbon tabs. The views for each of 
the four main object types are: 

• Tables: Datasheet view and Design view 
• Queries: Datasheet view, SQL view, and Design view 
• Forms: Form view, Layout view, and Design view 
• Reports: Report view, Layout view, Design view, and Print Preview 

You'll learn more specifically about each of these views in later modules in this course. 
For now, you only need to know that multiple views are available for objects. 

To open an object in a specific view, use one of the following steps: 

• With the object selected in the Navigation Pane, select the Enter key on the 
keyboard. You can also double-click the object. This will open the object in a default 
view for using the object. 

• With the object open in any view, you can select the Home tab and select the View 
drop-down list. This command also has variable default actions, but you can 
specifically choose a view by selecting one of the options in the drop-down list. 

• Alternatively, you can right-click or access the context menu for an object in the 
Navigation Pane and select a specific view. 

Opening database objects 
Opening tables, queries, forms, and reports will be a first for most of the class. This is an 
exciting time as you begin to explore the objects in an Access database. Multiple careers 
require employees to know how to manage and interpret data. Today is your start to 
that exciting future. What will the data indicate to you and to Munson's Pickles and 
Preserves Farm? 

In this topic, you’ll be opening and closing many database objects. When the objects are 
open, note the supporting contextual tabs that become available on the ribbon and the 
different views that are available with each object. 
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Activity: Show me how 
In this activity, you will instruct the teacher how to open objects and change views in a 
database file. You’ll also work on other tasks that the teacher asks of you in reference to 
the Access interface. Pay close attention to what is asked and what steps your 
classmates suggest. This will be helpful as you recall certain steps that work and other 
steps that might not be solutions. 

Resources 
You’ll need the following resources for this try-it: 

• L3_T3_act_harvest_tracking.accdb in this lesson’s Learning Activity Resources 
folder 

Instructions: 
1. Open the database file. 

2. Pay attention to the teacher's prompts for students to answer questions and provide 
suggestions and instructions to complete tasks in the database file. 

3. Explore the database file yourself to find solutions to the teacher's questions. 

Try-it: Open Access objects 
 Opening tables, queries, forms, and reports are the first steps to realizing the 

power of a database. Let's continue our quest to help Munson's Pickles and Preserves 
Farm by opening objects within Access. Examining an existing database will help you to 
understand how the well-designed database is constructed so that Munson’s employees 
can efficiently manage data and use it effectively to gain insights and make informed 
business decisions. 

Resources 
You’ll need the following resources for this try-it: 

• L3_T3_try_harvest_tracking.accdb in this lesson’s Learning Activity Resources 
folder 
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Instructions 
The following are the general tasks that you need to perform during this try-it: 

1. Open the database file. 

2. Open the first table listed and examine it. Answer the following questions. 

a. What is the name of the table? _________________________ 

b. What is the currently active View for the table? _________________________ 

c. How many fields does the table have? _________________________ 

d. Which field do you think is the primary key? _________________________ 

e. How many records are in the table? _________________________ 

f. Can you think of any other information that Munson’s could find helpful to store 
in this table? _________________________ 

3. Change to Design View for the table. Answer the following questions. 

a. How is the primary key field identified? _________________________ 

b. What is the Field Name of the primary key? _________________________ 

c. What is the Data Type of the primary key? _________________________ 

d. What is the Description for the second field? _________________________ 

e. What contextual ribbon tabs are available? _________________________ 

4. Change to Datasheet View for the table. Answer the following questions. 

a. What contextual ribbon tab is available? _________________________ 

b. How many records are in the table? _________________________ 

c. Can you think of a question that Munson’s might want to ask about data in this 
table? _________________________ 

5. Open the first query listed and examine it. Answer the following questions. 

a. What is the name of the query? _________________________ 

b. How is the data in the query different from the data in the table that's open? 
_________________________ 

c. How many rows are in the query results? _________________________ 

d. What contextual ribbon tab is available? _________________________ 

e. Can you think of a question that Munson’s might ask that could be answered by 
this query? _________________________ 
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6. Change to Design View for the query. Answer the following questions. 

a. From which table(s) does the query retrieve data? _________________________ 

b. Can you identify the primary key in the table(s)? _________________________ 

c. What contextual ribbon tab is available? _________________________ 

7. Open the form and examine it. 

a. Do you think Munson’s employees would find it easier or more difficult to use the 
form instead of the table to enter data? _________________________ 

b. What aspects of the form cause you to make that choice? _________________________ 

8. Open the first report listed and examine it. 

a. What is the name of the report? _________________________ 

b. What information can Munson’s employees find in this report that they can’t get 
from reviewing the other objects (tables, queries, forms)? _________________________ 

c. What aspects of the report cause you to make that choice? 

9. Are there any other observations that you have from examining this Access database 
and the objects in it, especially in your role as an intern at Munson’s Pickles and 
Preserves Farm? _________________________ 

10. Wait for the teacher’s instructions before closing the Access database file. 

Wrap-up 
Use these questions to check what you learned in this lesson:  

1. The objects included in the Navigation Pane include: 

Select all that apply. 

a. Views 

b. Tables 

c. Relationships 

d. Queries 

e. Fields 
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2. You can use the Navigation Pane to: 

Select all that apply. 

a. Search 

b. Calculate totals 

c. Filter by group 

d. Navigate to a category 

e. Create objects 

3. Which view is available in all of these objects: tables, queries, forms, and reports? 

Select the correct option. 

a. Datasheet view 

b. Design view 

c. Layout view 

d. Print view 

e. Report view 

4. When you select a table that is open in Design view, which item can you identify? 

Select the correct option. 

a. Primary key 

b. Related queries 

c. Relationship to other tables 

d. Reports that reference the table 

5. When you select a query that is open in Design view, which information is available? 

Select all that apply. 

a. Primary keys for tables 

b. Selected fields 

c. Relationships between tables 

d. Reports based on the query 
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Glossary 
Anomalies Irregularities, differences, or variances that can be caused by an 

inefficiently designed database. These can occur more often in 
unnormalized databases (also known as flat databases). 

Data type A property of a field that indicates the kind of data that can be stored 
in that field. 

Database A tool for collecting information that is organized to provide efficient 
retrieval of data. Databases often begin as a list of items that have 
some form of relevance. 

Database 
Management 
System (DBMS) 

A software program (application) that is used to create, store, 
manipulate, find, and manage data in a database. 

Datasheet An interactive presentation of a table with fields in columns and 
records in rows, which is similar to an Excel spreadsheet. 

Field A single descriptive item of information about items in a list, 
organized into columns within a table. 

Flat database A single list organized with records in single rows and fields in 
columns. 

Form An Access object that allows the user to view, enter, and edit data in 
a user-friendly and controlled interface. 

Key fields Fields that uniquely identify a record (primary key) or connect a 
record to a record in another table (foreign key). 

Macro Access object that uses a simplified programming language to add 
functionality to a database, often used to automate actions and tasks. 
(Not covered as part of this course.) 
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Module Access object that is a collection of programming procedures, 
statements, and declarations that are stored together as a unit.  
(Not covered as part of this course.) 

Naming 
conventions 

Recommended practice of naming items such as folders, files, and 
Access objects to a designated standard. 

Normalization A step in the database design process of reviewing a preliminary data 
structure according to specific rules to ensure that data is divided 
appropriately into tables to be most efficient and useful.  

Null value A value that doesn't exist.  

Objects Access components that are used to store, find, and otherwise 
manage data in a database. 

Queries Access objects within a database that are used to ask questions of 
data and retrieve specific data from one or more tables in the 
database and display it. 

Record A collection of fields about an item in a list, usually organized into 
rows in a table.  

Relational 
database 

A database in which data is divided into separate, subject-based 
tables, which are linked together by shared key fields into 
relationships to bring the data together as needed for meaningful 
information and insights. 

Relational 
Database 
Management 
System (RDBMS) 

A software program (application) that is used to create, store, 
manipulate, find, and manage data in a relational database. 

Relationship A designated connection between two tables through shared key 
fields to allow retrieval of related information from both tables. 

Report Access object used to present distilled or summarized data in an 
easily consumable format. 
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Table Access object in which data is stored in an organized structure similar 
to a spreadsheet. 

Value A value is the data stored in a field. Fields that are used as a primary 
key in a table cannot have a null value. 

View The term for how Access objects that are active are always presented 
for creating, designing, or using the object. 

Table 2: Glossary terms and definitions 
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Cornerstone 
Overview 
In the Cornerstone project, you’ll assess an Access database for good database design, 
and identify Access and database elements. Throughout this module, you and your 
classmates have had discussions and reviewed examples of what a database is and how 
a database is designed. You’ve also explored the Access interface and an Access 
database file. In this Cornerstone, you’ll open a database file, analyze its design quality, 
and make speculations or suggestions on the table structure, the field names, the 
potential naming conventions, and any other item that is not consistent with good 
database design. You’ll also identify parts of the Access interface and the database file. 

A helpful tip for completing this Cornerstone project is to consider the terms listed 
within the Glossary section of this module. 

Objectives 
The following table outlines the Cornerstone objectives and their corresponding MOS 
exam objectives. 

Understand the purpose of 
a database 

Not mapped 

Define database terms Not mapped 

Explore data sources Not mapped 

Understand database 
design principles 

Not mapped 

Plan tables Not mapped 

Identify the parts of the 
Access interface 

Not mapped 

Hide and display objects in 
the Navigation Pane 

1.1.3: Hide and display objects in the Navigation Pane 

Identify the items in an 
Access file 

Not mapped 



Introduction to databases and Microsoft Access 
 

 
58 

Open tables, queries, 
forms, reports 

Not mapped 

Use object views Not mapped 

Table 10: The Cornerstone objectives 

Duration 
50 minutes 

Instructions 
1. Complete the tasks below. 

2. Follow your teacher’s directions for where to save any files and a naming convention 
of saving your file. 

3. When you’re done with the Cornerstone, assess your completion and enter the 
points you think you earned within the task lists below. You can take the help of your 
teacher if required. 

Tasks 
You’ll work with one file in this Cornerstone: 

• Cornerstone_harvest_tracking.accdb in this Cornerstone's Learning Activity 
Resources folder 

Explore the database file and recognize good design practices where applicable. Identify 
where poor design practice is presented and which design principle is not being 
followed. Throughout the completion of this Cornerstone, you’ll also need to 
understand terminology and be able to identify elements of the Access interface and the 
database file itself. The following section includes the tasks you need to do in the file. 
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File: Cornerstone_harvest_tracking.accdb 
Task: Open and examine the database (12 points) 
1. Open the database file and examine the list of objects in the Navigation Pane. (1

point)

2. Identify and list any hidden objects in the Navigation Pane.

_________________________ (3 points) (1.1.3: Hide and display objects in the Navigation
Pane)

3. Determine and describe what you think is the purpose of this database.

_________________________ (2 points)

4. Are there any elements of poor database design present?

_________________________ (1 point)

o If you answered Yes, list any elements and explain why they are poor database
design choices:
_________________________ (5 points)

Points scored: ______ / 12 

Task: Open and examine a database table (28 points) 
1. Open tblCropHarvesting. (1 point)

2. Identify and describe the subject of this table.

_________________________ (1 point)

3. Are there any elements of poor database design in the table?

_________________________ (1 point)

o If you answered Yes, list any elements and explain why they are poor database
design choices:
_________________________ (5 points)

4. Which fields don’t belong in this table?

_________________________ (5 points)

5. What value is located in the sixth record in the Unit field?

_________________________ (1 point)

6. Switch to the Design View for the table. (1 point)
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7. Which field is the primary key for this table? 

_________________________ (1 point) 

8. Why is this field appropriate or inappropriate as the primary key for the table? 

_________________________ (5 points) 

9. For the field called Quantity: 

o What Data Type is assigned? 
_________________________ (2 points) 

o What Field Size is assigned? 
_________________________ (2 points) 

10. In the field named Unit, the data type is assigned as Short Text. What is the Field 
Size of this field? 

_________________________ (2 points) 

11. Switch to the Datasheet View for the table. (1 point) 

Points scored: ________ / 28 

Task: Open and examine a database query (20 points) 
1. Open qselHarvestersDates. (1 point) 

2. Describe the data results of this query. What question(s) of the data does it answer? 
________________________ (5 points) 

3. How many rows are in the query results? _________________________ (2 points) 

4. Switch to the Design View for the query. (1 point) 

5. From which table(s) does the query retrieve data? _____________________________ (3 
points) 

6. What are the primary key field(s) in the table(s)? ________________________ (3 points) 

7. Which field(s) is/are used to sort the results and what sorting order is applied? 
________________________ (2 points) 

8. If Munson’s wants to use the query results to contact each employee in the results of 
the query, which field(s) should be added to the design of the query? 
________________________ (3 points) 

Points scored: ________ / 20 
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Task: Open and examine a database form (5 points) 
1. Open frmEmployees. (1 point) 

2. What do forms allow users to do within the database? ________________________ (2 
points) 

3. How many records are presented on the form? ______________________________ (1 point) 

4. What is the value for the Employee First Name? ________________________ (1 point) 

Points scored: ________ / 5 

Task: Open and examine a database report (9 points) 
1. Open rptCropQuantities. (1 point) 

2. Which View is active for the report? _________________________ (3 points) 

3. How many crops are listed on the report? __________________________ (1 point) 

4. What is the Unit listed for Strawberries? _________________________ (1 point) 

5. Which tables in the database do you think are included as sources for the report? 
___________________________ (3 points) 

Points scored: ________ / 9 

TOTAL POINTS: ________ /74 
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Module overview 
Description 
Now that you’ve had a chance to review an existing database and explore the Microsoft 
Access 2019 interface, it's time to begin planning and creating your own database. This 
module introduces you to organizing related data into databases. You’ll become familiar 
with database tables, lists, and data types. You’ll also learn about primary keys and their 
purpose. Finally, you'll learn about creating Access files and tables, using AutoNumber, 
setting the primary key, and creating table fields. You'll have plenty of opportunities to 
apply these concepts. 

You'll begin by learning how to organize related data into tables, and then define and 
describe a primary key. Next, you'll create an Access database file with multiple tables, 
utilize AutoNumber, and set the primary key. Finally, you'll create text, numeric, 
Date/Time, and Yes/No fields in a table, and set various field properties. 

The following table outlines the lesson objectives and their corresponding Microsoft 
Office Specialist (MOS) exam objectives. 

Lesson Learning objective Exam objectives 

Starting the 
database design 

Organize related data into tables, 
describe data types and primary keys 
and describe their purpose. 

• Not mapped 

Starting an Access 
database 

Create an Access database file, create 
tables and add table descriptions, use 
AutoNumber, and set the primary key. 

• 1.2.3 
• 2.1.2 
• 2.1.3 
• 2.2.3 
• 2.4.6 

Creating table 
fields 

Create text, numeric, Date/Time, and 
Yes/No fields in a table, and set field 
properties. 

• 2.4.1 
• 2.4.2 
• 2.4.3 
• 2.4.4 
• 2.4.5 
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Lesson Learning objective Exam objectives 

Cornerstone: 
Create the CSA 
Operations 
database and 
tables 

Design and create an Access database, 
create table fields, import tables, link 
tables from a Microsoft Excel 
spreadsheet. 

• All the preceding 
exam objectives 

Table 1: MOS objectives by lesson 

Scenario 
Your visit with the Harvesting team at Munson’s Pickles and Preserves Farm was very 
worthwhile. They demonstrated how they use their database and described the thinking 
process that they used to decide which data to store and how to label that data to 
maximize its usefulness in their decisions. It’s now time to sit down with your 
Community Supported Agriculture (CSA) program team to figure out what data you 
need to store and to think about how you want to use the data. The answers to those 
two questions will dictate your next steps—creating tables and fields to store the data. 

Cornerstone 
At the end of this module, you’ll work on a Cornerstone project, in which you’ll design 
and create a database file. You’ll organize related data into the basis for tables, use 
AutoNumber and set the primary key, create table fields, and also compact and repair 
the database. 

  



Designing and setting up data structure 
 

 
6 

Lesson 1: Starting the database 
design 
Overview 
In this lesson, you'll discuss how to sort data into tables, determine field names, and 
predict the data type based on field names. You’ll then partner with a classmate to 
identify unique information based on field names and types to include in the table. At 
the end of this lesson, you'll be able to organize related data into tables and lists. You’ll 
then describe data types and define and explain the purpose of a primary key. 

Warm-up 
Use these questions to find out what you already know about this lesson’s topics: 

1. What is the storage structure for data in an Access database? 

Select the correct option. 

a. Forms 

b. Queries 

c. Reports 

d. Tables  

2. Which of the following are data types in Access? 

Select all that apply. 

a. Yes/No 

b. Table 

c. Large Number 

d. OLE Object 

3. ________________________ are columns that uniquely identify each row stored in the 
table. 

Fill in the blank space. 
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Topic 1: Organize related data 
Properly designing a database will provide you access to up-to-date, accurate 
information. Because a correct design is essential to achieving your goals in working 
with a database, it makes sense to invest the time required to learn the principles of 
good design. In the end, you're much more likely to create a database that meets your 
needs and can easily accommodate change. In this topic, you'll learn how to design a 
database properly. 

The design process 
The design process consists of the following steps: 

1. Determine the purpose of your database. Note down what you intend to use the 
database for and the purpose you want to achieve. 

2. Find and organize the information required. Gather all the types of information that 
you might want to record in the database, such as product name and order number. 

3. Divide the information into tables. Divide your information items into major entities 
or subjects, such as Products or Orders. Each subject then becomes a table. 

4. Turn information items into columns. Decide what information you want to store in 
each table. Each item is a field and is displayed as a column in the table. For example, 
an Employee table might include fields such as Last Name and Hire Date. 

Dividing the information into tables 
To divide the information into tables, choose the major entities, or subjects. For 
example, after finding and organizing information for a product sales database, the 
preliminary list might look like this: 

• Customers 
o Name  
o Address 
o Email 

• Suppliers 
o Company name 
o Contact name 
o Address 
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• Products 
o Product name 
o Price 
o Units in stock 

• Orders 
o Order number 
o Order date 
o Product 

The major entities included here are the customers, the suppliers, the products, and the 
orders. Therefore, it makes sense to start with these four tables: one for facts about 
products, one for facts about suppliers, one for facts about customers, and one for facts 
about orders. Although this doesn’t complete the list, it's a good starting point. You can 
continue to refine this list until you have a design that works well. 

Turning information items into columns 
To determine the columns in a table, decide what information you need to track about 
the subject recorded in the table. For example, for the Customers table, Name, Address, 
and Email comprise a good starting list of columns. Each record in the table contains the 
same set of columns so that you can store Name, Address, and email information for 
each record. For example, the Address column contains customers’ addresses. Each 
record contains data about one customer, and the address field contains that customer's 
address. 

 

Additional information 

For more information about database design, refer to: Database 
design basics 

  

https://aka.ms/Database-design-basics
https://aka.ms/Database-design-basics
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Caution 

This course uses database files that follow a general storyline for the 
CSA program at Munson’s Pickles and Preserves Farm. These database 
files are the Learning Activity Resource files that you’ll use to work on 
each module’s activities and try-its. Each Learning Activity Resource 
file contains the data and objects, such as tables, queries, forms, and 
reports, that you need to complete a corresponding activity. 

Due to this course’s modular nature, the objects and data in these 
files might vary across activities or try-its. Therefore, it’s important 
that you start your activities or try-its only with the designated files, as 
per applicable instructions. You also should note that screenshots in 
the topic content are for illustration purposes only and might appear 
different than those that are in the Learning Activity Resource files. 

Activity: Think-pair-share 
In this activity, you'll sort related information into appropriate tables. 

Resources required 
• None 

Activity instructions 
Participate in the activity by following these instructions: 

1. Pair with a classmate. 

2. Review the field names that your teacher provided. 

3. Review the table names and descriptions that your teacher provided. 

4. Discuss your grouping and sorting options with your partner. 

5. Place the fields in the appropriate table. 

6. Ask clarification questions. 

Try-it: Organize related data 
 In this standalone try-it activity, you'll think about the information to include in 

the Munson’s Pickles and Preserves Farm CSA database, and you'll create a list of tables 
and fields to group and organize relevant information. 
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Resources 
You'll need the following resource for this activity: 

• None 

Instructions 
1. Review the module scenario. 

2. Think about at least two tables that you would use to group information collected 
for use in the database. 

3. List at least five fields to include for each table. 

4. Share your ideas. 

5. Ask clarification questions. 

Topic 2: Overview of data types 
Careful selection of data types can help you take advantage of more Access features, 
such as data validation and functions, and improve the accuracy of the information that 
you’re storing. In this topic, you'll learn that when creating tables in Access, you must 
select a data type for each column of data. 

The following table lists the data types available in Access. 

Data type Usage Size 

Short Text Alphanumeric data, such as names and 
titles 

Up to 255 characters. 

Long Text Large amounts of alphanumeric data, such 
as sentences and paragraphs 

Up to approximately 1 
gigabyte (GB), but 
controls to display a 
long text are limited 
to the first 64,000 
characters 

Number Numeric data 1, 2, 4, 8, or 16 bytes 
Large Number Numeric data 8 bytes 
Date/Time Dates and times 8 bytes 
Currency Monetary data, stored with four decimal 

places of precision 
8 bytes 

AutoNumber A unique value generated by Access for 
each new record 

4 bytes (16 bytes for 
Replication ID) 
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Data type Usage Size 

Yes/No Boolean (true/false) data; Access stores the 
numeric value zero (0) for false, and -1 for 
true. 

1 byte 

OLE Object Pictures, graphs, or other ActiveX objects 
from another Windows–based application 

Up to approximately 2 
GB 

Hyperlink A link address to a document or file on the 
internet, an intranet, a local area network 
(LAN), or your local computer 

Up to 8,192 (each part 
of a Hyperlink data 
type can contain up to 
2048 characters) 

Attachment You can attach files such as pictures, 
documents, spreadsheets, or charts; each 
Attachment field can contain an unlimited 
number of attachments per record, up to 
the storage limit of the size of a database 
file. Note that the Attachment data type 
isn't available in MDB file formats. 

Up to approximately 2 
GB 

Calculated You can create an expression that uses data 
from one or more fields. You can designate 
different result data types from the 
expression. Note that the Calculated data 
type isn't available in MDB file formats. 

Depends on the data 
type of the Result 
Type property. Short 
Text data type results 
can have up to 243 
characters. Long Text, 
Number, Yes/No, and 
Date/Time should 
match their respective 
data types. 

Lookup 
Wizard 

The Lookup Wizard entry in the Data Type 
column in Design View is not a data type. 
When you choose this entry, a wizard starts 
to help you define either a simple lookup 
or a complex lookup field. A simple 
lookup field uses the contents of another 
table or a value list to validate the contents 
of a single value per row. A complex 
lookup field allows you to store multiple 
values of the same data type in each row. 

Dependent on the 
data type of the 
lookup field. 

Table 2: Data types available in Access 
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Additional information 

For more information on data types, refer to: Data types for Access 
desktop databases 

Activity: Pose a challenge 
In this activity, you'll think about the fields that your teacher provided and determine 
what kind of data type you should use in the table field. 

Resources required 
• None 

Activity instructions 
Participate in the activity by following these instructions: 

1. Review the field name that your teacher provided in Topic 1. 

2. Determine the correct data type for each field. 

3. Discuss your choice options. 

4. Ask clarification questions.  

Try-it: Overview of data types 
 In this standalone try-it activity, you'll determine data types of the Munson’s 

Pickles and Preserves Farm CSA database. 

Resources 
You'll need the following resource for this try-it: 

• Your list from Topic 1 of fields to include in the Munson’s Pickles and Preserves Farm 
CSA database. 

Instructions 
You'll perform the following general tasks during this try-it: 

1. Review the list of tables and fields that you created in Topic 1 for information to 
collect for the Munson’s Pickles and Preserves Farm CSA database. 

2. Review the type of data types available in Access. 

3. Identify which type of data type you’ll collect for each field. 

https://aka.ms/data-types-for-access-desktop-databases
https://aka.ms/data-types-for-access-desktop-databases
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4. Discuss the options for your choice. 

5. Ask clarification questions. 

Topic 3: Create primary keys 
When creating a database, you should identify at least one unique number column for 
each table, such as an employee ID number or a serial number. Access uses the unique 
identification to quickly associate data from multiple tables and collect that data for you. 
In this topic, you'll learn how to create a column that uniquely identifies each row stored 
in a table. 

Specifying primary keys 
In database terminology, this unique identification number is called the primary key of 
the table. If you already have a unique identifier for a table, such as a product number 
that uniquely identifies each product in your catalog, you can use the product number 
as the identifier and set it as the table’s primary key. 

You can only do this if the values in the product number column will always be different 
for each record. You can't have duplicate values in a primary key. For example, don’t use 
people’s names as a primary key, because names are not unique. You could easily have 
two people with the same name in the same table. 

A primary key must always have a value. If a column's value can become unassigned or 
unknown (a missing value) at some point, it can't be a component in a primary key. 

Setting a primary key 
Unless you have a specific reason not to, you should specify a primary key for a table. 
Access automatically creates an index for the primary key, which can help improve 
database performance. Access also makes sure that every record has a value in the 
primary key field, and that the value is always unique. Unique values are crucial because 
without them, there is no way to distinguish one row from other rows reliably. 

1. Select the table whose primary key to set or change. 

2. On the Home tab, in the Views group, select View, and then select Design View. 
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3. In the table design grid, select the field or fields to use as the primary key. 

o To select one field, select the row selector for the field that you want, as depicted 
in the following screenshot. 

 
Figure 1: Setting fields as the primary key 

o To select more than one field, use CTRL, and then select the row selector for each 
field. 

4. On the Design tab, in the Tools group, select Primary Key. 

A key indicator is found to the left of the field or fields that you specify as the primary 
key. 

Remove the primary key 
1. Select the table whose primary key you want to remove. 

2. On the Home tab, in the Views group, select View, and then select Design View. 

3. Select the row selector for the current primary key. If the primary key consists of 
multiple fields, use CTRL, and then select the row selector for each field. 

4. On the Design tab, in the Tools group, select Primary Key. 

When you’re saving a new table without setting a primary key, Access prompts you to 
create a new field for the primary key. If you select Yes, Access creates an ID field that 
uses the AutoNumber data type to provide a unique value for each record. If your table 
already includes an AutoNumber field, Access uses it as the primary key. If you select 
No, Access does not add a field and no primary key is set. 
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Additional information 

For more information on primary keys, refer to: Specifying primary 
keys, Setting a primary key, and Add or change a table’s primary key in 
Access 

Activity: Discuss and learn 
In this activity, you'll discuss what kinds of information are unique to people. Then you’ll 
examine the information that you discussed and determine if that information is the 
best option as a unique identifier. 

Resources required 
• None 

Activity instructions 
Participate in the activity by following these instructions: 

1. Participate in the discussion by providing examples of unique identifiers for a specific 
database. 

2. Ask clarification questions. 

Try-it: Create primary keys 
 In this standalone try-it activity, you’ll determine the unique identifier for the 

Munson’s Pickles and Preserves Farm CSA database tables. 

Resources 
• Your list from Topic 1 and Topic 2 of fields to include in the Munson’s Pickles and 

Preserves Farm CSA database. 

Instructions 
You'll perform the following general tasks during this try-it: 

1. Review the list of tables and fields that you created for your Munson’s Pickles and 
Preserves Farm CSA database tables. 

2. Think about the information that would be included in each field column and identify 
any issues with using that field column as the primary key. 

https://aka.ms/Database-design-basics-specify-primary-keys
https://aka.ms/Database-design-basics-specify-primary-keys
https://aka.ms/create-a-table-and-add-fields-Setting-a-primary-key
https://aka.ms/Add-or-change-a-tables-primary-key-in-Access
https://aka.ms/Add-or-change-a-tables-primary-key-in-Access
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Wrap-up 
Use these questions to check what you learned in this lesson: 

1. What is the first step in the design process? 

Fill in the blank space. 

________________________ 

2. Which of the following data field types do you use to include pictures, graphs, or 
other ActiveX objects from another Windows–based application? 

Select the correct option. 

a. Calculated 

b. OLE object 

c. Hyperlink 

d. Attachment 

3. If you don't set a primary key, Access will ask if you would like to set one. 

Select the correct option. 

a. True 

b. False 
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Lesson 2: Starting an Access 
database 
Overview 
At the end of this lesson, you'll be able to create an Access database file, create tables in 
multiple ways, add table descriptions, use AutoNumber, and set the primary key. You'll 
explore the available database templates, and learn how to compact and repair a 
database. You’ll then follow a demonstration of the methods for creating database 
tables and predict how to create a unique ID for records. 

Warm-up 
Use these questions to find out what you already know about this lesson’s topics: 

1. What happens when you attempt to create a database but do not supply a file
name?

Select the correct option.

a. Access does not create the database.

b. Access creates a temporary, unnamed database.

c. Access creates a database in the default location, with the name Database
followed by a sequential number.

d. Access creates a database in the default location, with the name MyDatabase
followed by a sequential number.

2. In Access, a template is which of the following?

Select the correct option.

a. A database to manage contacts

b. Where a database is stored

c. Two tables linked together

d. A ready-to-use database
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3. When you create a new blank database, Access opens a database that contains
which of the following?

Select the correct option.

a. One of each type of database object

b. A table

c. Sample data

d. A template

Topic 1: Create an Access file 
 Access comes with a variety of templates that you can use as provided or as a 

starting point. A template is a ready-to-use database that contains all the tables, 
queries, forms, macros, and reports needed to perform a specific task. Some templates 
contain a few sample records to help demonstrate their use. If you're not interested in 
using a template, you can create a database by building tables, forms, reports, and other 
database objects. In this topic, you'll learn how to organize your information by creating 
a new blank database, and then prevent or fix problems that arise by using the 
Compact and Repair Database command. 

Create a database by using a template 
1. On the File tab, select New, and then select the template that you want to use.

Several sets of templates are available in the New tab.

2. Enter a file name in the File Name box. To change the location of the file from the
default, select Browse for a location to put your database, browse to the new
location, then select OK.

3. Select Create.

Create a blank database 
1. On the File tab, select New, and then select Blank Database.

2. Enter a filename in the File Name box. To change the location of the file from the
default, select Browse for a location to put your database, browse to the new
location, and then select OK.

3. Select create. Access creates the database with an empty table named Table1 and
then opens Table1 in Datasheet view. The cursor is placed in the first empty cell in
the Click to Add column.
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4. Begin entering the data. Entering data in Datasheet view is designed to be very
similar to working in an Excel worksheet. Create the table structure automatically as
you enter data. Define new fields as you add a new column to the datasheet in the
table. Access automatically sets each field's data type, based on the data that you
enter.

Additional information 

For more information about creating databases, refer to: Create a new 
database 

Compact and repair a database 
Database files can quickly grow as you use them, sometimes affecting performance. Files 
can also occasionally become corrupt or damaged. You can use the Compact and 
Repair Database command to prevent or fix these problems. The compact process does 
not compress your data—it makes your database file smaller by eliminating unused 
space. The Compact and Repair Database command can also help improve your 
database's performance. 

Explore ways to compact and repair a database 
You can use several approaches to compact and repair a database. One common 
practice is to automatically compact and repair a database when it closes. Also, you can 
manually run the Compact and Repair Database command when you have a database 
open. You can also run it on a database that isn't open. 

Automatically compact and repair a database when it closes 
You can select the Compact on Close database option if you want to automatically 
compact and repair a database when it closes. Setting this option affects only the 
database that is currently open. Set this option separately for each database that you 
want to automatically compact and repair. In multiuser databases, you might not want 
to set this option because it can momentarily disrupt database availability. 

1. On the File tab, select Options.

2. In the Access Options dialog box, select Current Database.

3. In the Application Options section, select the Compact on Close check box.

4. Select OK.

5. Close and reopen the database for the option to take effect.

https://aka.ms/create-a-new-database
https://aka.ms/create-a-new-database
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Manually compact and repair a database that you have open 
• On the File tab, select Info then Compact & Repair Database. 
Access creates a copy of the compacted and repaired database in the same location. 

 

Additional information 

For more information about compacting and repairing a database, 
refer to: Compact and repair a database 

Activity: Discuss and learn 
In this activity, you'll review the available database templates in Access, then discuss 
when it's advisable to use a template and when you should use a blank database. Lastly, 
you’ll follow along as your teacher demonstrates the Compact and repair feature. 

Resources required 
• None 

Activity instructions 
Participate in the activity by following these instructions: 

1. Open Access and follow along as your teacher demonstrates how to create a 
database by using a template. 

2. Discuss the included template options and the tables and fields in the template that 
you choose. 

3. Participate in the discussion about when you would choose a template and when 
you would choose a blank database. 

4. Follow along as your teacher demonstrates the Compact and Repair database 
command. 

5. Ask clarification questions. 

  

https://aka.ms/Compact-and-repair-a-database
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Try-it: Create an Access file 
 In this standalone try-it activity, you'll put into practice what you learned in the 

activity by creating a blank database file. 

Resources 
• None 

Instructions 
You'll perform the following general tasks during this try-it: 

1. Create a new blank database for the Munson’s Pickles and Preserves Farm CSA
program and name the database CSA.

2. Set the database to automatically compact when it closes.

Topic 2: Create a table 
 In this topic, you'll learn how to create a new table in an existing database, copy 

data from another source, and import, append, or link to data from another source to an 
existing table in Access. 

Add a table 
You can add new tables to an existing database by using the commands on the Create 
tab in the Tables group.  

Figure 2: Tables group options 
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Create a table, starting in Datasheet view. In Datasheet view, you can enter data 
immediately and let Access build the table structure for you. Field names are assigned 
numerically (Field1 and Field2, for example), and Access automatically sets each field's 
data type, based on the data that you enter. 

1. On the Create tab, in the Tables group, select Table. Access creates the table and
selects the first empty cell in the Click to Add column.

2. On the Fields tab, in the Add & Delete group, select the type of field that you want
to add. If you don't find the type that you want, select More Fields.

3. You can move the field by dragging it. When you drag a field in a datasheet, a
vertical insertion bar appears.

4. To add data, begin entering the information in the first empty cell.

5. To rename a column (field), select the column heading, and then enter the new
name. You should give a meaningful name to each field so that you can tell what it
contains when you find it in the Field List pane.

Additional information 

For more information about adding tables, refer to: Creating a table 

Copy data from another source 
If your data is in another program, such as Excel, you can copy and paste it into an 
Access table. In general, this works best if your data is already separated into columns, 
as they are in an Excel worksheet. If your data is in a word-processing program file, it's 
best to use tabs or tables to separate the columns of data in that file before you copy 
the data. If your data needs editing or manipulation (for example, separating full names 
into first and last names), you might consider doing this before you copy the data. 

When you paste data into an empty table, Access sets the data type of each field 
according to what kind of data it finds there. For example, if a pasted field contains 
nothing but date values, Access applies the Date/Time data type to that field. If the 
pasted field contains only the words yes and no, Access applies the Yes/No data type to 
the field. 

https://aka.ms/creating-a-table
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If Access assigns generic field names, you should rename the fields as soon as possible 
to avoid confusion. Use the following procedure: 

1. On the Home tab, in the Records group, select Save to save the table.

2. On the Home tab, in the View group, select Datasheet View, select each column
heading, and then enter a descriptive field name for each column.

3. Save the table again.

You can also rename the fields by switching to Design View and editing the field names 
there. To switch to Design View, on the Home tab, in the View group, select Design 
View. 

Additional information 

For more information, refer to: Copy data from another source into an 
Access table 

Import, append, or link to data from another 
source 
You might have stored data in another application, and you want to import that data 
into a new table or append it to an existing table in Access. Or you might collaborate 
with people who keep their data in other applications, and you want to work with that 
data in Access by linking to it. Either way, Access makes it easy to work with data from 
other sources. You can import data from an Excel worksheet from a table in another 
Access database, from a SharePoint list, or from a variety of other sources. The process 
that you use differs slightly depending on your source, but you can use the following 
procedure to get started. 

1. On the External Data tab, in the Import & Link group, select New Data Source,
and then select the type of file that you're importing, as depicted in the following
screenshot.

https://aka.ms/Copy-data-from-another-source-into-an-Access-table
https://aka.ms/Copy-data-from-another-source-into-an-Access-table
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Figure 3: External Data options 

For example, if you're importing data from an Excel worksheet, select Excel. If you don't 
find the application type that you need, select More. 

2. In the Get External Data dialog box, select Browse to find the source data file, or
type the full path of the source data file in the File name box.

3. Select the option that you want. Note that all programs let you import, and some let
you append or link.

4. In the Specify section, choose how and where you want to store the data in the
current database. You can create a new table that uses the imported data or, with
some programs, you can append the data to an existing table or create a linked table
that maintains a link to the data in the source program.

o If a wizard starts, follow the instructions on the wizard, and on the last page of
the wizard, select Finish.

o If you import objects or link tables from an Access database, either the Import
Objects or Link Tables dialog box is revealed. Choose the items that you want
and then select, OK.

 The exact process that you use depends on whether you choose to import,
append, or link data.
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5. Access prompts you about whether you want to save the details of the import
operation that you just completed. If you think that you’ll perform this same import
operation again in the future, select Save import steps, and then enter the details.
You can then easily repeat the operation in the future by selecting Saved Imports
on the External Data tab in the Import & Link group; if you don't want to save the
details of the operation, select Close.

o If you chose to import a table, Access imports the data into a new table and then
displays the table under the Tables group in the Navigation Pane.

o If you chose to append data to an existing table, Access adds the data to that
table.

o If you chose to link to data, Access creates a linked table under the Tables group
in the Navigation Pane.

Additional information 

For more information, refer to: Import, append, or link to data from 
another source 

Activity: Show and tell 
In this activity, you'll observe as your teacher demonstrates how to create a new blank 
table, create a linked table, and import data from an external data source. 

Resources required 
• None

Activity instructions 
Participate in the activity by following these instructions: 

1. Follow along as your teacher demonstrates how to create a new blank table, create a
linked table, and import data from an external data source.

2. Participate in the discussion about when you could use the various options when
creating a table.

3. Ask clarification questions.

https://aka.ms/Import-append-or-link-to-data-from-another-source
https://aka.ms/Import-append-or-link-to-data-from-another-source
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Try-it: Create a table 
 In this standalone try-it activity, you'll link and import table data. 

Resources 
• Your CSA.accdb from the previous topic or L2_T2_try_sample_csa_starter.accdb in

this lesson’s Learning Activity Resources folder.
• The customer_sample.accdb and order_sample.xlsx in this lesson’s Learning

Activity Resources folder.

Instructions 
You'll perform the following general tasks during this try-it: 

1. Save customer_sample. accdb and order_sample.xlsx from this lesson’s Learning
Activity Resources folder to your class folder.

2. If it isn't open already, open your CSA.accdb from the previous topic or
L2_T2_try_sample_csa_starter.accdb in this lesson’s Learning Activity Resources
folder.

3. Import the content from the customer_sample. accdb and name the table
customer sample.

4. Link the content from the order_sample.xlsx and name the table order_sample.

Topic 3: Use AutoNumber and set the 
primary key 

 Unless you have a specific reason not to specify a primary key for a table, specify 
one. Access automatically creates an index for the primary key, which can help improve 
database performance. Access also makes sure that every record has a value in the 
primary key field, and that the value is always unique. Unique values are crucial because 
without them, there is no way to distinguish a particular row from other rows reliably. In 
this topic, you'll learn how to set the primary key by using an AutoNumber field. 

1. In the navigation pane, select the table to which you want to add the primary key.

2. Open the table in Design View by selecting the Home tab and View group, and
then select Design View.

3. Locate the first available empty row in the table design grid.
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4. In the Field Name column, enter a name, such as CustomerID 

5. In the Data Type column, select the drop-down arrow and select AutoNumber. 

6. In the Field Properties section, in New Values, select Increment to use 
incrementing numeric values for the primary key, or select Random to use random 
numbers. 

 
Figure 4: AutoNumber field property options 

When you create a new table in Datasheet view, Access automatically creates a primary 
key for you and assigns it to the AutoNumber data type. 

 

Additional information 

For more information, refer to: Add an AutoNumber field as a primary 
key 

Activity: Pose a challenge 
In this activity, you'll determine the steps to set a unique identifier or primary key, when 
no natural ID exists. 

Resources required 
• None 
  

https://aka.ms/Add-an-AutoNumber-field-as-a-primary-key
https://aka.ms/Add-an-AutoNumber-field-as-a-primary-key
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Activity instructions 
Participate in the activity by following these instructions: 

1. Think back to the discussion in Lesson 1, Topic 3 about creating unique identifiers or
primary keys, when creating a database table.

2. How could you uniquely identify records when no natural ID exists?

3. Discuss your ideas about creating the primary key.

4. Ask clarification questions.

Try-it: Use AutoNumber and set the primary key 
 In this standalone try-it activity, you’ll set the primary key by using AutoNumber 

and compact and repair the database. 

Resources 
• Your CSA.accdb from the previous topic or L2_T3_try_sample_csa_starter.accdb in

this lesson’s Learning Activity Resources folder.

Instructions 
You'll perform the following general tasks during this try-it: 

1. If it's not open already, open your CSA.accdb from the previous topic or
L2_T3_try_sample_csa_starter.accdb in this lesson’s Learning Activity Resources
folder.

2. Open the customer sample table and add a column as the primary key, and set it as
AutoNumber with increment values.

3. Open the order_sample table and add a column as the primary key, and set it as
AutoNumber with random values.
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Wrap-up 
Use these questions to check what you learned in this lesson: 

1. Entering data in Datasheet view is similar to entering data in a(n) 
________________________. 

Fill in the blank space. 

2. The Templates group is located on which of the following tabs? 

Select the correct option. 

a. Home 

b. Create 

c. Database Tools 

d. Datasheet 

3. Before you rename a table or other database object, you should do which of the 
following? 

Select the correct option. 

a. Save it. 

b. Close it. 

c. Edit it. 

d. Open it. 
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Lesson 3: Creating table fields 
Overview 
In this lesson, you'll learn how to create a variety of table fields, and then set the 
properties of each field depending on the data that you are collecting.  You'll also 
participate in discussions and follow demonstrations on creating text fields, numeric 
fields, Date/Time fields, and Yes/No fields. 

Warm-up 
1. Which of the following is not a field property? 

Select the correct option. 

a. Column Template 

b. Field Size 

c. Caption 

d. Allow Zero Length 

2. Which field property requires users to enter data in a specific format? 

Select the correct option. 

a. Validation Text 

b. Default Value 

c. Required 

d. Input Mask 

3. Short Text fields can have up to how many characters? 

Select the correct option. 

a. 50 

b. 100 

c. 155 

d. 255 
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Topic 1: Create text fields 
 To store a new piece of data about something for which you already have an 

Access table, add a field to the table. For example, suppose you have a table that stores 
the last name, first name, email address, telephone number, and mailing address of each 
of your customers. If you want to start tracking each customer’s preferred means of 
communication, you add a field to store that data. In this topic, you'll learn to add and 
configure text fields in an Access table. 

Adding fields 
Every field has certain essential characteristics, such as a name that uniquely identifies 
the field within a table, a data type that defines the data's nature, the available 
operations, and the storage space to set aside for each value. 

Before you create fields, try to separate data into its smallest useful parts. It is much 
easier to combine data later than it is to separate it. For example, instead of a Full 
Name field, consider creating separate fields for Last Name and First Name. Then, you 
can easily search or sort by First Name, Last Name, or both. If you plan to report, sort, 
search, or calculate on a data item, put that item in a field by itself. 

To enter data in the Add New Field column 
1. Create or open a table in Datasheet view by selecting the Home tab and View 

group, and then selecting Datasheet view. 

2. In the Click to Add column, select the data type of the field that you would like to 
create. 

3. Enter the name of the field that you want to create. Use a descriptive name to make 
the field easier to identify. 

4. Enter data in the new field. 

 

Additional information 

For more information, refer to: Adding fields 

  

https://aka.ms/create-a-table-and-add-fields
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Create a Short Text field 
You add a Short Text field to a table when you need to store small amounts of textual 
data. Short Text fields can store up to 255 alphanumeric characters. You can apply 
custom display formats, and you can also apply input masks that control how users 
enter data. 

You can add a Short Text field in Datasheet view as previously explained, or you can 
add and set field properties in Design View. 

1. Open the table in Design View by going to the Home tab and View group, and 
then select Design View. 

2. In the Field Name column, select the first blank row, and then enter a name for the 
field. 

3. Select the adjacent cell in the Data Type column, and then select Short Text from 
the list. 

4. Save your changes. 

Set or change Short Text field properties 
1. Use Design View to set all available properties by selecting the Home tab and View 

group, and then select Design View. 

2. On the General tab in the lower section of the table designer, in the Field 
Properties section, locate the property that you want to change. As depicted in the 
following screen clipping. 

 
Figure 5: Short Text field properties 

3. Select the field next to the property name. Depending on the property, you can enter 
data or select an option from a list. 

For information about how to use each field property, select the property and then 
Select F1. 
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Additional information 

For more information, refer to: Create or delete a Short Text field 

Create or delete a Long Text field 
A Long Text field can be useful for storing large amounts of information, such as notes, 
comments, and descriptions. The Long Text data type stores up to 65,536 alphanumeric 
characters and supports rich text formatting, such as different colors, fonts, and 
highlighting. 

You can add a Long Text field in Datasheet view, as previously explained, or you can 
add and set field properties in Design View. 

1. Open the table in Design View by selecting the Home tab and View group, and 
then select Design View. 

2. In the Field Name column, select the first blank row and then enter a name for the 
field. 

3. Select the adjacent cell in the Data Type column, and then select Long Text from 
the list. 

4. Save your changes. 

Set or change Long Text field properties 
1. Use Design View to set all available properties by selecting the Home tab and View 

group, and then select Design View. 

2. On the General tab in the lower section of the table designer, in the Field 
Properties section, locate the property that you want to change. The following 
screenshot depicts this. 

 
Figure 6: Long Text field properties 

https://aka.ms/Create-or-delete-a-Short-Text-field
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3. Select the field next to the property name. Depending on the property, you can enter 
data or select an option from a list. 

For information about how to use each field property, select the property, and then 
select F1. 

 

Additional information 

For more information, refer to: Create or delete a Long Text field 

Activity: Show and tell 
In this activity, the teacher will demonstrate how to create a field in Datasheet view and 
then switch to Design View for additional field property options. 

Resources required 
• None 

Activity instructions 
Participate in the activity by following these instructions: 

1. Participate in the discussion by sharing fields that should be text, and then identify it 
as Short Text or Long Text. 

2. Follow along as your teacher demonstrates how to create new fields and sets the 
data type and field properties. 

Try-it: Create text fields 
 In this try-it activity, you'll create the text fields that you identified in your list for 

the CSA database, and then you’ll set the field properties for each field. 

Resources 
You'll need the following resource for this try-it: 

• Your CSA.accdb from the previous topic or L3_T1_try_example_csa_starter.accdb 
in this lesson’s Learning Activity Resources folder. 

  

https://aka.ms/Create-or-delete-a-Long-Text-field
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Instructions 
You'll perform the following general tasks during this try-it: 

1. Refer to your list that you created in Lesson 1 of the tables and fields that you need 
for the Munson’s Pickles and Preserves Farm CSA database. 

2. Add each table then add each text field needed to the appropriate table by using the 
Datasheet view. 

3. Set the properties for each field by using the Design View. You should include a 
variety of field properties. 

Topic 2: Create numeric fields 
You add a Number or Currency field to a table when you need to store numeric 

data, such as sales and revenue figures or population data. Consider the optimal field 
size and additional properties such as decimal places, uniqueness, and whether the field 
is required when you create numeric data. In this topic, you'll learn to add and configure 
numeric fields in an Access table. 

Create a numeric field 
You add a Short Text field to a table when you need to store small amounts of textual 
data. Short Text fields can store up to 255 alphanumeric characters. You can apply 
custom display formats, and you can also apply input masks that control how users 
enter data. 

You can add a numeric field in Datasheet view, as previously explained, or you can add 
and set field properties in Design View. 

1. Open the table in Design View by selecting the Home tab and View group, and 
then select Design View. 

2. In the Field Name column, select the first blank row, and then enter a name for the 
field. 

3. Select the adjacent cell in the Data Type column, and then select number or long 
number from the list. 

4. Save your changes. 

  



Designing and setting up data structure 
 

 
36 

Set or change numeric field properties 
1. Use Design View to set all available properties by going to the Home tab and View 

group, and then select Design View. 

2. On the General tab in the lower section of the table designer, in the Field 
Properties section, locate the property that you want to change, as depicted in the 
following screenshot. 

 
Figure 7: Numeric field properties 

3. Select the field next to the property name. Depending on the property, you can enter 
data or select an option from a list. 

4. For information about how to use each field property, select the property and then 
select F1. 

 

Additional information 

• For more information, refer to: Create or delete a Number or 
Currency field 

Activity: Discuss and learn 
In this activity, the teacher will demonstrate how to create and set the field properties 
for a numeric field, and then demonstrate what happens when entering text into the 
numeric field. 

Resources required 
• None 
  

https://aka.ms/Create-or-delete-a-Number-or-Currency-field
https://aka.ms/Create-or-delete-a-Number-or-Currency-field
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Activity instructions 
Participate in the activity by following these instructions: 

1. Participate in the discussion by sharing fields that should be numeric, and then 
identify how to set the field properties. 

2. Follow along as your teacher demonstrates how to create the new fields and set the 
data type and field properties. 

Try-it: Create numeric fields 
 In this try-it activity, you'll create the numeric fields that you identified in your list 

for the CSA database, and then you’ll set the field properties for each field. 

Resources 
You'll need the following resource for this try-it: 

• Your CSA.accdb from the previous topic or L3_T2_try_example_csa_starter.accdb 
in this lesson’s Learning Activity Resources folder. 

Instructions 
You'll perform the following general tasks during this try-it: 

1. Refer to your list that you created in Lesson 1 for the tables and fields that you need 
for the Munson’s Pickles and Preserves Farm CSA database. 

2. Add each Numeric field needed to the appropriate table by using the Datasheet 
view. 

3. Set the properties for each field by using the Design View. You should include a 
variety of field properties. 

Topic 3: Create Date/Time fields 
 You add a Date/Time field to a table when you need to store dates and times. You 

can use date and time data for a variety of personal and business purposes, such as 
birthdays, shipping and billing information, and employee timecards. In this topic, you'll 
learn how to create and configure Date/Time fields. 
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Understand Date/Time fields 
When you use an Access database, you might find date and time values in numerous 
formats, such as a European format (28.11.2006 or 28-11-2006), a South Asian format 
(28/11/2006), or the U.S. format (11/28/2006). 

Regardless of how Access formats the date and time data, and regardless of how you 
enter the date or time data, Date/Time fields store the dates and times using a system 
called serial dates. The following table represents a typical serial date and time value. 

 
Figure 8: Example of serial date 

The integer portion of the value, to the left of the decimal point, represents the date. 
The fractional portion, to the right of the decimal point, represents the time. 

Add a Date/Time field 
You can add a Date/Time field in Datasheet view as previously explained, or you can 
add and set field properties in Design View. 

1. Open the table in Design View by selecting the Home tab and View group, and 
then select Design View. 

2. In the Field Name column, select the first blank row and then enter a name for the 
field. 

3. Select the adjacent cell in the Data Type column, and then select Date/Time from 
the list. 

4. Save your changes. 
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Set or change Date/Time field properties 
1. Use Design View to set all available properties by selecting the Home tab and View 

group, and then select Design View. 

2. On the General tab in the lower section of the table designer, in the Field 
Properties section, locate the property that you want to change, as depicted in the 
following screenshot. 

 
Figure 9: Date/Time field properties 

3. Select the field next to the property name. Depending on the property, you can enter 
data or select an option from a list. 

4. For information about how to use each field property, select the property and then 
select F1. 

 

Additional information 

• Learn more from about Date/Time fields through Microsoft 
Support. For more information, refer to: Create or delete a 
Date/Time field 

Restrict data input by using validation rules 
You can validate data in Access by using validation rules. You can use the expression 
builder to help you format the rule correctly. Set validation rules can in either Datasheet 
view or Design View. 

  

https://aka.ms/Create-or-delete-a-Date-Time-field
https://aka.ms/Create-or-delete-a-Date-Time-field
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Validation rules in Access: 

• Field Validation Rule: You can use a field validation rule to specify a criterion that 
all valid field values must meet. For example, a date field might have a validation rule 
that disallows values in the past. 

• Record Validation Rule: You can use a record validation rule to specify a condition 
that all valid records must satisfy. You can compare values across different fields 
using a record validation rule. For example, a record with two date fields might 
require that values of one field always precede values of the other field (for instance, 
the StartDate is before the EndDate). 

Create a field validation rule 
1. Select the field that you want to validate. 

2. On the Fields tab, in the Field Validation group, select Validation, and then select 
Field Validation Rule. 

3. Use the Expression Builder to create the rule. For more information about using the 
Expression Builder, refer to the article: Use the Expression Builder 

Create a message to display for field input that is not valid 
1. Select the field that needs a message for input that is not valid. The field should 

already have a validation rule. 

2. On the Fields tab, in the Field Validation group, select Validation, and then select 
Field Validation Message. 

3. Enter an appropriate message. For example, if the validation rule is >10, the message 
might be: Enter a value that is less than 10. 

4. For some examples of field validation rules and messages, refer to: Validation rule 
reference 

 

Additional information 

• Learn more from Microsoft Support. For more information, refer to: 
Restrict data input by using validation rules 

  

https://aka.ms/use-the-expression-builder
https://aka.ms/validation_rule_reference
https://aka.ms/validation_rule_reference
https://aka.ms/Restrict-data-input-by-using-validation-rules
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Activity: Tell a story 
In this activity, the teacher will demonstrate how to create a Date/Time field and then 
set a validation rule. 

Resources required 
• None 

Activity instructions 
Participate in the activity by following these instructions: 

1. Participate in the discussion by sharing fields that should be Date/Time field and 
identify validation rules for this field. 

2. Follow along as your teacher demonstrates how to create the new fields and set the 
data type and field properties. 

Try-it: Create Date/Time fields 
 In this try-it activity, you'll create Date/Time fields for the CSA database, and then 

you’ll set the validation rule for the field. 

Resources 
You'll need the following resource for this try-it: 

• Your CSA.accdb from the previous topic or L3_T3_try_example_csa_starter.accdb 
in this lesson’s Learning Activity Resources folder. 

Instructions 
You'll perform the following general tasks during this try-it: 

1. Refer to your list that you created in Lesson 1 for the tables and fields that you need 
for the Munson’s Pickles and Preserves Farm CSA database. 

2. Add each Date/Time field needed to the appropriate table by using the Datasheet 
view. If you didn’t initially list a field that will use the Date/Time data type, review 
your current tables to identify a table that requires this information, and then add 
the field. 

3. Set the properties for the field, including a validation rule. 
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Topic 4: Create Yes/No fields 
 Use the Yes/No data type to store a Boolean value, such as True or False, On or 

Off, Yes or No, and any field that contains only one of two values. This data type often 
maps to a Check Box control on a form or report. In this topic, you’ll learn how to add 
and set properties for the Yes/No field. 

Add a Yes/No field 
You can add a Yes/No field in Datasheet view, as previously explained, or you can add 
and set field properties in Design View. 

1. Open the table in Design View by going to the Home tab and View group, and 
then select Design View. 

2. In the Field Name column, select the first blank row and then enter a name for the 
field. 

3. Select the adjacent cell in the Data Type column, and then select Yes/No from the 
list. 

4. Save your changes. 

Set or change Yes/No field properties 
1. Use Design View to set all available properties by going to the Home tab and View 

group, and then select Design View. 

2. On the General tab in the lower section of the table designer, in the Field 
Properties section, locate the property that you want to change, as depicted in the 
following screenshot. 

 
Figure 10: Yes/No field properties 
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3. Select the field next to the property name. Depending on the property, you can enter 
data or select an option from a list. 

4. For information about how to use each field property, select the property and then 
select F1. 

 

Additional information 

Learn more about Yes/No fields through Microsoft Support resources. 
For more information, refer to: Create or delete a Yes/No field 

Activity: Pose a challenge 
The teacher will ask the class how to create a Yes/No field and types of properties for 
the type of field. Volunteer if you think that you can demonstrate the solution. 

Resources required 
You'll need the following resource for this activity: 

• None 

Activity instructions 
Participate in the activity by following these instructions: 

1. Think about how you've added other data type fields in your database, then predict 
how you’ll set the field data type as Yes/No. 

2. What properties do you think you could set for the Yes/No field? 

3. Share your ideas with the class and participate in the discussion. 

Try-it: Create Yes/No fields 
 In this try-it activity, you'll create Yes/No fields for the CSA database, and then set 

the properties for the field. 

Resources 
You'll need the following resource for this try-it: 

• Your CSA.accdb from the previous topic or L3_T4_try_example_csa_starter.accdb 
in this lesson’s Learning Activity Resources folder. 

https://aka.ms/Create-or-delete-a-Yes-No-field
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Instructions 
You'll perform the following general tasks during this try-it: 

1. Refer to your list that you created in Lesson 1 for the tables and fields that you need 
for the Munson’s Pickles and Preserves Farm CSA database. 

2. Add each Yes/No field needed to the appropriate table by using the Datasheet 
view. If you didn’t initially list a field that should use the Yes/No data type, review 
your current tables and identify a table that requires this information, and then add 
the field. 

3. Set the properties for the field. 

Wrap-up 
Use these questions to check what you learned in this lesson: 

1. The Date/Time fields store the dates and times as a system called 
________________________.  

Fill in the blank space. 

2. To ensure that the information inputted in a field is in the correct format, Access 
allows you to create a ________________________.  

Fill in the blank space. 

3. You should use the ________________________ data type if you would like to add a 
Check Box to collect a Boolean value such as True or False. 

Fill in the blank space. 
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Glossary 
Field  A column in a database table. 

Primary key The column in a database that uniquely identifies each row. 

Properties Control the appearance or behavior characteristics for objects and 
related parts like fields and controls. 

Table The most basic database object; stores data in categories. 

Template A ready-to-use database that contains all the tables, queries, forms, 
and reports needed to perform a specific task. 

Validation rule An expression that limits the values that can be entered in the field. 

Validation text The text in the error message that appears when users violate a 
validation rule. 

Table 3: Glossary terms and definitions 
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Cornerstone 
Overview 
This Cornerstone project requires you to plan and create a database. You'll use the skills 
that you learned in this module to create an Access file, create Access tables, use 
AutoNumber, and set the primary key. You'll also create table fields, and compact and 
repair the database. 

Objectives 
The following table outlines the Cornerstone objectives and their corresponding 
Microsoft Office Specialist (MOS) exam objectives. 

Starting the database 
design 

• Not mapped 

Starting an Access 
database 

• OD 1.2.3: Set Primary Keys 
• OD 2.1.2: Create linked tables from external sources  
• OD 2.1.3: Import tables from other databases 
• OD 2.2.3: Add table descriptions 
• OD 2.4.6: Configure fields to auto-increment 

Creating table fields • OD 2.4.1: Add and remove fields 
• OD 2.4.2: Add validation rules to fields 
• OD 2.4.3: Change field captions 
• OD 2.4.4: Change field sizes 
• OD 2.4.5: Change field data types 

Table 4: Cornerstone objectives 
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Duration 
40 minutes 

Instructions 
1. Complete the tasks for each file. 

2. When saving your file, add your name to the end of the filename—for example, 
You_pick_day_Dwayne_Espino. Follow your teacher’s directions for where to save 
your files. 

3. After completing the Cornerstone, assess your completion, and then enter the points 
that you think you earned within the task lists in the following sections. You can ask 
your teacher for help, if necessary. 

Tasks 
You'll work with two supporting files in this Cornerstone: 

• information.accdb 
• pictures.xlsx 

Task: Database design (11 points) 
1. Think of a subject that interests you to create a database. Some examples would be 

sports statistics, animals, video games, student information, or a company database. 
(1 point) (Not mapped) 

2. Plan your database by listing the information that you need to collect, and then 
organize that information in appropriate tables. You should list at least three tables 
and a total of at least 10 fields. (5 points) (Not mapped) 

3. Plan the fields needed for each table and determine the data type. Be sure to include 
at least four different data types (5 points) (Not mapped) 

Points scored: ________ / 11 
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Task: Create an Access file (7 points) 
1. Create your database file and set it to compact and repair the database on close. (1 

point) (Not mapped) 

2. Create at least three tables. (3 points) (Not mapped) 

3. Add a table description to each of the three tables. (3 points) (Exam objective 2.2.3) 

Points scored: ________ / 7 

Task: Create table fields (39 points) 
1. Create fields with the appropriate data type in each of your tables. You must include 

at least 10 fields in total. (10 points) (Exam objective 2.4.1) 

2. Establish a primary key for each of the tables. (3 points) (Exam objective 1.2.3) 

3. Set at least one of the primary keys to AutoNumber. (1 point) (Exam objective 2.4.6) 

4. Configure the field captions for each of the 10 fields. (10 points) (Exam objective 
2.4.3) 

5. Change the field size for each of the 10 fields. (10 points) (Exam objective 2.4.4) 

6. Set the validation rules for at least five fields. (5 points) (Exam objective 2.4.2) 

Points scored: ________ / 39 

Task: Import tables from another source (10 points) 
1. Import the information to collect table from the information.accdb. (5 points) 

(Exam objective 2.1.3) 

2. Configure the ID AutoNumber properties to increment values. (2 points) (Exam 
objective 2.4.6) 

3. Set captions for each of the three fields. (3 points) (Exam objective 2.4.3) 

Points scored: ________ / 10 

Task: Link a table from an Excel spreadsheet (10 points) 
1. Link the picture table from the pictures.xlsx file. (5 points) (Exam objective 2.1.2) 

2. Configure the ID AutoNumber properties to random values. (2 points) (Exam 
objective 2.4.6) 

3. Set captions for each of the three fields. (3 points) (Exam objective 2.4.3) 

Points scored: ________ / 10 

Total points: ________ / 77 
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Module overview 
Description 
Now that you know how to plan and create a database, you will want to add data to 
your database. In addition to adding data to your database one record at a time, you 
can also import larger datasets from other apps such as a Microsoft Excel workbook or 
another Access database. 

As you are aware, data keeps changing and you might often want to modify existing 
data or delete unwanted data. Similar to adding or deleting contacts in your phone, you 
can add, modify, or delete records in a Microsoft Access 2019 database. Sometimes, you 
might want to make the same types of changes to multiple records or display a certain 
subset of data in a specific order. Access includes several features that you can use to 
perform data operations like these. 

In this module, you will learn how to import data from Excel or other Access databases. 
You will also learn how to work with data in datasheets and forms, including how to add 
new data, change existing data or delete records, and how to use undo when editing 
and deleting records. You will learn to work with various features of datasheets and 
forms to work with data in a more efficient and consistent way, including using Find 
and Replace to make changes to multiple records. In both datasheets and forms, you 
will find records more quickly by using sorting and filtering. 

The following table outlines the lesson objectives and their corresponding Microsoft 
Office Specialist (MOS) exam objectives: 

Lesson Learning objective Exam objective(s) 

Using 
datasheets 

At the end of this lesson, you will be 
able to navigate datasheets, 
including hiding fields and adding 
totals rows, add and edit records in 
tables. 

• 2.2.1: Hide fields in tables 
• 2.2.2: Add totals rows 
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Lesson Learning objective Exam objective(s) 

Importing, 
sorting, and 
filtering data 

At the end of this lesson, you will be 
able to copy data from Microsoft 
Excel to create a table and append 
data to an existing table, import a 
table from a Microsoft Access 
database, and sort and filter the 
data in various tables. 

• 2.1.1: Import data into 
tables 

• 1.1.1: Import objects or 
data from other sources 

• 2.3: Manage table records 
o 2.3.2: Sort records 
o 2.3.3: Filter records 

Improving 
data-entry 
efficiency 

At the end of this lesson, you will be 
able to use Find and Replace to 
make changes to data, add choices 
and default values to tables, and 
create a form with an input mask. 
You will use the form to sort, add, 
and edit records. 

• 2.3.1: Find and replace 
data 

• 2.4.7: Set default values 
• 2.4.8: Apply built-in input 

masks 
• 4.2.2: Sort records by 

form field 

Cornerstone Prepare a database for an upcoming 
launch of Munson’s new preserves 
products by importing data from 
Excel and Access, creating forms, 
and working with the data through 
tables (datasheets) and forms. 

• All of the preceding exam 
objectives 

Table 1: The objectives by lesson 

Scenario 
You have created an Access database by using the information from your meeting with 
the Community Supported Agriculture (CSA) program team. You have also continued 
gathering the data you need to incorporate into your database from all the existing 
scattered information. 

As you work through the vast amount of information, you realize that you need to be 
more efficient in adding data to the database. You use different methods such as 
import, copy and paste, and direct entry into table datasheets. 

To arrange the data so that it is easy to locate and work with, you use techniques such 
as sorting, filtering, and finding and replacing. To make it easy for others in the team 
with less Access experience to observe, enter, edit, and sort or filter data, you create 
some basic forms. 
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Cornerstone 
This module concludes with a Cornerstone in which you will use the skills you learned in 
the module to begin preparing the CSA Program database for the launch of a new line 
of preserves products at Munson’s. In the Cornerstone, you’ll: 

• Add data to the database 
• Edit data in the database 
• Simplify data entry by configuring datasheets and forms 
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Lesson 1: Using datasheets 
Overview 
In this lesson, you will learn how to navigate datasheets using both buttons and 
keyboard commands. You’ll hide fields (columns) that you don’t need and add rows to 
datasheets that return averages and totals of the data in the table. You’ll also practice 
adding new and editing existing records in tables, and using sorting and filtering to 
organize that table data. 

Warm-up 
A keyboard shortcut is selecting two or more keys, usually simultaneously, to perform an 
action. Keyboard shortcuts can significantly speed up certain activities on a computer. 
Before you learn new ways to navigate an Access datasheet using keyboard shortcuts, 
work with a classmate to find out how many keyboard shortcuts you already know from 
playing computer games or from other applications you use. 

In the table provided, enter the keyboard shortcut in the first column and describe what 
it does in the second column. The table includes two examples to get you started. 

Be prepared to share your results with the class. 

Keyboard shortcut What it does 

Ctrl+S Saves a file, a document, or an Access object. 

Ctrl+C Copies content from a file or spreadsheet to the clipboard 
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Keyboard shortcut What it does 

  

  

  

Table 2: Keyboard shortcuts 

Topic 1: Navigate datasheets 
Munson’s has expanded their CSA business recently, which means that they have more 
members and orders in the database than when they started. Even though everyone is 
pretty happy about this, you and your fellow interns are starting to realize that 
managing all that data will require more skills. The first thing on the agenda is learning 
different ways to get around in, or, navigate, the records in a table datasheet. 

What’s a datasheet? 
A datasheet is an object view that is made up of rows and columns. Rows contain 
records, and columns contain fields. The terms are used interchangeably, so don’t be 
surprised if you come across, for example, fields referred to as columns. 

In Access, datasheet views are available for tables, forms, and queries. With the 
exception of certain kinds of queries, you can work directly with your data in datasheets. 
You’ll learn about forms later in this module, and queries later in the course. 

The Datasheet View is the default view for tables, and the one you use while working 
with data in your tables. 

Navigating a table datasheet 
You can navigate a datasheet by using: 

• The Record buttons. 
• Vertical and horizontal scroll bars. 
• Your keyboard, such as Page up or Page down keys and arrow keys, or keyboard 

shortcuts such as Ctrl+Right arrow. 
The buttons are: 

• First record 
• Previous record 
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• Current Record box (the current record and the total number of records) 
• Next record 
• Last record 
• New (blank) record 
• Filter indicator 
• Search box 

 
Figure 1: The buttons and scroll bars used to navigate a datasheet 

When using the navigation buttons: 

• Select a navigation button to move between records. 
• Navigate to a specific record by entering a record number in the Current Record 

box and then selecting Enter. 
• Quickly find a specific record by entering a search term in the Search box and then 

selecting Enter. 
To use the scroll bars, select the arrow buttons on either end of the scroll bar. 
Alternatively, drag the scroll box to quickly move from one end of the scroll bar to the 
other. You can select the scroll box and then select the Up, Down, Left, and Right arrow 
keys to scroll through the datasheet. Dragging the scroll box vertically will reveal a 
tooltip that indicates the current record’s position number in the datasheet. 
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Additional information 

For more information on locating specific records, refer to: Locate 
specific records in a database 

Using the keyboard to navigate a datasheet 
To navigate within a datasheet, you can use your keyboard to navigate between cells or 
to refer to the beginning or end of a row, column, or datasheet. The following table 
provides keyboard shortcuts with descriptions: 

Key or key combination What it does 

Tab or Enter or Right 
arrow 

Moves one field to the right in the same record, and after 
the last field, moves to the next record. If it’s the last 
record, it creates a new record. 

Shift+Tab or Left arrow Moves one field to the left in the same record. After the 
first field, moves to the previous record, if there is one. 

Down arrow Moves to the next record in the same field. 

Up arrow Moves to the previous record in the same field. 

Home Moves to the first field of the current record. 

End Moves to the last field of the current record. 

Ctrl+Home Moves to the first field in the first record. 

Ctrl+End Moves to the last field in the last record. 

Page up Scrolls up one screen 

Page down Scrolls down one screen 

Ctrl+Page up Scrolls left one screen 

Ctrl+Page down Scrolls right one screen 

Table 3: Keyboard shortcuts with descriptions 

https://aka.ms/Locate-specific-records-in-a-database
https://aka.ms/Locate-specific-records-in-a-database


Module 3: Adding and editing data 
 

 
11 

 

Did you know? 

It is possible to use all the commands on the ribbon by using only 
your keyboard without ever using the mouse! Select the Alt key, and 
then select the Right and Left arrow keys to navigate between ribbon 
tabs. 

For more information, please refer to: Navigate the ribbon with only 
the keyboard 

Hide and unhide fields in datasheets 
Think about circumstances when there was so much to notice, you couldn’t focus 

on what you needed to find or do. For example, consider when you couldn’t find 
something in the refrigerator because it was so full. Or, when unnecessary words in a 
sentence made it hard to understand. Hiding things temporarily can make a task much 
easier. 

You can hide fields (columns) in a datasheet as a way to simplify using datasheets with 
many fields because there will be fewer fields to read. You can also hide fields 
temporarily to enter data into only a few fields, to print a datasheet with only some 
fields, or to hide fields that are no longer used, but which contain data you might need 
in the future. 

The following screenshots compare the same datasheet without hidden fields and with 
hidden fields. Which printout would be easier to use for locating phone numbers of 
members? 

 
Figure 2: The tblMembers table with no hidden fields 

https://aka.ms/keyboard-shortcuts-for-access-nav-ribbon
https://aka.ms/keyboard-shortcuts-for-access-nav-ribbon
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Figure 3: The tblMembers table with some fields hidden 

If you save the table with the fields hidden, they will still be hidden the next time you 
open the table. If you don’t want to save the table with the fields hidden, unhide the 
fields before closing the table, or don’t save the table. 

 

Caution 

You can’t use or enter data in a field while it is hidden, so be careful 
not to hide fields you might need later. It’s best to unhide fields as 
soon as possible. 

Hide fields 
1. Select the field (or fields) that you want to hide. 

2. On the Home tab, in the Records group, select the More drop-down list, and then 
select Hide Fields, as the following screenshot depicts. Alternatively, right-click or 
access the context menu for the selected columns, and then select Hide Fields. 

 
Figure 4: The More button and Hide Fields selection 

  



Module 3: Adding and editing data 
 

 
13 

Unhide fields 
1. On the Home tab, in the Records group, select More, and then select Unhide 

Fields, as the following screenshots depict. Alternatively, right-click or access the 
context menu for the selected columns, and then select Unhide Fields. 

2. Select the check boxes for the fields you want to unhide, and then select Close. 

 
Figure 5: The More button and Unhide Fields selection 

 
Figure 6: Select all fields you want to be displayed in the datasheet in the Unhide 
Columns dialog box 

 

Did you know? 

You can use the Hide Fields feature to hide the Click to Add column. 
Many database authors do this after they finish creating their 
database, to lessen the chances that they, or someone else, will 
accidentally add a new column. 
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Add Total rows to datasheets 
A Total row is a row at the end of a datasheet that reveals totals and other 

calculations for the fields in the datasheet. Adding a Total row to a datasheet is useful 
because you can find and print totals quickly without having to perform more 
complicated steps, such as creating a report or a query. You can add a Total row as the 
last row in any datasheet including tables, queries, and forms. In this lesson, you’ll 
discover how to add Total rows to tables. 

Although the row itself is called a Total row, the calculations aren’t always a total of a 
numerical field. For example, even if your datasheet doesn’t have any fields with 
numbers, you can use a Total row to count the number of records. 

In the following screenshot of the Orders table, the Total row indicates that there are 
nine records, by using the Count function in the OrderDate column. It indicates that the 
total amount of the orders is $170.21, by using a Sum function in the OrderTotal 
column. 

 
Figure 7: The tblOrders table with a Total row 

Add a Total row to a datasheet 
1. Open a table in Datasheet View. 

2. On the Home tab, select Totals as depicted in the following screenshot. The Total 
row is added after the (New) record row. 

 
Figure 8: The Totals button 
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3. Select the cell in the Total row in the column where you want the total. 

4. Select the down arrow to reveal the calculation options, and then select the function 
you want to use. Refer to the following screenshot: 

 
Figure 9: Calculation options in the Total row 

5. To save the Total row as part of the datasheet, select Save on the Quick Access 
Toolbar. 

 

Did you know? 

For fields that have a data type of number, decimal, or currency, the 
following functions are available: Sum, Average, Count, Maximum, 
Minimum, Standard Deviation, and Variance. For text fields, only 
the Count function is available. 

 

Additional information 

For more information about using Total rows, refer to: Display column 
totals in a datasheet using a Totals row 

  

https://aka.ms/Display-column-totals-in-a-datasheet-using-a-Totals-row
https://aka.ms/Display-column-totals-in-a-datasheet-using-a-Totals-row


Module 3: Adding and editing data 
 

 
16 

 

Caution 

This course uses database files that follow a general storyline for the 
CSA program at Munson’s Pickles and Preserves Farm. These 
database files are the Learning Activity Resource files that you’ll use 
to work on each module’s activities and try-its. Each Learning Activity 
Resource file contains the data and objects, such as tables, queries, 
forms, and reports, that you need to complete a corresponding 
activity. 

Due to this course’s modular nature, the objects and data in these 
files might vary across activities or try-its. Therefore, it’s important 
that you start your activities or try-its only with the designated files, 
as per applicable instructions. You also should note that screenshots 
in the topic content are for illustration purposes only and might 
appear different than those that are in the Learning Activity Resource 
files. 

Activity: Follow me 
In this activity, you will follow along with your teacher to practice ways to navigate a 
datasheet using specific navigation techniques. 

Resources required 
You will need the following resources for the first part of this activity: 

• Open L1_T1_act_csa_program_starter.accdb in this lesson’s Learning Activity 
Resources folder. 

• Open the tblMembers table. 
Participate in the activity by following these instructions: 

• Follow your teacher’s instructions to navigate the table with the scroll bar, 
navigation buttons, and keys. 

• If you cannot move between rows or columns, you might have begun to edit a 
record. Select the Esc key to return to the navigation mode. 

• When you are using keys to navigate, do not use your mouse, and select only the 
required or keys and key combinations. Selecting other keys (letters, numbers, or 
backspace) can modify the data in the table. 

• If you think you accidentally changed the data, ask your teacher for help. 
o When you are done, close the database. 
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Activity: Show me how 
In this activity, observe your teacher demonstrate how to hide fields and add a Total 
row to a datasheet. 

Resources required 
None 

Instructions 
To participate in this activity: 

• Pay attention to the methods that your teacher uses to perform data entry and 
editing. 

• Be prepared to repeat these actions in the upcoming try-its. 
• Ask questions to clarify anything that isn’t clear to you. 

Try-it: Navigate datasheets 
 The Sales department has asked for a printout of all the sales so far. They need a 

dollar amount for the total orders, and a count of how many orders there are. This 
information is in the tblOrders table. In this try-it activity, you will prepare the 
tblOrders table datasheet for printing by hiding fields and adding a Total row. 

You’ll hide the MemberID and the FarmBoxID fields because you don’t want to include 
them in the printout. 

Resources required 
You will need the following resources for the first part of this activity: 

• L1_T1_try_csa_program_starter.accdb in this lesson’s Learning Activity Resources 
folder. 

• The tblOrders table. 

Instructions 
The following are the general tasks to perform during this try-it: 

1. Open L1_T1_try_csa_program_starter.accdb. 

2. Open the tblOrders table. 

3. In the tblOrders table, select the MemberID field and the FarmBoxID field, and 
hide them. 

4. Add a Total row to the tblOrders table. 
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5. In the Total row, add a field total in the OrderDate field to display the number of 
records by using the Count function. 

6. In the Total row, add a field total in the OrderTotal field to display the total of all 
orders by using the Sum function. 

7. For this try-it activity, you don’t need to print the datasheet. Instead, verify the 
following facts in your datasheet, and then ask your teacher to check your work: 

Row 10 should be the (New) row for entering new records.  

Row 11 should be the Total row. It should display 9 in the OrderDate column and $376.92 
in the OrderTotal column. 

 
Figure 10: The tblOrders table with two fields hidden and a Total row 

8. Unhide all the fields. 

9. Save the table with the Total row and then close it. 
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Topic 2: Add and edit records 
Add records to a table 

A quick way to add a new record is to enter the data directly in the table in the 
Datasheet View. To begin, navigate to the last row of the datasheet by selecting 
Ctrl+Down arrow or use the Tab key to navigate  to the last record with data. 
Alternatively, select the New (blank) record button in the record navigation buttons, 
as the following screenshot depicts: 

 
Figure 11: The New (blank) record button 

Add a new record 
1. There are several ways to add a new record: 

o On the Home tab, refer to the Records group, and then select New.  
o Navigate to the last row in the datasheet and enter data. An asterisk in the record 

selector indicates the last row. 
o Select Ctrl++(plus sign). 
o Select the New (blank) record button. 

2. Enter data for each field and select Enter or Tab after each entry. 

3. When you are done entering the data for the new record, do one of the following: 

o On the Home tab, in the Records group, select Save. 
o Select Shift+Enter. 
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o Move the cursor to the next or previous record. The following Did you know? 
provides additional information. 

 
Figure 12: The Save record button 

 

Did you know? 

There is no need to select Save record to save your changes to a 
record. When you move to the next (or previous) record, Access saves 
your changes automatically. This takes some getting used to. 
Wouldn’t it be great if it did other things for you too, such as 
homework? 

When you close a table, Access prompts you to save, referring to the 
changes you made to the design of the table itself (such as hidden 
fields or a filter). Access is not prompting you to save changes to the 
data stored in the table, because those changes would have already 
been saved. 

Notes about key (ID) fields 
As you learned in Module 2, tables should have one field that contains unique values. 
This means that no two records can have the same value in that field. These are called 
primary key fields. You can identify which field is a primary key field from the table’s 
Design View. Primary key field is typically the first field in the table, and sometimes has 
the word “ID” in the field name. 

• When you enter data in the primary key field, you must be sure to always choose a 
value that hasn’t been taken already. This is known as a unique value. 
o If you try to reuse a value in the primary key field, when you try to save the 

record or move to a different record, the following error message displays: “The 
changes you requested to the table were not successful because they would 
create duplicate values in the index, primary key, or relationship...”  
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The following screenshot depicts the error message: 

 
Figure 13: The error message when a primary key contains a value that is not unique 

• If the primary key field has (New) in it, it means the data type is AutoNumber, and 
you can’t (and don’t need to) enter any values in this field. Access will generate the 
values for this field. Select the Enter or Tab key to advance the active cell one more 
field and begin typing in that field. A few things to note about AutoNumber fields: 
o Do not use AutoNumber if you need a specific number for a record, because you 

cannot control which number is assigned to the record. 
o If you cancel entering a new record (for example, by selecting the Esc key), or if 

you delete a record, the AutoNumber associated with the record cannot be 
reused. 

 
Figure 14: The new record row, with the AutoNumber field OrderID 

Edit records in a table 
To edit records in a table: 

• Open the table and enter data directly in the datasheet. 
• Select Tab or Enter to move to the next field after you enter or change data. 
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• By default, when you move the cursor to the next field, all the contents of that cell 
are selected. If you enter a cell and start typing, everything in the cell will be 
replaced. 

• To enter the cell to change only part of the data, select the cell with a mouse or 
select the F2 key to clear the selection of all the cell contents and use an insertion 
point, and then use the following keys to move through and edit the data: 
o Backspace or Delete to delete 
o Left and right arrow keys to move left and right through the data 
o Ctrl+arrow keys to move word-by-word 
o Shift+arrow keys to select data 
o Home to refer to the first insertion point in the cell 
o End to refer to the end of the cell 
o F2 to toggle between an insertion point and selecting all the contents of a cell 
o Esc to cancel any changes in the cell and to stop editing the record. 

You can copy and paste data using the buttons in the Clipboard group on the ribbon, by 
right-clicking or accessing the context menu, or by using keyboard shortcuts (Ctrl+C to 
copy, Ctrl+V to paste). 

 

Additional information 

For more information on editing records in Access, refer to: Ways to 
add, edit, and delete records 

Recognize data entry symbols 
Next to each record, there is a small symbol that indicates the current status of the 

record. The following screenshot depicts that the current record is indicated by a change 
in color in the record selector: 

 
Figure 15: The record selector for the current record 

As soon as you make a change to a record, a small pencil icon appears next to the 
record, indicating that you are editing the record, and changes have not yet been saved. 

  

https://aka.ms/ways-to-add-edit-and-delete-records
https://aka.ms/ways-to-add-edit-and-delete-records
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After making all the changes to a record, select Save on the ribbon, or select Tab or 
Enter to move to the next record. The pencil icon will disappear, and your changes will 
be saved to the database. The following screenshot depicts the pencil, which indicates 
that the record is being edited and the changes are not saved: 

 
Figure 16: The pencil indicates that the record is being edited and the changes are not 
saved 

The asterisk in the record selector of the last row in a table datasheet indicates that this 
is a new row for entering new records, as the following screenshot depicts: 

 
Figure 17: The asterisk indicates the row to enter a new record 

Entering dates 
Date fields will display a button called a date picker that you can use to select a date 
from a calendar or select Today to enter today’s date. You can also enter the date in the 
short date format, which is often month/day/year. For example, February 6, 2020 would 
be entered as 02/06/2020. The following screenshot depicts a date picker in a date field: 

 
Figure 18: A date picker in a date field 
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Did you know? 

To enter today’s date, you can also select Ctrl+; (semicolon). 

 

Additional information 

For more information on date and time fields, refer to: Format a date 
and time field 

Delete a record in a table 
To delete a record in a table: 

1. Select the record selector for the record. 

2. Select the Delete key, or on the Home tab, in the Records group, select the Delete 
button. 

3. In the warning message that appears, select Yes. 

 
Figure 19: The record selector and a selected record 

 
Figure 20: The Delete button on the ribbon 

https://aka.ms/format-a-date-and-time-field
https://aka.ms/format-a-date-and-time-field
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Figure 21: The warning message that appears when you are about to delete a record 

 

Caution 

Only delete records if you are absolutely sure they are not needed. 
When you delete a record (or multiple records), you cannot undo the 
action and that data is unrecoverable. 

For this reason, it is a good idea to export the data or make a backup 
copy of a table before deleting multiple records. 

Use undo when editing and deleting records 
 Access has both an Undo button and a keyboard shortcut (Ctrl+Z) to undo actions. 

You can undo up to the last 20 actions, in the reverse order that you performed the 
original action. In other words, you can’t skip any. When you work with data in tables, 
the undo command works a little differently compared to other programs you’re used 
to. Undo only affects one record at a time. 

1. To undo the last action you made, select Undo or select Ctrl+Z. 

2. To undo multiple actions, repeatedly select Ctrl+Z, or select the arrow next to Undo 
Typing in the Quick Access Toolbar and select from the list. 

3. When working with table records, selecting Undo or selecting Ctrl+Z will undo 
changes to the current field if your cursor is still in it, or all the changes to the record 
as long as you haven’t begun to edit another record. To illustrate this idea, imagine 
you are editing the table with member details, and you’ve just changed Alba’s last 
name from “Smith” to “Sutton,” and the address from “123 Pine Avenue” to “4567 
Pine Avenue”. 

Name Address 

Alba Smith 123 Pine Avenue 

Daniel Tijerina 678 Cherry Street 

Table 4: The data before edits 
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Name Address 

Alba Sutton 4567 Pine Avenue 

Daniel Tijerina 678 Cherry Street 

Table 5: The data after edits 

o While your cursor is still in the address cell, Undo will revert the change to the 
address, but not the name. 

o After you move to the next record, Undo will revert all the changes you made in 
Alba’s record, including the name and the address change. 

o After you make a change in Daniel’s record, you can no longer undo anything in 
Alba’s record. 

 

Additional information 

For more information on undoing changes, refer to: Undo or redo 
typing or design changes 

For more information on adding, editing, and deleting records, refer 
to: Ways to add, edit, and delete records 

Activity: Show me how 
In this activity, observe your teacher briefly demonstrate the skills you will need in the 
upcoming try-its. 

Resources required 
None 

Instructions 
To participate in this activity: 

• Pay attention to the methods that your teacher uses to perform data entry and 
editing. 

• Be prepared to repeat these actions in the upcoming try-its. 
• Ask questions to clarify anything that isn’t clear to you. 
  

https://aka.ms/undo-or-redo-typing-or-design-changes
https://aka.ms/undo-or-redo-typing-or-design-changes
https://aka.ms/ways-to-add-edit-and-delete-records
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Try-it: Add and edit records 
 In this leveled try-it activity, you will work in the tblMembers and tblOrders tables 

to add new records, edit records, and delete a record. 

Try-it 1 
You have been given order information that you need to add to the tblOrders table. 
You will also make corrections to some data and fill in some missing information in 
members’ records. 

Resources 
You will need the following resources for this try-it: 

• L1_T2_try1_csa_program_starter.accdb in this lesson’s Learning Activity 
Resources folder. 

Instructions 
The following are the general tasks to perform during this try-it: 

1. Open L1_T2_try1_csa_program_starter.accdb. 

2. Open the tblOrders table. 

3. Add a new order to the tblOrders table with the following data: (Note that the 
OrderID will now be revealed as 10, or whatever the next highest value is. Because it 
is an AutoNumber field, you don’t need to enter the ID number. Access will 
generate it automatically.) 

o OrderDate: today’s date 
o PickupDate: one week from today’s date 
o MemberID: 5 
o FarmBoxID: 3 
o OrderTotal: 62.98 
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4. Use the information in the following table to fill in missing or incorrect data in the 
tblOrders table: 

OrderID Field to edit Value to enter 

1 OrderTotal 62.98 

3 PickupDate 12/24/2019 

6 MemberID 2 

7 OrderTotal 62.98 

8 FarmBoxID 4 

Table 6: The OrderID fields to edit 

5. To save the last edited record, on the Home tab, in the Records group, select Save, 
or select Shift+Enter. 

6. Close the tblOrders table and then close the database. 

Try-it 2 
You’ve been given the information to add a new member to the tblMembers table. 
You’ve also been alerted that one record was accidentally added twice, so you will 
delete the second, duplicate addition. 

Resources 
You will need the following resources for this try-it: 

• L1_T2_try2_csa_program_starter.accdb in this lesson’s Learning Activity 
Resources folder. 

Instructions 
The following are the general tasks to perform during this try-it: 

1. Open L1_T2_try2_csa_program_starter.accdb. 

2. Open the tblMembers table. 
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3. Add a new record with the following member’s information: 

o MemberID: 12 
o FirstName: Nihad 
o LastName: Homsi 
o AddressLine1: 456 Lake Boulevard 
o AddressLine2: Apt. 25 
o City: Mount Vernon 
o State: WA 
o Zip: 11215 
o Phone: 555-0190 
o BoxSize: Medium 
o Frequency: Weekly 
o Allergies: None 

4. Note that the records for MemberID 10 and 11 in the tblMembers table are for the 
same person, Yue Ying Lin, and all the information except the MemberID number is 
the same. 

5. Delete the record for Yue Ying Lin with the MemberID of 11. 

6. Begin entering data for a new member: 

a. MemberID: 13 

b. FirstName: your first name 

c. LastName: your last name 

7. Select the Esc key or the Undo button in the Quick Access Toolbar twice (or more, 
if necessary), until the new entry disappears, and the new record row is blank. 

8. Ask your teacher to check your work. 

9. Close the tblMembers table and then close the database. 

 

Did you know? 

When you enter data, select Ctrl+’ (the apostrophe) to copy the value 
from the previous record, so you don’t have to enter it again. 
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Wrap-up 
1. In a datasheet, what happens when you select Tab or Enter?

Select the correct option.

a. The active cell moves down.

b. The active cell moves to the right.

c. Access enters the data but doesn't move the active cell.

d. Access creates a new record.

2. What's the correct sequence of steps that you must perform to add a Total row to
add all the values in a field?

Indicate the correct sequence by adding the numbers 1-4 next to the following items.

a. Select Totals. ________________________

b. Open a table in the Datasheet View. ________________________

c. Select the drop-down arrow, and then choose the Sum function.
________________________

d. Select the cell in the Total row in the field for which you want to enter a total.
________________________

3. True or False: A Total row in a table reveals totals with the Sum function. No other
functions, such as Average or Count, are available in a Total row.

a. True

b. False

4. When you hide fields in a table, why should you follow the best practice of unhiding
the fields as soon as possible?

Select all that apply.

a. You can't observe data in the field if it’s hidden.

b. You can't edit data in the field if it’s hidden.

c. Access doesn’t save the hidden fields with the table.
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5. Which of the following are the correct first steps for creating a new record? 

Select all that apply. 

a. Select the New (blank) record button in the navigation buttons. 

b. Enter data in the last row of the datasheet that has an asterisk in the record 
selector.  

c. Select Ctrl+N. 

d. On the Home tab, in the Records group, select New. 

6. True or False: You can't undo a record deletion. 

a. True 

b. False 
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Lesson 2: Importing, sorting, 
and filtering data 
Overview 
In this lesson, you’ll learn how to import data from an Excel workbook and tables from 
another Access database. 

Warm-up 
With a classmate as a partner, brainstorm and recollect at least three times in your real 
life when you reused something that someone already made instead of making it all 
over again. Enter your answers in the supplied space. 

________________________ 

Topic 1: Copy data from Excel 
 Because data lists in Excel and Access tables are laid out in the same way with 

fields and records (columns and rows), you can use Copy and Paste to copy data from 
Excel into Access. You can use this technique to create a new table, or to add data to an 
existing table, which is called appending data. 

Prepare the Excel data before copying it to Access 
Before you import data from Excel, ensure that your data is ready by checking all of the 
following points: 

• There should be no blank (empty) rows or columns in your data.
• If you have headings, they should be in the first row, and should be no more than

one row.
• The data types in each column in Access and the data types of the Excel data you are

pasting must match.
• If you are adding (appending) data to an existing Access table and the Access table

uses AutoNumber (usually for an ID field), you should not try to add an ID number
from your data. Access will provide it for you.
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• If you are adding (appending) data to an existing Access table, the Excel columns 
need to be in the same order as the Access table and be the same number. If your 
Excel data has fewer columns than the Access table, add columns with headings and 
no data, so that the Excel structure matches the Access structure. 

The following screenshot depicts an example of Excel data with no ID column or data to 
match the Access table: 

 
Figure 22: Example of Excel data with 1) no ID column and 2) column with no data to 
match Access table 

Copy data from Excel to a new Access table 
Follow these steps to copy data from an Excel sheet into a new table in Access: 

1. In Excel, open the Excel workbook that contains the data. 

2. Select the sheet that contains the data. 

3. Select and drag through the cells that contain the data to select the cells. 
Alternatively, select cell A1, select Shift+Ctrl+Down arrow, and then select 
Shift+Ctrl+Right arrow. Copy the selected cells by selecting Ctrl+C, or by selecting 
Copy on the Home tab, as the following screenshot depicts: 

 
Figure 23: Copying selected cells in Excel 

4. Switch to Access. 
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5. Right-click or access the context menu for the navigation pane and choose Paste, 
or activate the navigation pane and select Ctrl+V. 

 
Figure 24: Pasting in the navigation pane 

6. Access will display a dialog box asking if the first row of the copied data contains 
column headings. Select Yes or No. In the example in these instructions, you would 
select Yes, as the following screenshot depicts: 

 
Figure 25: The column headings confirmation dialog box 

7. In the All objects were imported successfully message box, select OK, as the 
following screenshot depicts: 

 
Figure 26: A message confirming that the data was successfully imported 

Import data from Excel and add it to an existing Access table 
Follow these steps to add data from an Excel sheet to an existing table in Access: 

1. In Excel, open the Excel workbook that contains the data. 

2. Navigate to the sheet that contains the data. 
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3. Select and drag through the cells that contain the data to select them, or select the 
first cell that you want, select Shift+Ctrl+Down arrow, and then select 
Shift+Ctrl+Right arrow. 

4. Right-click or access the context menu, and then select Ctrl+C. Alternatively, on the 
Home tab, select Copy to copy the data, as the following screenshots depict: 

 
Figure 27: Copying selected cells in Excel 

 
Figure 28: Data in Excel that is selected and the Copy button 

5. Switch to Access. 

6. Select the asterisk in the new record row to select it. 
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7. On the Home tab, select the Paste drop-down list, and then select Paste Append, 
as the following screenshot depicts: 

 
Figure 29: The selected new record row and the Paste Append option 

8. In the dialog box confirming that you want to paste the records, select Yes, as the 
following screenshot depicts: 

 
Figure 30: The confirmation dialog box for appending new records 

 

Video 

To review the video on copying data from Excel to Access, refer to: Copy 
data from Excel 

  

https://aka.ms/Copy-data-from-Excel-Access
https://aka.ms/Copy-data-from-Excel-Access
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Activity: Show me how 
In this activity, observe as your teacher demonstrates two ways to add data to Access 
from Excel: 

1. Copy new member information from Excel and paste the data into the existing 
tblMembers table. 

2. Copy payment information from Excel and paste the data as a new table in the 
Access database. 

After the demonstration, participate in a brief discussion about the differences between 
appending data to an existing table and creating a new table, and how you can make a 
decision about which method to choose. 

Resources required 
None 

Activity instructions 
Participate in the activity by: 

• Observing the teacher demonstrate the two methods to add Excel data to an Access 
database. 

• Asking clarifying questions. 
• Referring to your Student Guide to observe the steps for each method. 
• Participating in a brief discussion about the advantages of each method, and how to 

choose between them. 

Try-it: Copy data from Excel 
 In this standalone try-it, you will import data from Excel into your Access database. 

Resources required 
You will need the following resources for this activity: 

• L2_T1_try_csa_program_starter.accdb in this lesson’s Learning Activity Resources 
folder. 

• L2_T1_try_spreads.xlsx in this lesson’s Learning Activity Resources folder. 
• L2_T1_try_spreads_categories.xlsx in this lesson’s Learning Activity Resources 

folder. 
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Instructions 
The following are the general tasks to perform during this try-it: 

1. In Excel, open L2_T1_try_spreads.xlsx, and then select the four records in the range 
A1:D5. 

2. Copy the selected range, and then switch to Access. 

3. In L2_T1_try_csa_program_starter.accdb, in the tblSpreads table, append the four 
records using Paste Append. You should have a total of five spreads in the 
tblSpreads table. 

4. Close the tblSpreads table. 

To copy the data for spread categories, open L2_T1_try_spreads_categories.xlsx in Excel, 
and then select and copy the range A1:C4. 

5. Note that the sheet name (on the sheet tab) is tblSpreadsCategories. This will 
become the new table’s name in Access. 

6. Switch to Access and paste the copied data to the navigation pane to create a new 
table named tblSpreadsCategories. 

7. Open tblSpreadsCategories to reveal the three records. Note the column names are 
the same as in the Excel sheet, and the table has the same name as the sheet tab 
name in Excel. 

8. Close the tblSpreadsCategories table. 

Topic 2: Import a table from an Access 
database 

 You can import tables (and other objects such as queries or forms) from other 
Access databases. Importing tables can be useful if you want to: 

• Consolidate all the tables in several databases into one database 
• Use objects that colleagues have made in their databases 
• Restore a table from a backup copy of the database 
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Import a table from an Access database 
To import a table into an Access database from a different Access database: 

1. Open the database into which you want to import the table. 

2. On the External Data tab on the ribbon, in the Import & Link group, select New 
Data Source drop-down list and select From Database, and then select Access, as 
the following screenshot depicts: 

 
Figure 31: Choosing Access as an external data source 

3. In the Get External Data dialog box, select Browse. 

4. Navigate to the database file on your computer, select it, and then select Open. 
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5. In the Get External Data dialog box, select OK, as the following screenshot depicts: 

 
Figure 32: The Get External Data - Access Database dialog box 

6. In the Import Objects window, choose the tab for the kind of object that you want 
to import: 

o Tables 
o Queries 
o Forms 
o Reports 
o Macros 
o Modules 
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Figure 33: Select the objects to import in the Import Objects window 

7. Select the object that you want to import, and then select OK. 

8. On the Save Import Steps dialog box, select Close. 

 

Did you know? 

There is a wizard in Access you can use to import data from Excel and 
create a new Access table. The wizard steps are similar to importing a 
table from Access. 

The wizard can be found on the External Data tab on the ribbon, in 
the Import & Link group. Open New Data Source, select From file, 
and then select Excel. 
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Activity: Pair and share 
What circumstances can you imagine where it would be useful to import an object from 
a different database? Discuss ideas with a classmate, and then be prepared to share one 
idea with the class. 

Resources required 
None 

Try-it: Import a table from an Access database 
 In this try-it, you will import two tables to the 

L2_T2_try_csa_program_starter.accdb database: 

• A copy of the tblOrders table from a backup of the database. 
• The tblCropHarvesting table in the L2_T2_try_harvest_tracking.accdb database. 

Resources required 
You will need the following resources for this activity: 

• L2_T2_try_csa_program_starter.accdb in this lesson’s Learning Activity Resources 
folder. 

• L2_T2_try_backup_csa_program_starter.accdb in this lesson’s Learning Activity 
Resources folder. 

• L2_T2_try_harvest_tracking.accdb in this lesson’s Learning Activity Resources 
folder. 

General instructions 
The following are the general tasks to perform during this try-it: 

1. Open the L2_T2_try_csa_program_starter.accdb database. 

2. Import the following tables: 

a. The tblOrders table from the L2_T2_try_backup_csa_program_starter.accdb 
database. 

b. The tblCropHarvesting table from the L2_T2_try_harvest_tracking.accdb 
database. 
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Did you know? 

You can export tables and other Access objects as backup before you 
make significant changes, or before deleting the object entirely. This 
way, if you make a mistake or change your mind, you can import the 
earlier version from the backup. 

 

Additional information 

For more information on exporting Access objects, refer to: Export a 
database object to another Access database 

Topic 3: Sort and filter data 
 When you have a large number of records, it can be hard to find what you are 

searching for. You can use sorting and filtering to organize your data, or temporarily 
hide data you don’t need, to make working with the data easier. 

Sorting records 
Sorting arranges items in a meaningful order, such as the process of taking roll in 
alphabetical order. 

The sort tools in Access provide you with two options to sort data: 

• Ascending: In this option, text fields display in alphabetical order from A-Z, 
numerical data displays from the smallest number to the largest, and date fields 
display from the oldest date to the newest. 

• Descending, which is the reverse of Ascending: text fields sort so that Z is at the 
beginning of the list, number fields sort from largest to smallest, and date fields sort 
from newest to oldest. 

Sort records in a datasheet 
To sort record, use one of the following methods: 

• Select the drop-down arrow in the field name and then choose the sort option you 
want (For example, you can select Sort A to Z). 

• Right-click or access the context menu for the field and choose the sort option you 
want (For example, you can select Sort A to Z). 

https://aka.ms/export-a-database-object-to-another-access-database
https://aka.ms/export-a-database-object-to-another-access-database
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• Select the field, and then, on the Home tab, in the Sort & Filter group, select 
Ascending or Descending. 

 
Figure 34: The field drop-down arrow 

 
Figure 35: The sort buttons on the ribbon 

Filtering records 
Filtering is the process of keeping the parts you want, and temporarily hiding the parts 
you don’t want. Consider how coffee is made. The hot water drips through the coffee 
grounds, and the coffee filter keeps the grounds from getting into your cup (most of the 
time). 

Filtering table data doesn’t remove the data from the table, it just hides the data you 
don’t want to display, so you find only the data you want revealed. 

For example, you could filter a list of members by city, searching for members who live 
in Baker Heights. When you review fewer records, it’s easier to locate a particular 
member who lives in Baker Heights. Access also reveals a count of the number of 
records in the filtered result, so you know how many members live in Seattle. In the 
following table, data is filtered so the result you find only has records where the city is 
Baker Heights. 

 
Figure 36: The Members table filtered by Baker Heights 

  



Module 3: Adding and editing data 
 

 
45 

The following conceptual diagram depicts a filter that displays records for Baker Heights 
in the City field: 

 
Figure 37: Conceptual diagram of a filter that displays records where the value in the City 
field is Baker Heights 

You can combine filters by applying one filter immediately after another filter. For 
example, after applying the filter for City as Baker Heights, you could apply another 
filter to reveal only records where the BoxSize field contains Small. In the following 
example, there are three people who live in Baker Heights who order a small farm box. 
You can observe that the City and BoxSize fields both have filters applied because of 
the filter symbol on the drop-down arrow. 

 
Figure 38: Two filters applied to a datasheet 

 

Caution 

Unless you want to combine filters, be sure to remove each filter 
before applying another one. If you don’t remove a filter, any 
subsequent filter you add will be combined with previous filters. 



Module 3: Adding and editing data 
 

 
46 

Filter records in a datasheet 
You can use the following four methods to filter a datasheet by a field. 

Use the Filter button 
1. In the field that contains the values that you want to sort by, select a cell or select 

the column. 

2. On the Home tab, select the Filter button, as the following screenshot depicts: 

 
Figure 39: The Filter button 

Use the field drop-down arrow to select check boxes 
1. In the field that contains the values that you want to sort by, select the field’s drop-

down arrow. 

2. Select or clear check boxes to choose the values that you want to refer to. For the 
selected check boxes, records with that value will display. 

Use the field drop-down arrow to apply a custom filter 
1. In the field that contains the values that you want to sort by, select the field’s drop-

down arrow. 

2. Choose the filter appropriate for the field type: text, date, or number. 

3. Select how you want to filter. You can choose from one of several options such as 
Equals, Does Not Equal, Begins With, and more. 
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4. In the Custom Filter window, enter the filter value you want to use, and then select 
OK. 

 
Figure 40: The field name drop-down list and Text Filters 

 
Figure 41: Custom Filter window 

Use Filter by Selection  
To filter by all the contents of the cell, in the field that contains the values you want to 
filter by, perform the following steps: 

1. Insert the cursor in a cell. 

2. Select Filter by Selection, and then choose one of following options: 

o Equals 
o Does Not Equal 
o Contains 
o Does Not Contain 

 
Figure 42: The Selection choices when the cursor is in the field, but no text is selected 
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To filter by part of the contents of a cell (a word, for example): 

1. In the field that contains the values you want to filter by, select the text. 

2. Select Filter by Selection, and then choose one of following options: 

o Contains 
o Does Not Contain 

 
Figure 43: The Selection choices when a word is selected in the field 

Clear a filter 
To clear a filter from a datasheet, do one of the following: 

• Select the drop-down list arrow in the field that has the filter and select Clear filter 
from <field name>, as the following screenshot depicts: 

 
Figure 44: The field drop-down list arrow, the Clear filter choice, and the (Select All) 
check box 

• To remove all filters applied to the datasheet, on the Home tab, select the Sort & 
Filter group, select Advanced, and then select Clear All Filters. 

• In the Sort & Filter group, select the Toggle Filter button. Note that the Toggle 
Filter button doesn’t clear the filter, it turns off the last filter that was applied. If you 
select the Toggle Filter button again, the last filter that was applied is reapplied. 
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Caution 

It is possible to save one (and only one) filter with a datasheet, so that 
next time you open the datasheet, the filter is still on. 

Generally, it is not a good idea to do this, because the next person 
who uses the datasheet won’t observe the records that are hidden, 
which might be confusing. (That person might be you!) 

 

Additional information 

For more information on filtering data in a datasheet, refer to: Apply a 
filter to view select records in an Access database 

Activity: Discuss and learn 
The teacher will refer to three lists and ask you to find particular records. You will vote 
on which list is easiest to use, and then discuss which characteristics of the lists made 
the difference. 

Resources required 
None 

Activity instructions 
Participate in the activity by following these instructions: 

1. One by one, examine the three lists that the teacher refers to, follow the teacher’s 
instructions to find particular records, and count how many there are. 

2. When you know the answer, indicate that you know the answer, but don’t say the 
answer out loud. 

3. Pay attention to how easy it was to find the records and count them, and which list 
you think was fastest to use. 

4. You will be asked to vote on which list was fastest and easiest to use. 

5. Participate in a brief discussion about the specific qualities of each list that made 
them harder or easier to use. 

6. Follow along as your teacher demonstrates how to use the four methods of sorting 
outlined in your Student Guide. 

  

https://aka.ms/apply-a-filter-to-view-select-records-in-an-access-database
https://aka.ms/apply-a-filter-to-view-select-records-in-an-access-database


Module 3: Adding and editing data 
 

 
50 

Try-it: Sort and filter data 
 In this leveled try-it, you will sort columns of data and use various methods of 

filtering data in a datasheet. 

Resources 
• L2_T3_try1_csa_program_starter.accdb in this lesson’s Learning Activity 

Resources folder. 
• L2_T3_try2_csa_program_starter.accdb in this lesson’s Learning Activity 

Resources folder. 

Try-it 1 
In this try-it, you will practice sorting data in the tblFarmBoxes table. You can use any 
of the sorting methods available. To challenge yourself, try to use at least two. 

1. Open L2_T3_try1_csa_program_starter.accdb. 

2. Open the tblFarmBoxes table. 

3. Before you sort the data, examine the tblFarmBoxes table to review the field that 
the data is sorted by already, and then record your answer in the space provided: 
The data in the tblFarmBoxes is sorted by the ________________________ field. 

4. Sort the table by the values in the Weight field, so the heaviest items are the first 
records in the list. 

5. Is the original sort still in place? Indicate Yes or No. 

6. Save the tblFarmBoxes table and close it. 

7. Open the tblFarmBoxes table. Which field is the table sorted by and why? Record 
your answer in the space provided. 
 

8. Close the table and the database. 

Try-it 2 
Work with a partner to use each of the following four methods of sorting or filtering to 
answer the questions given. You must use each of these sorting and filtering methods at 
least once: 

1. Sorting (use any method) 

2. The Filter drop-down list, select/clear check boxes 
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3. Filter by Selection  

4. The Filter drop-down list and add a custom value 

Instructions 
For each question in the table, perform the following steps: 

1. Open L2_T3_try2_csa_program_starter.accdb. 

2. Open the tblFarmBoxes table. 

3. Read the question in the first column of the table. 

4. Decide together which sort or filter method you should try. 

5. Apply the sort or filter to the datasheet. 

6. If your sort or filter worked as expected: 

a. Enter your answer in the Answer column. 

b. Note in the Sort or Filter method used column the number of the method you 
used. For example, if you used sorting, enter the number 1. 

7. Clear the filter or sort, unless you need to use two filters at the same time. 

8. At the end of the activity, clear all filters and close the table without saving any 
changes. 

Question Answer Sort or filter method used 
1: Sorting 
2: Filter with select/clear 
check boxes 
3: Filter by Selection 
4: Filter with custom value 

1. How many farm boxes 
weigh 10 pounds or 
more? 

  

2. How many farm boxes 
contain vegetables? 

  

3. How many farm boxes 
do not contain dips? 
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Question Answer Sort or filter method used 
1: Sorting 
2: Filter with select/clear 
check boxes 
3: Filter by Selection 
4: Filter with custom value 

4. How many farm boxes 
weigh less than 10 
pounds? 

  

5. How many small farm 
boxes are there? 

  

6. Apply two filters to 
discover how many 
farm boxes: 

o Include vegetables, 
and 

o Are five pounds or 
less 

  

Table 7: Using sort and filter methods 
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Wrap-up 
Turn to a neighbor and share your favorite way to filter data, or anything else covered in 
the module. Be prepared to share with the class. 

Next, use these questions to check what you learned in this lesson: 

1. What are the steps to copy data from Excel and append it to an Access table? 

Indicate the correct sequence by adding the numbers 1-4 next to the following items. 

a. Select the asterisk (*) in the new record row to select it. ________________________ 

b. On the Home tab, select the Paste drop-down list, and then select Paste 
Append. ________________________ 

c. Ensure you have no blank rows or columns in the Excel data and that only one 
heading row exists. ________________________ 

d. Select and copy the Excel data. ________________________ 

2. What are the two choices for sorting a text field? 

Select the correct option. 

a. Up and down 

b. Left and right 

c. Ascending and descending 

d. Low and high 

3. When you filter a datasheet, what is the action that you are actually performing? 

Select the correct option. 

a. Deleting the data that you don’t want from the database. 

b. Moving the data that you don’t want to a different table in the database. 

c. Temporarily hiding the data that you don’t want to study, without altering the 
data or removing it from the database. 

d. Putting the data in ascending or descending order by the value in a field. 
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Lesson 3: Improving data-entry 
efficiency 
Overview 
Data entry is fundamental to the integrity of the data in the database, yet it can be time-
consuming, tedious, and prone to typing mistakes. 

To make entering data easier and more efficient, in this lesson, you will learn how to edit 
records in bulk by using Find and Replace, add choices and default values to fields to 
reduce data entry errors, and create forms. You’ll use forms to sort records, and to add 
and delete records. To reduce the amount of data entry needed and increase data entry 
accuracy, you’ll create a field with a list of values, add a default value to a form, and 
apply an input mask. 

Warm-up 
Discuss with a classmate any situations in your life where you have found a more 
efficient way to do something. Have you figured out a better way to study, or a faster 
way home from school? Is there a shortcut you take when you fix yourself a snack? Note 
some ideas in the space provided. Be prepared to share your ideas with the class. 

________________________ 

Topic 1: Use Find and Replace 
 Making changes to multiple records that need the same change can be faster if 

you can quickly find the data to change using Find and Replace. For example, if you 
find a misspelling of a street name or company name in many records, rather than find 
and change them one by one, you can find all of them and change them all at once. 

Using Find and Replace to edit multiple records 
1. Open the table or a form with the data you want to find and replace.

2. Select the field (column) in which you want to perform changes.
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3. On the Home tab, select the Find group, and then select Replace, as the following 
screenshot depicts: 

 
Figure 45: The Replace button 

4. Depending on what you are searching for, fill in the Replace dialog box with the 
appropriate information in the following table. Note that all the information you add, 
taken as a whole, are called search criteria. 

Setting What it does 

Find What The text (or value) you want to find and be replaced. This is 
sometimes referred to as a search term. 

Replace 
With 

The text or value which will replace the original text. 

Look In The field that the Find and Replace will affect. Most of the time, you 
should keep this set to Current field, and be sure the active field is 
the correct one. This will prevent the Find and Replace from 
affecting other fields, where it might unintentionally change data. 

Match Start of field matches the Find What value with the first characters 
of the field. Whole field will match all of the contents of a field with 
the Find What value. Any part of field will search anywhere in the 
field’s value for the Find What value. 

Search  All will search all the records in the field or datasheet. Up and Down 
will search from the active row up, or down, respectively, and will not 
search the records on the other side of the active row. 

Table 8: The settings in the Find and Replace dialog box 

5. Select Find Next to find the first occurrence of the search term, and then (if Find is 
working as you expected) select Replace. 

6. When you are confident that your search term is finding what you expected, select 
Replace All to replace all occurrences. 
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Caution 

Undo is not available when you use Find and Replace. Before you 
select Replace All, be sure to use Find and Replace once to test your 
search criteria. 

 
Figure 46: A Find and Replace set up to replace Bakere with Baker in the City field 

Activity: Think-pair-share 
After a brief demonstration by your teacher on how to use Find and Replace, you will 
participate in a think-pair-share activity to sharpen your find and replace skills. 

Work with a classmate to determine how to set up the Find and Replace window to 
find all the records that match specific search terms and replace the values with an 
alternate term. 

Resources required 
The resources required for this activity are: 

• L3_T1_act_csa_program_starter.accdb in the Learning Activity Resources folder. 
• The tblFind_Replace_Practice table. 

Activity instructions 
1. Open L3_T1_act_csa_program_starter.accdb, and then open the 

tblFind_Replace_Practice table. 

2. In Access, on the Home tab, select the Find group, and then select Replace. 
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3. For each of the following scenarios, share with your classmate what the Find and 
Replace window settings should be, and record your answer in the space provided. 

4. Select the field in which you want to perform your find and replace. 

5. Fill in the Find and Replace window in Access and select Find Next to test your 
search criteria. 

6. When you are confident that your search criteria are working, either select Replace 
to replace one at a time, or select Replace All to replace all at once. 

7. Examine the records to find whether the correct records were replaced. 

8. Find in the AddressLine1 field all occurrences of avenue and replace with Avenue. 

o Find What: 
o Replace With: 
o Look In: Current Field 
o Match: 
o Match Case: 

9. Find in the AddressLine1 field all occurrences of Ave. and replace with Avenue. 

o Find What: 
o Replace With: 
o Look In: Current Field 
o Match: 
o Match Case: 

10. Find in the City field all occurrences of Lynman and replace with Lyman. 

o Find What: 
o Replace With: 

Look In: Current Field 

o Match: 
o Match Case: 

11. Find in the Allergies field all occurrences of Sweet corn and replace with 
Sweetcorn. 

o Find What: 
o Replace With: 

Look In: Current Field 

o Match: 
o Match Case: 
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Try-it: Use Find and Replace 
A fellow intern has noticed some incorrect information in the database, which is 

repeated many times throughout the tblMembers table. In this try-it, you will use Find 
and Replace to fix the data. 

Resources 
You will need the following resources for this try-it: 

• L3_T1_try_csa_program_starter.accdb in this lesson’s Learning Activity Resources 
folder. 

General instructions 
The following are the general tasks to perform during this try-it: 

1. Open L3_T1_try_csa_program_starter.accdb, and then open the tblMembers table. 

2. In the Frequency field, replace 2x per week with Bi-weekly. 

3. In the City field, replace Big Lk. with Big Lake. 

4. In the Allergy field, replace Carotts with Carrots. 

5. In the AddressLine1 field, replace Lake Blvd. with Lake Boulevard.  
Hint: There are multiple street addresses on Park Boulevard. 

6. Close the tblMembers table and then close the database. 

 

Additional information 

For more information on using Find and Replace, refer to: Use the 
Find and Replace dialog box to change data 

  

https://aka.ms/Use-the-Find-and-Replace-dialog-box-to-change-data
https://aka.ms/Use-the-Find-and-Replace-dialog-box-to-change-data
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Topic 2: Add default values and values 
list fields 

 Adding default values to fields and pre-defined choices to a field, called a values 
list field, can help make data entry more consistent and faster: 

• A default value is a value that is added automatically in a field when a new record is 
added. For commonly used values, using default values will reduce data entry. For 
example, if most of your customers are in Washington, you could add the default 
value of WA to the State field. 

• Values list fields are a type of lookup field that contains a list of values you add 
(usually with the help of the Lookup Wizard) to restrict what can be entered into the 
field and make data entry easier and faster. 
When you add pre-defined choices, people using the database can’t enter any values 
except those in the list, so you get more consistent data. For example, if you enter box 
size choices of Small, Medium, and Large, people adding a record to the Orders table 
can choose one of those choices. 

o Because people using the field choose what they want from a list, they need to 
enter less data, and you won’t have to deal with spelling issues later (such as 
Med. for medium), which can cause issues when filtering data. 

o After you add choices to a field, you can use a drop-down menu in the table 
Datasheet View to choose a value from the list. You can also create a form and 
use various controls on the form to choose a value. 

You can create a values list field in two ways: make a new field as a values list field 
or change an existing field to a values list field. Either way, you can use the Lookup 
Wizard to help you add choices to the field. 

Add a default value 
1. Open the table that you want to work with. 

2. To add a default value in the Datasheet View: 

a. Select the field to which you want to add a default value. 

b. In the Properties group, select Table Tools, select Fields, and then select 
Default Value. 
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c. In the Expression Builder, insert the cursor after the equals sign and enter a 
value. For example: 

 Enter WA to enter WA in the State field 

 Enter =Date() to automatically enter today’s date in the OrderDate field. 

 
Figure 47: Entering a text Default Value in the Expression Builder 

3. To add a default value in the Design View: 

a. To switch to the Design View, on the Home tab, in the Views group, select the 
View drop-down list, and select Design View. 

b. In the Design View, select the row for the field to which you want to add a 
default value. 

c. On the General tab, select Field Properties, and then enter a value in the 
Default Value property box. 

Note that when you add text to the Default Value, Access adds quotation marks to 
surround the text, which is normal. Refer to the following screenshot: 

 
Figure 48: A text Default Value in the General tab 

d. Save the table, select View, and then select Datasheet View. 

4. To observe the Default Value in action, refer to the new record row, where the 
default value is already in the field, as the following screenshot depicts: 

 
Figure 49: The Default Value in a new record 
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Add a new values list field 
To add a new values list field that contains a list of choices, follow these steps: 

1. Open the table to which you want to add the values list field. 

2. If the table displays the Click to Add column, select the Click to Add drop-down list, 
and then select Lookup & Relationship. 

o Alternatively, on the ribbon, select Table Tools, and then select Fields. In the 
Add & Delete group, select More Field, and then select Lookup & 
Relationship. 

 
Figure 50: Starting the Lookup Wizard from Click to Add  

 
Figure 51: Open the Lookup Wizard by selecting Fields on the Table Tools tab 
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3. On the How do you want your lookup field to get its values? page of the Lookup 
Wizard, select I will type in the values that I want, and then select Next, as the 
following screenshot depicts: 

 
Figure 52: The Lookup Wizard choice to indicate if values are from a table, query, or 
entered by typing 

4. On the What values do you want to see in your lookup field? page of the Lookup 
Wizard, enter the values you want in your list, by selecting the Tab key (not the Enter 
key) between each value, as the following screenshot depicts: 

 
Figure 53: The Lookup Wizard step for entering the list values 
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5. When you finish entering your list, select Next. 

6. On the What label would you like for your lookup field? page of the wizard: 

a. Enter a label for the lookup field. 

b. Select Limit to List to restrict the values entered in the field. 

 
Figure 54: Adding a label and choosing not to allow entries not in the choices 

 

Caution 

While limiting choices to the values in the list is considered a good 
idea most of the time, keep in mind that no values other than those 
in your list of choices will be allowed. If you are not certain you have 
included all the values that might be needed, don’t select this option. 

 

c. Optionally, select Allow Multiple Values. Typically, you do not choose this 
option, because it can make working with the data in the field more difficult. 

d. Select Finish. 

e. Select Save to save your table, and then open your datasheet by selecting View 
on the Home tab, and then selecting Datasheet View. 
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Change an existing field to a values list field 
To add choices with a values list to a field that already exists, follow these steps: 

1. Open the table that you want to work with in Design View: 

a. In the navigation pane, right-click or access the context menu for the table, and 
then select Design View. 

b. Alternatively, select the table in the navigation pane and then, on the Home tab, 
select the View drop-down list, and then select Design View. 

2. In the Design View, in the row for the field to which you want to add choices, select 
the Data Type menu, and then select Lookup Wizard, as the following screenshot 
depicts: 

 
Figure 55: The Design View of the table, choosing the Lookup Wizard for a field 
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3. On the first page of the Lookup Wizard, select I will type in the values that I want, 
and then select Next, as the following screenshot depicts: 

 
Figure 56: The Lookup Wizard option to indicate if values are from a table, query, or 
entered by typing 

4. On the next page of the Lookup Wizard, enter the values you want in your list by 
selecting the Tab key (not the Enter key) to move between each value, as the 
following screenshot depicts:  

 
Figure 57: The Lookup Wizard for entering the list values 
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5. When you finish adding your list items, select Next. 

6. On the next page of the wizard: 

a. Enter a label for the lookup field. 

b. Select Limit to List to restrict the values entered in the field. 

 

Caution 

While limiting choices to the values in the list is considered a good 
idea most of the time, keep in mind that no values other than those 
in your list of choices will be allowed. If you are not certain you have 
included all the values that might be needed, don’t select this option. 

 

c. Optionally, select Allow Multiple Values. Typically, you do not choose this 
option, because it can make working with the data in the field more difficult. 

d. Select Finish. 

 
Figure 58: Adding a label and choosing not to allow entries not in the choices 
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7. Save the table. You now can use a drop-down list of choices in the field, as the 
following screenshot depicts: 

 
Figure 59: A list of choices in the values list field 

8. If you enter a value that is not in the list, an error message opens, and you cannot 
enter the record, as the following screenshot depicts. Close the message and then 
choose an item from the list. 

 
Figure 60: An error is displayed 

 

Did you know? 

If you need to update the list of choices frequently, consider creating 
a table for your choices, and then using the Lookup Wizard in a form 
or table to research those values. This is an alternative to adding 
choices directly to fields. Maintaining the list in a table is easy to do 
and to understand, and it can be more flexible than adding choices 
directly to a field. 

 

Additional information 

For more information on values list fields, refer to: Create or delete a 
values list field 

For more information about creating a lookup field, refer to: Create or 
delete a lookup field 

https://aka.ms/Create-or-delete-a-values-list-field
https://aka.ms/Create-or-delete-a-values-list-field
https://aka.ms/create-or-delete-a-lookup-field
https://aka.ms/create-or-delete-a-lookup-field


Module 3: Adding and editing data 
 

 
68 

Activity: Think-pair-share 
After following your teacher’s demonstration of adding choices and default values, 
consider the following three questions by yourself, and then share your answers with a 
classmate: 

• Think of a time when having only a few choices made making a decision easier. 
• Think of a time when you started a task, and something was completed for you 

already. 
• How do you think having choices available and inserting default values might help 

someone using a database? 
Be prepared to share your ideas with the class. 

Try-it: Add default values and values list fields 
 In this leveled try-it, you will make data entry more streamlined by adding default 

values to fields and adding choices to fields with values lists. 

Try-it 1 
Recently, orders have been coming in without order dates or with incorrect order dates. 
Also, people have been entering different ways to state the payment method, such as 
entering credit card payments as CC pmts., Credit, credit cards, and so on. This is making 
it very difficult for the Orders department at Munson’s to identify the most popular 
methods to pay. 

In this try-it, you will: 

• Add a default date of today’s date to the OrderDate field. 
• Add a new values list field to the PaymentMethod field, to control how the 

payment method is entered. 

Resources 
You will need the following resources for this try-it: 

• Open L3_T2_try1_csa_program_starter.accdb in this lesson’s Learning Activity 
Resources folder. 

Instructions 
The following are the general tasks to perform during this try-it: 

1. Open L3_T2_try1_csa_program_starter.accdb, and then open the tblOrders table. 

2. In the tblOrders table, add a default value of =Date() to the OrderDate field. 
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3. Use the Lookup & Relationship choice in the Click to Add column to add a new 
values list field. 

4. In the Lookup Wizard, use the following settings: 

o Page 1: Select I will type in the values that I want. 
o Page 2: Enter the following values: 

 Number of columns: 1 

 Cash 

 Credit 

 Account 

 E-transfer 

o Page 3: Enter the label PaymentMethod and select Limit to List 
5. Save the table. 

6. Add a new order with this data: 

o OrderDate: leave as the default value, which is today’s date 
o PickupDate: leave empty 
o MemberID: 8 
o FarmBoxID: 5 
o PaymentMethod: Credit 

7. Close the tblOrders table, and then close the database. 

Try-it 2 
Most of Munson’s members live in Washington state, so you will add a default value of 
WA to the State field. Because Munson’s only uses three sizes of boxes, you will add a 
list of choices to the BoxSize field so people doing data entry won’t have to remember 
or enter them. 

Resources 
You will need the following resources for this try-it: 

• Open L3_T2_try2_csa_program_starter.accdb in this lesson’s Learning Activity 
Resources folder. 
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Instructions 
The following are the general tasks to perform during this try-it: 

1. Open L3_T2_try2_csa_program_starter.accdb. 

2. Open the tblMembers table and switch to Design View. 

3. In the Field Properties for the State field, add a default value of WA. 

4. Select the Data Type for the BoxSize field and choose Lookup Wizard to add a 
values list to the field. 

5. In the Lookup Wizard, use the following settings: 

o Page 1: Select I will type in the values that I want. 
o Page 2: Enter the following values: 

 Small 

 Medium 

 Large 

o Page 3: Leave the label BoxSize and select Limit to List 
6. Save the tblMembers table and switch to Datasheet View. 

7. In the new record row, add the following information as a new record: 

o FirstName: your name 

LastName: your last name 

o AddressLine1: 567 Elm Street 
o City: Lake Ketchum 

State: Tab through this field, because WA will already be entered 

o Zip: 55778 
o BoxSize: Small 

8. Close the tblMembers table and then close the database. 

 

Additional information 

For more information on default values in Access, refer to: Set default 
values for fields or controls 

For more information on adding list or combo boxes to forms, refer to: 
Add a list box or combo box 

https://aka.ms/Set-default-values-for-fields-or-controls
https://aka.ms/Set-default-values-for-fields-or-controls
https://aka.ms/Add-a-list-box-or-combo-box
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Topic 3: Create and use forms 
You can use forms to review, edit, organize, and sometimes print data. The data itself is 
stored in tables, not in forms. You use forms as a “portal” to access the data. 

Access includes different types and configurations of forms. The form you use depends 
partially on the data you have, and partially on what you need to do with the data. For 
example, a traditional form reveals one record at a time, which is great if you have a lot 
of fields. Sometimes, you want to work in a datasheet, like you have been so far in this 
module. You’re in luck! You can create a form that is a datasheet. Most forms also have 
a View option to use the form in the Datasheet View (although sometimes this is 
turned off). 

Create a form by using the Form tool 
You can create forms from tables or queries, and the method is the same. You can 
create a form with one action by selecting Form in the Create tab. All the fields from the 
underlying table are added to the form. 

To create a form by using Form: 

1. In the navigation pane, select the table, or open it. 

2. On the Create tab, in the Forms group, select Form, as the following screenshot 
depicts: 

 
Figure 61: Create a form from a table with the Form tool 
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3. The form opens in the Layout View: 

o To edit the form, stay in the Layout View or switch to the Design View. 
o To edit your data, switch to the Form View. 

4. Save your form. A common naming convention is to use frm at the beginning of the 
form’s name. 

Navigating records in a form 
To move between records in a form, select the record navigation buttons, or select the 
Page up or Page down keys. 

When using the navigation buttons: 

• Select a navigation button to move between records. 
• To refer to a specific record, enter a record number in the Current Record box, and 

then select Enter. 
• To quickly find a specific record, enter a search term in the Search box, and then 

select Enter, as the following screenshot depicts: 

 
Figure 62: The navigation buttons and Search box in a form 
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Form views 
Every form has several views, which you can use either for editing the form or for 
working with the underlying table data. The following table describes the three default 
views of forms: 

View 
name 

What 
it’s used 
for 

Description 

Form 
View 

Editing 
data 

The Form View is a common view for forms. Use this view for 
editing data. 

Layout 
View 

Editing 
the form 

Use the Layout View to help you plan the layout of your form. 
Its appeal is that it resembles the Form View, and you can 
review the data of the first record of the underlying data. 
Therefore, it’s easy to figure out, for example, how wide a field 
needs to be to reveal all the data in it. However, it can also be 
confusing because although it resembles the Form View, you 
can’t edit data in this view. You can only use this view for 
editing the layout of the form. 

Design 
View 

Editing 
the form 

The Design View is a more complicated view that is used for 
more advanced work in complex forms. You can’t observe any 
data in this view. 

 
Figure 63: Changing form views 
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Figure 64: A form in Form View 

 
Figure 65: A form in Layout View 

There is a fourth view, the Datasheet View, which resembles and works just like a table 
Datasheet View. By default, this option is not available in the View options. You can 
add it as an option in the form’s properties. 

In addition, you can make a form to specifically include the Datasheet View called a 
datasheet form. You will create datasheet forms in Module 8. 

 
Figure 66: A form in Design View 
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To change views: 

1. On the Home tab, select View. 

2. From the list, select the view you need. 

 

Additional information 

For more information on creating forms, refer to: Introduction to 
forms 

Sort records in a form 

 When you are working with data in a form, you can sort the records of the 
underlying table or query to help find and organize data. Sorting works for both forms 
in a Datasheet View and forms in a form view. 

On the ribbon, in the Sort & Filter group, select the sort option you want: Ascending or 
Descending. Select Remove Sort to remove the sort from the form. Refer to the 
following screenshot: 

 
Figure 67: Choose the sort option or remove an applied sort 

Save a sort in a form 
Similar to sorting records in a table’s Datasheet View, you can save a sort with a form. 
To save a sort, first apply the sort, and then save the form. The sort will still be active 
when the form is opened. 

Apply input masks to form fields 

 An input mask is both a method to display data differently, and a method to help 
ensure that data is entered accurately in a form or table. It is an object property of a 
field (or, if applied in a form, a form control). It consists of letters, numbers, and symbols, 
which indicate the type of value (number, letter) that can be entered. Sometimes, input 
masks also contain literal text or symbols, such as the parenthesis around a phone 
number area code (206), so you don’t have to enter them. 

https://aka.ms/introduction-to--forms
https://aka.ms/introduction-to--forms
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You can add input masks directly in the design of a table, but for flexibility, we 
recommend that you use input masks in forms. 

Use input masks for fields that contain data that is formatted consistently, such as 
phone numbers. Input masks can reduce the amount of data entry required because you 
can use them to reveal characters, such as dashes and parenthesis, which are tedious or 
repetitive to enter. For example, the parenthesis, space, and dash in a phone number 
(123) 555-0123. 

You can control data that you can enter into the database by applying an input mask 
that specifies the type of characters you can enter. For instance, you can specify whether 
the entries should be text or numbers, and whether they are optional or required. For 
example, imagine that you apply an input mask to a product number where the first 
three digits are letters, the last five are numbers, and the letters and numbers are 
separated by a dash. You want the data to match this: ABC-12345. The input mask 
>LLL\-00000 is applied so you enter abc12345. Here’s how the mask works: 

• The > formats the abc as capital letters (ABC). 
• The LLL ensures that the first three characters entered are text (not digits or 

symbols). 
• The \- inserts a dash after the letters. 
• The 00000 ensures that the last five characters entered are digits, 0-9 (not text or 

symbols). 
The following table lists a few examples of input masks at work. The first column is the 
data how you enter it, the second column is the string of characters that make up the 
input mask, and the third column is how the data appears with the input mask applied. 

How the data is entered The input mask How the data displays 
with the input mask 
applied 

abc12345 >LLL\-00000 ABC-12345 

2065550123 (999) 000-0000 (206) 555-0123 

Table 9: Examples of input mask 
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Caution 

Don’t use an input mask if: 

• You might need to enter data that doesn’t match the mask. An 
input mask does not allow exceptions. 

• You plan to use a Date Picker control with a Date/Time field. 
Input masks are not compatible with the Date Picker control. 

Apply an input mask to a form 
1. Open the form in Layout or Design View that contains the field to which you want 

to apply an input mask. 

2. Select the field’s control on the form. 

3. If necessary, open the Property Sheet: 

o On the Form Layout Tools, select the Design tab, and then in the Tools group, 
select Property Sheet, as the following screenshot depicts: 

 
Figure 68: Open the Property Sheet 

4. On the Data tab, select the Property Sheet group, and then in the Input Mask 
property sheet, select the Build button to start the Input Mask Wizard, as the 
following screenshot depicts: 

 
Figure 69: Select the form control and the Input Mask Build button 
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5. On the Which input mask matches how you want data to look? page of the Input 
Mask Wizard, in the Input Mask list, select the input mask you want to use, and 
then select Next, as the following screenshot depicts: 

 
Figure 70: The first page of the Input Mask Wizard allows you to select the Input 
Mask 

6. On the Do you want to change the input mask? page of the Input Mask Wizard, 
in the Try It box, you can (optionally) enter characters as you would if you were 
entering data into the form field, to find out how the mask works, and then select 
Next, as the following screenshot depicts: 

 
Figure 71: The Do you want to change the input mask? page of the Input Mask 
Wizard allows you to try the mask 
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7. On the How do you want to store the data? page of the Input Mask Wizard, 
choose how you want to store the data. Tip: If you want to observe the symbols all 
the time, select With the symbols in the mask, like this, as the following 
screenshot depicts: 

 
Figure 72: The How do you want to store the data? page of the Input Mask Wizard 
allows you to choose how you want to store the data 

8. On the That’s all the information the wizard needs to create your image mask. 
page of the Input Mask Wizard, select Finish. 

9. Save the form. 

10. Be sure you are in the Form View. If you are not, select View, and then select Form 
View to try out the mask in the form. 

 

Additional information 

For more information on input masks in Access, refer to: Control data 
entry formats with input masks 

Add an input mask 
If you don't see the input mask you want, you can add it. Here are the steps to add an 
input mask for a phone number and then apply it to a field control: 

1. Open the form in Layout or Design View that contains the field to which you want 
to apply an input mask. 

2. Select the field’s control on the form. 

https://aka.ms/control-data-entry-formats-with-input-masks
https://aka.ms/control-data-entry-formats-with-input-masks
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3. If necessary, open the Property Sheet: 

o On the Form Layout Tools, select the Design tab, and then in the Tools group, 
select Property Sheet, as the following screenshot depicts: 

4. Select Edit List. 

5. In the Customize Input Mask Wizard, select New (blank record), as the following 
screenshot depicts. 

 
Figure 73: The Customize Input Mask Wizard and the New (blank) record button 

6. In the new input mask record, enter the following information: 

a. Description: Phone Number 

b. Input Mask: !(999) 000-0000 

c. Placeholder: _ 

d. Sample data: enter 2065550123 

e. Mask Type: Text/Unbound 

7. Select Close. 

8. Select the Phone Number input mask, and then select Finish. 

Use a form to add, edit, and delete records 

When you add, edit, or delete a record in a form, you are actually making those 
changes directly to the data in the underlying table. 

1. Open the form you want to use. 

2. If necessary, switch to Form View. 
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3. Add a new record or find and edit an existing record: 

o To add a new record, on the Home tab, in the Records group, select New. 
Alternatively, select the New (blank) record button from the navigation 
buttons. 

 
Figure 74: The New Record and Save Record buttons on the ribbon 

 
Figure 75: The New Record button in the navigation buttons 

To edit a record, locate the record you want to edit by using one of the following 
methods: 

a. Use Find on the ribbon 

b. Select Ctrl+F 

c. Use a method such as sorting or filtering 

It is important to be sure you have the correct record selected before you start to do 
any work on a record. 

4. Enter or make changes to your data. Note that while you are entering the new 
record, the pencil appears beside the record, indicating that the record is being 
edited, as the following screenshot depicts: 

 
Figure 76: The pencil indicates that the record is being edited 

5. To move to the next field in the same record, select the Tab key. You can select 
Shift+Tab to move backward between fields. You can also use the Right or Left arrow 
keys or use a mouse to select the field you want to edit. 
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6. When you move to another record or close the form, Access saves the new record 
that you added, which is similar to working in a datasheet. To save changes to the 
current record, select Shift+Enter, or select Save Record on the ribbon. 

Delete a record using a form 
1. With the form open, navigate to the record you want to delete. Remember that you 

can’t undo a record deletion, so make sure it’s the right one. 

2. On the ribbon, in the Records group, select the Delete drop-down list, and then 
select Delete Record, as the following screenshot depicts: 

 
Figure 77: The Delete Record button 

Activity: Experimentation 
In this activity, you and a classmate will work together on one computer while trying to 
accomplish as many of the following tasks as possible in the time your teacher gives 
you. The person who is not using the computer can use the Student Guide to research 
instructions for doing the various tasks. 

Resources needed 
• Open L3_T3_act_csa_program_starter.accdb. 
• Open the frmFarmBoxes form. 
  



Module 3: Adding and editing data 
 

 
83 

Instructions 
With a partner, using one computer, find out how many of these tasks you can perform 
in the time given by your teacher. 

• One person should operate the computer, the other should use the Student Guide (if 
necessary) to figure out how to perform each task and mark each task as it is done. 

• If you have questions or don’t know how to complete a task, ask your teacher or 
note it in the third column of the table. 

Task to complete together Mark 
 
when 
done 

Note 
questions 
here 

1. Open the frmFarmBoxes form.   

2. Use the record navigation buttons or select Page down 
to move to the fifth record. Confirm that the record is: 

o FarmBoxID: 5 
o FarmBoxName: Couple 
o FarmBoxDescription: 5 fruits, 4 vegetables 

  

3. Sort the records by the FarmBoxName field in ascending 
order. FarmBoxID 5 should now be the first record. 

  

4. Save the form to save the sort with the form.   

5. Close and reopen the form, and confirm that it is still 
sorted by FarmBoxName. 

  

6. Find the record that has the FarmBoxName Large. 
Confirm that you have selected the correct record. You 
should observe, in the Form View section: 

o FarmBoxID: 3 
o FarmBoxDescription: 6 fruits, 6 vegetables 

  

7. Change the weight of FarmBoxID 3, the Large farm box, 
from 10 to 9. 
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Task to complete together Mark 
 
when 
done 

Note 
questions 
here 

8. The records with FarmBoxID 15 and16 are duplicates. 
Find the record with FarmBoxID 16 and delete it, and 
then close the form. 

  

9. Open frmMembers in Layout or Design View, and then 
use the Input Mask Wizard to apply the built-in input 
mask Phone Number to the Phone field. If you don't see 
Phone Number in the list, you will need to edit the list 
and add an input mask. 

  

10. Test the input mask by attempting to (in any record) 
enter the text abc in the Phone field. (Hint: If you applied 
the mask correctly, you won’t be able to do this.) 

  

11. Close the form and then close the database.   

Table 10: Tasks to complete 

Try-it: Create and use forms 
 In this leveled try-it, you will create two forms: one based on the tblFarmBoxes 

table and one based on the tblMembers table. You’ll apply sorts to both forms, use the 
forms to edit and delete records, and modify the members form with an input mask. 

Try-it 1  
Resources required 
You will need the following resources for the first part of this activity: 

• Open L3_T3_try1_csa_program_starter.accdb in this lesson’s Learning Activity 
Resources folder. 
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Instructions 
The following are the general tasks to perform during this try-it: 

1. Open L3_T3_try1_csa_program_starter.accdb. 

2. Create a form based on the tblFarmBoxes table by using the Form tool. 

3. Save the form as frmFarmBoxes. 

4. Create a form based on the tblMembers table by using the Form tool. 

5. Apply the built-in Phone Number input mask to the Phone field and choose to 
store the symbols in the mask. 

6. Save the form as frmMembers. 

7. Close both forms and close the database. 

Try-it 2 
Resources required 
You will need the following resources for the first part of this activity: 

• Open L3_T3_try2_csa_program_starter.accdb in this lesson’s Learning Activity 
Resources folder. 

Instructions 
The following are the general tasks to perform during this try-it: 

1. Open L3_T3_try2_csa_program_starter.accdb in this lesson’s Learning Activity 
Resources folder. 

2. Open the frmMembers form. 

3. In the frmMembers form, sort the records by the LastName field in descending 
order. Do not save the sort with the form. 

4. The first record displayed should be Xiang Zhong. Make the following changes to 
this record: 

o Add in the AddressLine2 field: Apt. 1304  
o Add the 206 area code to the value in the Phone field. Hint: With the input mask 

already applied to the form, it should match this: (206) 555-0118. 
o If you don't see Phone Number in the list, you will need to edit the list and add 

an input mask. 
5. Sort the member records by the LastName field in ascending order. 

6. Save and close the frmMembers form. 
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7. Open the frmFarmBoxes form. 

8. Sort the records by the FarmBoxName field in the ascending order. 

9. Locate the two (duplicate) records (FarmBoxIDs 17 and 18) with the FarmBoxName 
of Summer fruit and conserves box. 

10. Delete one of the duplicate Summer fruit and conserves box records. 

11. Save and close the form, and then close the database. 

Wrap-up 
Use these questions to review what you learned in this lesson: 

• Turn to a neighbor and share the favorite thing that you learned about Find and 
Replace, adding choices to fields, default values, creating forms, or anything else 
covered in the lesson. 

• Be prepared to share with the class. 
Then use these questions to review what you learned in this lesson: 

1. The following datasheet is ________________________ by the LastName field. 

Customer FirstName LastName AddressLine1 

24952 Michael Yin 45 Second Street 

18982 Fang Yin Tu 4567 Pine Avenue 

10828 Alba Sutton 4567 Pine Avenue 

13321 Sun Li 45 View Avenue 

22015 Archie Lamb 67 Lake Drive 

28887 Akia Kassis 234 Main Street 

27560 Manuel Jerome 456 Lake Boulevard 

17696 Cameron Hyde 789 9th Street 

18542 Iker Dominguez 456 College Street 

22749 Maurice Charron 67 Lake Drive 

26269 Emery Cate 567 Park Boulevard 

Table 11: A datasheet 
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Select the correct option. 

a. Filtered by Last Name 

b. Sorted in ascending order 

c. Sorted in descending order 

d. Selected 

2. Examine the following Find and Replace options: 

Find What: Lake  

Look In: Current Field  

Match: Start of Field  

Search: All  

Match case: selected  

 
Figure 78: The Find and Replace dialog box 

If you place your cursor in the City field in the tblMembers table, and select Find 
Next, which of the following record(s) will Access find? 

Select all that apply. 

a. Lake Ketchum 

b. lake ketchum 

c. Bow Lake 

d. Big Lake 
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3. If you want to have a field filled in automatically when you create a new record, you 
add ________________________ to the field. 

a. An input mask 

b. A default value 

c. A values list field 

d. A sort order 

4. True or False: When you apply a sort to records while you are using a form and then 
save the form, Access will save the sort with the form. 

a. True 

b. False 

Note: If you have any concerns about any topics covered in this module, ask your 
teacher for assistance. 
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Glossary 
append To add to something that already exists. In Access, append means to 

add records to a table, usually multiple records, and usually by 
pasting them into the table, or by using a query. 

criteria, search 
criteria 

Search criteria includes all of the parameters of a search. This 
includes search terms, which field you are searching, whether you are 
researching for all the contents in a field or just part of the field, and 
so on. 

datasheet A view in Access that reveals data in a grid of columns (fields) and 
rows (records). Tables, queries, and forms all have datasheet views. 

default value A value that is automatically added to a field when you make a new 
record. You can add them to a field in a table, or in a form. 

lookup field A lookup field is a type of field in Access that gives a list of values to 
choose from. The lookup field can either search in a table for those 
values, or you enter them in (which is called a values list field). You 
use the Lookup Field Wizard to create both kinds of lookup fields. 

navigate To navigate is to move in, to, or through something, similar to a boat 
navigating the ocean. If you are asked to navigate to a file, or a 
particular record in a table, it means that you open folders (for a file), 
scroll, or perform a search (for records) to display it. 

objects People in the computer field use the term object to mean many 
things. In Access, tables, forms, queries, and reports are all objects, as 
are the controls on forms and reports. Generally, when you read 
about an Access object, it's probably referring to objects that are 
available in the Navigation Pane including tables, forms, and queries, 
as well as controls on forms. 

search term A search term is the text, numbers, and other criteria that you are 
searching for when you use the Find or Find and Replace feature. 

values list field A type of lookup field that you use in the Lookup Field Wizard to 
create, in which you enter values. When you use the field in a table 
datasheet or a form, you get a list of values from which to choose. 
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view Views give you a different appearance and allow you to do different 
things in objects such as tables, queries, reports, and forms. There are 
views for editing the object, such as Design View, and views for 
using the object to work with data, such as Form View (for forms) or 
Datasheet View (for tables). 

Table 12: Glossary terms and definitions 
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Cornerstone 
Overview 
Munson’s is considering adding new items to the products they sell. In this Cornerstone, 
you will begin preparing a database for the launch of a new line of preserves products at 
Munson’s. 

In this Cornerstone, you will use the skills you learned in this module to begin preparing 
the CSA program database for the launch of a new line of preserves products at 
Munson’s. You will add data to the database, edit data in the database, and make data 
entry easier by configuring datasheets and forms. 

Objectives 
The following table outlines the Cornerstone objectives and their corresponding MOS 
exam objectives. 

Import data from Excel to create a new 
table. 

• OD 1.1.1: Import objects or data
from other sources

Import a table from another Access 
database. 

• OD 1.1.1: Import objects or data
from other sources

Import data from Excel to append data 
to an existing table. 

• OD 2.1.1: Import data into tables

Modify a datasheet by hiding fields. • OD 2.2.1: Hide fields in tables

Modify a datasheet by adding a Total 
row. 

• OD 2.2.2: Add totals rows

Modify records through a table’s 
Datasheet View. 

• OD 2.3: Manage table records

Sort records in a datasheet. • OD 2.3.2: Sort records

Apply filters to a datasheet • OD 2.3.3: Filter records
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Find and replace data in a datasheet. • OD 2.3.1: Find and replace data 

Set default values and add choices for 
fields in a table, and use them when 
entering data. 

• OD 2.4.7: Set default values 

Sort records in a form by form fields. • OD 4.2.2: Sort records by form field  

Add an input mask to form and use it 
when entering data. 

• OD 2.4.8: Apply built-in input masks 

Table 2: The Cornerstone objectives 

Duration 
35 minutes 

Instructions 
1. Complete the following tasks for each file. 

2. When saving your file, add your name to the end of the filename, for example: 
Cornerstone_csa_program_starter_Alex. Follow your teacher’s directions for where 
to save your files. 

3. When you finish the Cornerstone, assess your completion, and enter the points you 
think you earned within the following task lists. You can ask your teacher for help, if 
required. 

Tasks 
You will work with one database file directly in this Cornerstone. You will import data 
from one database file and two Excel files. 
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File 1: Cornerstone_csa_program_starter.accdb 
Task: Import data from Access (6 points) 
• In the file Cornerstone_csa_program_starter.accdb, import the tblPickles table 

from the Cornerstone_preserves.accdb Access database. (6 points) (Exam objective 
1.1.1) 

Points scored: ________ / 6 

Task: Copy data from Excel (8 points) 
1. In Excel, in Cornerstone_spreads.xlsx, select and then copy the A1:D4 range on the 

tblSpreads worksheet. (2 points) 

2. In the Cornerstone_csa_program_starter.accdb file, paste the copied data as a new 
table that has column headings. (Exam objective 1.1.1) (6 points) 

Points scored: ________ / 8 

Task: Copy data from Excel and append to an existing table 
(8 points) 
1. In Cornerstone_additional_orders.xlsx, on the Additional_order_data sheet, select 

and copy the range A1:F11. (2 points) 

2. In Access, in the Cornerstone_csa_program_starter.accdb file, Paste Append the 
copied data as new records to the tblOrders table. (6 points) (Exam objective 2.1.1) 

Points scored: ________ / 8 

Task: Hide fields in datasheets (6 points) 
1. In the tblMembers table, hide the MemberID field, and then save and close the 

table. (3 points) (Exam objective 2.2.1) 

2. In the tblPreserves table, hide the PreservesCategoryID field, and then save the 
table. (3 points) (Exam objective 2.2.1) 

Points scored: ________ / 6 

  



Module 3: Adding and editing data 
 

 
94 

Task: Add a Total row in a datasheet (8 points) 
1. In the tblPreserves table, add a Total row. (4 points) (Exam objective 2.2.2) 

2. In the Total row, in the PreservesName column, select the Count function. (2 
points) (Exam objective 2.2.2) 

3. In the Total row, in the WSCostPerJar column, select the Sum function, and then 
save the table. (2 points) (Exam objective 2.2.2) 

Points scored: ________ / 8 

Task: Edit and add records in a datasheet (7 points) 
1. In the tblPreserves table, in the record with a PreservesID of 6, change the text in 

the PreservesDescription box so it matches: Jam made from an assortment of 
berries (2 points) (Exam objective 2.3) 

2. Add a new record to the tblPreserves table with the following information: (5 
points) 

o PreservesID: 11 
o PreservesName: Peach Compote 
o PreservesDescription: Slow-cooked peaches with warm spices  
o PreservesCategory: Compote 
o WSCostPerJar: 4.5 

Points scored: ________ / 7 

Task: Sort records in a datasheet (3 points) 
1. Sort the tblPreserves table by the PreservesName column in Ascending order. 

(2 points) (Exam objective 2.3.2) 

2. Save the sort in the table. (1 point) (Exam objective 2.3.2) 

Points scored: ________ / 3 

Task: Find and replace data in a datasheet (12 points) 
1. In the tblMembers table, in the Allergies field, replace all occurrences of Carotts 

with Carrots. (4 points) (Exam objective 2.3.1) 

2. In the AddressLine1 field, replace all occurrences of Bolevard with Boulevard. (4 
points) 

3. In the AddressLine1 field, fix the capitalization of the word “avenue” for all records 
by finding avenue and replacing it with Avenue. (4 points) 

Points scored: ________ / 12 
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Task: Apply filters to a datasheet (9 points) 
1. In the tblMembers table datasheet, filter the City field to reveal only the rows where 

the value for City is Samish. Note how many records there are: ________ 
(3 points) (Exam objective 2.3.3) 

2. Clear the filter from the City field and then save the table. (2 points) (Exam objective 
2.3.3) 

3. Filter the tblPreserves table datasheet to reveal records that do not contain the 
word Dill in the PreservesDescription field, and then save the table. (4 points) 
(Exam objective 2.3.3) 

Points scored: ________ / 9 

Task: Set and use a default value in a table (9 points) 
1. In the tblPreserves table, set a Default Value in the PreservesCategory field of 

Jam, and then save the table. (4 points) (Exam objective 2.4.7) 

2. Enter a new record with these values: (5 points) 

o PreservesID: 12 
o PreservesName: Munson’s Marmalade 
o PreservesDescription: Thin-cut oranges and lemons in a classic morning 

spread 
o PreservesCategory: Default value of Jam 
o WSCostPerJar: 3 

Points scored: ________ / 9 

Task: Create a new field with choices (values list field) (10 points) 
1. In the tblOrders table, use the Lookup Wizard to create a new lookup values list 

field with these settings: (7 points) 

o How do you want your lookup field to get its values? I will type in the values 
that I want. 

o Number of columns: 1 
o Col1 values: 

 Same-day shipping 

 Next-day shipping 

 Carry-out 

o Label: DeliveryChoice 
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o Limit To List check box: selected 
2. For the first three records, select the Tab key to refer to the DeliveryChoice field, 

open the list, and choose an option from the list. (3 points) 

Points scored: ________ / 10 

Task: Sort data in a form (6 points) 
1. In the frmOrders form, sort the records in the OrderTotal field smallest to largest, 

and enter down the amount in the OrderTotal field for the first record: ________ (2 
points) (Exam objective 4.2.2) 

2. Sort the records in the PickupDate field from newest to oldest, and enter the date in 
the PickupDate field for the first record: ________ (2 points) (Exam objective 4.2.2) 

3. Sort the records in ascending order by the OrderDate field, and then save the table. 
(2 points) (Exam objective 4.2.2) 

Points scored: ________ / 6 

Task: Add and use an input mask in a form (10 points) 
1. In the frmMembers form, apply a built-in input mask with these settings: (6 points) 

(Exam objective 2.4.8) 

o Select this input mask: Phone Number  
Note: If you don't see Phone Number in the list, you will need to edit the list 
and add an input mask. 

o On the Do you want to change the input mask? page, leave all the defaults. 
o On the How do you want to store the data? page, choose: With the symbols 

in the mask, like this: 
2. Sort the records in the form by the LastName field in Ascending order. (2 points) 

(Exam objective 4.2.2) 

3. In the first record, in the Phone field, enter: 2045550129, save the record, and then 
save and close the form. (2 points) 

Points scored: ________ / 10 

FILE 1 TOTAL POINTS: ________ /102 
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Module overview 
Description 
Now that you've learned how to create basic tables in your database and populate them 
with data, you’re ready to begin asking questions of your database. You'll use what you 
learned about your database in earlier modules to build useful queries that you can 
reuse throughout the remainder of this course. 

This module consists of two lessons during which you'll learn how to create and manage 
queries in Microsoft Access 2019. By the end of this module, you'll be able to create a 
query either manually or by using the Query Wizard and then modify and manage the 
query. 

The following table outlines the lesson objectives and their corresponding Microsoft 
Office Specialist (MOS) exam objectives. 

Lesson Learning objective MOS exam 
objectives 

Introducing 
queries 

Describe the use of queries in Access and 
create and save queries 

• 3.1.1 
• 3.1.6 
• 3.1.7 

Modifying 
queries 

Modify fields in a query, sort and filter query 
data, and delete a query 

• 1.1.2 
• 3.2.1 
• 3.2.2 
• 3.2.3 
• 3.2.4 

Cornerstone: 
Ask reusable 
questions of 
data 

Create, manage, and modify simple and 
complex queries 

• All the 
preceding 
objectives 

Table 1: MOS exam objectives by lesson 
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Scenario 
Organizing and creating the database for the community supported agriculture (CSA) 
program at Munson's Pickles and Preserves Farm required a lot of thinking. Now, it's 
time to find out if all that preplanning and careful database construction will help in 
answering some of the questions you have about the members. Your team wants more 
information about the members who place orders, including who has allergies to certain 
fruits and vegetables. You want to be able to quickly get answers to these questions and 
to get the most current information. Other team members of the CSA program are also 
requesting data in different formats for other purposes. 

Cornerstone 
This module ends with a Cornerstone project, during which you'll use queries to ask 
questions about a sample database. In the Cornerstone, you’ll: 

• Create a query that lists customers’ cities and states. 
• Create a query that finds customer records with duplicate first and last names. 
• Update the customers’ cities and states query to include their postal codes. 
• Sort the duplicate customers by last name. 

  



Asking questions of data 
 

 
6 

Lesson 1: Introducing queries 
Overview 
Now that you've placed data into your database, you might start to have questions 
about your data. For example, you might want to know where your customers are 
located. You'll also eventually need more-detailed information about each customer so 
you can customize the customers’ produce boxes to their individual needs and 
preferences. 

In this lesson, you’ll learn how to use queries to ask questions about your database. 
You’ll learn how to create queries from scratch or by using special tools that make it 
easier to build complex queries. You’ll also learn how to save and reuse your queries so 
you can repeatedly ask the same questions—even as your database changes over time. 

Warm-up 
Discussion 
Your teacher will lead the class through a discussion on how to use queries to ask 
questions of a database. Be prepared to answer the following questions during the 
classroom discussion: 

1. What information do you want to know about your customers? 

Fill in the blank space. 

 

2. What are some questions you’d ask the database if the database could converse with 
you? 

Fill in the blank space. 

 

3. Who on the farm would benefit from asking questions of the database? 

Fill in the blank space. 
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Topic 1: Overview of queries 
 You can use queries to ask questions of your Access database. In a typical 

database, the data you want to research usually resides in one or more existing 
database tables. A query can retrieve information from tables in your database, 
assemble that information into a format that makes logical sense, and then display that 
data to you. A query can answer a simple question, perform calculations, and even 
combine data from different tables for you. 

 

Video 

For a basic introduction to queries, review the video at: Get started 
with queries 

If you want to review data from a database table but have only certain fields from that 
table, you can build a basic select query. At its most fundamental level, a select query 
selects one or more fields from a table in the database. The following screenshot depicts 
how you can select five fields from the tblCustomers table in the database to display in 
your query. 

 
Figure 1: Fields in a query 

 

Did you know? 

You can select the special asterisk wildcard inside quotation marks 
("*") as a field to return all the fields in your database table. 

  

https://aka.ms/video-get-started-with-queries
https://aka.ms/video-get-started-with-queries
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When you’re building a query, the questions you ask of the database are called criteria. 
The following screenshot depicts a query that uses criteria to specify that only results 
having a last name of Doyon will display. 

 
Figure 2: Criteria in a query 

Create a query by using the Design view 
To create a query within a database, you can use one of two methods. The first method 
uses the Design view, where you can build new queries from scratch. The next topic 
explains the second method, which uses the Query Wizard. 

To display the Design view, go to the Create tab, and then in the Queries group, select 
Query Design, as the following screenshot depicts. 

 
Figure 3: The Query Design button on the Create tab 

Select source tables 
To begin creating a query, you first select one or more database objects to use as the 
source of your query. For most queries, you'll use existing database tables. The following 
screenshot depicts the list of tables that the Show Table dialog box makes available. 
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Figure 4: The Show Table dialog box 

 

Did you know? 

You can also select queries to use as the source of other queries. This 
might lead to exciting combinations of nested queries. 

After you add the source tables, you'll notice that the query editor displays them. The 
following screenshot depicts an empty query editor that references only a single table. 
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Figure 5: The query editor 

Select basic query fields 
You use the table in the pane following the query editor to build your questions for the 
database. Each query field in this table has a particular purpose for determining the 
results of your query. The following table describes what each query field can do in 
building your query. 

Query field Options Effect 

Field The fields for the currently 
selected table 

Selects a field to use for the current 
query field 

Table The tables in the database Selects a table to use as a source 
for the current query field 

Sort Ascending and Descending Sorts the query results by using the 
current query field 
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Query field Options Effect 

Show True and False Switches the current query field in 
the query results 

Criteria Your own filter that you build 
by using plain text 

Adds filters to limit the data that 
the query results return 

Table 2: The query field components 

For example, you might create a query field that selects the CustomerID field from the 
tblCustomers table and sorts the IDs in descending order. The following screenshot 
depicts this query field. 

 
Figure 6: A query field 

Sort and display query fields 
You can add as many query fields as you need to build a comprehensive query. You can 
choose whether to sort each query field and whether to display it in the query results. By 
using a combination of these techniques, you can build sophisticated queries relatively 
quickly. 

Observe some table data 
The following table displays some of the data in the tblCustomers table in the 
database. 

CustomerID FirstName LastName City State PostalCode Allergies 

1 Akia Kassis Edison WA 11215 Strawberries 

2 Alain Margand Bow WA 98107  

Table 3: Part of the tblCustomers table 
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Observe some queries 
Review the following sections for examples of queries you can build by using the 
tblCustomers table in the database and the query editor. 

To list all the customer names in the database 
Run the query that the following table depicts. 

Query field LastName FirstName 

Table tblCustomers tblCustomers 

Sort Ascending Ascending 

Show ✔ ✔ 

Table 4: A query that will return the full names of all the customers sorted by last name 
and then by first name 

The following table depicts the results. 

LastName FirstName 

Kassis Akia 

Margand Alain 

Table 5: The query results 

Note: Recall that the customer numbers were assigned chronologically as they signed 
up for the CSA program. 
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To find the last names of all the customers in the database in 
the order they were created 
Run the query that the following table depicts. 

Query field CustomerID LastName 

Table tblCustomers tblCustomers 

Sort Descending  

Show  ✔ 

Table 6: A query that will sort customers in descending order by CustomerID and display 
only their last names 

The following table depicts the results. 

FirstName LastName 

2 Margand 

1 Kassis 

Table 7: The query results 

To list everything stored in the database 
Run the query that the following table depicts. 

Query field tblCustomers.* 

Table tblCustomers 

Sort  

Show ✔ 

Table 8: A query that returns all fields and all data from the tblCustomers table 
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The following table depicts the results. 

CustomerID FirstName LastName City State PostalCode Allergies 

1 Akia Kassis Edison WA 11215 Strawberries 

2 Alain Margand Bow WA 98107  

Table 9: The query results 

To find the city and state for every customer in the database 
Run the query that the following table depicts. 

Query 
field 

City State PostalCode 

Table tblCustomers tblCustomers tblCustomers 

Sort   Ascending 

Show ✔ ✔  

Table 10: A query that lists the city and state for each customer and sorts the list by postal 
code 

The following table depicts the results. 

City State 

Edison WA 

Bow WA 

Table 11: The query results 
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To list the allergies of every customer in the database 
Run the query that the following table depicts. 

Query field Allergies CustomerID 

Table tblCustomers tblCustomers 

Sort  Ascending 

Show ✔ ✔ 

Table 12: The query results 

The following table depicts the results. 

Allergies CustomerID 

Strawberries 1 

 2 

Table 13: The query results 

Review your query results 
When your query is ready, you can review the results by running your query. To run your 
query, go to the Design tab, and then in the Results group, select Run, as the following 
screenshot depicts. 

 
Figure 7: The Run button on the Design tab 

When you run the query, Access switches from the Design view to the Datasheet view. 
The Datasheet view displays the results of the query. 
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Assume that you want to anonymously list the postal code and state for each customer 
to find out where your customers live and plan for an expansion of the produce box 
program. You can build this query in the Design view by specifying two query fields, as 
the following table depicts. 

Field State PostalCode 

Table tblCustomers tblCustomers 

Sort  Ascending 

Show ✔ ✔ 

Table 14: A query that lists the state and postal code for each customer 

After you finish building this query in the Design view, it resembles the following 
screenshot. 

 
Figure 8: A query that returns the State and PostalCode fields from the tblCustomers 
table 

After you run the query, the Datasheet view displays the query results, as the following 
screenshot depicts. 

 
Figure 9: The Datasheet view 
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Caution 

This course uses database files that follow a general storyline for the 
Community Supported Agriculture (CSA) program at Munson’s 
Pickles and Preserves Farm. These database files are the Learning 
Activity Resource files that you’ll use to work on each module’s 
activities and try-its. Each Learning Activity Resource file contains the 
data and objects, such as tables, queries, forms, and reports, that you 
need to complete a corresponding activity. 

Due to this course’s modular nature, the objects and data in these 
files might vary across activities or try-its. Therefore, it’s important 
that you start your activities or try-its only with the designated files, 
as per applicable instructions. You also should note that screenshots 
in the topic content are for illustration purposes only and might 
appear different than those that are in the Learning Activity Resource 
files. 

Activity: Show me how 
The teacher will demonstrate the various ways to create a query in an Access database. 

Resources required 
• L1_T1_act_csa.accdb from this lesson’s Learning Activity Resources folder 

Activity instructions 
Pay close attention and follow along as your teacher demonstrates how to create and 
run queries in Access. For each question that you answer from a query, fill in the results 
in the following tables. 

Question 1: How can you find the first and last names of all customers in the database? 

Field FirstName LastName 

Table tblCustomers tblCustomers 

Sort Ascending Ascending 

Show ✔ ✔ 

Table 15: A query that lists the first and last names of all customers 
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Question 1 results: Enter your results in the following table. 

FirstName LastName 
  

  

  

  

  

Table 16: The results of the query that lists the first and last names of all customers 

Question 2: How can you find the city and state of every customer in the database? 

Field City State 

Table tblCustomers tblCustomers 

Sort   

Show ✔ ✔ 

Table 17: A query that lists the city and state of every customer 

Question 2 results: Enter your answers in the following table. 

City State 
  

  

  

  

  

Table 18: The results of the query that lists the city and state of every customer 
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Try-it: Overview of queries 
 In this leveled try-it activity, you'll open an existing database and create a basic 

query. 

Try-it 1 
Resources 
You'll need the following resource for this try-it: 

• L1_T1_try1_csa_starter.accdb from this lesson’s Learning Activity Resources folder 

Instructions 
The following are the general tasks that you need to perform during this try-it: 

1. Create a new query by using the Design view. 

2. Add the tblCustomers table to the new query. 

3. Create a single query field that uses the settings in the following table. 

Field tblCustomers.* 

Table tblCustomers 

Sort  

Show ✔ 

Table 19: Select all fields 

4. Run the query. 

5. Observe the query results. The query should return all fields for all records in the 
database. 

Try-it 2 
Resources 
You'll need the following resource for this try-it: 

• L1_T1_try2_csa_starter.accdb from this lesson’s Learning Activity Resources folder 
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Instructions 
The following are the general tasks that you need to perform during this try-it: 

1. Create a new query by using the Design view. 

2. Add the tblCustomers table to the new query. 

3. Create two query fields that use the settings in the following table. 

Field State City 

Table tblCustomers tblCustomers 

Sort Ascending Ascending 

Show ✔ ✔ 

Table 20: Select only the City and State fields 

4. Run the query. 

5. Observe the results of the query. The query should return an alphabetical list of cities 
that are listed by state (also alphabetically) in which your customers reside. 

Try-it 3 
Resources 
You'll need the following resource for this try-it: 

• L1_T1_try3_csa_starter.accdb from this lesson’s Learning Activity Resources folder 

Instructions 
The following are the general tasks that you need to perform during this try-it: 

1. Create a new query by using the Design view. 

2. Add the tblCustomers table to the new query. 
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3. Create three query fields that use the settings in the following table. 

Field State City PostalCode 

Table tblCustomers tblCustomers tblCustomers 

Sort   Ascending 

Show ✔ ✔  

Table 21: Sort by postal code and then select the City and State fields 

4. Run the query. 

5. Observe the results of the query. The query should return a list of the cities and 
states in the database. 

6. Create another new query by using the Design view. 

7. Add the tblCustomers table to the new query. 

8. Create two query fields that use the settings in the following table. 

Field LastName FirstName 

Table tblCustomers tblCustomers 

Sort Descending Ascending 

Show ✔ ✔ 

Table 22: Select only the FirstName and LastName fields 

9. Run the query. 

10. Observe the results of the query. The query should return a list of full names for all 
the customers in the database. 

11. Create another new query by using the Design view. 

12. Add the tblCustomers table to the new query. 
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13. Create a single query field that uses the settings in the following table. 

Field Allergies 

Table tblCustomers 

Sort Ascending 

Show ✔ 

Table 23: Select only the Allergies field 

14. Run the query. 

15. Observe the results of the query. The query should return a list of all allergies in the 
database. 

Try-it review 
Answer the following questions by using the information you learned during the try-it 
exercise: 

1. Where are your customers located? In the following table, enter the cities and states 
that the query results displayed. 

State City 
  

  

  

  

  

Table 24: Customer locations 
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2. For each state in the following table, indicate whether Munson’s does business there 
by entering Yes or No. 

State Does Munson’s do business here? 
Montana  

Wyoming  

Idaho  

Oregon  

Washington  

Table 25: States 

3. Munson’s is planning a new distribution warehouse. Which city in the state of 
Washington would you recommend, and why? 

 

Topic 2: Create a simple query with 
Query Wizard 

 You can use the Query Wizard to automatically create a query. When you use the 
Query Wizard, you have less control over the details of the query design at first, but the 
process is faster than manually creating a query. The Query Wizard might also help you 
avoid some common mistakes you might make when manually building queries. 

Use the Query Wizard 
To open the Query Wizard, go to the Create tab, and then in the Queries group, select 
Query Wizard, as the following screenshot depicts. 

 
Figure 10: The Query Wizard button on the Create tab 
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The New Query dialog box displays, offering four choices for you to start building your 
query, as the following screenshot depicts. 

 
Figure 11: The New Query dialog box 

Use the Simple Query Wizard 
The Simple Query Wizard offers the easiest way to create a query that includes one or 
more fields from a single database table. To use this wizard, select Simple Query 
Wizard in the New Query dialog box. 

The Simple Query Wizard page displays and includes a list of the tables in the 
database. On this page, you select the table you want to include in your query. The 
following screenshot depicts selecting the tblCustomers table. 

 
Figure 12: Selecting a table for your query 
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After you select a table, you can select one or more fields in the table to include in your 
query. The following screenshot depicts selecting the CustomerID, FirstName, and 
LastName fields. 

 
Figure 13: Selecting the CustomerID, FirstName, and LastName fields 

In the final step of the wizard, you can change the title of your query and then select 
one of two choices: to open the query so you can review the results or to modify the 
query design. The following screenshot depicts this final step. 

 
Figure 14: The final step of the Simple Query Wizard 

Use the Find Duplicates Query Wizard 
You can use the Find Duplicates Query Wizard to find data that was incorrectly 
entered more than once in your database. To use this wizard, select Find Duplicates 
Query Wizard in the New Query dialog box. 
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The Find Duplicates Query Wizard displays a list of the tables in the database. Select 
the table you want to include in your query. The following screenshot depicts selecting 
the tblCustomers table. 

 
Figure 15: Selecting a table for your query 

The next step in the Find Duplicates Query Wizard is to select the fields that you 
suspect contain duplicate information. The following screenshot depicts selecting the 
FirstName and LastName fields. 

 
Figure 16: Selecting the FirstName and LastName fields 
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The next step in the wizard asks if you want to display additional data in the query 
results. The fields you selected in the previous step will already automatically display in 
the query results. The following screenshot depicts selecting the CustomerID field. 

 
Figure 17: Adding the CustomerID field to the query 

As in the Simple Query Wizard, the final step of the Find Duplicates Query Wizard is 
to change the title of your query if you want and then select one of two choices: to open 
the query so you can review the results or to modify the query design, as the following 
screenshot depicts. 

 
Figure 18: The final step of the Find Duplicates Query Wizard 

Activity: Show me how 
The teacher will demonstrate the various ways to create a query by using the Query 
Wizard for an Access database. 
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Resources required 
• L1_T2_act_csa.accdb from this lesson’s Learning Activity Resources folder 

Activity instructions 
Pay close attention and follow along as your teacher demonstrates how to create a 
query by using the Query Wizard in Access. For the single question that you answer 
from a query, fill in the results in the following table. 

Question 1: Does the database have any duplicated customers? 

Question 1 results: Enter your results in the following table. 

CustomerName First CustomerID value Second CustomerID 
value 

   

   

Table 26: Duplicated customers 

Try-it: Create a simple query with Query Wizard 
 In this leveled try-it activity, you'll open an existing database and create a query. 

Try-it 1 
Resources 
You'll need the following resource for this try-it: 

• L1_T2_try1_csa_starter.accdb from this lesson’s Learning Activity Resources folder 

Instructions 
The following are the general tasks that you need to perform during this try-it: 

1. Create a new query by selecting Query Wizard. 

2. Select Find Duplicates Query Wizard. 

3. Choose the tblCustomers table. 

4. Choose the FirstName and LastName fields to check for duplicates. 

5. Don’t include additional fields. 

6. Select the View the results option. 
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7. Finish the wizard to review the query results. 

Try-it 2 
Resources 
You'll need the following resource for this try-it: 

• L1_T2_try2_csa_starter.accdb from this lesson’s Learning Activity Resources folder 

Instructions 
The following are the general tasks that you need to perform during this try-it: 

1. Create a new query by selecting Query Wizard. 

2. Select Find Duplicates Query Wizard. 

3. Choose the tblCustomers table to use in the query. 

4. Choose the FirstName and LastName fields to check for duplicates. 

5. Choose the CustomerID field as an additional field in the query. 

6. Select the View the results option. 

7. Finish the wizard to review the query results. 

Try-it 3 
Resources 
You'll need the following resource for this try-it: 

• L1_T2_try3_csa_starter.accdb from this lesson’s Learning Activity Resources folder 

Instructions 
The following are the general tasks that you need to perform during this try-it: 

1. Create a new query by selecting Query Wizard. 

2. Select Find Duplicates Query Wizard. 

3. Choose the tblCustomers table to use in the query. 

4. Choose the FirstName and LastName fields to check for duplicates. 

5. Choose the CustomerID field as an additional field in the query. 

6. Select the Modify the design option. 

7. Select Finish to open the query designer so you can modify the query design. 
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8. Add an additional query field to the existing query that uses the settings in the 
following table. 

Field PostalCode 
Table tblCustomers 

Sort  

Show ✔ 

Table 27: Select the PostalCode field 

9. Run the query to review the query results. 

Try-it review 
Answer the following questions by using the information you learned from the try-it 
exercise: 

1. Which customers does the database duplicate? List each customer along with both 
of that customer’s CustomerID values in the following table. 

CustomerName First CustomerID value Second CustomerID 
value 

   

   

Table 28: Duplicated customers 

2. What other data in the database do you need to review to be sure that any particular 
name is truly a duplicate? What do you recommend as considerations, and why? 
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Topic 3: Use Save Object As 
 As the number of queries you build grows, it will become important for you to 

manage them in a way that makes sense to you. For example, suppose you have two 
similar queries that differ only slightly. If you then need to quickly query your database, 
how will you tell these two queries apart? 

After you author a query, you can name it when you save it and then later come back to 
it. To answer the preceding question, you name the two queries differently to help you 
quickly tell them apart. 

Save a query from the Design view 
Each query that you create in Access has its own tab. By default, Access names the query 
Query followed by a number. Access thus names the first query Query1 and the second 
query Query2, and the rest of the queries continue this pattern. The following 
screenshot depicts the tab for the first query that’s open in the editor. 

 
Figure 19: The tab for the first unnamed query 

To save this query, right-click or access the context menu of the Query1 tab, and then 
select Save, as the following screenshot depicts. 

 
Figure 20: The context menu of a query tab 
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The final step is to enter a unique name in the Query Name box of the Save As dialog 
box. Select OK to then save the query with the unique name. The following screenshot 
depicts the Save As dialog box. 

 
Figure 21: The Save As dialog box 

After you save your query, it will appear in the Queries list for this database. The 
following screenshot depicts Example Query in this list. 

 
Figure 22: The list of queries in the database 

Save a query from a design wizard 
Both wizards that you learned about—Simple Query Wizard and Find Duplicates 
Query Wizard—have a final step during which you can save your query with a unique 
name. 

The Simple Query Wizard has a What title do you want for your query? box, where 
you can enter a query name. The following screenshot depicts a query that Access will 
save with the name tblCustomers Query. 
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Figure 23: The final page of the Simple Query Wizard 

The Find Duplicates Query Wizard has a What do you want to name your query? 
box, where you can also enter a query name. The following screenshot depicts a query 
that Access will save with the name Find duplicates for tblCustomers. 

 
Figure 24: The final page of the Find Duplicates Query Wizard 
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Just like with the Design view, any query you save from a wizard will appear in the 
Queries list for this database. The following screenshot depicts the new queries in this 
list. 

 
Figure 25: The updated list of queries in the database 

Resave a query with a new name 
You might want to create a new copy of an existing query and save it with a new name. 
You can do this in Access by using Save Object As, which saves a copy of an existing 
database object with a new name. 

For example, you might want to save Example Query, which you created earlier, as a 
new query named Sample Query. 

To do this, select the existing query, and then on the File tab, select Save As. The 
following two screenshots depict the selection of the existing query and the location of 
the File tab. 

 
Figure 26: Selecting a query in the Queries list 
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Figure 27: The File tab 

When you select Save As, the Save As pane appears. In this pane, select Save Object 
As, and then select the Save As button to indicate that you want to save the currently 
selected database object (Example Query) as a new database object. The following 
screenshot depicts this process. 

 
Figure 28: The Save As pane 

The final step in this process is to give the new query a name. The following screenshot 
depicts the Save As dialog box, where you enter Sample Query for the name of the 
new query. 

 
Figure 29: The Save As dialog box 
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Activity: Show me how 
The teacher will demonstrate the various ways to create a query by using the Query 
Wizard in an Access database. 

Resources required 
• L1_T3_act_csa.accdb from this lesson’s Learning Activity Resources folder 

Activity instructions 
Pay close attention and follow along as your teacher demonstrates how to save a query 
in Access with a new name. While your teacher is demonstrating, answer the following 
questions: 

1. What’s the original name of the query that already existed in the Access database? 

 

2. What’s the new name that your teacher gave to the new query in the Access 
database? 

 

Try-it: Use Save Object As 
 In this standalone try-it activity, you'll save the queries that you created. 

Scenario 
Another member of the CSA team needs to run the same queries that you built. Instead 
of asking that person to re-create the queries, you decide to save your queries so others 
can run them later. 

Resources 
You'll need the following resource for this try-it: 

• L1_T3_try_csa_starter.accdb from this lesson’s Learning Activity Resources folder 

Instructions 
The following are the general tasks that you need to perform during this try-it: 

1. Open the existing qselCustomerAllergies query. 

2. Use Save Object As to create a copy of the query named 
qselCustomerAllergiesFiltered. 
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Wrap-up 
Use these questions to check what you learned in this lesson:  

1. What’s a query in Access? 

Select the correct option. 

a. A wizard that displays your data in a printable manner 

b. A way to ask a question of the database 

c. A connection between database tables 

d. A tool for adding new records to the database 

2. Which two methods can you use to create a new query? 

Select all that apply. 

a. The Query Wizard 

b. SQL instructions 

c. Query Design 

d. Table Design 

e. Form Design 

3. After you run a query, which of the following actions can’t you do in the Datasheet 
view? 

Select the correct option. 

a. Sort the query results 

b. Review the SQL instructions that the query ran 

c. Apply filters to the query results 

d. Change the fields that the query displays 

4. You can save a query any time after you change it. 

Select the correct option. 

a. True 

b. False 
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Lesson 2: Modifying queries 
Overview 
A query is a powerful and versatile way to communicate with a database. Running a 
query performs a set of instructions that you previously defined to ask a question of the 
database and supply an answer. You can sort, group, or filter the results that a query 
returns. Queries differ from basic sort or filter conditions, because you can save them for 
future use. 

In this lesson, you’ll learn how to manage and modify existing queries in your database. 
You’ll change an existing query to add new tables, define query criteria, or sort query 
results. You'll also learn how to delete an existing query. 

Warm-up 
Discussion 
Your teacher will lead the class through a discussion on how to modify the queries you 
use to ask questions of a database. Be prepared to answer the following question during 
the classroom discussion: 

• Imagine that you already asked each customer for their city and state. You need 
more information to figure out where each customer is located. What are examples 
of other information you might ask a customer to supply so you can get a more 
precise location for them? 
Fill in the blank space. 

________________________  
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Topic 1: Modify fields in a query 
 You can modify a query in the Design view regardless of how it was created. You 

can add or remove a table, add or remove fields, and add criteria to refine the query 
results. 

Add a table to a query 
To add a table to a query, you need to display the Design view: run the query, and then 
on the View menu, select Design View, as the following screenshot depicts. 

 
Figure 30: Design View on the View menu 

On the Design tab, in the Query Tools group, select Add Tables. The Show Table 
dialog box appears with the following three tabs: 

• Tables. Displays the tables in the database. 
• Queries. Displays the queries. 
• Both. Displays the tables and the queries.  
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Select the object you want to add to the query, and then select Add. The following 
screenshot depicts the Show Table dialog box. 

 
Figure 31: The Show Table dialog box 

If you add a second copy of a table to the query, Access indicates that by adding an 
underscore and the number 1 (_1) to the title of the field list. A field list is a pane that 
lists all the fields in the underlying record source or database object. The following 
screenshot depicts the changed name that displays if you add the tblCustomers table 
to a query twice. 

 
Figure 32: A duplicate table 
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Add criteria to a query 
A query doesn’t have to include criteria, but if you don’t want to display all the records 
stored in the underlying record source, you can add criteria to a query when designing 
it. Criteria are rules that identify the records you want to include in the query results. 

A criterion is like a formula. Some criteria are simple and use basic operators and 
constants. Others are complex and use functions, special operators, and field references. 

To specify one or more criteria to restrict the records that the query will return, open the 
query in the Design view. Select the field, and then in the Criteria row, enter the 
condition you want to specify. The following screenshot depicts an example criterion 
specifying that the query will return only the records where the LastName field equals 
"Kassis". 

 
Figure 33: An example of a criterion 

To display the results, change to the Datasheet view. The results display each field, 
including the one where you specified the criterion. 

Hide a query field 
Sometimes, you might want to get a more concise overview of the resulting data by 
displaying only certain fields (while hiding others) from the records that match a 
criterion. In this case, for each field that you don’t want to display in the results, clear the 
Show check box that appears in that field’s column. The following screenshot depicts 
how to hide the FirstName field in a query. 

 
Figure 34: Hiding a query field 
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The results will hide the fields that you choose not to display, except the field with the 
criterion, after you change to the Datasheet view. 

Activity: Show me how 
For this activity, observe your teacher briefly demonstrate the skills you'll need in the 
upcoming try-its. You can open the database file and follow along with the 
demonstration if you want. 

Resources required 
• L2_T1_act_csa.accdb from this lesson’s Learning Activity Resources folder 

Activity instructions 
To participate in this activity: 

• Pay attention to the methods your teacher uses to modify existing query fields.  
• Be prepared to repeat these actions in the upcoming try-its.  
• Ask questions to clarify anything that doesn’t seem clear to you. 

Try-it: Modify fields in a query 
 In this leveled try-it activity, you'll make minor modifications to an existing query. 

Try-it 1 
Resources 
You'll need the following resource for this try-it: 

• L2_T1_try1_csa_starter.accdb from this lesson’s Learning Activity Resources folder 

Instructions 
The following are the general tasks that you need to perform during this try-it: 

1. Open the existing qselCustomersOverview query. 

2. Switch to the Design View. 

3. Find the existing State query field. 

4. In the State query field, change the field that the tblCustomers table uses from 
State to PostalCode. 

5. Save the changes to the query. 
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6. Run the query. 

7. Observe the results of the query. The query should return a list of customer names, 
cities, and postal codes for all customers. 

Try-it 2 
Resources 
You'll need the following resource for this try-it: 

• L2_T1_try2_csa_starter.accdb from this lesson’s Learning Activity Resources folder 

Instructions 
The following are the general tasks that you need to perform during this try-it: 

1. Open the existing qselCustomersOverview query. 

2. Switch to the Design View. 

3. Add a new query field for the Allergies field in the tblCustomers table. 

4. Find the existing State query field. 

5. In the State query field, change the field that the tblCustomers table uses from 
State to PostalCode. 

6. Save the changes to the query. 

7. Run the query. 

8. Observe the results of the query. The query should return a list of customer names, 
cities, allergies, and postal codes for all customers. 

Try-it 3 
Resources 
You'll need the following resource for this try-it: 

• L2_T1_try3_csa_starter.accdb from this lesson’s Learning Activity Resources folder 

Instructions 
The following are the general tasks that you need to perform during this try-it: 

1. Open the existing qselCustomersOverview query. 

2. Switch to the Design View. 

3. Add a new query field for the Allergies field in the tblCustomers table. 
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4. Find the existing State query field. 

5. In the State query field, change the field that the tblCustomers table uses from 
State to PostalCode. 

6. Find the existing City query field. 

7. In the City query field, clear the Show check box. 

8. In the City query field, in the Criteria box, enter = 'Edison'. 

9. Save the changes to the query. 

10. Run the query. 

11. Observe the results of the query. The query should return a list of customer names, 
allergies, and postal codes for customers living in Edison, WA. 

Topic 2: Sort and filter data in a query 
 By sorting and filtering data in a query, you can display only the records you want, 

display records in a particular order, or both. 

Sort data in a query 
By sorting data in a query, you can help efficiently organize data and make it easier for 
users to review and find the records they want without having to browse the data. You 
can sort data in the Datasheet view of a query. 

Right-click or access the context menu of the field you want to sort, and then select the 
sort order you want (ascending or descending). The following screenshot depicts the 
sort choices for a field. 

 
Figure 35: The sort choices for a field 
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After you select the sort order, Access rearranges the records to match that sort order. 
To sort by more than one field, on the Home tab, in the Sort & Filter group, select 
Advanced, and then select Advanced Filter/Sort. A new tab displays where you can 
specify more than one field by which to sort and specify the sort order. The following 
screenshot depicts this process. 

 
Figure 36: Selecting Advanced Filter/Sort 

Filter data in a query 
A filter limits the display of data to specific records—without requiring you to alter the 
design of the underlying query. If the criteria are temporary or change often, you can 
filter the query results instead of frequently modifying the query criteria. 

You can think of a filter as a temporary criterion that changes the query results without 
altering the query design. To filter data in a query, select the field you want to filter, and 
then on the Home tab, in the Sort & Filter group, select Filter, as the following 
screenshot depicts. 

 
Figure 37: Filter in the Sort & Filter group on the Home tab 
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The available filters depend on the type and values of the field. The following screenshot 
depicts an example. 

 
Figure 38: The menu for filtering a field 

When you apply the filter, only those records that contain the values you want appear in 
the results. The rest are hidden until you remove the filter by selecting Remove Filter, 
as the following screenshot depicts. 

 
Figure 39: The Remove Filter button 

Activity: Show me how 
For this activity, observe your teacher briefly demonstrate the skills you'll need in the 
upcoming try-its. You can open the database file and follow along with the 
demonstration if you want. 
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Resources required 
• L2_T2_act_csa.accdb from this lesson’s Learning Activity Resources folder 

Activity instructions 
To participate in this activity: 

• Pay attention to the methods your teacher uses to sort and filter fields in the results 
of a query. 

• Be prepared to repeat these actions in the upcoming try-its. 
• Ask questions to clarify anything that doesn’t seem clear to you. 

Try-it: Sort and filter data in a query 
 In this leveled try-it activity, you'll sort and filter the results of a query. 

Try-it 1 
Resources 
You'll need the following resource for this try-it: 

• L2_T2_try1_csa_starter.accdb from this lesson’s Learning Activity Resources folder 

Instructions 
The following are the general tasks that you need to perform during this try-it: 

1. Open the existing qselCustomersOverview query. 

2. Switch to the Datasheet view, if it’s not already displayed. 

3. Right-click or access the context menu of the LastName field, and then sort this field 
from A to Z. 

4. Right-click or access the context menu of the State field, and then filter the field to 
return only those records that have a value of WA. 

5. Right-click or access the context menu of the City field, and then filter the field to 
return only those records that have a value of Edison. 

6. Observe the updated results of the query. The query should return the customers 
who live in the city of Edison, WA sorted by their last names. 
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Try-it 2 
Resources 
You'll need the following resource for this try-it: 

• L2_T2_try2_csa_starter.accdb from this lesson’s Learning Activity Resources folder 

Instructions 
The following are the general tasks that you need to perform during this try-it: 

1. Open the existing qselCustomersOverview query. 

2. Switch to the Datasheet view, if it’s not already displayed. 

3. Right-click or access the context menu of the CustomerID field, and then sort this 
field from Largest to Smallest. 

4. Right-click or access the context menu of the LastName field, and then sort this field 
from A to Z. 

5. Right-click or access the context menu of the State field, and then filter this field to 
return only those records that have a value of WA. 

6. Right-click or access the context menu of the City field, and then filter this field to 
return only those records that have a value of Edison. 

7. Observe the updated results of the query. The query should return the customers 
who live in the city of Edison, WA sorted by their customer IDs and then by their last 
names. 

Try-it 3 
Resources 
You'll need the following resource for this try-it: 

• L2_T2_try3_csa_starter.accdb from this lesson’s Learning Activity Resources folder 

Instructions 
The following are the general tasks that you need to perform during this try-it: 

1. Open the existing qselCustomersOverview query. 

2. Switch to the Datasheet view, if it’s not already displayed. 

3. Right-click or access the context menu of the CustomerID field, and then sort this 
field from largest to smallest. 
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4. Right-click or access the context menu of the FirstName field, and then sort this 
field from A to Z. 

5. Right-click or access the context menu of the LastName field, and then sort this field 
from A to Z. 

6. Right-click or access the context menu of the State field, and then filter this field to 
return only those records that have a value of WA. 

7. Right-click or access the context menu of the City field, and then filter this field to 
return only those records that have a value of Edison. 

8. Select Toggle Filter to remove the City and State filters. 

9. Observe the updated results of the query. The query should return the customers 
who live in the state of WA sorted by their customer IDs and then by their first and 
last names. 

Topic 3: Delete a query 
 Deleting a query is like deleting any other database object in Access. 

Delete a query object 
To delete a database object in Access, you first need to find that object in the 
Navigation Pane. For queries, you can find your specific query in the Queries list in this 
pane. To delete a query, right-click or access the context menu of the query, and then 
select Delete, as the following screenshot depicts. 
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Figure 40: Selecting Delete for a query 

After you select Delete, you need to confirm that you want to delete the query. A dialog 
box simply warns you that the object will permanently disappear after your 
confirmation. Select Yes to permanently delete the query from the database. The 
following screenshot depicts the warning dialog box. 

 
Figure 41: The delete confirmation dialog box 

Activity: Show me how 
For this activity, observe your teacher briefly demonstrate the skills you'll need in the 
upcoming try-it. You can open the database file and follow along with the 
demonstration if you want. 
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Resources required 
• L2_T3_act_csa.accdb from this lesson’s Learning Activity Resources folder 

Activity instructions 
To participate in this activity: 

• Pay attention to the methods your teacher uses to delete a query. 
• Be prepared to repeat these actions in the upcoming try-it. 
• Ask questions to clarify anything that doesn’t seem clear to you. 

Try-it: Delete a query 
 In this standalone try-it activity, you'll delete a saved query. 

Scenario 
Now that the marketing project has wrapped up, you want to return your database to its 
original condition and remove the additional queries you created. 

Resources 
You'll need the following resource for this try-it: 

• L2_T3_try_csa_starter.accdb from this lesson’s Learning Activity Resources folder 

Instructions 
The following are the general tasks that you need to perform during this try-it: 

1. Find the existing qselCustomersOverview query in the Navigation Pane. 

2. Right-click or access the context menu of the qselCustomersOverview query, and 
then select Delete. 

3. In the confirmation dialog box, select Yes. 
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Wrap-up 
Use these questions to check what you learned in this lesson:  

1. Which of the following statements best describes why queries differ from sort or 
filter conditions? 

Select the correct option. 

a. You can apply them to multiple fields. 

b. You can save them. 

c. You can modify them. 

d. You can use them on forms. 

2. You can add the same table to a query multiple times and use the same name for 
each table. 

Select the correct option. 

a. True 

b. False 

3. Which of the following should you use to create a sort order that uses multiple fields 
at the same time in a query? 

Select the correct option. 

a. Advanced Filter/Sort 

b. Multiple-sort 

c. Filter 

d. Sort A to Z 
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Glossary 
Datasheet view A view that displays the results of a query you ran. 

Design view A view you can use to either add components to a query or modify 
them. 

Query A formalized instruction to a database that gives you an answer to a 
specific question. 

Query criterion A rule that identifies the records you want to include in the query 
results. 

Query field A specific field that a query contains and that you can optionally 
display in the query results. The query fields typically correspond to 
fields from the source table. 

Query filter A condition you can specify to limit the query results to specific 
records. 

Query wizard A step-by-step tool that helps you build queries. 

Table 29: Glossary terms and definitions 
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Cornerstone 
Overview 
This Cornerstone project requires you to demonstrate your understanding of the 
concepts covered in this module by using queries to ask different questions about a 
sample database. The project expects you to use what you learned to create simple 
queries and build complex queries. In addition, you need to demonstrate your skills with 
managing and modifying existing queries in the database. 

Objectives 
The following table outlines the Cornerstone objectives and their corresponding MOS 
exam objectives. 

Use the Query 
Wizard to create, 
save, and run 
queries 

• 3.1.1 Create simple queries
• 3.1.6 Save queries
• 3.1.7 Run queries

Modify fields in a 
query and sort 
query results 

• 3.2.1 Add, hide, and remove fields in queries
• 3.2.2 Sort data within queries

Table 30: Cornerstone objectives mapped to MOS exam objectives 

Duration 
50 minutes 

Instructions 
1. Complete the tasks for the file.

2. After completing the Cornerstone, assess your completion, and then enter the points
you think you earned in the task lists in the following sections. You can get help from
your teacher if necessary.
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Tasks 
You’ll work with one file in this Cornerstone. The following section includes the tasks 
you need to do in the file. 

File 1: Cornerstone_csa_starter.accdb 
Task: Create a query that lists the customer's cities and states 
(25 points) 
1. Create a new query by using the Design View. (5 points) (Exam objective 3.1.1 

Create simple queries) 

2. Add the State and City fields to the new query. (10 points) (Exam objective 3.1.1 
Create simple queries) 

3. Run the query. (5 points) (Exam objective 3.1.7 Run queries) 

4. Save the new query as qselCustomerLocations. (5 points) (Exam objective 3.1.6 Save 
queries) 

Points scored: ________ / 25 

Task: Create a query that finds customer records with duplicate 
first and last names (25 points) 
1. Create a new query by using the Find Duplicates Query Wizard. (5 points) (Exam 

objective 3.1.1 Create simple queries) 

2. Configure the query to search for duplicates in the FirstName and LastName fields. 
(5 points) (Exam objective 3.1.1 Create simple queries) 

3. Include the CustomerID field in the query. (5 points) (Exam objective 3.1.1 Create 
simple queries) 

4. Run the query. (5 points) (Exam objective 3.1.7 Run queries) 

5. Save the new query as qselCustomerDuplicates. (5 points) (Exam objective 3.1.6 
Save queries) 

Points scored: ________ / 25 
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Task: Update the customer's cities and states query to include 
their postal codes (25 points) 
1. Open the qselCustomerLocations query in the Design View. (5 points) (Exam 

objective 3.2.1 Add, hide, and remove fields in queries) 

2. Add the PostalCode field to the query. (10 points) (Exam objective 3.2.1 Add, hide, 
and remove fields in queries) 

3. Run the query. (5 points) (Exam objective 3.1.7 Run queries) 

4. Save the updated query. (5 points) (Exam objective 3.1.6 Save queries) 

Points scored: ________ / 25 

Task: Sort the duplicate customers query by last name (25 
points) 
1. Open the qselCustomerDuplicates query in the Datasheet View. (5 points) (Exam 

objective 3.2.2 Sort data within queries) 

2. Sort the query results from A to Z by the LastName field. (10 points) (Exam objective 
3.2.2 Sort data within queries) 

3. Run the query. (5 points) (Exam objective 3.1.7 Run queries) 

4. Save the updated query. (5 points) (Exam objective 3.1.6 Save queries) 

Points scored: ________ / 25 

File 1 total points: ________ / 100 
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Module overview 
You can use reports to review, format, summarize, and present information from your 
Microsoft Access 2019 databases. In this module, you'll learn the basics about reports. 
You'll also learn to prepare reports for displaying or printing. 

Description 
The following table outlines the lesson objectives and their corresponding Microsoft 
Office Specialist (MOS) exam objectives. 

Lesson Learning objective MOS exam 
objective(s) 

Understanding 
report basics 

Create and customize reports • 5.1.1 
• 5.1.2 
• 5.2.5 
• 5.2.6 

Preparing 
reports for 
viewing and 
printing 

Configure settings for displaying and 
printing reports and insert information in 
report headers and footers 

• 5.1.3 
• 5.2.1 
• 5.2.3 
• 5.2.4 

Cornerstone: 
Produce a 
basic report 

Create, modify, and use database reports to 
present information 

• 5.1.1 
• 5.1.2 
• 5.1.3 
• 5.2.4 
• 5.2.5 

Table 1: MOS objectives by lesson 

Scenario 
The Community Supported Agriculture (CSA) program team at Munson's Pickles and 
Preserves Farm has been hard at work organizing the harvest area. This is where they fill 
the farm boxes with produce for members while the latest harvest is abundant with a 
variety of healthy choices. As word spreads in the community about the CSA program, 
the list of members is poised to grow rapidly. This also means that Munson’s will need 
to tailor the types of farm boxes to the needs and requests of the incoming members. 
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It's now time to find out if the carefully constructed database will perform as everyone 
hopes. Everyone on the team has been assigned a task that will depend upon the 
database providing usable data outputs. Someone is in charge of verifying and updating 
member contact information and preferences, another team member is assigned to 
determine how to distribute the available produce among the ordered boxes, and yet 
another will coordinate the box-filling process according to the orders placed. 

Cornerstone 
This module concludes with a Cornerstone in which you’ll create and customize a report 
that lists Munson’s customers and the cities they live in. You’ll use the concepts you 
learned in this module to start with a simple report and then modify that report to 
address changed needs. 
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Lesson 1: Understanding 
reporting basics 
Overview 
A report is a database object that is used to organize and display data from tables and 
queries. After creating a report, you can apply a theme to create a professional 
appearance. You can also sort and filter data in a report to display the records that suit 
your needs. 

Warm-up 
Activity: Think-pair-share 
Your teacher will lead the class through this group activity. You’ll be asked to think of an 
answer to a question. Your teacher will then pair you with another student to discuss 
your responses. 

After you and your partner have discussed your responses, the teacher might call on you 
to present your partner's answer, rather than your own. 

Be prepared to answer the following questions during the classroom discussion: 

1. If you were asked to share information from your database with a person who 
doesn’t have a computer, how would you share that information? 

 

2. If you could print data from your database, which data or fields would you include 
from each database table? Is there any reason you wouldn't include all the data or 
fields? 
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Topic 1: Create a basic report 
You can use Access to create simple or complex reports. If you all you need is a simple 
display of all the fields in a table or query, you can use the Report option. For complex 
reports, you might need to choose which fields you want to include from various tables 
or queries, which can be a time-consuming task. 

 

Video 

For a basic introduction to reports, review the video at: Create basic 
reports 

To create reports, use the Reports group of commands on the Create tab. You can use 
the Report, Report Wizard, Report Design, or Blank Report option, depending on the 
amount of customization you want. You can also create labels by using the Labels 
option. The following screenshot depicts the Reports group. 

 
Figure 1: Reports group 

Reports are commonly used as formatted hard copies of table or query data. You can 
modify a report’s design, but you cannot add or edit data in a report. That’s because the 
purpose of a report is only to allow users to review data. For example, a supervisor 
might ask you to create a sales report that is filtered to reveal only one region’s sales. 
The supervisor does not want to change the data, just review it. The table or query that 
provides the data used to generate a report is its record source, which you first must 
define. To do so, in the Navigation Pane, select the table or query on which you want 
to base the report. The following screenshot highlights a table that a user has selected 
in the Navigation Pane. 

 
Figure 2: Selecting a database object 

https://aka.ms/video-create-basic-reports
https://aka.ms/video-create-basic-reports
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Next, select the Report option in the Reports group of the Create tab. Access 
automatically generates a report based on the table or query you selected. The 
following screenshot highlights the Report option and the tooltip that displays when 
you select it. 

 
Figure 3: Selecting the report option 

You can modify a report’s design and choose to print a report, or you can save and 
close it. You should save a report’s design if you’re likely to use it again. To save a 
report, select the Save option on the context menu of the report's tab, as the following 
screenshot highlights. 

 
Figure 4: Saving a new report 
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Caution 

This course uses database files that follow a general storyline for the 
CSA program at Munson’s Pickles and Preserves Farm. These 
database files are the Learning Activity Resource files that you’ll use 
to work on each module’s activities and try-its. Each Learning Activity 
Resource file contains the data and objects, such as tables, queries, 
forms, and reports, that you need to complete a corresponding 
activity. 

Due to this course’s modular nature, the objects and data in these 
files might vary across activities or try-its. Therefore, it’s important 
that you start your activities or try-its only with the designated files, 
as per applicable instructions. You also should note that screenshots 
in the topic content are for illustration purposes only and might 
appear different than those that are in the Learning Activity Resource 
files. 

Activity: Show me how 
In this activity, your teacher will demonstrate how to create a basic report. 

Resources required 
• Open L1_T1_act_csa.accdb in this lesson’s Learning Activity Resources folder. 

Activity instructions 
To participate in this activity: 

• Pay attention to the methods that your teacher uses to create a new basic report. 
• Be prepared to repeat these actions in the upcoming try-it. 
• Ask questions to clarify anything that isn't clear to you. 

Try-it: Create a basic report 
 In this standalone try-it activity, you’ll create a new basic report. 
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Try-it 
Resources 
You’ll need the following resources for this try-it: 

• Open L1_T1_try_csa_starter.accdb in this lesson’s Learning Activity Resources 
folder. 

Instructions 
The following are the general tasks that you need to perform during this try-it: 

1. Select the existing tblCustomers table. 

2. Create a new report from the database object. 

3. Save the new report using the name rptCustomers. 

Topic 2: Customize report structure 
 You may already be familiar with the way Access wizards work. The Report Wizard 

displays a series of questions about the report you want and then creates the report for 
you, based on your answers. The Report Wizard knows what makes a good report, so 
the questions are designed to help you create a professional report with little effort. The 
Report Wizard is usually the easiest way to create a report when you want to choose 
which fields to include. It guides you through a series of questions and then generates a 
report based on your answers. 

Customize a report using the Report Wizard 
To get started with the Report Wizard, select the table or query on which you want to 
base the report, and then in the Reports group of the Create tab, select the Report 
Wizard option, which the following screenshot highlights. 
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Figure 5: Selecting the Report Wizard option 

In the Report Wizard, you can choose to include fields from more than one table or 
query. You can include all the fields in the report or include them one at a time. The 
following screenshot depicts the Report Wizard. 

 
Figure 6: Select fields to include in the report 

If you want to skip steps such as sorting or grouping in the Report Wizard, select Next 
to go to the next step. You can select Finish anytime it is available to create the report 
with the choices you’ve specified. The Report Wizard allows you to include fields from 
more than one table or query. You can also specify group levels; for example, grouping 
all the customers by city or state. The following screenshot depicts the grouping options 
on the Report Wizard. 
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Figure 7: Select fields to use as grouping levels 

You can also choose up to four fields on which to sort data in ascending or descending 
order, as the following screenshot depicts. 

 
Figure 8: Select fields to sort reports results 

Access provides a wide variety of design styles for you to choose from. On the layout 
screen, you can choose from various layouts, such as Stepped, Block, or Outline. All 
these options indent fields and records in different ways to make the report easier to 
review. You can also choose to display the report in Portrait or Landscape orientation. 
The following screenshot depicts these options. 
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Figure 9: Customize design and layout of report 

On the last screen of the Report Wizard, you can enter a name for the report and also 
choose to preview the report or modify its design, as the following screenshot depicts. 

 
Figure 10: Name final generated report 

The wizard will create a new report that you can then review, modify, or print. 

Add images to a report 
After reviewing your customized report, you might decide to improve its appearance, 
such as by adding an image.  For example, you might decide to add the Munson's logo 
at the beginning of every report. To do this, you can add a Logo element to the header 
or footer of your report. To do so: 
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Select the Logo option in the Header/Footer group of the Design tab. The following 
screenshot highlights this option. 

 
Figure 11: Logo option in Header/Footer group 

In the Insert Picture dialog box, select the image you want to use for the logo in your 
report. The image will then be part of the report, and you can rearrange it to be in the 
header or footer however you choose. The following screenshot depicts an example, 
with the Munson’s logo on the header of a report. 

 
Figure 12: Report with the Munson's logo in the header 

Activity: Show me how 
This is a teacher-led demonstration on how to customize the structure of a report. 

Resources required 
• Open L1_T2_act_csa.accdb in this lesson’s Learning Activity Resources folder. 

Activity instructions 
To participate in this activity: 

• Pay attention to the methods that your teacher uses to customize the structure of a 
new report. 

• Be prepared to repeat these actions in the upcoming try-it. 
• Ask questions to clarify anything that isn't clear to you. 
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Try-it: Customize report structure 
 In this leveled try-it activity, you’ll customize the structure of a new report. 

Try-it 1 
Resources 
You’ll need the following resources for this try-it: 

• Open L1_T2_try1_csa_starter.accdb in this lesson’s Learning Activity Resources 
folder. 

Instructions 
The following are the general tasks that you need to perform during this try-it: 
1. Select the existing tblCustomers table. 

2. Create a new report using the Report Wizard. 

3. Include the CustomerID, FirstName, and LastName fields in the report. 

Try-it 2 
Resources 
You’ll need the following resources for this try-it: 

• Open L1_T2_try2_csa_starter.accdb in this lesson’s Learning Activity Resources 
folder. 

Instructions 
The following are the general tasks that you need to perform during this try-it: 

1. Select the existing tblCustomers table. 

2. Create a new report using the Report Wizard. 

3. Include the CustomerID, FirstName, LastName, City, and State fields in the report. 

4. Group the report, first by using the State field, and then by using the City field. 

  



Understanding reporting basics 
 

 
15 

Try-it 3 
Resources 
You’ll need the following resources for this try-it: 

• Open L1_T2_try3_csa_starter.accdb in this lesson’s Learning Activity Resources 
folder. 

Instructions 
The following are the general tasks that you need to perform during this try-it: 

1. Select the existing tblCustomers table. 

2. Create a new report using the Report Wizard. 

3. Include the CustomerID, FirstName, LastName, City, and State fields in the report. 

4. Group the report, first by using the State field, and then by using the City field. 

5. Sort the customers in the report, first by their LastName in ascending order and 
then by their FirstName in ascending order. 

Wrap-up 
Use these questions to check what you learned in this lesson: 

1. What is a report in Access? 

Select the correct option. 

a. A list of available fields to add to the design of a database object 

b. A database object that is used to organize and display data from tables or 
queries 

c. A predefined set of colors and format that is applied to a database object 

d. A database object that asks questions of your data 

2. In the Reports group, which option would give you a step-by-step wizard that helps 
you create a report? 

Select the correct option. 

a. Report 

b. Report Design 

c. Report Wizard 

d. Blank Report 
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3. In the Reports group, which option would give you a new report with the least 
amount of work? 

Select the correct option. 

a. Report 

b. Report Design 

c. Report Wizard 

d. Blank Report 
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Lesson 2: Preparing reports for 
viewing and printing 
Overview 
Reports help you group and summarize data in different ways. However, after you create 
a report, you can use Layout View or Report View to help locate data. For example, 
you can use Layout View to easily sort field data one at a time, or you can perform 
more complex sorts by using the Group, Sort, and Total pane. You can also use Layout 
View to filter data and review only those records that meet the criteria you specify. 

Warm-up 
Discussion 
Your teacher will lead the class through a discussion on how to update existing queries. 
Be prepared to answer the following question during the classroom discussion: 

• If you were asked by your team leader to make a report "more exciting", what do 
you think you could add to the report or change about the report? 
 

Topic 1: Configure view and print 
settings 

 You can use the View drop-down list in the View group to review your reports in 
different ways. The View drop-down list makes it easy to switch back and forth between: 

• Outputting your report's data. 
• Rendering a print preview of the report. 
• Changing the design of the report. 
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Video 

For basic steps on how to modify or print a report, review the video at: 
Modify and print reports 

To change the current view of a report, open the report object in the Navigation Pane, 
and then select the View drop-down list in the Views group to find the following 
options: 

• Report View 
• Print Preview 
• Layout View 
• Design View 
The following screenshot depicts the View drop-down list options. 

 
Figure 13: View menu for a report 

Change print options 
After you create your report, you can set options for the print layout in the Page Setup 
dialog box. These options help you customize the format with options for margin 
settings, use of gridlines and columns, or printing only the data from the report without 
the formatting. To set the print page options, select the View drop-down list in the 
Views group and then select the Print Preview option. You can then select the Page 
Setup option in the Page Layout group, which the following screenshot highlights. 

 
Figure 14: Page Setup option 

https://aka.ms/video-modify-and-print-reports
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In the Page Setup dialog box, you can change the margins of the printed report, decide 
if you want to print data, or modify data and layout features. The following screenshot 
depicts the Page Setup dialog box. 

 
Figure 15: Page Setup dialog 

Change the report layout 
The Layout View option makes it easier to note how your design changes affect the 
way data is rendered on your report. To switch to the Layout View, select the View 
drop-down list in the Views group, and then select Layout View. 

To change the design of your report, you can select a new theme from the Themes 
group on the Design tab, as the following screenshot depicts. 

 
Figure 16: Theme options 
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To change the layout of your report, go to the Page Layout group on the Page Setup 
tab and then select either Portrait (vertical) or Landscape (horizontal). The following 
screenshot highlights these options. 

 
Figure 17: Portrait or landscape layout 

Activity: Show me how 
This is a teacher-led demonstration on how to configure view, layout, and print settings. 

Resources required 
• Open L2_T1_act_csa.accdb in this lesson’s Learning Activity Resources folder. 

Activity instructions 
To participate in this activity: 

• Pay attention to the methods that your teacher uses to configure view, layout, and 
print settings for an existing report. 

• Be prepared to repeat these actions in the upcoming try-it. 
• Ask questions to clarify anything that isn't clear to you. 

Try-it: Configure view and print settings 
 In this leveled try-it activity, you’ll configure view, layout, and print settings for an 

existing report. 

Try-it 1 
Resources 
You’ll need the following resources for this try-it: 

• Open L2_T1_try1_csa_starter.accdb in this lesson’s Learning Activity Resources 
folder. 
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Instructions 
The following are the general tasks that you need to perform during this try-it: 

1. Open the existing rptCustomers report. 

2. Switch to the Layout View. 

3. Change the orientation from Portrait to Landscape. 

4. Save the updated report. 

Try-it 2 
Resources 
You’ll need the following resources for this try-it: 

• Open L2_T1_try2_csa_starter.accdb in this lesson’s Learning Activity Resources 
folder. 

Instructions 
The following are the general tasks that you need to perform during this try-it: 

1. Open the existing rptCustomers report. 

2. Switch to the Layout View. 

3. Change the orientation from Portrait to Landscape. 

4. Change the theme to Ion Boardroom. 

5. Switch to the Print Preview. 

6. Change the print options to Print Data Only and not print the other report 
elements. 

7. Save the updated report. 

Try-it 3 
Resources 
You’ll need the following resources for this try-it: 

• Open L2_T1_try3_csa_starter.accdb in this lesson’s Learning Activity Resources 
folder. 
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Instructions 
The following are the general tasks that you need to perform during this try-it: 

1. Open the existing rptCustomers report. 

2. Switch to the Layout View. 

3. Change the orientation from Portrait to Landscape. 

4. Change the theme to Ion Boardroom. 

5. Switch to the Print Preview. 

6. Change the print options to Print Data Only and not print the other report 
elements. 

7. Change the report margins, for the Top and Bottom enter 1 inch or 25.4 
millimeters, and for the Left and Right enter 0.25 inches or 6.35 millimeters. 

8. Save the updated report. 

Topic 2: Add and format report 
elements 

 When you want to create a customized report, you can use Design View. Design 
View gives you the most options for creating a report exactly the way you want it, 
because it displays the underlying structure of the report. It also provides you with more 
design tools and capabilities. 

In Design View, a report displays on a design grid with sections. The following table 
lists and describes these sections. 

Report header This section is printed once at the beginning of every report. This is a 
good place to include a logo, a date, or information that might 
normally appear on a cover page. 

Page header This section is printed at the beginning of every page of a report, so 
it is a good place to include the report title. 

<Group> header This section is printed at the beginning of a group. (The name of the 
grouping field replaces <Group>.) It is a good place to include the 
group name. 
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Detail This section includes the body of the report. It is printed once for 
every row in a record source. 

<Group> footer This section is only printed at the end of a group that contains 
summary information for the group. (The name of the grouping field 
replaces <Group>.) 

Page footer This section is printed at the end of every page of a report, so it is a 
good place to include information such as a page number. 

Report footer This section is printed once at the end of every report. It is a good 
place for report totals. 

Table 2: Report sections 

You can observe the breakdown of each section for your report by reviewing the 
report's design, as the following screenshot depicts. 

 
Figure 18: Report designer 
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To add fields to the report design, you can display the Field List pane (if it is not already 
displayed) by selecting Add Existing Fields on the Tools group. 

 
Figure 19: Field list for a report 

To review your modified report, select the View drop-down list in the Views group and 
then select Report View, as the following screenshot highlights. 

 
Figure 20: View menu for a report 

Activity: Show me how 
This is a teacher-led demonstration on how to change the elements in a report. 

Resources required 
• Open L2_T2_act_csa.accdb in this lesson’s Learning Activity Resources folder. 
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Activity instructions 
To participate in this activity: 

• Pay attention to the methods that your teacher uses to change the elements of an 
existing report. 

• Be prepared to repeat these actions in the upcoming try-its. 
• Ask questions to clarify anything that isn't clear to you. 

Try-it: Add and format report elements 
 In this standalone try-it activity, you’ll change the elements of an existing report. 

Try-it 
Resources 
You’ll need the following resources for this try-it: 

• Open L2_T2_try_csa_starter.accdb in this lesson’s Learning Activity Resources 
folder. 

Instructions 
The following are the general tasks that you need to perform during this try-it: 

1. Open the existing rptCustomers report. 

2. Switch to the Design View. 

3. Change the rptCustomers label to Customers Report. 

4. Change the FirstName label to First Name. 

5. Change the LastName label to Last Name. 

6. Add a new CSA label to the footer of the report. 

7. Save the updated report. 
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Wrap-up 
Use these questions to check what you learned in this lesson: 

1. Which report view should you use to add or remove fields from a report? 

Select the correct option. 

a. Design View 

b. Print Preview 

c. Layout View 

d. Report View 

2. Which report view should you use to change the theme of a report? 

Select the correct option. 

a. Design View 

b. Print Preview 

c. Layout View 

d. Report View 
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Glossary 
Design View A view where you can edit the components or controls in a report. 

Layout View A view where you can edit the layout of a report. 

Print Preview A view where the report is rendered exactly as it would be on paper. 

Report A database object that is used to organize and display data from 
tables or queries. 

Report View A view where report data is calculated and displayed on the current 
layout. 

Report Wizard A step-by-step wizard that assists you in creating a report. 

Table 3: Glossary terms and definitions 

Cornerstone
Overview 
This Cornerstone project requires you to demonstrate your understanding of the concepts 
covered in this module by creating and using reports. You’ll further demonstrate what you 
learned by creating simple reports and then modifying those reports to address changed 
needs. 

Objectives 
The following table outlines the Cornerstone objectives and their corresponding MOS exam 
objectives. 

• Create a report
• Group fields on 

reports

• 5.1.1: Group and sort fields on reports
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• Change report
orientation

• Add report
controls

• Insert
information in
report headers
and footers

• 5.1.2: Add report controls
• 5.1.3: Add and modify labels on reports
• 5.2.4: Change report orientation
• 5.2.5: Insert information in report headers and footers

Table 4: Cornerstone objectives 

Duration 
50 minutes 

Instructions 
1. Complete the tasks for each file.

2. After completing the Cornerstone, assess your completion, and then enter the points
you think you earned within the task lists in the following sections. You can get help
from your teacher, if necessary.

Tasks 
You'll work with one file in this Cornerstone. The following are the tasks you need to do 
within that file: 
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File 1: Cornerstone_csa_starter.accdb 
Task: Create a report that lists customers and their cities (40 
points) 
1. Create a report using the Report Wizard. (5 points) (Exam objective 5.1.1: Group and 

sort fields on reports) 

2. Include the FirstName, LastName, and City fields in the report. (10 points) (Exam 
objective 5.1.2: Add report controls) 

3. Group the report using the City field. (20 points) (Exam objective 5.1.1: Group and 
sort fields on reports) 

4. Save the report as tblCustomers. (5 points) (Exam objective 5.1.1: Group and sort 
fields on reports) 

Points scored: ________ / 40 

Task: Change the report's orientation (30 points) 
1. Open the tblCustomers report. (5 points) (Exam objective 5.2.4: Change report 

orientation) 

2. Change the orientation of the report to Landscape. (20 points) (Exam objective 5.2.4: 
Change report orientation) 

3. Save the report. (5 points) 

Points scored: ________ / 30 

Task: Change the report's header (30 points) 
1. Open the tblCustomers report. (5 points) 

2. Update the content of the existing label in the Report Header to Customers by 
Location. (20 points) (Exam objective 5.1.3: Add and modify labels on reports, Exam 
objective 5.2.5: Insert information in report headers and footers) 

3. Save the report. (5 points) 

Points scored: ________ / 30 

FILE 1 TOTAL POINTS: ________ / 100 
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Module overview 
Description 
As you start using databases to manage a lot of information, you must make sure that 
you’ve organized your data. You must also be able to retrieve exactly what you want. 
You can use table relationships to link related information while keeping everything 
separate and organized. Table relationships make it possible to store data efficiently and 
without redundancy. 

In this module, you'll learn about the benefits of relationships and the different 
relationships Microsoft Access 2019 supports. You'll understand how foreign keys are 
important to relationships. You’ll also learn how to use Access to make sure those keys 
always match between tables. Finally, you'll learn to create, edit, and delete relationships 
by using the Relationships window. 

The following table outlines the lesson objectives and their corresponding Microsoft 
Office Specialist (MOS) exam objectives. 

Lesson Learning objective MOS exam 
objective(s) 

Understanding 
relationship 
basics 

Explain the role of relationships, different 
relationship types, and the use of foreign 
keys. 

• 1.2.1 
• 1.2.4 
• 1.2.5 

Creating and 
modifying 
relationships 

Define, test, and manage various table 
relationships. 

• 1.2.1 
• 1.2.2 
• 1.2.4 

Cornerstone: 
Make the 
connections 

Create and manage relationships between 
tables used by the Customer Supported 
Agriculture (CSA) program at Munson's. 

• 1.2.1 
• 1.2.2 
• 1.2.4 
• 1.2.5 

Table 1: MOS objectives by lesson 
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Scenario 
The Community Supported Agriculture (CSA) program at Munson's Pickles and 
Preserves Farm is now larger than when you first designed the database. The CSA 
program team has received much positive feedback from other employees, members, 
and the community. There are requests from the team to track more information about 
members and their orders. There is also growing demand for more variety in the farm 
boxes and there are opportunities to create special offers. 

You are now managing an increasing number of datasets regarding members, farm box 
offerings, available produce, and supplies inventory. To manage all this data in a 
practical and efficient manner, you need to create relationships between the tables. This 
will allow you to create more complex queries that include data from multiple tables. 

Other teams at Munson’s are also increasing their use of Access databases. They have 
created databases for beekeeping, irrigation, greenhouse yield, and water management. 
You would eventually like to connect CSA program data with other databases, where 
applicable. 

Cornerstone 
This module concludes with a Cornerstone in which you’ll create and maintain table 
relationships in the CSA database at Munson's. In the Cornerstone, you'll: 

• Use the Relationships window. 
• Add a foreign key and define a relationship. 
• Delete a relationship. 
• Modify a relationship. 
• Identify a “many to many” relationship. 
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Lesson 1: Understanding 
relationship basics 
Overview 
In this lesson, you'll learn how relationships can make databases more efficient and 
reliable dividing data into multiple, related tables. You'll also identify the different types 
of table relationships supported by Access. You'll learn how to add a foreign key field to 
a table so that you can then add that table to a relationship. Finally, you'll understand 
the role of referential integrity in relationships. 

Warm-up 
Use these questions to find out what you already know about this lesson’s topics: 

1. Which of the following terms describes a record that cannot be correctly connected 
to another record in a relationship? 

Select the correct option. 

a. Foreign key 

b. Orphan 

c. Primary key 

d. Referential integrity 

2. Which of the following terms describes a primary key from one table that is used in 
another table? 

Select the correct option. 

a. Foreign key 

b. Orphan 

c. Primary key 

d. Query 

e. Referential integrity 
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3. Which of the following are benefits of table relationships? 

Select all that apply. 

a. Minimizing duplication of data. 

b. Consolidating data into one large table. 

c. Preventing data from one table from being connected to another table. 

d. Ensuring that data is consistent. 

4. A relationship connects two __________________________ in a database. 

Fill in the blank space. 

Topic 1: Explore the role of 
relationships 

 As you start to get more data in a storage system, whether it's a spreadsheet, 
paper index cards, or a database, you need to have a plan to address data redundancy. 
Data redundancy refers to the duplication of data. In your own life, you might have 
several lists of people you know, including a contact list in your phone, another in your 
school or work email, a third in your personal email, and others. 

Some people, like your best friend from school, might be in multiple lists, or even all of 
them. If that friend changes their phone number, you'll need to change it in every list. 
Each time you change it, there's a chance you might make a mistake. Also, if you forget 
to update one list, you could easily end up with different information in different 
locations. Not only that, but all that duplication wastes storage space. 

Understand table relationships 
It’s best to spread information out and store each piece of data in as few places as 
possible. You can then link those locations together to connect related information. 

This is the nature of a relational database management system, such as Access. You can 
create a table for each subject or category that you need to store and use table 
relationships to bring together information from the different tables. 
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The CSA team at Munson's Pickles and Preserves Farm faces these same issues. When a 
member orders a farm box, that order includes customer information, such as name, 
address, and phone number. It also includes information about the farm box ordered by 
the member. As the team receives more orders, there will be a lot of data redundancy, 
because the same members order multiple farm boxes. Also, many different members 
order the same farm boxes. 

As you've learned, the team can organize the data using tables. They can store all the 
member information in one table and all the farm box information in another. When a 
member places an order, a relationship can connect information from members table to 
information in the farm boxes table. 

The benefits of related tables include: 

• Consistency. Each piece of information is stored only once, and in one table. This 
means there is a lower risk of data that doesn't match. If a member’s name has a 
spelling mistake, for example, you only need to go to one place to correct it. 

• Efficiency. Keeping a piece of data in only one place uses less storage space. This 
might not seem important if you're just thinking about a list of your friends' names. 
However, storage is a big consideration if you think about all the large items you can 
store in databases. What if a database includes photographs or video clips? Even if 
you have plenty of storage, databases can retrieve data more quickly from a smaller 
table. 

• Ease of use. It's easier to understand database organization if it’s divided into 
multiple, related tables. For example, if you want to edit member information, you 
know it will be in the table for member data. 

 

Additional information 

For more information on the role of relationships, go to: Guide to 
table relationships - Introduction 

  

https://aka.ms/Guide-to-table-relationships_Introduction
https://aka.ms/Guide-to-table-relationships_Introduction
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Additional information 

For more information on the reasons to use relationships, go to: Guide 
to table relationships - Why create table relationships? 

 

Caution 

This course uses database files that follow a general storyline for the 
CSA program at Munson’s Pickles and Preserves Farm. These 
database files are the Learning Activity Resource files that you’ll use 
to work on each module’s activities and try-its. Each Learning Activity 
Resource file contains the data and objects, such as tables, queries, 
forms, and reports, that you need to complete a corresponding 
activity. 

Due to this course’s modular nature, the objects and data in these 
files might vary across activities or try-its. Therefore, it’s important 
that you start your activities or try-its only with the designated files, 
as per applicable instructions. You also should note that screenshots 
in the topic content are for illustration purposes only and might 
appear different than those that are in the Learning Activity Resource 
files. 

Activity: Discuss and learn 
In this activity, you'll participate in a group discussion about the role of table 
relationships in a database. 

Resources required 
You'll need the following resources for this activity: 

• None 

Activity instructions 
Participate in the activity by following these instructions: 

1. Think carefully about the questions posed by the teacher. 

2. Join in the discussion. 

3. Study the document the teacher is presenting. 

4. Ask the teacher any clarifying questions you might have. 

https://aka.ms/Guide-to-table-relationships-why-create-table-relationships
https://aka.ms/Guide-to-table-relationships-why-create-table-relationships
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Try-it: Explore the role of relationships 
 In this standalone try-it activity, you'll explain the purpose and advantages of table 

relationships. 

Resources 
You'll need the following resources for this try-it: 

• None 

Instructions 
The following are the general tasks to perform during this try-it: 

1. On a sheet of paper or in a document, respond to the following prompts in 1-2 
sentences each: 

a. Explain the role of a relationship between two tables. 

b. Is it good to have data redundancy in a database? Why or why not? 

c. What are some benefits of using table relationships? 

2. Submit or share your response as directed by the teacher. 

Topic 2: Identify relationship types 
 After you’ve organized your information into tables, you can connect them with 

relationships. In Access, there are three types of table relationships: a “one to many” 
relationship, a “many to many” relationship, and a “one to one” relationship. 

Understand “one to many” relationships 
A “one to many” relationship is when a single record in Table A is related to one or more 
records in Table B. Your local library might have a database that keeps track of all library 
borrowers and books. One table stores your information as a borrower, including your 
name, address, and phone number. A separate table stores information about each 
book, such as the title and author. 

An individual borrower can check out many books, but only one borrower can check out 
a specific book. This is an example of a “one to many” relationship, and they are very 
common in databases. In the same way, a salesperson can make many sales, but only 
one salesperson can be responsible for a specific sale. And a warehouse can have many 
different boxes, but each box can only be in one warehouse. 
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Understand “many to many” relationships 
A “many to many” relationship is one in which a single record in Table A can be related 
to one or more records in Table B, and a single record in Table B can also be related to 
one or more records in Table A. 

Your school could have a database with one table to keep track of you and all the other 
students, with your name, grade level or major, and contact information. A second table 
could keep track of the information for each class, such as the class name, teacher's 
name, room number, and the schedule of class meetings. As an individual student, you 
can take many classes and each class can have many different students. 

Another example of a “many to many” relationship is order tracking. A single order can 
have many products, and a product could be part of many different orders. 

Understand “one to one” relationships 
A “one to one” relationship is far less common, and refers to a relationship in which one 
record in Table A is connected to one record in Table B, and in turn that one record in 
Table B is only connected to that one record in Table A. 

An example of this would be if the library separated the borrower's contact information 
into a different table with that person's address, phone number, and email. This is 
unusual because that information could be stored in the borrower information table. 
The library might separate it for privacy or security purposes. It could also be 
information that is only stored for some of the records in Table A, and you want to avoid 
having a lot of empty fields. 

 

Additional information 

For more information on relationship types, go to: Guide to table 
relationships - Types of table relationships 

 

Additional information 

For more information on relationship types, go to: Database design 
basics - Creating the table relationships 

 

Video 

To review the video on relationship types, go to: Get started with table 
relationships 

https://aka.ms/Guide-to-table-relationships-Types-of-table-relationships
https://aka.ms/Guide-to-table-relationships-Types-of-table-relationships
https://aka.ms/Database-design-basics-table-relationships
https://aka.ms/Database-design-basics-table-relationships
https://aka.ms/video-get-started-with-table-relationships
https://aka.ms/video-get-started-with-table-relationships
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Activity: Each one, teach one 
In this activity, you'll learn about one of the three relationship types. Then you’ll share 
what you’ve learned with two classmates. 

Resources required 
You'll need the following resources for this activity: 

• None 

Activity instructions 
Participate in the activity by following these instructions: 

1. Learn about the table relationship type your teacher assigns you. Use the Additional 
Information links as a starting point. You can also search on 
Office_Help_and_Training for additional resources. 

2. When directed by the teacher, group together with two students who learned about 
the other relationship types. 

3. When it's your turn, explain what you learned about your assigned topic. 

4. When other students are explaining, pay attention and actively ask any questions 
you might have. 

Try-it: Identify relationship types 
  In this standalone try-it, you'll identify the best relationship type for different 

database designs. 

Resources 
You'll need the following resources for this try-it: 

• None. 
  

https://aka.ms/Office_Help_and_Training
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Instructions 
The following are the general tasks to perform during this try-it: 

1. Create a blank Microsoft Word document with the file name L1_T2_try_types.docx. 

2. For each of the following descriptions, select which table relationship type is the best 
fit. Choose from a “one to many”, “many to many”, or “one to one” relationship. 
Record your answers in your Word document. 

o An online game has a table of players and a table of game servers that host 16 
players at a time. When the game begins, it automatically assigns each player to 
one of the servers. 

o A relationship in which a record is connected to an individual record in another 
table, and the record in that table is connected back to the first record. 

o A database system for tracking great works of literature has one table with 
information about books and another table with information about authors. 

o A database system for the Munson's farm-to-table recipe book, with a table that 
stores recipes and a table with ingredients used in those recipes. 

o A database with a table for recipient addresses and a separate table for packages 
that need to be delivered. 

o A table relationship in which a single record in Table A is related to one or more 
records in Table B. 

o A table that acts as a phone's contact list and a separate table that maintains a 
call history. 

o A table relationship in which a single record in Table A can be related to one or 
more records in Table B, and a single record in Table B can also be related to one 
or more records in Table A. 

Topic 3: Add foreign keys and 
understand referential integrity 

 A table relationship in Access works by matching data from a field in one table with 
data from a field in another table. These matching values provide a link to pull together 
data from each table for use in queries, forms, reports, and other database objects. 
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Consider a database that keeps track of an employee's sales so you can run reports 
about how much they sell and calculate a commission to pay them. You can create a 
table with information about the salespeople only, with SalespersonID as the primary 
key. The following screenshot depicts the Design View of the tblSalespeople table with 
SalespersonID as the primary key: 

 
Figure 1: The Design View of the tblSalespeople table with SalespersonID as the 
primary key 

A separate table can maintain information about each sale, with SaleID as the primary 
key. The following screenshot depicts the Design View of the tblSales table with SaleID 
as the primary key: 

 
Figure 2: The Design View of the tblSales table with SaleID as the primary key 

To bring these databases together, you'll need to have common fields in the related 
tables that you can use to connect them. Imagine keeping these sales records on paper. 
You could pull the paperwork for a sale and find the salesperson's name written 
somewhere on the document. In that case, the name provides a link back to the 
salesperson. 

In our sales example, there's no obvious connection between tblSales and 
tblSalesPerson. You can solve this issue by adding a field to tblSales that links back to 
the salesperson who made the sale. 
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As you've learned in previous modules, in good database design, each table will have a 
field with unique values called a primary key. If you want a sale to link to a specific 
salesperson, you simply need to store the corresponding SalespersonID with the sales 
record. Remember that the table on the "many" side of the relationship has a foreign 
key field linking to the primary key field of the table on the "one" side of the 
relationship. 

To do this, you’ll create a new field in tblSales that stores a Number. Although there is 
nothing special about the field at this point (it's just a number), you know that you’ll be 
using it to connect records to a primary key in another table. This is called a foreign key, 
and to keep everything clear, you’ll use the same name: SalespersonID. The following 
screenshot depicts the Design View of the tblSales table with SalespersonID added to 
serve as a foreign key: 

 
Figure 3: The Design View of the tblSales table with SalespersonID added to serve as a 
foreign key 

Note: It is a good idea to indicate in Description that the field is a foreign key. 

Use foreign keys in a “one to one” relationship 
In a “one to many” relationship, the foreign key field might have many duplicated 
values. One salesperson might have many sales, so that individual's SalespersonID will 
appear many times in tblSales. 
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However, a “one to one” relationship can’t have this duplication. When you create the 
foreign key field in the Design View, you'll need to use the Properties pane to 
configure the Indexed property to Yes (No Duplicates). The following screenshot 
depicts the Properties pane in the Design View with the Indexed property highlighted: 

 
Figure 4: The Properties pane in the Design View with the Indexed property highlighted 

Note: Remember to only use this setting for Indexed when you’re creating a “one to 
one” relationship. 

 

Additional information 

For more information on foreign keys, go to: Guide to table 
relationships - Introduction 

Referential integrity 
A relationship depends on the value in the foreign key field of one table matching a 
value in the primary key field in another table. If there's no match, Access is not able to 
link the tables. 

As an example, think about a record in tblSalespeople for a salesperson named Demi 
Holloway. Demi has made 36 sales, so there are 36 records in tblSales with her 
SalespersonID. However, Demi takes a job in a different department, so you delete that 
record in tblSalespeople. There are now 36 records in tblSales that refer to a 
SalespersonID that is not valid. Those disconnected records are known as orphans. 

Orphans would also occur if you entered a new record in tblSales with a SalespersonID 
that doesn't exist or if you changed the SalespersonID of a record in tblSalespeople. 

  

https://aka.ms/Guide-to-table-relationships_Introduction
https://aka.ms/Guide-to-table-relationships_Introduction
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A feature called referential integrity prevents orphans. Referential integrity: 

• Prevents any deletion that would result in orphans. 
• Will not accept a new record that does not have a valid foreign key value. 
• Does not allow a change in a primary key value if it would result in one or more 

orphans. 

What happens if you need to delete a salesperson? Access supports cascade deletion, 
which deletes the salesperson and any related records in the sales table. Similarly, 
cascade updates will update matching foreign key values if the value of a primary key 
changes. 

When you create relationships in Access, you have the option to enable referential 
integrity. In most cases, you should enable it. 

 

Additional information 

For more information on referential integrity, go to: Guide to table 
relationships - Understanding referential integrity 

 

Caution 

This course uses database files that follow a general storyline for the 
CSA program at Munson’s Pickles and Preserves Farm. These 
database files are the Learning Activity Resource files that you’ll use 
to work on each module’s activities and try-its. Each Learning Activity 
Resource file contains the data and objects, such as tables, queries, 
forms, and reports, that you need to complete a corresponding 
activity. 

Due to this course’s modular nature, the objects and data in these 
files might vary across activities or try-its. Therefore, it’s important 
that you start your activities or try-its only with the designated files, 
as per applicable instructions. You also should note that screenshots 
in the topic content are for illustration purposes only and might 
appear different than those that are in the Learning Activity Resource 
files. 

  

https://aka.ms/Guide-to-table-relationships-Understanding-referential-integrity
https://aka.ms/Guide-to-table-relationships-Understanding-referential-integrity
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Activity: Show and tell 
In this activity, the teacher will demonstrate adding a foreign key field to a table. 

Resources required 
You'll need the following resources for this activity: 

• Open L1_T3_act_farm_boxes_starter.accdb in this lesson’s Learning Activity 
Resources folder. 

Activity instructions 
Join in the activity by observing and participating in the teacher's demonstration. Ask 
any clarifying questions you have as the teacher is presenting. 

Try-it: Add foreign keys and understand referential 
integrity 

 In this try-it activity, you'll add a foreign key field to a table so that it is ready to be 
connected to a related table in the future. Then you'll enter valid foreign key values. 

Try-it 1 
Add a foreign key field in tblOrders that will match the primary key field in 
tblMembers. Then, add a valid foreign key value for each record in tblOrders. 

Resources 
You'll need the following resources for this try-it: 

• Open L1_T3_try1_members_starter.accdb in this lesson’s Learning Activity 
Resources folder. 

Instructions 
The following are the general tasks to perform during this try-it: 

1. Open the Design View for tblMembers to find the name of the primary key field. 

2. Open the Design View for tblOrders and add a field with that same name. 

3. View data in tblMembers and identify the values in its primary key field. 

4. In tblOrders, add a valid value to the foreign key field for each record. 
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Try-it 2 
Add a foreign key field in tblOrders that will match the primary key field in 
tblMembers. Include a description for the new field. Then, add a valid foreign key value 
for each record in tblOrders. 

Resources 
You'll need the following resources for this try-it: 

• Open L1_T3_try2_members_starter.accdb in this lesson’s Learning Activity 
Resources folder. 

Instructions 
The following are the general tasks to perform during this try-it: 

1. Open the Design View for tblMembers to find the name of the primary key field. 

2. Open the Design View for tblOrders and add a field with that same name. In 
Description, enter text explaining that it is a foreign key for tblOrders. 

3. View data in tblMembers and identify the values in its primary key field. 

4. In tblOrders, add a valid value to the foreign key field for each record. 

Wrap-up 
Use these questions to check what you learned in this lesson: 

1. Which of the following relationship types is the least common? 

Select the correct option. 

a. “One to one” relationship 

b. “One to many” relationship 

c. “Many to many” relationship 

2. Which of the following issues does referential integrity prevent? 

Select the correct option. 

a. Data inconsistency 

b. Data redundancy 

c. Orphaned records  
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3. A __________________________ field connects to a primary key field in another table. 

Fill in the blank space. 

4. Match each definition with one of the following table relationship types: 

o “One to one” relationship 
o “One to many” relationship 
o “Many to many” relationship 
Categorize the following items by adding the appropriate group name next to each 
item. 

a. A table relationship in which a single record in Table A can be related to one or 
more records in Table B. A single record in Table B can also be related to one or 
more records in Table A. __________________________ 

b. A table relationship in which one record in Table A is connected to one record in 
Table B. In turn, that one record in Table B is only connected to that one record in 
Table A.  

c. A table relationship in which a single record in Table A is related to one or more 
records in Table B. __________________________ 
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Lesson 2: Creating and 
modifying relationships 
Overview 
In this lesson, you'll learn how to review and create table relationships in the 
Relationships window. You'll also learn how to delete and modify table relationships. 

Warm-up 
Use these questions to find out what you already know about this lesson’s topics: 

1. Which relationship type requires an intermediate table? 

Select the correct option. 

a. “One to many” 

b. “Many to many” 

c. “One to one” 

d. No relationships require an intermediate table 

2. Which is the least common relationship type? 

Select the correct option. 

a. “One to many” 

b. “Many to many” 

c. “One to one” 

3. Which tab contains the Relationships command? 

Select the correct option. 

a. Home 

b. Create 

c. External Data 

d. Relationship Tools Design 
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4. The __________________________ can depict the tables and relationships in a database. 

Fill in the blank space. 

Topic 1: Use the Relationships window 
 Keeping track of relationships can be difficult. To help, Access includes a feature 

called the Relationships window. You can use this window to display relationships, and 
to create and modify table relationships. 

You can access the Relationships window from the ribbon: 

1. Select the Relationship Tools Design tab. 

2. In the Relationships group, select Relationships. 

The following screenshot depicts the Relationships group of the Relationship Tools 
Design tab with Relationships highlighted: 

 
Figure 5: The Relationships group with Relationships highlighted 
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The following screenshot depicts the Relationships window displaying the relationships 
between three tables: 

 
Figure 6: The Relationships window displaying the relationships between three tables 

• A line between two tables depicts a table representation. 
• The presence of two symbols indicates a “one to many” relationship. 
• A 1 is depicted on the line on the "one" side of the relationship and an infinity 

symbol is depicted on the "many" side of the relationship. 
• A line with no symbols depicts a “one to one” relationship. 

As you'll learn in the next topic, a “many to many” relationship requires an additional 
table. There are no unique symbols to indicate that type of connection. 

You can add and remove tables in the Relationships window without affecting the 
tables themselves or any of their relationships. You can add only the tables you're 
working on and remove all others. 
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To add tables to the Relationships window: 

1. Select the Design tab. 

2. In the Relationships group, select Add Tables. The following screenshot depicts the 
Relationships group of the Design tab with Add Tables highlighted: 

 
Figure 7: The Relationships group of the Design tab with Add Tables highlighted 

3. The Add Tables command opens the Show Table dialog box. 

4. Select a table name and select Add to add the table to the Relationships window. 

5. Repeat to add more tables. 

6. Then select Close to close the Show Table dialog box. The following screenshot 
depicts the Show Table dialog box: 

 
Figure 8: The Show Table dialog box 
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Did you know? 

You can also add a table to the Relationships window by selecting it 
in the navigation pane and dragging it onto the Relationships 
window. 

To hide a table from the Relationships window: 

1. Select the table in either the navigation pane or in the Relationships window. 

2. Then, select the Design tab on the ribbon. 

3. In the Relationships group, select Hide Table. The following screenshot depicts the 
Relationships group of the Design tab with Hide Table selected: 

 
Figure 9: The Relationships group of the Design tab with Hide Table selected 

You can also hide a table from the Relationships view with the context menu: 

1. Right-click or access the context menu for the table in the Relationships window. 

2. Then, select Hide Table. The following screenshot depicts the context menu with 
Hide Table highlighted: 

 
Figure 10: The context menu with Hide Table highlighted 
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To close the Relationships window: 

1. Select the Design tab on the ribbon. 

2. In the Relationships group, select Close. The following screenshot depicts the 
Relationships group of the Design tab with Close highlighted: 

 
Figure 11: The Relationships group of the Design tab with Close highlighted 

 

Additional information 

For more information on the Relationships window, go to: What is the 
Relationships window? 

Activity: Pose a challenge 
In this activity, the teacher will challenge you to find information about tables in a 
database system. 

Resources required 
You'll need the following resources for this activity: 

• Open L2_T1_act_sales_starter.accdb in this lesson’s Learning Activity Resources 
folder. 

Activity instructions 
Join in the activity by following these instructions: 

1. Join in the discussion by guessing at a solution to the challenge. 

2. Take part in the demonstration and follow along on your computer. 

3. Ask questions about any part of the activity you don't fully understand. 

Try-it: Use the Relationships window 
 In this leveled try-it, you'll examine the organization of a database and identify all 

the tables. 

https://aka.ms/What-is-the-Relationships-window
https://aka.ms/What-is-the-Relationships-window
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Try-it 1 
In this try-it, you'll hide the tblEvents table and add all other tables to the 
Relationships view. Then, you’ll examine the Relationships window to create a list of 
tables in the database. 

Resources 
You'll need the following resources for this try-it: 

• Open L2_T1_try1_Munsons_starter.accdb in this lesson’s Learning Activity 
Resources folder. 

Instructions 
The following are the general tasks to perform during this try-it: 

1. Open the Relationships window. 

2. It includes a table for events on the Farm called tblEvents. As it is not related to your 
work with the CSA team, hide it from the Relationships view. 

3. Add all other tables that don’t currently display in the Relationships window. 

4. Open a new Word document and save it with the name L2_T1_try1_tables.docx. In 
it, list all the tables in the database other than tblEvents. 

Try-it 2 
In this try-it, you'll hide the tblEvents table and add all other tables to the 
Relationships view. Then, you’ll examine the Relationships window to create a list of 
tables and foreign key fields in the database. 

Resources 
You'll need the following resources for this try-it: 

• Open L2_T1_try2_Munsons_starter.accdb in this lesson’s Learning Activity 
Resources folder. 

Instructions 
The following are the general tasks to perform during this try-it: 

1. Open the Relationships window. 

2. It includes a table for events on the Farm called tblEvents. As it is not related your 
work with the CSA team, hide it from the Relationships view. 

3. Add all other tables that don’t currently display in the Relationships window. 
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4. Create a new Word document and save it with the name L2_T1_try2_tables.docx. In 
it, list all the tables in the database other than tblEvents. 

5. For each table you find, list any foreign key fields it contains. 

Topic 2: Define table relationships 
 The Relationships window also includes commands for creating new table 

relationships. 

Define a “one to many” relationship 
Before you create a “one to many” relationship, make sure that the table on the "many" 
side of the relationship has a foreign key field. It should match the primary key field on 
the "one" side of the relationship. The following screenshot depicts the Relationships 
window displaying tables with a primary key field highlighted and a corresponding 
foreign key field highlighted: 

 
Figure 12: The Relationships window displaying tables ready for a relationship with a 
primary key field highlighted and a corresponding foreign key field highlighted 
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Next: 

1. Select the Relationship Tools Design tab on the ribbon. 

2. In the Tools group, select Edit Relationships. The following screenshot depicts the 
Tools group with Edit Relationships highlighted: 

 
Figure 13: The Tools group with Edit Relationships highlighted 

3. The Edit Relationships command opens the Edit Relationships dialog box. 

4. Select Create New. The following screenshot depicts the Edit Relationships dialog 
box with Create New highlighted: 

 
Figure 14: The Edit Relationships dialog box with Create New highlighted 

5. The Create New command will access the Create New dialog box. This is where 
you'll the fields used to create the relationship. 

6. In Left Table Name, select the table on the "one" side of the relationship. 

7. In Right Table Name, select the table on the "many" side of the relationship. 

8. Use the Left Column Name drop-down list to select the primary key field. 

  



Defining database relationships 
 

 
30 

9. Use the Right Column Name drop-down list to select the foreign key field. It usually 
has the same name. The following screenshot depicts a portion of the Relationships 
window with the Create New dialog box active and the table and field names 
selected: 

 
Figure 15: A portion of the Relationships window with the Create New dialog box 
active and the table and field names selected 

Note: You can define the relationship in either direction. It's a good idea to match the 
way they're displayed in the Relationships window to avoid confusion. 

10. Select OK to close the Create New dialog box and return to the Edit Relationships 
dialog box. The table and field names are now selected. 

11. Select the Enforce Referential Integrity check box. 
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12. Select Create to close the dialog box and create the relationship. The following 
screenshot depicts the Edit Relationships dialog box with table and field names 
selected and Enforce Referential Integrity and Create highlighted: 

 
Figure 16: The Edit Relationships dialog box with table and field names selected and 
Enforce Referential Integrity highlighted 

 

Did you know? 

You can also access the Edit Relationship dialog box to define a new 
relationship by selecting the primary key and dragging it to the 
foreign key. This action will automatically populate the field names in 
the dialog, saving you a couple of steps. 

Define a “one to one” relationship 
Creating a “one to one” relationship is very similar to creating a “one to many” 
relationship. Before you begin, remember that your foreign key field must have the 
Indexed property set to Yes (No Duplicates). Then: 

1. Select the Relationship Tools Design tab on the ribbon. 

2. In the Tools group, select Edit Relationships to open the Edit Relationships dialog 
box. 

3. Select Create New to open the Create New dialog box. 

4. Use the Left Column Name and Right Table Name drop-down lists to select the 
two tables. 
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5. Use the Left Column Name and Right Column Name drop-down lists to select the 
common fields. The following screenshot depicts a portion of the Relationships 
window with the Create New dialog box active and the table and field names 
selected for a “one to one” relationship: 

 
Figure 17: A portion of the Relationships window with the Create New dialog box 
active and the table and field names selected for a “one to one” relationship 

6. Select OK to close the Create New dialog box and return to the Edit Relationships 
dialog box. The table and field names are automatically selected. 

7. Don’t select the Enforce Referential Integrity check box for a “one to one” 
relationship. This is one of the few situations in which you'll leave that option 
unchecked. 

8. Select Create to close the dialog box and create the relationship. 

Define a “many to many” relationship 
A “many to many” relationship between two tables requires a third table to act as a go-
between for the tables. This third table is known as an intermediate table or junction 
table. You'll add the primary key of each of the two tables into the intermediate table. 
This enables a “one to many” relationship with each of the two original tables. 
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Consider the database for tracking sales from previous examples. Each individual sale 
can include many products, and in turn, each product might be part of many orders. To 
establish a “many to many” relationship between tblSales and tblProducts, you’ll need 
an intermediate table that we'll call tblSaleDetails. The table will consist of two fields: 
the primary key fields in the two tables you’re linking. The following screenshot depicts 
the Design View for the intermediate table tblSaleDetails: 

 
Figure 18: The Design View for the intermediate table tblSaleDetails 

In an intermediate table, both fields work together to act as the primary key. This 
arrangement is known as a composite key. To create a composite key: 

1. Select both fields at the same time. 

2. Select the ProductID row first. 

3. Select Shift while you simultaneously select the SaleID row using the down arrow 
key. 

4. After selecting both fields, select the Design tab on the ribbon. 

5. In the Tools group, select Primary Key. The following screenshot depicts the Tools 
group with Primary Key selected: 

 
Figure 19: The Tools group with Primary Key selected 
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6. After creating the intermediate table, connect it to both original tables in “one to 
many” relationships. The following screenshot depicts two tables connected in a 
“many to many” relationship via an intermediate table: 

 
Figure 20: The two tables connected in a “many to many” relationship via an 
intermediate table 

Correct referential integrity issues when defining a 
relationship 
When you select Enforce Referential Integrity while creating a relationship between 
tables that already contain data, Access verifies each value in the foreign key field. It 
checks that each value is present in the other table's primary key field. If not, Access will 
create an alert notifying you that it can’t create the relationship. 

To fix this, you must correct any invalid foreign values or create the relationship without 
enforcing referential integrity. We don’t recommend disabling referential integrity 
checking. The following screenshot depicts the alert activated when you have a 
referential integrity problem: 

 
Figure 21: The alert activated when you have a referential integrity problem 
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Additional information 

For more information on defining table relationships, go to: Create, 
edit or delete a relationship) 

 

Video 

To review the videos on defining “one to many” relationships, go to: 
Create relationships with the Relationships Pane 

 

Video 

To review the videos on defining “many to many” relationships, go to: 
Create many-to-many relationships 

 

Video 

To review the videos on defining “one to one” relationships, go to: 
Create one-to-one relationships 

Activity: Show and tell 
In this activity, the teacher will demonstrate how to define a “one to many” relationship 
between two tables. 

Resources required 
You'll need the following resources for this activity: 

• Open L2_T2_act_farm_boxes_starter.accdb in this lesson’s Learning Activity 
Resources folder. 

Activity instructions 
Join in the activity by engaging in the demonstration. Follow along on your computer. 
Ask questions about any part of the activity you don't fully understand. 

Try-it: Define table relationships 
 In this standalone try-it, you'll define a relationship between a table that stores 

members of the Farm's CSA program and a table that stores information about orders. 

https://aka.ms/Create-edit-or-delete-a-relationship
https://aka.ms/Create-edit-or-delete-a-relationship
https://aka.ms/video-create-relationships-with-the-relationships-pane
https://aka.ms/video-create-many-to-many-relationships
https://aka.ms/video-create-one-to-one-relationships
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Resources 
You'll need the following resources for this try-it: 

• Open L2_T2_try_members_starter.accdb in this lesson’s Learning Activity 
Resources folder. 

Instructions 
The following are the general tasks to perform during this try-it: 

1. Use the Edit Relationships command on the ribbon to create a “one to many” 
relationship between tblMembers and tblOrders. 

2. Be sure that referential integrity is enforced. 

Topic 3: Delete and modify 
relationships 
Deleting a table relationship does not affect the tables and data that are associated with 
that relationship, but referential integrity is disabled. This means that you might have 
problems establishing the relationship again if you add or change records. 

Delete a relationship 
There are multiple ways to delete a relationship. Here’s how to delete a relationship 
using the context menu:  

1. Select the relationship line between tblMembers and tblEvents. 

2. Right-click or access the context menu for the relationship line. Select Delete. In the 
dialog box that appears, select Yes to confirm the deletion. 

3. In the Relationships window, select tblEvents. 
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4. Select the Design tab. In the Relationships group, select Hide table. 

 
Figure 22: The context menu for the relationship line with Delete highlighted 

Here’s how to delete a relationship using Edit Relationships to select the relationship: 

1. Select the Relationship Tools Design tab. In the Tools group, select Edit 
Relationships to open the Edit Relationships dialog box. 

2. Select tblMembers from the Table/Query drop-down list. 

3. Select tblEvents from the Related Table/Query drop-down list. 

4. Select OK. 

5. Select the Delete key. In the dialog box that appears, select Yes to confirm the 
deletion. 

6. In the Relationships window, select tblEvents. 

7. Select the Design tab. In the Relationships group, select Hide table. 

Modify a relationship 
You can edit a table relationship with the Edit Relationships dialog box. This enables 
you to change the key fields used in the connection and edit referential integrity 
settings. To do this, use the following steps: 

1. Select the Relationship Tools Design tab on the ribbon. 

2. In the Tools group, select Edit Relationships. The following screenshot depicts the 
Tools group with Edit Relationships highlighted: 

 
Figure 23: The Tools group with Edit Relationships highlighted 



Defining database relationships 
 

 
38 

3. In the Edit Relationships dialog box, use the Table/Query and Related 
Table/Query drop-down lists to select the two related tables. 

4. The Edit Relationships dialog box will update to display the keys used in the 
relationship and the referential integrity settings. The following screenshot depicts 
the Edit Relationships dialog box with Table/Query and Related Table/Query 
highlighted: 

 
Figure 24: The Edit Relationships dialog box 

5. Edit the settings you want to change and then select OK. 

 

Additional information 

For more information on deleting relationships, go to: Delete a table 
relationship 

 

Additional information 

For more information on modifying a relationship, go to: Edit a 
relationship 

Activity: Discuss and learn 
In this activity, you'll participate in a group discussion about deleting and modifying 
relationships. 

  

https://aka.ms/delete-a-table-relationship
https://aka.ms/delete-a-table-relationship
https://aka.ms/Create-edit-or-delete-a-relationship_edit_a_relationship
https://aka.ms/Create-edit-or-delete-a-relationship_edit_a_relationship
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Resources required 
You'll need the following resources for this activity: 

• Open L2_T3_act_farm_boxes_starter.accdb in this lesson’s Learning Activity 
Resources folder. 

Activity instructions 
Participate in the activity by following these instructions: 

1. Think about the questions posed by the teacher. 

2. Join in the discussion. 

3. Study the document the teacher is presenting and follow along as they demonstrate 
deleting and editing relationships. 

4. Ask the teacher any clarifying questions you might have. 

Try-it: Delete and modify relationships 
 In this leveled try-it you'll fix a flawed table relationship and delete a relationship 

that you don’t need. 

Try-it 1 
In this try-it, you'll edit the relationship between the members table and the orders table 
so that it uses the correct foreign key field. You will also enforce referential integrity. 

Resources 
You'll need the following resources for this try-it: 

• Open L2_T3_try1_Munsons_starter.accdb in this lesson’s Learning Activity 
Resources folder. 

Instructions 
The following are the general tasks to perform during this try-it: 

1. Study the relationships in the database. 

2. The relationship between the members table and the orders table is not configured 
correctly. Fix the foreign key fields. 

3. Make sure that the relationship enforces referential integrity. 
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Try-it 2 
In this try-it, you'll edit the relationship between the members table and the orders table 
so that it uses the correct foreign key field. You will ensure that the relationship enforces 
referential integrity. You'll also delete the relationship between the box details table and 
the box items table. 

Resources 
You'll need the following resources for this try-it: 

• Open L2_T3_try2_Munsons_starter.accdb in this lesson’s Learning Activity 
Resources folder. 

Instructions 
The following are the general tasks to perform during this try-it: 

1. Study the relationships in the database. 

2. The relationship between the farm boxes and the orders is correct. However, you 
need to delete the relationship between tblBoxItems and tblBoxDetails. 

3. The relationship between the members table and the orders table is not configured 
correctly. Fix the foreign key fields. 

4. Make sure that the relationship enforces referential integrity. 

Wrap-up 
 Use these questions to check what you learned in this lesson:  

1. Which of the following prevents orphan records? 

Select the correct option. 

a. Maintaining a composite key 

b. Creating an intermediate table 

c. Enforcing referential integrity 

d. Adding a uniquely indexed key 
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2. Which command removes a table from the Relationships window? 

Select the correct option. 

a. Delete Table 

b. Disable Table 

c. Hide Table 

d. Remove Table 

3. An intermediate table has a/an __________________________ key consisting of two fields. 

Fill in the blank space. 

4. To create a “many to many” relationship, first create a/an __________________________ 
table. 

Fill in the blank space. 
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Glossary 
Composite key A key that has more than one field. 

Foreign key A primary key from one table that is in use in another table. 

Intermediate table A table that facilitates a “many to many” relationship between two 
other tables. Also known as a junction table. 

“many to many” 
relationship 

A table relationship in which a single record in Table A can be related 
to one or more records in Table B, and a single record in Table B can 
also be related to one or more records in Table A. 

“one to many” 
relationship 

A table relationship in which a single record in Table A is related to 
one or more records in Table B. 

“one to one” 
relationship 

A table relationship in which one record in Table A is connected to 
one record in Table B, and in turn that one record in Table B is only 
connected to that one record in Table A. 

Orphan A record with a foreign key value that does not exist in the primary 
key field of a related table. 

Primary key A field or set of fields with values that are unique throughout a table.  

Table relationship A feature that allows Access to combine data from two different 
tables. 

Table 2: Glossary terms and definitions  
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Cornerstone 
Overview 
In this Cornerstone, you'll help the CSA team at Munson's by managing relationships 
between the tables in their database. You'll use the Relationships window, create a new 
relationship, delete a relationship, and modify a relationship. 

Objectives 
The following table outlines the Cornerstone objectives and their corresponding MOS 
exam objectives. 

Use the 
Relationships 
window 

• 1.2.2: Display relationships

Add a foreign key 
and define a 
relationship 

• 1.2.5: Set foreign keys

Delete a 
relationship 

• 1.2.2: Display relationships

Modify a 
relationship 

• 1.2.4: Enforce referential integrity

Identify a “many to 
many” relationship 

• 1.2.1: Understand relationships

Table 2: Cornerstone objectives 

Duration 
50 minutes 
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Instructions 
1. Complete the following tasks for each file. 

2. When saving your file, add your name to the end of the filename, for example: 
“Cornerstone_Munsons_Dwayne_Espino.accdb.” Follow your teacher’s directions for 
where to save your files. 

3. When you’re done with the Cornerstone, assess your completion and enter the 
points you think you earned within the following task lists. You can ask for help from 
your teacher if needed. 

Tasks 
You'll work with one file in this Cornerstone. The following are the tasks you need to do 
within that file: 

File 1: Cornerstone_Munsons_starter.accdb 
Task: Use the Relationships window (2 points) 
1. Marcos Serna, the Farm's General Manager, eventually wants a table for employee 

information. The team started to create a table for that data, but now it's no longer 
needed. Access the Relationships window and hide the tblEmployees table. (1 
point) (Exam objective 1.2.2) 

2. The CSA team has decided to move forward with offering one promotional discount 
per order. There's a table ready to go, but it's hidden. Add the tblPromotions table 
to the Relationships window. (1 point)  

Points scored: ________ / 2 

Task: Add a foreign key and define a relationship (4 points) 
1. The promotions table needs to connect to the orders table. An order can only have 

one promotion, but many different orders can use one promotion. Add a foreign key 
to enable a relationship between tblPromotions and tblOrders. (1 point) (Exam 
objective 1.2.5) 

2. Create the relationship between tblPromotions and tblOrders, taking care to 
prevent orphan records. (3 points) (Exam objective 1.2.5) 

Points scored: ________ / 4 
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Task: Delete a relationship (2 points) 
1. The CSA team is not able to maintain data related to events at the farm but they 

might wish to add this feature later. Remove the relationship between tblEvents and 
tblMembers. (1 point)  

2. Hide tblEvents. (1 point) (Exam objective 1.2.2) 

Points scored: ________ / 2 

Task: Modify a relationship (3 points) 
• A colleague that was making some changes to the database has changed the 

configuration of one of the relationships. The relationship between tblMembers and 
tblOrders is not configured correctly. Modify it to be a “one to many” relationship 
based on common fields with referential integrity. (3 points) (Exam objective 1.2.4) 

Points scored: ________ / 3 

Task: Identify a “many to many” relationship (1 point) 
• Use the Relationships window to find the “many to many” relationship in the 

database. Change the name of the intermediate or junction table by appending Int 
to the end of the name. For example, if the table had the name tblSales, change the 
name to tblSalesInt. (1 point) (Exam objective 1.2.1) 

Points scored: ________ / 1 

FILE 1 TOTAL POINTS: ________ /12 
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Module overview 
Description 
Now that you’ve learned about database design, creating tables, queries, and data 
relationships, you can use those skills to ask deeper questions of data by using 
advanced queries. This module consists of two lessons that help you learn how to use 
some of the advanced queries in Microsoft Access 2019. By the end of this module, 
you’ll be able to create a multiple-table query by using the Query Wizard, modify a 
multiple-table query, and create parameter queries, crosstab queries, append queries, 
and delete queries. 

The following table outlines the lessons in this module and their corresponding 
Microsoft Office Specialist (MOS) exam objectives. 

Lesson Learning objective MOS exam 
objective(s) 

Creating and 
modifying 
advanced 
queries 

Create a multiple-table query with Query 
Wizard, modify a multiple-table query, and 
create a parameter query. 

• 3.1.3 
• 3.1.5 

Creating 
special 
queries 

Create a crosstab query, an append query, 
and a delete query. 

• 3.1.2 
• 3.1.4 

Cornerstone: 
Create 
multiple-
table queries 

Create a multiple-table query with Query 
Wizard, and then modify an existing 
database to create a parameter query, a 
crosstab query, an append query, and a 
delete query. 

• 3.1.2 
• 3.1.3 
• 3.1.4 
• 3.1.5 

Table 1: Objectives by lesson 
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Scenario 
Munson's Pickles and Preserves Farm is having a very busy summer, and senior 
management is pleased with the Community Supported Agriculture (CSA) program 
team and the team's transformative work with databases. Munson's has asked your 
manager for assistance with data analysis, and you’ve been asked to help. The company 
intends to use the information from its existing database to improve their strategies for 
produce planning, produce management, and data management. 

You think that some of the advanced query features such as multiple-table queries, 
parameter queries, and crosstab queries can help display information more easily. This 
will help answer questions such as: 

• Which produce items do large families order most frequently?
• How many orders are placed each day?

Munson's has also asked you to help with the regular cleanup of frequently accessed 
data. You plan to do this more efficiently by using action queries such as append and 
delete, instead of manually changing or deleting data on a regular basis. 

Cornerstone 
This module concludes with a Cornerstone project, in which you’ll create advanced and 
special queries to help Munson's with data-analysis tasks that ask deeper questions of 
their CSA program database. During the Cornerstone, you’ll: 

• Create and modify a multiple-table query.
• Create a parameter query and specify parameter data types.
• Create a crosstab query.
• Create an append query.
• Create a delete query.
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Lesson 1: Creating and 
modifying advanced queries 
Overview 
In this lesson, you’ll learn how to create a multiple-table query with the Query Wizard, 
create a parameter query, and modify an advanced query. You’ll participate in 
discussions and step-by-step demonstrations, and have opportunities to put into 
practice what you learn along the way. 

Warm-up 
Use these questions to find out what you already know about this lesson’s topics: 

1. Which of the following statements are correct? 

Select all that apply. 

a. Queries are essential for storing data. 

b. Queries can automatically apply changes. 

c. Queries automatically combine related tables. 

d. Queries summarize table data.  

2. A ________________________ is a major query type that you can use to retrieve data from 
a table or make calculations. 

Fill in the blank space. 

3. How do queries help you define how to create and review your database information 
options? 

Select all that apply. 

a. By storing parameters 

b. By storing images 

c. By saving the data 

d. By storing settings 
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4. Before you create a multiple-table query, the tables must have a defined 
________________________ in the Relationships window. 

Fill in the blank space. 

5. What are the basic steps to create a select query? 

Indicate the correct sequence by adding numbers 1-4 next to the following items. 

a. Choose your source of data. - ________________________ 

b. Run the query. - ________________________ 

c. Specify the fields to include. - ________________________ 

d. Optionally specify criteria. - ________________________ 

Topic 1: Create and modify a multiple-
table query with the Query Wizard 

 Think about some of the data-related questions to help Munson’s plan for another 
successful year. Perhaps the team is analyzing information about members, produce, 
and orders. You might have cases in which basic member information such as names, 
addresses, and phone numbers appear in your query results. You realize that it would be 
more useful to also include other optional details that the members have shared with 
Munson's. This includes information such as the total number of people in members’ 
families, but this detail is in a different table. Wouldn't it be helpful if you could combine 
this information from different tables and retrieve it easily when the team needs it? 

Create a multiple-table query to combine 
information from multiple table sources 
In Access, you can analyze data by building a query that combines information from 
multiple sources. A table usually only displays data that it stores, but a multiple-table 
query lets you pick and choose fields from various sources, and then specify how to 
combine that information. For example, if you want your query results to include basic 
member information from a primary table and more detailed member information such 
as order ID from a related secondary table, you must include both tables in your query. 
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You also must ensure that you define a relationship for both tables by using the 
Relationships window, as the following screenshot depicts: 

 
Figure 1: Multiple-table relationships view in the Relationships window 

 

Did you know? 

If you don’t have defined table relationships before creating a 
multiple-table query, you can create one in the Relationships 
window. To open the Relationships window, go to the Database 
Tools tab, and then select Relationships. 

 

Additional information 

For more information on creating relationships between tables, refer 
to: Guide to table relationships 

Use the Query Wizard to build a multiple-table 
query 
You can save time by using the Query Wizard to create multiple-table queries in 
Access. Before using the Query Wizard to build an advanced query, you must pick the 
data source to use from a primary table, and also identify the data source from a related 
table in the same database. If edits are required for defined table relationships, be sure 

https://aka.ms/Guide-to-table-relationships
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to make them before you create your query. To build a multiple-table query by using 
the Query Wizard: 

1. Open an existing Access database with existing table relationships. 

2. From the Create tab, in the Queries group, select Query Wizard. The following 
screenshot depicts the Queries group: 

 
Figure 2: Queries group 

3. In the New Query dialog box, select Simple Query Wizard, and then select OK. 

4. In the Simple Query Wizard dialog box, you can select the fields from the primary 
table that you want in your query. In the Available Fields list, select the fields that 
you want to include, and then select the single right arrow (>) to move that field to 
the Selected Fields list, moving one field at a time. You can also select the double 
arrows (>>) to move all fields at once. The following screenshot depicts the 
Available Fields and Selected Fields lists in the Simple Query Wizard dialog box: 

 
Figure 3: Simple Query Wizard dialog box 

5. Repeat steps 2 to 4 for your second related table, by selecting the table in the 
Tables/Queries drop-down list. Use the same procedure to select the fields that you 
want in your query from your secondary table, as depicted in the following 
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screenshot. To avoid duplicate data columns, you must only select the fields that 
aren’t already in the primary table. 

 
Figure 4: Secondary related table 

6. Select Next, and then select Detail to review your query records. 

7. Select Next, and then name the query. 

8. Select Modify the query design to review data in query design mode. 

9. Select Finish. 

10. The multiple-table query now contains a combination of your selected fields from 
related multiple tables, as depicted in the following screenshot: 

 
Figure 5: A multiple-table query 

11. Save the query and the database. 
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Did you know? 

You can also create multiple-table queries in Design view by going 
to the Create tab, and then selecting Query Design in the Queries 
group. 

 

 

Additional information 

For more information on creating a multiple-table query in Design 
view, refer to: Create a query based on multiple tables 

Modify a multiple-table query 
To modify a multiple-table query: 

1. Open the multiple-table query in query design mode. 

2. On the Home tab, in the Views group, select View, and then select Design View. 

3. In Design View, to add a field to the query design grid, select from the following 
two options to add field names to the query window: 

o Select and drag a field. 
o Double-click a field name, or select it, and then select Enter. The following 

screenshot depicts fields in the query design grid. 

https://aka.ms/Create-a-query-based-on-multiple-tables
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Figure 6: Add a field to a multiple-table query 

4. To remove a field from the query, clear the Show check box in the query window. 

5. From the Home tab, in the Views group, select from the following two options to 
review your modified query: 

a. Select View, and then select Datasheet View. 

b. From the Design tab, in the Results group, select Run. 

6. Save your query, and then save the database. 

 

Did you know? 

You can also connect data from two tables by using their 
relationships with a third table. 
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Additional information 

For more information on building a query based on data sources from 
many tables, refer to: Create a query based on multiple tables 

 

Caution 

This course uses database files that follow a general storyline for the 
CSA program at Munson’s Pickles and Preserves Farm. These 
database files are the Learning Activity Resource files that you’ll use 
to work on each module’s activities and try-its. Each Learning Activity 
Resource file contains the data and objects, such as tables, queries, 
forms, and reports, that you need to complete a corresponding 
activity. 

Due to this course’s modular nature, the objects and data in these 
files might vary across activities or try-its. Therefore, it’s important 
that you start your activities or try-its only with the designated files, 
as per applicable instructions. You also should note that screenshots 
in the topic content are for illustration purposes only and might 
appear different than those that are in the Learning Activity Resource 
files. 

Activity: Discuss and learn 
In this activity, you’ll follow the teacher-led group discussion on real-world scenarios for 
creating and modifying a multiple-table query. After the discussion, the teacher will 
demonstrate how to create and modify an existing multiple-table query with the Query 
Wizard. 

Resources required 
None. 

Activity instructions 
Participate in the activity by following these instructions: 

1. Observe the teacher demonstrating how to use Query Wizard to create a multiple-
table query. 

2. Ask the teacher clarifying questions. 

3. Participate in the discussion. 

https://aka.ms/Create-a-query-based-on-multiple-tables
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Try-it: Create and modify a multiple-table query 
with the Query Wizard 
  In this leveled try-it activity, you'll create and modify a multiple-table query. 

Try-it 1 
In this try-it, you'll create a multiple-table query by using the Query Wizard. 

Resources 
You’ll need the following resources for this try-it: 

• Open L1_T1_try1_background_starter.accdb in this lesson’s Learning Activity 
Resources folder. 

Instructions 
The following are the general tasks that you  perform during this try-it: 

1. Run the Query Wizard, and select the primary and secondary related tables and 
their corresponding fields that you want to include in your multiple-table query. 

2. Give your new query a title. 

3. Select Modify to review data in query design mode. 

4. Select Finish. 

5. Save your query, then save your database. 

Try-it 2 
In this try-it, you’ll modify an existing multiple-table query. 

Resources 
You’ll need the following resources for this try-it: 

• Open the saved multiple-table query from the previous try-it, or open 
L1_T1_try2_background_starter.accdb in this lesson’s Learning Activity Resources 
folder and create a multiple-table query before continuing with this try-it. 

Instructions 
The following are the general tasks that you perform during this try-it: 

1. In Design view, modify the query by adding a field to it. 

2. Modify the query by removing a field from the query. 
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3. View your changes in Datasheet view. 

4. Save your query. 

5. Save your database. 

Topic 2: Create a parameter query 
 Suppose your coworkers at Munson's want to further analyze the data. They want 

answers to questions such as: Which farm boxes do customers most frequently order by 
using specific information such as a produce order date? You think that it's helpful for 
users to quickly review data based on any order dates, and that an advanced query can 
help with this task. You also want to use query criteria to focus on specific order dates in 
the database. To accomplish this data-analysis task in Access, you can build a parameter 
query that asks for specific criteria, such as order dates. 

Create a parameter query 
Parameter queries are especially useful for instances in which you need to ask for input, 
such as a produce order date, when you’re running a query in Access. The parameter is 
the piece of information that you supply to a query as you’re running it. Creating a 
parameter in a parameter query is like adding a normal criterion to various other query 
types, such as select query, crosstab query, and append query. You’ll learn about these 
query types in this module. 

You can run parameter queries to find data that satisfy a particular condition based on 
the criteria or filters that you set. Parameter queries only select and return specific data. 
You can save parameter queries the same way that you save select, crosstab, or append 
queries. When you save a parameter query, you can use it multiple times, without having 
to constantly open it in Design view to edit its criteria. 

To create a parameter query: 

1. Open a multiple-table query in Design view from a previous activity in this module. 

2. Select a cell on the Criteria row of the field that you want to apply a parameter to. 
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3. Enter the criteria or filter that you want the parameter query to satisfy. Consider the 
following example: 

a. To find data on all farm-box produce orders based on a produce order date, 
enter [Order date?] in the Criteria row of the Orders table column for the 
OrderDate field, as the following screenshot depicts: 

 
Figure 7: Parameter Criteria row in a parameter query 

Note: The text that you want to display in the Parameter dialog box are the 
words enclosed in square brackets. 

b. The dialog box appears without the square brackets when you run the parameter 
query, as depicted in the following screenshot: 

 
Figure 8: Example dialog box when a parameter query is run 
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4. From the Design tab, in the Results group, select Run to run the parameter query 
and review the results. The following screenshot depicts this: 

 
Figure 9: Example results when a parameter query is run in Datasheet view 

 

Caution 

Be sure to save this parameter query if you plan to use it multiple 
times. By saving it, you can avoid having to constantly open it in 
Design view to edit its criteria. 

5. To set a parameter query data type: 

a. Open the saved query in Design view. 

b. With the query open in Design view, on the Design tab, in the Show/Hide 
group, select Parameters, as the following screenshot depicts: 

 
Figure 10: Parameters option in Show/Hide group 

6. In the Query Parameters box, in the Parameter column, enter the prompt for each 
parameter that you want to specify a data type for. 
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7. In the Data Type column, make sure that each parameter matches the prompt that 
you used in the Criteria row of the query design grid. For example, enter [Order 
Date?] in the Parameter column. In the Data Type column, select Date With Time 
in the drop-down list, and then select OK, as the following screenshot depicts: 

 
Figure 11: Query Parameters box 

8. Save your query, and then save the database. 

 

Did you know? 

You can specify the type of data that a parameter should accept. This 
approach helps ensure that users can receive a more helpful message 
if they enter the wrong type of data, such as text in place of numbers. 
To specify data type for a parameter, in the Criteria row, in the Data 
Type column, select type for that parameter. 

Sometimes you need to use a query as a starting point for another 
query rather than creating a query from scratch. You can copy an 
existing query by selecting the query from the Navigation Pane, and 
then using the shortcut keys Ctrl+C and Ctrl+V. Alternatively, select 
the query from the Navigation Pane, go to the Home tab, select 
Copy from the Clipboard group, and then select Paste. 
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Additional information 

To learn more about how to use parameters to ask for input when 
running a query, refer to: Use parameters to ask for input when 
running a query. 

To learn more about how to copy a query, refer to: Copy a query in a 
database 

Activity: Think-pair-share 
In this activity, you’ll follow along as the teacher leads a discussion about why and how 
to set parameter criteria. 

Resources required 
None 

Activity instructions 
Think about the new tools that you’ve learned to use in previous lessons to create 
advanced queries to enhance information summaries. Participate in the activity by 
following these instructions: 

1. Partner with a classmate. 

2. With your partner, collaborate by thinking of at least two parameter criteria that can 
be useful in planning for produce inventories. 

3. Participate in the discussion. Remember that there is usually more than one way to 
do something. Share and discuss your ideas. 

Try-it: Create a parameter query 
 In this leveled try-it activity, you’ll create a parameter query. 

Try-it 1 
In this try-it, you’ll set a parameter criterion to create a parameter query. 

  

https://aka.ms/Use-parameters-to-ask-for-input-when-running-a-query
https://aka.ms/Use-parameters-to-ask-for-input-when-running-a-query
https://aka.ms/Copy-a-query-in-a-database
https://aka.ms/Copy-a-query-in-a-database
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Resources 
You’ll need the following resources for this try-it: 

• Open the saved multiple-table query from a previous try-it in this module, or open 
L1_T2_try1_background_starter.accdb in this lesson’s Learning Activity Resources 
folder and create a multiple-table query before continuing with this try-it. 
Alternatively, copy the previously saved multiple-table query from a previous try-it. 

Instructions 
The following are the general tasks that you perform during this try-it: 

1. Open a multiple-table query in Design view. 

2. Add a parameter criterion to a field. For example, add a criterion for the produce 
pickup date field using a criteria. 

3. Run the query to review results. 

4. Save the query, and then save the database. 

Try-it 2 
In this try-it, you’ll modify a data type in a parameter query. 

Resources 
You’ll need the following resources for this try-it: 

• Open the previously saved multiple-table query from the previous try-it in this 
lesson, or open L1_T2_try2_background_starter.accdb in this lesson’s Learning 
Activity Resources folder and practice creating a multiple-table query using Try-it 1 
steps before continuing with this try-it. 

Instructions 
The following are the general tasks that you need to perform during this try-it: 

1. Open a multiple-table query in Design view. 

2. In the query Parameters box, in the Parameter column, enter the criterion that you 
set for produce pickup order date field that you created. 

3. In the Data Type column, select a data type for your parameter. Make sure that the 
parameter matches the prompt that you used in the Criteria row of the query design 
grid. 

4. Select OK. 

5. Save the query, and then save the database. 
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Wrap-up 
Use these questions to check what you learned in this lesson: 

1. Which of the following can you specify for a parameter to accept? 

Select the correct option. 

a. Square brackets 

b. Data type 

c. Criteria row 

d. Display text 

2. In the ________________________ drop-down list, you can select the table that contains 
the related data that you want to use to enhance your query results. 

Fill in the blank space. 

3. Where can you enter the text you want to display in a parameter box? 

Select the correct option. 

a. Field row 

b. Sort row 

c. Criteria row 

d. Show row 

4. You can also connect data from two ________________________ by using their 
relationships with a third table. 

Fill in the blank space. 

5. What are the basic steps to build a multiple-table query by using the Query Wizard? 

Indicate the correct sequence by adding numbers 1-4 next to the following items. 

a. Select the fields you want in your query. - ________________________ 

b. Run the query. - ________________________ 

c. Select Simple Query Wizard. - ________________________ 

d. Add the query title. - ________________________ 



Asking deeper questions of data 
 

 
21 

Lesson 2: Creating special 
queries 
Overview 
In this lesson, you'll learn to create special queries. Special queries such as crosstab, 
append, and delete queries help you review information in various ways. You’ll 
participate in discussions, follow step-by-step demonstrations, and explore where to 
find additional options and tools. 

Warm-up 
Use these questions to find out what you already know about this lesson’s topics: 

1. Which of the following are major query types? 

Select all that apply. 

a. Select 

b. Totals 

c. Action 

d. Calculations 

2. Which of the following are action queries? 

Select all that apply. 

a. Append 

b. Parameter 

c. Delete 

d. Totals 

3. A ________________________ query helps you save time by summarizing data that is 
frequently displayed by using two sets of grouped values set in Row Heading and 
Column Heading. 

Fill in the blank space. 
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4. Which of the following can you calculate by using a crosstab query? 

Select all that apply. 

a. Sum 

b. Average 

c. Aggregate functions 

d. Count null values 

5. The Crosstab Query Wizard is usually the fastest and easiest way to create a 
________________________ query, but there are a few options that the wizard does not 
offer. 

Fill in the blank space. 

Topic 1: Create a crosstab query 
 As part of Munson's data analysis, your manager has asked for your help to create 

a summary report of member orders by month. Munson’s will use the report for 
produce inventory planning, and also to review any trends in member orders by date. 
You’ve learned about advanced queries in Access and think that you can use a crosstab 
query to save time by summarizing data using a set of values. A crosstab query groups 
query results by using two crosstab values—one vertically located in the first column of 
the datasheet and the other horizontally located across the first row of the datasheet, as 
depicted in the following screenshot: 

 
Figure 12: Crosstab horizontal and vertical values 
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To create a crosstab query: 

1. On the Home tab, in the Views group, select Design View. 

2. On the Design tab, in the Query Type group, select Crosstab. 

3. In the Query Design window, identify the field names for your crosstab criteria. 
Consider the following example: 

a. If you want a crosstab query to review possible trends in member order dates, set 
OrderID as your Row Heading, set OrderDate as your Column Heading, and 
then set FarmBoxName as your value heading. 

b. To set these criteria, on the Crosstab row, select the cell that is after the Group 
By cell, and then set the Row Heading, Column Heading, and Value source, as 
depicted in the following screenshot: 

 
Figure 13: Total row, Group By with Row, Column, and Value set for crosstab criteria 

c. For your designated field with a Value source, be sure to set the Total row to 
Count to display a total count of all orders by date in the query, and then select 
Run. 

4. Save the query, and then save the database. 

 

Additional information 

Keep crosstab queries simple by using only the row headings that you 
need. For more information, refer to: Make summary data easier to 
read by using a crosstab query 

Activity: Show and tell  
In this activity, you’ll follow along as your teacher demonstrates how to create a crosstab 
query in Design view. 

Resources required 
None 

https://aka.ms/Make-summary-data-easier-to-read-by-using-a-crosstab-query
https://aka.ms/Make-summary-data-easier-to-read-by-using-a-crosstab-query
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Activity instructions 
Participate in the activity by following these instructions: 

1. Observe the teacher demonstrating an example of the following key areas of a 
crosstab query: 

o Horizontal row heading 
o Vertical column heading 
o Summary value 

2. Ask the teacher clarifying questions. 

3. Participate in the discussion. Remember that there is usually more than one way to 
do something. If you think of a different way to do a task, share and explore your 
ideas with the class! 

Try-it: Create a crosstab query 
 In this standalone try-it activity, you’ll create a crosstab query in Design view. 

Suppose you need to help summarize Munson's monthly information with a produce 
data report. Using a crosstab query, you’ll calculate the sum of orders by month by 
using the aggregate criterion. 

Resources 
You’ll need the following resources for this try-it: 

• Open a saved multiple-table query from a previous try-it in this module, or open 
L2_T1_try_background_starter.accdb in this lesson’s Learning Activity Resources 
folder and create a multiple-table query before starting the next try-it. 

Instructions 
The following are the general tasks that you perform during this try-it: 

1. Open a multiple-table query in Design view. 

2. On the Design tab, in the Query Type group, select Crosstab. 

3. In the query design window, select designated fields, and then set your Row 
Heading, Column Heading, and Value sources. 

4. For Value source, select an appropriate aggregate criterion such as Count. 

5. Select Run. 

6. Save the query, and then save the database. 
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Topic 2: Create an append query 
 Munson's has also asked for your help with the regular cleanup of frequently 

accessed data. The CSA program team has acquired a database that contains a table of 
potential new members, and they want to copy it to the existing members table. You’re 
excited, because based on what you’ve learned about Access so far, you’ve discovered 
the versatility of Access queries, and you think that an action query can accomplish this 
task. 

To avoid entering the new data manually, you consider using an append query. An 
append query selects records from one or more data sources and copies or appends the 
selected records to an existing table. Also, because the CSA team regularly acquires a 
table of potential new members’ orders from various events during the year, an append 
query can save the team time, because they won’t have to manually append data on a 
regular basis. 

To create an append query: 

1. Save a backup of the affected tables. 

 

Caution 

Before you run action queries, you must create backup copies of the 
affected tables. An append query is permanent, and after you run it, 
you cannot use the Undo command to reverse the changes.  

2. Create a select query to select the records to copy, and then open in Design view. 
Review your data before you copy it, by considering the following: 

a. Review the data in Datasheet view and make sure that the query is selecting the 
data that you want to copy. 

b. Consider criteria to refine the query selection and filter the data needed. For 
example, you might want to append member records from a certain city. 

c. At this stage, consider adjusting your select query as needed, and run it as many 
times as you want to make sure that you’re selecting the data that you want to 
copy. 
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3. Next, convert the select query to an append query. From the Design tab, in the 
Query Type group, select Append, as depicted in the following screenshot: 

 
Figure 14: Append option from the Query Type group 

4. Choose the destination fields in the Append dialog box that the following 
screenshot depicts: 

 
Figure 15: Append dialog box 

5. Choose a table to append the data to. 

6. Review the data types of the fields in the source table and make sure that they’re 
compatible with the data types of the fields in the destination table. Also, if you leave 
the destination field blank, the query won’t append data to that field. The following 
screenshot depicts the append field designation: 

 
Figure 16: Append field designation 

7. Select OK. 
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8. Preview, and then run the append query by selecting Run to append records, and 
when prompted to append, select Yes. You cannot undo this process, as the 
following screenshot depicts: 

 
Figure 17: Append query prompt 

9. Save the query, and then save the database. 

 

Did you know? 

It’s a best practice to protect your data when you can’t use the Undo 
command to fix a mistake or in case of a system failure. For more 
information, refer to: Protect your data with backup and restore 
processes 

Additional information 

For more information on append queries, refer to: Add records to a 
table by using an append query 

Activity: Show me how 
In this activity, follow along as your teacher demonstrates how to add new records to an 
existing table by copying data from another existing Access database. 

Resources required 
None 
  

https://aka.ms/Protect-your-data-with-backup-and-restore-processes
https://aka.ms/Protect-your-data-with-backup-and-restore-processes
https://aka.ms/add-records-to-a-table-by-using-an-append-query
https://aka.ms/add-records-to-a-table-by-using-an-append-query
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Activity instructions 
Participate in the activity by following these instructions: 

1. Observe the teacher demonstrating an append query feature. 

2. Ask the teacher clarifying questions. 

3. Participate in the discussion. Remember that there is usually more than one way to 
do something. If you think of a different way to do a task, share and explore your 
ideas with your teacher and class! 

Try-it: Create an append query 
 In this standalone try-it activity, you’ll create an append query. 

Resources 
You’ll need the following resources for this try-it: 

• Open L2_T2_try_background_starter.accdb in this lesson’s Learning Activity 
Resources folder. 

Instructions 
The following are the general tasks that you perform during this try-it: 

1. First, back up the affected tables. 

2. Open a query. 

3. Select a table to append records to. 

4. Run the append query to append the records. 

5. Save the query, and then save the database. 

Topic 3: Create a delete query 
 During the CSA team's data analysis, they noticed that the database contains 

records of orders for inventory that Munson's no longer sells. Your manager has asked 
for your assistance to clean up this data. In this module, you were introduced to action 
queries, such as append queries. Another type of action query is a delete query, which 
you think is especially useful for this task, because the team wants to be able to quickly 
remove records from a table. The inventory will change regularly, and automating this 
task can save the team time by enabling them to reuse a saved delete query. 
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You can also set a criterion to specify which rows should be deleted. For example, 
imagine the data cleanup task is to delete Kolomikta—a type of kiwi fruit with high 
vitamin C content— from the orders database, because Munson's will be offering 
another type. You’ll use the Like operator to set your criteria, Like "Kolomikta", as 
depicted in the following screenshot: 

 
Figure 18: Delete query Criteria row 

Like an append query, a delete query can’t be undone. You should create a reminder to 
help ensure that the database is backed up before running the query. 

To create a delete query: 

1. Save a backup of the affected tables. 

2. On the Design tab, select Delete in the Query Type group. 

3. In the Criteria row, enter your criteria in the query edit field for the data to be 
deleted. Ensure that the criteria you set are appropriate for the data type. For 
example, to only append delete records from a certain city, set the Criteria row for 
the City field by using a parameter criterion. 

4. On the Home tab, in the Views group, select View, and examine the query before 
running it. This step helps you to review and make changes as needed. You can’t use 
the Undo command to undo this process and reverse the changes. Deletion is 
permanent and can’t be reversed. On the Design tab, in the Results group, select 
Run. 
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5. After you’re certain that you can delete the data, select Yes to run the delete query, 
as depicted in the following screenshot: 

 
Figure 19: Delete query prompt 

6. Save the query, and then save the database. 

 

Did you know? 

To create and run a delete query, you must have the necessary 
permissions to delete records from the database. For the lessons in 
this module, you can open files with the necessary permissions. In the 
Munson’s scenario, for instance, you would have to contact your 
system administrator or the database designer to make sure that you 
have the necessary permissions. To do so, in File Explorer, select or 
activate the context menu for the database file, select Properties, and 
make sure that the read-only attribute isn’t selected. 

 

Additional information 

For more information, refer to Create and run a delete query.  

Activity: Pose a challenge 
In this activity, you’ll follow along as your teacher demonstrates how to create and run a 
delete query. 

Resources required 
None 

https://aka.ms/create-and-run-a-delete-query
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Activity instructions 
Participate in the activity by following these instructions: 

1. Observe the teacher demonstrating how to delete a query. 

2. Ask the teacher clarifying questions.  

3. Participate in the discussion. Remember that there is usually more than one way to 
do something. If you think of a different way to do a task, share and explore your 
ideas with your teacher and classmates. 

Try-it: Create a delete query 
In this standalone try-it, you'll practice creating and running a delete query. 

Resources 
You’ll need the following resources for this try-it: 

• Open L2_T3_try_background_starter.accdb in this lesson’s Learning Activity 
Resources folder. 

Instructions 
The following are the general tasks that you perform during this try-it: 

1. Back up your database. 

2. On the Design tab, select Delete in the Query Type group. 

3. Set criteria for the data that you need to delete. Ensure that the criteria are specific 
to the data specifications within the table. For example, to only append delete 
records from a certain city, set the Criteria row for the City field by using a 
parameter criterion. 

4. On the Design tab, in the Results group, select Run. 

5. Select View to review the results before running the delete query. 

6. If you’re satisfied with the results, select View to go back to Query Editing. 

7. Select Run to run the delete query. 

8. Save the query, and then save the database. 
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Wrap-up 
Use these questions to check what you learned in this lesson: 

1. When you’re modifying a multiple-table query, you can: 

Select all that apply. 

a. Rename the query 

b. Hide fields 

c. Add fields 

d. Remove fields 

2. When you’re creating an append query, you must specify a ________________________ in 
which to append the records. 

Fill in the blank space. 

3. When you’re creating an append query, which of the following is considered the best 
option in case the Undo command isn’t enough to fix a mistake? 

Select the correct option. 

a. Restart the database. 

b. Back up your data. 

c. Restore the process. 

d. First preview the query and then run the query. 

4. A ________________________ query is useful when you want to quickly remove a large 
amount of data on a frequent basis in Access. 

Fill in the blank space. 

5. What are the basic steps for creating a delete query? 

Indicate the correct sequence by adding numbers 1-4 next to the following items. 

a. Select database properties to ensure that the read-only attribute isn‘t selected. - 
________________________ 

b. Review the results, and then run the query. - ________________________ 

c. Ensure that criteria are specific to data specifications within the table. - 
________________________ 

d. Ensure that you have the necessary delete permissions. - ________________________ 
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Glossary 
Action query A major query type that you can use to add, change, or delete data. 

Each task has a special type of action query. 

Aggregate 
function 

A function that performs a calculation on a column of data and 
returns a single value. 

Collaborative Produced or conducted by two or more parties working together. 

Criteria The filters you add to a query to specify which items the query will 
return when you run it. 

Data type The most important property of a field, because it determines what 
kind of data the field can store. 

Default A preexisting value that a software application, computer program, 
or device has assigned to a user-configurable setting. 

Parameter A piece of information that you supply to a query as you run it. You 
can use a parameter by itself or as part of a larger expression to form 
a criterion in the query. 

Proficiency A high degree of competence or skill; expertise. 

Query criteria Query criteria help Access zero in on specific items in an Access 
database. If an item matches all the criteria you enter, it will appear in 
the query results. 

Relationships 
window 

The window in which you define relationships between items stored 
in multiple Access tables. 

Table relationship A relationship that Access uses to decide how to join tables when 
you need to use them in a database object. 

Table 2: Glossary terms and definitions 
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Cornerstone 
Overview 
In this Cornerstone, you’ll create multiple-table queries. You’ll create and modify a 
multiple-table query with Query Wizard and create a parameter query. You’ll also 
create special queries, such as a crosstab query, an append query, and a delete query. 

Objectives 
The following table outlines the Cornerstone objectives and their corresponding MOS 
exam objectives. 

Create and modify 
a multiple-table 
query with Query 
Wizard 

• 3.1.5: Create basic multi-table queries

Create a parameter 
query 

• 3.1.3: Create basic parameter queries

Create a crosstab 
query 

• 3.1.2: Create basic crosstab queries

Create an append 
query 

• 3.1.4: Create basic action queries

Create a delete 
query 

• 3.1.4: Create basic action queries

Table 3: Cornerstone objectives 
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Duration 
50 minutes 

Instructions 
1. Complete the tasks below for each file. 

2. When saving your file, add your name to the end of the filename, for example: 
Cornerstone_background_starter_YourName. Follow your teacher’s directions for 
where to save your files. 

3. When you’re done with the Cornerstone, assess your completion and enter the 
points that you think you earned within the task lists below. You ask your teacher for 
help, if required. 

Tasks 
In this Cornerstone, you’ll work with two files. Save each file separately, and then move 
on to the next one. 

File 1: Cornerstone_background_starter.accdb 
Task: Create a multiple-table query (5 points) 
1. Create a query using tblFarmBoxes as the primary table, and move all available 

fields from the Available Fields list to the Selected Fields list. 

2. For the related table, use tblOrders and move OrderID, OrderDate, PickupDate, 
and MemberID to the Selected Fields list. 

3. Name the query qryFarmBoxOrders. (5 points). (Exam objective 3.1.5) 

Points scored: ________ / 5 

Task: Modify a multiple-table query (4 points) 
1. In the Design view, add the FarmBoxDescription field to the query design grid. 

2. Review the results of the modified query in Datasheet view. 

3. Save the query and the database. (4 points). (Exam objective 3.1.5) 

Points scored: ________ / 4 
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Task: Create a parameter query (3 points) 
1. In Design view, add the criteria [What’s the pickup date?] for the PickupDate field. 

2. Run the parameter query. 

3. Save the query and the database. (3 points) (Exam objective 3.1.3) 

Points scored: ________ / 3 

Task: Specify a parameter data type (3 points) 
1. In the Query Parameters dialog box, specify the parameter [What’s the pickup 

date?], and specify the data type Date With Time. 

2. Run the parameter query. 

3. Save the query and the database. (3 points) (Exam objective 3.1.3) 

Points scored: ________ / 3 

FILE 1 TOTAL POINTS: ________ / 15 

File 2: Cornerstone_munsons_starter.accdb 
Task: Create a crosstab query (5 points) 
1. Change qryFarmBoxOrders to a Crosstab query. 

2. In the query design grid table, set the Row Heading source, Column Heading 
source, and Value source as FarmBoxName, OrderDate, and OrderID respectively. 

3. In the Total row, change the Group By cell to Count. 

4. Run and save the query. 

5. Create an alternate crosstab query by first copying the 
qryFarmBoxesOrders_crosstab query and then pasting it as 
qryFarmBoxOrders_crosstab2. 

6. Add the OrderDate field to the query design grid, in the Total row, select Count, 
and then in the Crosstab row, select Row Heading. 

7. Run the query and review the results. 

8. Save the query and the database. (5 points). (Exam objective 3.1.2) 

Points scored: ________ / 5 
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Task: Create an append query (5 points) 
1. Make a copy of tblMembers, name it tblMembers_backup, and specify the paste 

option Structure and Data. 

2. Create a second copy of tblMembers, name it tblMembers_blank, and specify the 
paste option Structure Only. 

3. Create a select query using tblMembers_backup table and all the available fields. 

4. Review individual records of your query, and name it tblMembers_backup_query. 

5. Convert the select query to an append query. 

6. Append records only from Mount Vernon. 

7. Append the data to tblMembers_blank  and use Current Database. 

8. Save the query. (5 points). (Exam objective 3.1.4) 

Points scored: ________ / 5 

Task: Create a delete query (3 points) 
1. Make a copy of tblMembers, name it tblMembers_backup_del, and specify the 

paste option Structure and Data. 

2. Create a second copy of tblMembers, name it tblMembers_blank_del, and specify 
the paste option Structure Only. 

3. Create a select query using the tblMembers_backup_del table and all the available 
fields. 

4. Review individual records of your query, and name it 
tblMembers_backup_query_del. 

5. Convert tblMembers_backup_query_del to a delete query, and refine the query 
selection and filter to delete records only from Mount Vernon. 

6. Run and save the query. (3 points) (Exam objective 3.1.4) 

Points scored: ________ / 3 
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Task: Create a delete query with a specific criterion (2 points) 
1. Make a copy of tblMembers_backup_query_del, name it 

tblMembers_backup_del_query2, and make it a delete query. 

2. Modify the filter you used in the previous task to delete records only from the city of 
Edison. 

3. Add a second filter to delete records only from the city of Edison that have members 
with the last name Doyon. 

4. Save the query and the database. (2 points). (Exam objective 3.1.4) 

Points scored: ________ / 2 

FILE 2 TOTAL POINTS: ________ / 15 
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Module overview 
Description 
A form is an object that you use to enter, edit, find, and work with the data in a 
Microsoft Access 2019 database. Forms do not store data, but you can use them to 
make it easier to work with database tables. You can use forms to work with the data in 
one table or in multiple tables at the same time. You can also use forms to make data 
easier to understand by using graphics and modifying field placements. 

When you get to the end of this module, you’ll be able to create forms based on one or 
several tables. You’ll use the Form tool and the Form Wizard to create simple forms, 
split forms, datasheet forms, and forms with subforms. You’ll customize forms for ease 
of use by applying and anchoring form layouts, and adjusting control properties and tab 
order. You’ll also add text and images to form headers and footers. 

The following table outlines the lesson objectives and their corresponding Microsoft 
Office Specialist (MOS) exam objectives. 

Lesson Learning objectives MOS exam objective(s) 

Creating and modifying 
forms 

Create single-table forms, 
including datasheet forms 
and split forms; create 
multiple-table forms that 
contain a subform; and 
use form layouts to 
position controls on a 
form. Modify forms by 
adding labels and 
controls. 

• 4.1.1: Add, move, and 
remove form controls 

• 4.1.3: Add and modify 
form labels 

• 4.1.2: Set form control 
properties 

• 4.2.3: Modify form 
positioning 
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Lesson Learning objectives MOS exam objective(s) 

Customizing forms Customize and improve 
the appearance of forms 
by adding text and 
images, working with 
controls, adjusting the tab 
order, and using and 
anchoring form layouts. 

• 4.1.1: Add, move, and 
remove form controls 

• 4.1.2: Set form control 
properties 

• 4.1.3: Add and modify 
form labels 

• 4.2.1: Modify tab order 
on forms 

• 4.2.3: Modify form 
positioning 

• 4.2.4: Insert 
information in form 
headers and footers 

• 4.2.5: Insert images on 
forms 

Cornerstone: Customize 
forms  

Create single-table and 
multiple-table forms and 
then customize them by 
adjusting and anchoring 
layouts, modifying control 
properties, changing the 
tab order, adding form 
headers and footers, and 
adding text and images to 
the forms. 

• All the preceding exam 
objectives 

Table 1: MOS objectives by lesson 

Scenario 
It is now almost fall, and the Community Supported Agriculture (CSA) program is 
flourishing. The number of members has surpassed Munson’s expectations; even better, 
the members continue to increase their participation in the program. The database is 
serving well, but all data entry for member data, farm box details, and orders placed is 
being done separately. Some of your co-workers have suggested that being able to 
review a member’s contact information, preferences, and order history would help them 
provide better service. 
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You decide that changing the method of data entry will make this possible. You’ll now 
enter all related information in a single form, so that a complete overview of a member 
customer’s information and history with the CSA program is readily available. You’ll also 
create several auxiliary forms for entering information about the new lines of products, 
such as preserves and honey, that Munson’s soon will be carrying in the Farm boxes. 

Cornerstone 
In this Cornerstone, you’ll use the skills you learned in this module to create and 
customize single-table and multiple-table forms so that you can work with data from 
multiple tables at once. 
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Lesson 1: Creating and 
modifying forms 
Overview 
Forms make it easier to enter and retrieve data in Access. In this lesson, you’ll use 
various methods, including the Form tool and the Form Wizard, to create and configure 
forms. You’ll create forms that are based on a single table, as well as forms with 
subforms that are based on several related tables. You’ll also customize forms by 
modifying form layouts and by adding and removing controls. 

Warm-up 
Use these questions to find out what you already know about this lesson’s topics: 

1. Forms store data. 

Select the correct option. 

a. True 

b. False 

2. When you edit information in a form, where does Access store the data you’re 
editing? 

Select the correct option. 

a. In a query 

b. In the form 

c. In a table  

d. In a report 

3. You use forms to: 

Select all that apply. 

a. Find records 

b. Edit records 

c. Delete records 

d. Filter records 
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4. Briefly describe a margin. 

Fill in the blank space. 

 

5. Note down at least two non-Access forms you have used. 

Fill in the blank space. 

 

6. The steps to create a new form using the Form tool are: 

Indicate the correct sequence by adding numbers 1–3 next to the following items. 

a. Select Form. - ________________________ 

b. Select or open the table on which you’re basing the form. - 
________________________ 

c. Select the Create tab in the ribbon. - ________________________ 

Topic 1: Create and modify single-table 
forms 

 You use forms to work with data that is stored in tables. When you create a form, 
the data can be from one table, several tables, or from a query that is from one or 
several tables. This topic introduces you to several ways to create forms from a single 
table. 

Use the Form tool 
The Form tool creates a simple form for tables that are on the “many” side of one-to-
many relationships. The following screenshot highlights the Form command on the 
Forms group of the Create tab. 

 
Figure 1: The Form command 
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Create a single-table form with the Form tool 
1. In the Navigation Pane, select or open a table that is on the “many” side of any 

one-to-many relationships with other tables. 

2. On the Create tab, in the Forms group, select Form. 

3. Save the form. 

Use the Form Wizard 
The Form tool is convenient for making simple forms, but if the table on which you are 
basing the form is a parent table, it will automatically give you a primary form with a 
nested subform. A parent table is one that is on the “one” side of a one-to-many 
relationship with another table. If you need to create a single-table form (without a 
subform) from a parent table, you can use the Form Wizard. 

To create a single-table form with the Form Wizard: 

1. On the Create tab, in the Forms group, select Form Wizard, as the following 
screenshot highlights. 

 
Figure 2: Form Wizard 

2. On the What fields do you want on your form? page, choose the table from the 
Tables/Queries drop-down list. 

3. On the same page of the wizard, in the Available Fields list, double-click each field 
you want to include on the form and then move the field(s) to the Selected Fields 
list. Alternatively, select the single-arrow (>) button to move one field at a time, or 
select the double-arrow button (>>) to move all the fields at the same time. The 
following screenshot highlights the Tables/Queries drop-down list and the arrow 
buttons on the What fields do you want on your form? page. 
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Figure 3: The What fields do you want on your form? page: choose the table or 
query and fields 

4. On the What layout would you like for your form? page of the wizard, which the 
following screenshot depicts, choose the form layout. 

 
Figure 4: The What layout would you like for your form? page of the wizard: 
choose the form layout 
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5. On the What title do you want for your form? page of the wizard, add your title. 
This will become the name of the form and the title in the form header. Then select 
one of the options to decide which view you want to open after the form is created. 
If you want to open the form in Form view, select Open the form to view or enter 
information and then review or enter data. If you want to open the form in Design 
view, select Modify the form’s design and then modify the form. 

 
Figure 5: The What title do you want for your form? page of the Form Wizard: add 
a title and choose how it will open 

Change titles and form names 
The Form Wizard will save the form as you finish the steps and will use the title you 
enter on the last page as the form name. The name of the form might use a naming 
convention; for example, an appropriate title for the object name, such as 
frmMemberForm. However, if this title appears unattractive in the form header, you 
can then change the title on the form to something more appealing, such as Member 
Form. You can also do the reverse: enter the title you want to appear on the form in the 
wizard, and then rename the form with the frmMemberForm name. To rename a form, 
right-click the form in the Navigation Pane or access its context menu, and then select 
Rename. Enter the new name, and then select Enter. The following screenshot depicts 
the context menu option for renaming a form. 
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Figure 6: Renaming a form 

The title in a form created by the Form Wizard is a Label control in the form header. To 
change the text in the Label control, do one of the following: 

• In Layout or Design view, double-click or select the label text, edit the text, and then 
either select Esc or select outside the control. 

• In Layout or Design view, select F4 to open the Property Sheet pane. Select the 
label and then change its Caption property in the Format tab of the Property Sheet 
pane, as the following screenshot depicts. 

 
Figure 7: Changing the Caption property of the Label in the Form Header 

 

Additional information 

For more information on naming forms and controls, go to: 
Guidelines for naming fields, controls, and objects 

https://aka.ms/Guidelines-for-naming-fields-controls-and-objects
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Did you know? 

When entering text in a label, if you want to break the line, selecting 
Enter will not work. To add a line break, select Ctrl+Enter. 

 

 

Caution 

When you’re working in Design view, don’t change the text in a field 
control. Only change text in label or unbound text box controls. 

The text in a field control is the name of the field in the underlying 
table; if you change it, your field control can’t connect to the field in 
the table, as the following screenshot depicts. 

 
Figure 8: Changing the text in a field control will break the connection 
between the control and the table 

To repair this error, go to the field control’s Control Source property 
in the Property Sheet pane, open the list of available fields, and then 
select the field that the control should use, as the following 
screenshot depicts. 

 
Figure 9: The Control Source property for the control 
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Create datasheet forms 
A datasheet form is one that is arranged into rows and columns, like a table datasheet. 
Datasheet forms are useful when you want to work with a datasheet to review or edit 
your data, but you also want to add elements such as a value list or a default value to 
the form that you don’t want to add directly to the table. 

To create a datasheet form: 

1. Select or open the table or query in the Navigation Pane from which you want to 
make a form. 

2. On the Create tab in the ribbon, select More Forms, and then select Datasheet. 

3. Save the form. 

 

Did you know? 

Datasheet forms are often used as subforms. You can create a 
datasheet form and then later add it to another form as a subform, 
but only if the underlying tables of the two forms had a one-to-many 
relationship. 

Create split forms 
A split form is one that has both a Datasheet view and a Form view for the same data. 
Using a split form gives you the benefit of using both these views to work with the same 
data in a synchronized manner. For example, you can use the Datasheet view to review 
the list of records and find the specific record you want to work with and then use the 
Form view to work with one record at a time. The changes you make to one view will 
replicate in the underlying table and, therefore, will appear in the other view. 
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To create a split form: 

1. In the Navigation Pane, select or open the table or query that contains the data that 
you want on your form. 

2. In the ribbon, on the Create tab, in the Forms group, select More Forms and then 
select Split Form, as the following screenshot depicts. 

 
Figure 10: Creating a Split Form 

3. Select Save and give your form a name in the Save As box. Tip: A common naming 
convention is to add frm to the beginning of the form name. 

 
Figure 11: Saving the form 

4. Access creates the form and opens it in Layout view, where you can resize it and 
format it in other ways. To use the form, select View and then select Form View. 
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When you’re working with split forms, keep in mind the following useful tips: 

• When you edit data in a form, you are actually editing the data in the underlying 
table. Therefore, when you make edits to a record in one section of the form, you’ll 
notice those changes in the other section as well. The following screenshot depicts a 
split form. 

 
Figure 12: A split form allows you to work in either view on the same data 

• You can drag the divider up and down between the two form sections to change 
how much of each section is available. Alternatively, switch to Design view, select the 
form in the Property Sheet pane, and then on the Format tab, set the Split Form 
Size property. This property affects the height of the upper portion (by default, the 
form layout) of the form. 

 
Figure 13: Drag the divider between form sections 
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• When you sort data while using a split form, you can select the field to sort by in 
either the Form View section or the Datasheet View section, and the data is then 
sorted in both sections of the form. The following screenshot depicts the same field 
selected in both the form sections. 

 
Figure 14: Select the field in either form section 

• When you apply an input mask to a split form, it doesn't matter if you apply it to the 
field control on the Form view or on the Datasheet view. The input mask will apply 
to both field controls after you apply it to one. 

Add text to a form with a Label control 
You can add text to a form in Design view by using a Label control, which you can find 
on the Controls group of the Design tab, as the following screenshot depicts. 

 
Figure 15: The Label control button in the Controls gallery 
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Add and edit the Label control’s text by entering text directly in the control or by 
editing the control’s Caption property in the Property Sheet pane, as the following 
screenshot depicts. 

 
Figure 16: A label's Caption property in the Property Sheet pane 

To add a label control to a form: 

1. Open the form in Design view. 

2. On the Design tab, select the Label control. 

3. Select the spot on the form where you want the control. 

4. Enter text in the label directly, or modify the Caption property in the Property Sheet 
pane. The following screenshot depicts a label control in a form footer. 

 
Figure 17: A label control in a form footer 

Correct unassociated label errors 
By default, every field control has an associated label control. If you add a label control 
in the Detail section of a form, a green error symbol, as well as an Error Checking 
Options menu, will appear in the label. Select the Error Checking Options menu to 
associate the label with a control. However, if the label is not functioning as a label to a 
control (in other words, if it is just additional text on your form, similar to information in 
the footer), you can ignore the error. 



Enhancing data interaction 
 

 
19 

 
Figure 18: Unassociated Label options 

 

Caution 

This course uses database files that follow a general storyline for the 
CSA program at Munson’s Pickles and Preserves Farm. These 
database files are the Learning Activity Resource files that you’ll use 
to work on each module’s activities and try-its. Each Learning Activity 
Resource file contains the data and objects, such as tables, queries, 
forms, and reports, that you need to complete a corresponding 
activity. 

Due to this course’s modular nature, the objects and data in these 
files might vary across activities or try-its. Therefore, it’s important 
that you start your activities or try-its only with the designated files, 
as per applicable instructions. You also should note that screenshots 
in the topic content are for illustration purposes only and might 
appear different than those that are in the Learning Activity Resource 
files. 

Activity: Show me how 
In this activity, observe your teacher briefly demonstrate the skills you’ll need in the 
upcoming try-it activity. 

Resources  
You’ll need the following resources for this activity: 

• None 
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Instructions 
To participate in this activity: 

• Pay attention to the methods that your teacher uses to create single-table forms, 
edit form titles, and add text to forms with Label controls. 

• Be prepared to repeat these actions in the upcoming try-it. 
• Ask questions to clarify anything that isn't clear to you. 

Try-it: Create and modify single-table forms 
 In this try-it, you’ll create: 

• A datasheet form. 
• A single-table form by using the Form tool. 
• A single-table form by using the Form Wizard. 
• A split form. 

Resources 
You’ll need the following resources for this try-it: 

• Open L1_T1_try_csa_program_starter.accdb in this lesson’s Learning Activity 
Resources folder. 

Instructions 
The following are the general tasks that you need to perform during this try-it: 

1. Create a datasheet form for the tblFarmBoxes table, save it as 
frmFarmBoxes_datasheet, examine it in Form view, and then close it. 

2. Use the Form tool to create a single-table form for the tblPreserves table, save the 
form as frmPreserves, examine it in Form view, and then close it. 

3. Use the Form Wizard to create a single-table form for the tblMembers table with 
these choices: 

a. On the Which fields do you want on your form? page of the wizard, use all the 
fields from the tblMembers table. 

b. On the What layout would you like for your form? page of the wizard, select 
the default Columnar layout. 

c. On the What title do you want for your form? page of the wizard, add the title 
frmMemberInformation and choose Open the form to view or enter 
information. 
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4. Examine the form and notice that the title on the form and the name of the form are 
both frmMemberInformation. The form is saved and is open in Form view. 

5. Change the text in the Text label in the Form Header to Member Information. 

6. Add a Label control to the header at the 4.5 inch mark (or set the Left property at 
4.5”). 

7. Add the text For help with this form, call Helpdesk at ext. 123 to the label, and 
then save and close the form. 

8. Create a split form for the tblOrders table and then save it as frmOrders_split. 

9. Change the title text to Orders Data, examine the form in Form view, and then save 
and close the form. 

10. Close the database. 

 

Did you know? 

Data is only stored in one place in Access: the tables. Every other 
object in Access is there to help you work with the all-important data 
in the tables. That means that, in theory, you could delete all the 
forms, queries, and reports, but if you left the tables alone, your data 
would be just fine. (The person who made the database would be 
upset, though, so probably not a fabulous idea to do this.) 

It also means that the integrity of the tables is of critical importance. 
In other words, the most essential task in keeping your database 
healthy is to keep your data healthy. This is one reason why many 
database designers make datasheet forms. They can give their users 
something that displays and feels like a table datasheet, but the table 
is protected because it is closed. Sometimes, access to tables is 
restricted so only a few people can edit them; as a result, everyone 
works exclusively through forms. This is another reason why forms are 
so important. 

Remember: Tables store data; forms allow you to review and edit the 
data. 
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Additional information 

For more information on forms, go to: Introduction to forms 

For more information on creating forms, go to: Create a form in 
Access 

For more information on creating split forms, go to: Create a split form 

For more information on adding titles to forms, go to: Insert a title into 
a form or report 

Topic 2: Create multiple-table forms 
 This topic introduces you to creating forms that contain a subform. A subform is a 

form that is inserted in another form. A form that contains a subform is sometimes 
referred to as a parent/child form. You can use forms that contain one or more 
subforms to work with records from two or more related tables at the same time. Doing 
so simplifies the process of working with data from several related tables. 

You can create forms with subforms by: 

• Using the Form tool. 
• Creating a new form from multiple tables by using the Form Wizard. 
• Adding a subform to an existing form by using the SubForm Wizard. 
• Adding an existing subform to an existing form by dragging the subform onto the 

form. 

Before you can use any of these methods to create a multiple-table form, you need to 
establish one-to-many relationships between the tables. When you create a form based 
on two or more tables, the form will consist of a primary form on which you observe one 
record at a time and a subform on which you observe multiple related records. 

The main form is based on the table on the “one” side of a one-to-many relationship, 
which is called the parent table. The subform is the table that is on the “many” side of 
the one-to-many relationship, which is called the child table. The following screenshot 
depicts the Relationships window, in which tblMembers and tblFarmBoxes are parent 
tables, and the tblOrders table is a child table. 

https://aka.ms/Introduction_to_forms
https://aka.ms/Create-a-form-in-Access-create-from-query
https://aka.ms/Create-a-form-in-Access-create-from-query
https://aka.ms/create-a-split-form
https://aka.ms/insert-a-title-into-a-form-or-report
https://aka.ms/insert-a-title-into-a-form-or-report
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Figure 19: The Relationships window where tblMembers and tblFarmBoxes are parent 
tables, and the tblOrders table is a child table 

For example, imagine Member #5 placed four orders. In a form with a subform based on 
these two tables (the main form based on the tblMembers table, and the subform 
based on the tblOrders table), Member #5 would have one record in the tblMembers 
table and four records in the tblOrders table, as the following two screenshots depict. 

 
Figure 20: Diagram of a one-to-many database relationship 
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Figure 21: Form and subform 

Create a form that contains a subform by using the Form tool 
In Module 3, you learned that the Form tool (the Form button in the Forms group on 
the Create tab) will create a simple form based on a single table. However, when 
multiple tables in your database are related, the Form tool will make a form based on 
one table or several tables, depending on whether the primary table is the parent table 
or child table. Consider the following factors: 

• If the table you use to make a form is a child table (the table on the “many” side of a 
one-to-many relationship), the Form tool will create a simple form based only on 
that table. 

• If the table you use to make a form is a parent table (the table on the “one” side of a 
one-to-many relationship), the resulting form is a primary form that is based on the 
parent table, and the subform is based on the child table. 

To create a form that contains a subform by using the Form tool: 

1. If necessary, go to the Database Tools tab, and in the Relationships group, select 
Relationships. In the Relationships window, examine the relationship between the 
two (or more) tables upon which you want to make the form. 

2. Select or open the table which is on the “one” side of the relationship. 

3. On the Create tab, in the Forms group, select Form. Access creates the form in 
Layout view. 

4. Save the form. 
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The following screenshot depicts the Relationships window with the tblMembers table 
and the tblOrders table, which have a one-to-many relationship. The tblMembers table 
is the table that should be open or selected because it is the parent table on the “one” 
side of the relationship. 

 
Figure 22: The tblMembers table is the table that should be open or selected because it is 
the parent table on the “one” side of the relationship 

 

Video 

To review the video on table relationships, go to: Get started with 
table relationships 

Create a form that contains a subform by using the Form Wizard 
If you’ve created the relationships between your tables, you can use the Form Wizard 
to create a form that contains a subform. To do so: 

1. Before you begin, open the Relationships window and ensure that you have 
correctly created the one-to-many relationship(s) between the tables you want to 
use for your form and subform. 

2. On the Create tab, in the Forms group, select Form Wizard. 

3. On the What fields do you want on your form? page of the wizard, in the 
Tables/Queries drop-down list, select one of the tables. It doesn’t matter which one 
you add first. 

4. Double-click the fields that you want to include from the table, or select the double-
arrow (>>) button to move all the fields. 

5. In the Tables/Queries drop-down list, select the other table. 

6. Double-click the fields that you want to include from the table, or select the double-
arrow (>>) button to move all the fields. 

https://aka.ms/video-get-started-with-table-relationships
https://aka.ms/video-get-started-with-table-relationships
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7. On the How do you want to view your data? page, select a table on the “one” side 
of the one-to-many relationship(s), select Form with subform(s), and then select 
Next. 

 
Figure 23: The How do you want to view your data? wizard page 

8. On the What layout would you like for your subform? page, select a layout 
option, and then select Next. 

9. On the What titles do you want for your forms? page of the wizard, enter the 
titles that you want for the forms. Specify whether you want to open the form in 
Form view or in Design view, and then select Finish. Access creates two forms: one 
form for the main form and one form for the subform. 
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Figure 24: The What titles do you want for your forms? wizard page 

Adding a subform to an existing form 
If you already have a form for your primary form and you want to add a subform, you 
can: 

• Use the Subform Wizard in Design view to create a subform on the main form. 
• Create the main form and the subform independently, and then with the main form 

open in Design view, drag the subform from the Navigation Pane onto the Detail 
section of the main form. 

To add a form as a subform to another form by dragging: 

1. Establish a one-to-many relationship between the tables you are using and create 
single-table forms for both. The main form is based on the “one” side of the 
relationship, and the subform is based on the “many” side of the relationship. Tip: A 
Datasheet is a good choice for the type of subform. 

2. Open the main form in Design view. 

3. From the  Navigation Pane, drag the subform to the location on the open main 
form. If there is not enough room, the form will expand. The following two 
screenshots depict this process. 
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Figure 25: Drag the subform to the main form while in Design view 

 
Figure 26: The subform, added to the main form 

 

Additional information 

For more information on creating forms with subforms, go to: Create a 
form that contains a subform (a one-to-many form) 

 

https://aka.ms/create-a-form-that-contains-a-subform-a-one-to-many-form
https://aka.ms/create-a-form-that-contains-a-subform-a-one-to-many-form
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Did you know? 

Multiple-table forms and forms with subforms can include more than 
two tables if the tables are all related. For example, a form can have 
two subforms for two tables related to the table that the primary 
form is built on. 

Database designers sometimes create queries with multiple tables 
and then create forms based on the queries, rather than directly on 
the tables. 

Activity: Show me how 
In this activity, observe your teacher briefly demonstrate the skills you’ll need in the 
upcoming try-it. 

Resources  
You’ll need the following resources for this activity: 

• None 

Instructions 
To participate in this activity: 

• Pay attention to the methods that your teacher uses to create multiple-table forms 
and change and add text to forms. 

• Be prepared to repeat these actions in the upcoming try-it. 
• Ask questions to clarify anything that isn't clear to you. 

Try-it: Create multiple-table forms 
 In this leveled try-it activity, you’ll create forms that have subforms and are based 

on two related tables. 

Try-it 1 
In this try-it, you’ll create forms that depict the data from the tblMembers table and the 
tblOrders table, so you can manage Munson’s member data and order data at the same 
time. 



Enhancing data interaction 
 

 
30 

Resources 
You’ll need the following resources for this try-it: 

• Open L1_T2_try1_csa_program_starter.accdb in this lesson’s Learning Activity 
Resources folder. 

Instructions 
The following are the general tasks that you need to perform during this try-it: 

1. Use the Form tool to create a multiple-table form with a subform that is based on 
the tblMembers and tblOrders tables. 

2. Save the form as frmMembers_and_Orders. 

3. Use the Form Wizard to create a multiple-table form with a datasheet subform that 
is based on the tblFarmboxes and tblOrders tables. 

4. Enter frmFarmBoxes and frmsubOrders as the form titles. 

5. Add a subform to the frmMembers_and_Orders2 form by dragging 
frmsubOrders2 onto the available space at the bottom of the Detail section of the 
frmMembers_and_Orders2 form. Delete the subform’s label. 

Try-it 2 
In this try-it, you’ll create a form that you can use to manage the member data, order 
data, and farm box data simultaneously. 

Resources 
You’ll need the following resources for this activity: 

• Open L1_T2_try2_csa_program_starter.accdb in this lesson’s Learning Activity 
Resources folder. 

Instructions 
1. Use the Form Wizard to create a multiple-table form by using the specified fields 

from each of the following tables: 

o tblMembers: all fields 
o tblFarmboxes: FarmBoxName, FarmBoxDescription 
o tblOrders: OrderID, OrderDate, PickupDate, FarmBoxPrice, Quantity, and 

OrderTotal 

2. Create the form so that the tblMembers table is the basis for the primary form and 
the other two tables are the basis for the subform. 
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3. Use a Datasheet layout for the subform. 

4. Enter frmmainMembers and frmsubOrders_FarmBoxes as the form’s titles. 

5. Delete the Label control for the subform and widen the subform to approximately 
6". 

Topic 3: Modify positioning of controls 
in a layout 

 In this topic, you’ll examine different ways in which you can arrange and rearrange 
form controls and other elements. The end goal is to make attractive forms that are easy 
to comprehend and use. 

Understand form layouts 
By default, when you use one of the form tools on the Create tab to create a form, or 
when you open a form in Layout view and then add fields, the controls on the form are 
placed into a layout. A layout is a grid-like container, like a table, that you can use to 
align and arrange form elements quickly and consistently. Layouts are either tabular or 
stacked. 

Tabular layouts: 

• Resemble a spreadsheet, with labels across the top in the section before the rows of 
controls that will display the data. 

• Always span two sections of a form. Usually, the labels are in the Form Header, and 
the controls are in the Detail section. 

In a form using a tabular layout, you should change the form’s Default View property 
to Continuous Forms to display more than one record at a time. The following 
screenshot depicts a tabular layout. 
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Figure 27: A form with a tabular layout 

Stacked layouts arrange controls vertically, with the labels in the first column and 
controls in the next column. In a stacked layout, all the controls and labels are in one 
section together, typically the Detail section. In a form using a stacked layout, you 
should change the form’s Default View property to Single Form to display more than 
one record at a time. The following screenshot depicts a stacked layout. 

 
Figure 28: A form with a stacked layout 

To change a form from one type of layout to another: 

1. Select one cell in the layout. 

2. On the Arrange tab, in the Rows & Columns group, choose Select Layout. 

3. On the Arrange tab, in the Table group, select Tabular or Stacked. 

If the layout type you are changing to is Tabular: 

• Before you begin, change your control widths to roughly the width of the columns 
you want in the tabular layout (about one inch). 

• If necessary, increase the Form Header and move the Title to make space for the 
label controls. 
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• Select F4 to open the Property Sheet pane, select Form from the list, select the 
Format tab, and then ensure that the form’s Default View property is Continuous 
Forms. 

Add controls to a layout 
If you created a form by using a method that does not add a layout to your form, you 
might want to add controls to a layout to make aligning them fast and easy. The 
following screenshot depicts field and label controls that are not in a layout. 

 
Figure 29: Field and Label controls selected 

To add controls to a layout: 

1. Open the form in Layout or Design view. 

2. Select the controls and labels that you want to add to a layout. 

3. On the Arrange tab, in the Table group, select one of the following: 

o Select Stacked to arrange the layout with the label controls in the first column 
and the field controls in the second column. 

o Select Tabular to arrange the layout with the label controls in the Form Header 
and the field controls in the Detail section. 

The following two screenshots depict controls in a stacked layout and a tabular layout. 

 
Figure 30: Controls in a Stacked layout 
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Figure 31: Controls in a Tabular layout 

Remove controls from a layout 
If you want to place controls outside the layout on the form, you can remove a control 
from the layout or completely remove the layout. You must open the form in Design 
view to do this. To remove controls from a layout: 

1. In the Navigation Pane, right-click the form or access its context menu, and then 
select Design View. Alternatively, open the form, select the View drop-down list on 
the Home tab, and then select Design View. The following screenshot depicts the 
Design View option on the context menu. 

 
Figure 32: Choose the Design View from the context menu of the form 

2. Select the control(s) that you want to remove from the layout by using one of the 
following steps: 

o Select Shift while selecting multiple controls. 
o To select all the controls, select the layout selector in the corner of the layout, or 

select one control and then on the Arrange tab, in the Rows & Columns group, 
choose Select Layout. The following screenshot highlights the layout selector in 
the corner of the layout. 
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Figure 33: The layout selector box and a selected layout 

3. On the Arrange tab, in the Table group, select Remove Layout. Alternatively, right-
click or access the context menu for any of the selected controls, select Layout, and 
then select Remove Layout. 

 

Additional information 

For more information on Layout and Design View, go to: Understand 
Layout view and Design view 

For more information on removing controls from a layout, go to: Move 
and resize controls independently 

For more information on removing controls from a layout, go to: Make 
quick design changes by using Layout View 

For more information on removing controls from a layout, go to: Fine-
tune your form in Layout View 

For more information on removing controls from a layout, go to: Know 
when to use Layout View in Access 2010 

Change padding and margins in a layout 
Both padding and margin affect space between controls or the contents of controls in a 
layout. Padding is the distance between cells in a layout. Margins are the internal 
distance between the inside edges of the control and the contents of the control, much 
like a page margin in Microsoft Word. Text alignment in a control might affect how the 
margin will appear. 

  

https://aka.ms/Introduction-to-forms-understand-form-views
https://aka.ms/Introduction-to-forms-understand-form-views
https://aka.ms/Move-and-resize-controls-independently
https://aka.ms/Move-and-resize-controls-independently
https://aka.ms/Know-when-to-use-Layout-view-in-Access
https://aka.ms/Know-when-to-use-Layout-view-in-Access
https://aka.ms/Introduction-to-forms-fine-tune-in-layout-view
https://aka.ms/Introduction-to-forms-fine-tune-in-layout-view
https://aka.ms/Know-when-to-use-Layout-view-in-Access-2010
https://aka.ms/Know-when-to-use-Layout-view-in-Access-2010
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Examples of padding options 

Padding set at None will have no space between each cell in the layout, as the following 
screenshot depicts. 

 
Figure 34: Padding set at None 

Padding set at Narrow has a small amount of space between each cell in the layout, as 
the following screenshot depicts. 

 
Figure 35: Padding set at Narrow 

Padding set at Medium has a moderate amount of space between each cell in the 
layout, as the following screenshot depicts. 

 
Figure 36: Padding set at Medium 

Padding set at Wide has an amount of space between each cell in the layout roughly 
the same size as the default height of a cell, as the following screenshot depicts. 

 
Figure 37: Padding set at Wide 
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To change the padding of a layout: 

1. In the Design or Layout view, select one cell in the layout, and then on the Arrange 
tab, choose Select Layout. 

2. On the Arrange tab, in the Position group, select Control Padding and then choose 
None, Narrow, Medium, or Wide, which the following screenshot depicts. 

 
Figure 38: The Control Padding options 

Examples of margins 

A margin set at None has almost no internal distance between the inside edge of the 
control and the contents of the control, as the following screenshot depicts. 

 
Figure 39: Margin set at None 

A margin set at Narrow has a small internal distance between the inside edge of the 
control and the contents of the control, as the following screenshot depicts. 

 
Figure 40: Margin set at Narrow 

A margin set at Medium has a moderate internal distance between the inside edge of 
the control and the contents of the control, as the following screenshot depicts. 
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Figure 41: Margin set at Medium 

A margin set at Wide has the maximum amount of internal distance between the inside 
edge of the control and the contents of the control, as the following screenshot depicts. 

 
Figure 42: Margin set at Wide 

To change the margins in a layout: 

1. In the Design or Layout view, select one cell in the layout, and then on the Arrange 
tab, select Select Layout. 

2. On the Arrange tab, in the Position group, select Control Margins and then choose 
None, Narrow, Medium, or Wide. 

 
Figure 43: The Control Margins options 
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Resize a layout 

 Changing the width or height of one form control will change all the controls in the 
layout column or row. To change the width, position the cursor over an edge until it 
becomes a double-headed arrow and then drag, as the following two screenshots 
depict. Alternatively, select the controls and then adjust the Width or Height property 
in the Property Sheet pane. 

 
Figure 44: Changing the width of one control in a layout changes all controls in the 
column 

 
Figure 45: Resizing a layout that contains a picture 

Resize multiple controls with Size/Space 
To resize several controls at the same time and apply the width/height setting of one of 
the selected controls for all the selected controls: 

1. Select the controls, as the following screenshot depicts. 
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Figure 46: All the controls are selected 

2. On the Form Design Tools contextual tab, in the Arrange tab, select Size/Space, 
and then select the option you want, as the following screenshot depicts. 

 
Figure 47: Choosing the To Shortest option to resize all controls to the shortest one 
that is selected 
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3. In the following screenshot, the height property of all the selected controls was 
changed to the height of the shortest control in the selection. 

 
Figure 48: The form after applying the To Shortest option; all the fields are the same 
height 

Move controls within a layout 
You can move controls within a layout by dragging them or by using ribbon commands. 
If necessary, add columns and rows to create space for the controls before you move 
them. To move controls within a layout: 

1. Open the form in Layout view. 

2. If you need to create columns or rows for the moved controls, select a cell in the 
layout, and then use the options in the Rows & Columns group on the Arrange tab 
in the Form Design Tools contextual tab. For example: 

o To insert a column to the right of the layout, select a cell in the last column and 
then select Insert Right. 

o To insert a row at the bottom of the layout, select a cell in the last row and then 
select Insert Below. The following screenshot highlights the options in the Rows 
& Columns group. 

 
Figure 49: Options in the Rows & Columns group 
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3. Drag the controls to the empty cells where you want them to be, as the following 
screenshot depicts. 

 
Figure 50: Drag the controls to empty cells to move them 

4. Select rows to move by pointing to the left of the rows until the cursor changes to a 
small black arrow and then drag to select the rows. Alternatively, select a cell in the 
row, and then on the Arrange tab, in the Rows & Columns group, choose Select 
Row. 

o To move a row, on the Arrange tab, select Move Up to move the selected row 
up, and select Move Down to move the selected row down. 

o To delete a row, select the Delete key. 

 
Figure 51: Dragging to select a row 

Activity: Show me how 
In this activity, observe your teacher briefly demonstrate the skills you’ll need in the 
upcoming try-it. 

Resources  
You’ll need the following resources for this activity: 

• None 
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Instructions 
To participate in this activity: 

• Pay attention to the methods that your teacher uses to modify positioning of 
controls in a layout, change margins and padding in a layout, and remove a control 
from a layout. 

• Be prepared to repeat these actions in the upcoming try-it. 
• Ask questions to clarify anything that isn't clear to you. 

Try-it: Modify positioning of controls in a layout 
 In this try-it activity, you’ll modify form layouts using tabular and stacked layouts. 

Resources 
You’ll need the following resources for this try-it: 

• Open L1_T3_try_csa_program_starter.accdb in this lesson’s Learning Activity 
Resources folder. 

Instructions 
The following are the general tasks that you need to perform during this try-it: 

1. Open the frmOrders_Tabular form. 

2. Change the Default View form property to Continuous Forms. 

3. Examine the form in Form view, save the form, and then close it. 

4. Open the frmFarmBoxes form. 

5. Change the layout in the frmFarmBoxes form so it is four columns and three rows.  

6. Arrange the controls in row 1 as follows: 

o Column 1: FarmBoxID label 
o Column 2: FarmBoxID field control 
o Column 3: no control 
o Column 4: no control 

7. Arrange the controls in row 2 as follows: 

o Column 1: FarmBoxName label 
o Column 2: FarmBoxName field control 
o Column 3: FarmBoxDescription label 
o Column 4: FarmBoxDescription field control 
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8. Arrange the controls in row 2 as follows: 

o Column 1: Weight label 
o Column 2: Weight field control 
o Column 3: TrackingNumber label 
o Column 4: TrackingNumber field control 

9. Change the layout margins to Medium, the layout padding to Narrow, adjust the 
row heights to .25", and adjust the column widths as follows: 

o Column 1: 1.25" 
o Column 2: 1.3" 
o Column 3: 1.3" 
o Column 4: 1.3" 

When you apply these dimensions to the form, your output will appear similar to the 
screenshot below. FarmBoxID, FarmBoxName, and Weight are in the first column, 
and FarmBoxDescription and TrackingNumber are in the second column. 

 

Figure 52: The changed frmFarmBoxes form 

10. In the frmOrders form, remove all the controls from the form layout. 
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Wrap-up 
Use these questions to check what you learned in this lesson: 

1. From what kinds of objects can you make forms in Access? 

Select all that apply. 

a. A single table 

b. Multiple tables 

c. Queries 

d. Reports 

2. Forms do not store data. 

Select the correct option. 

a. True 

b. False 

3. If you delete your form, all the data that you were working on in the form is also 
deleted. 

Select the correct option. 

a. True 

b. False 

4. What are the three default views in a form? 

Select the correct option. 

a. Design, Layout, and Vista 

b. Vista, Design, and Edit 

c. Form, Design, and Layout 

d. Edit, Form, and Layout 
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5. The form view that you can use to review the data in the underlying table while you 
edit the form is the: 

Select the correct option. 

a. Form view 

b. Property Sheet 

c. Layout view 

d. Datasheet view 

6. A form that is added to another form so you can work with the data in both tables at 
once is called a: 

Select the correct option. 

a. Connected form 

b. Subform 

c. Child record 

d. Form Wizard 

7. Before you can create a form with a subform, the tables involved need to have a 
relationship created in the Relationships window. What kind of relationship does it 
need to be? 

Select all that apply. 

a. One-to-many 

b. One-to-one 

c. Form-subform 

d. Many-to-many 
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Lesson 2: Customizing forms 
Overview 
In this lesson, you’ll customize and improve the appearance of forms by changing 
control properties, adding and arranging field controls, using layouts, and adding text 
and images. To strengthen Munson’s branding and make it easier to understand and 
use forms, you’ll adjust the tab order in a form, add logos and titles to forms, and add 
text and images in the form header and form footer. 

Warm-up 
In this warm-up activity, you’ll examine and use three forms and, with the help of a 
classmate, give feedback about each one. 

Resources  
You’ll need the following resources for this activity: 

• Open warmup_csa_program_starter.accdb in this lesson’s Learning Activity 
Resources folder. 

Activity instructions 
Participate in the activity by following these instructions: 

1. One by one, open and examine the three forms in the 
warmup_csa_program_starter.accdb database. 

2. Select the Tab key to tab through the fields in each form and notice how easy or 
hard, it is to use. Use your keyboard, not your mouse, to move between fields. 

3. Briefly discuss the following questions with a classmate and then note your answer. 
Be prepared to share your answer with the class. 

o Which form was easiest to understand immediately and why? 
 

o Which form was most pleasant or easiest to use and why? 
 

o Which form was most confusing or hardest to use and why? 
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Topic 1: Add, modify, and position 
controls 

 After you create a form for a database, you might discover that it needs some 
fixing. For example, you might get some feedback that understanding or using the form 
is difficult. You might also want to make fixes because: 

• The fields seem scattered on the form. 
• The order of fields is illogical when users tab through the form. 
• You might have deleted a field on the form that you now need. 
• The form might not have a control for a new field that you added to the underlying 

table. 
• You might want to add text, such as instructions, or images to the form. 

In this topic, you’ll learn how to add, modify, and position form controls by using the 
mouse or control properties (or both) to fix and enhance forms. You’ll also learn how to 
maximize the usability of forms by using form design principles and by modifying the 
tab order of a form. 

Use controls 
Controls are the parts of a form that you use to enter, edit, or display data. Some 
controls allow you to review and edit the data stored in tables, with each control being 
connected to a field in the underlying table. These are called bound controls. 

Some controls display on the form and are not connected to the underlying table. These 
are called unbound controls. 

There are many kinds of controls. In this lesson, you’ll learn about: 

• Text Box controls, which display text, numbers, dates, times, and memo fields. When 
you’re using the form, entering a value in a text box changes the value in the 
underlying table. Text boxes can also display calculated values. 

• Label controls, which contain fixed data that is not connected, or bound, to the 
underlying table. Use labels for headings, instructions, and other text. 

• List Box controls, which display a list of values from which to choose. List Box 
controls are typically bound to the underlying table, but not always. 

• Combo Box controls display a list of values from which to choose, or you can enter 
data in the control. Combo Box controls are typically bound to the underlying table, 
but not always. 
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• Line and Rectangle controls are used to add lines and rectangles to a form. 
• Image controls add a static image to the form. 

 

Did you know? 

You can enter text in an unbound Text Box control and add 
calculations that will perform text, numerical, date, or other functions. 
This is called a calculated control. 

For example, you can add an unbound Text Box control to a Form 
Header and enter =[FirstName]&” “&[LastName], as the following 
screenshot depicts. 

 
Figure 53: A calculated control in Design view 

In Form view, the calculated control will display the value in the 
current record’s FirstName field, a space, and then the value in the 
LastName field, as the following screenshot depicts. 

 
Figure 54: The calculated control in Form view, now displaying both 
field values separated by a space  

The calculation is entered directly in the control, but you can also 
enter it and review it in the Property Sheet pane, in the Control 
Source property, as the following screenshot depicts. 

 
Figure 55: The calculation in the Control Source property 
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Additional information 

For more information on controls, go to: Introduction to controls 

For more information on adding text box controls to forms, go to: Add 
a text box control to a form or report 

For more information on calculated controls, go to: Learn to build an 
expression 

For more information on using the Control Source property, go to: 
ControlSource Property 

Modify form control properties in the Property Sheet pane 
You can modify properties of a form and its controls, such as height, width, color, and/or 
location on the form in either Layout view or Design view. You can also caption text by 
changing properties in the Property Sheet pane. 

You can make many modifications by using several other methods, such as using the 
ribbon or your mouse. Although these methods seem familiar, using the Property 
Sheet pane is fast and consistent, especially when you have multiple controls to edit or 
if you do not use a mouse or other pointing device. In addition, there are properties that 
you can only change by using the Property Sheet pane, because they have no ribbon or 
context menu equivalent. The following screenshot depicts the Property Sheet pane 
and the properties for a form. 

 
Figure 56: The Property Sheet and the properties for a form 

  

https://aka.ms/Introduction-to-controls
https://aka.ms/Add-a-text-box-control-to-a-form-or-report
https://aka.ms/Add-a-text-box-control-to-a-form-or-report
https://aka.ms/learn-to-build-an-expression
https://aka.ms/learn-to-build-an-expression
https://aka.ms/ControlSource-Property
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To open the Property Sheet pane: 

1. Select the control or part of the form you want to change. 

2. Open the Property Sheet by selecting the Property Sheet button on the Form 
Layout Tools/Form Design Tools, Design tab, or select F4. 

The currently-selected object is displayed in the list box at the beginning of the 
Property Sheet pane. You can also edit the properties of another object by selecting a 
different object from this list. Another option is to select the object on the form; you do 
not need to close the Property Sheet pane. 

The properties available on the Property Sheet pane are organized into tabs by 
category. If you can’t find what you’re searching for, go to the All tab, which contains all 
the properties. 

Format controls 
You can format a control by changing its properties in the Property Sheet pane or by 
using the ribbon. To format a control: 

1. Select the control. 

2. Select F4 to open the Property Sheet pane and adjust the properties on the Format 
tab. 

Alternatively: 

1. Select the control. 

2. To format a label or text control, on the Home tab, in the Text Formatting group, 
select the font and alignment formatting options that you want to use, such as Font, 
Font Size, Bold, Italic, Font Color, or Background Color. 

3. To format a section or shape, on the Format tab, in the Control Formatting group, 
select Shape Fill, and then select a color. Be sure to use a font color and background 
color that have a high contrast so the text is legible. For example, if you use a light 
background, choose a dark color for text. Some buttons have list arrows, such as 
Font, Font Size, and Font Color, which give you a menu from which you can choose 
the option you want. The following screenshots depict the Font Color menu and the 
Shape Fill menu. 



Enhancing data interaction 
 

 
52 

 
Figure 57: The Font Color menu 

 
Figure 58: The Shape Fill menu 

Position and resize controls 
You can position (move) and resize controls by dragging or by adjusting the control 
properties on the Property Sheet pane. In Design view, if controls are not in a layout, 
you can resize and move them independently from any associated labels. 

Select multiple controls 
You can select multiple controls or labels using different methods before aligning them 
to one another or resizing them. These methods are: 

• Select the Shift or Ctrl key while selecting the controls. To deselect a control, select 
the Shift or Ctrl key while selecting that control again. 

• Drag a selection box around the controls. Note that by default, the selection box 
does not have to totally enclose the controls; it just needs to partially enclose them. 
You can change this setting in Access Options. Note that you can drag in any 
direction, as the following two screenshots depict. 

 
Figure 59: Drag the cursor so the square "box" touches the controls you want to select 
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Figure 60: Controls selected by dragging a box with the cursor 

• Click or drag in either ruler; whatever the “line” touches will become selected, as the 
following screenshot depicts. If you want to deselect a control, select the Ctrl key 
and then select that control. 

 
Figure 61: Selecting multiple controls by dragging in the ruler 

Move controls by dragging 
To move a control by dragging: 

1. Select the control. To move multiple controls, select Ctrl or Shift to select the 
controls or use the cursor to drag a box that partially encloses the controls. 

2. Drag the control from the middle of the control, or from an edge of the control that 
does not have a square handle, to a different location on the form. 

Tips: 

• Be sure the cursor is a white arrow with a four-headed arrow under it before you 
begin to drag. 

• By default, controls and their labels move together. 
• If you accidentally insert the cursor inside a control, select Esc to reselect the control. 

The following screenshot depicts this process. 

 
Figure 62: Drag an edge to move a control. 
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You can move a label independently of its control, which is useful if you want the label 
to be in a different position than the default “on the left” position of the control. You 
can do this by dragging or by setting the label and/or control Top and Left properties. 

To move a label independently of its control: 

1. Select the label or the control. 

2. Point your cursor over the solid square in the top-left corner of the object you want 
to move, and then drag it to reposition the label. The following two screenshots 
depict this process. 

 
Figure 63: The top-left corner handle to move labels and controls independently 

 
Figure 64: Drag to move the label 

Move controls by modifying the Top and Left properties 
You can move controls without a mouse or other pointing device by changing the 
properties of the control in the Property Sheet pane. Setting the Top and Left 
properties of a control moves the control and its label independent from one another 
and can be used as an alternate method to dragging the top-left corner handle. 

To move a control by setting its properties: 

1. Select the control or label control. 

2. Select F4 to open the Property Sheet pane. 

3. On the Format tab, position the cursor in the Top property box and enter a value, 
which is the distance between the top of the section that the control is in and the 
top of the control. 
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4. On the Format tab, position the cursor in the Left property box and enter a value, 
which is the distance between the left edge of the section that the control is in and 
the top of the control. 

Resize controls by dragging 
Each selected control has resize handles on each edge (1) and corner (2), which the 
following screenshot depicts. 

 
Figure 65: Resize handles 

When your cursor is over a resize handle, drag to resize the control, as the following 
screenshots depict. 

 
Figure 66: Dragging with a side handle to resize a control  

 
Figure 67: Selecting a corner resize handle 

 
Figure 68: Dragging with a corner handle to resize a control  
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Resize controls by modifying the Width and Height properties 
You can resize controls without a mouse or other pointing device by changing the 
properties of the control in the Property Sheet pane. Setting the Width and Height 
properties of a control resizes the control and can be used as an alternate method to 
dragging the resize handles. To change the dimensions of a control by modifying its 
properties: 

1. Select the control or label control. 

2. Select F4 to open the Property Sheet pane. 

3. On the Format tab, position the cursor in the Width property box and enter a value, 
which is the width of the control. 

4. On the Format tab, position the cursor in the Height property box and enter a value, 
which is the height of the control. 

Add controls to a form with the Field List pane 
There are many reasons to add a field to a form. For example, you might need to add a 
control that has been deleted from the form, or you might need a control for a new field 
that was added to the underlying table after the form was built. 

You can add controls in Layout view or Design view. To add a control to a form: 

1. Open the Field List pane by selecting the Design tab, and then in the Tools group, 
selecting Add Existing Fields. Alternatively, select Alt+F8. 

2. Drag a field from the Field List pane to the form. If you drag into a layout, let go of 
the mouse pointer after the cell becomes highlighted. 

 
Figure 69: Dragging a field from the Field List pane to a form layout 
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Note that some field types will create controls when you drag them to a form. For 
example, dragging a Yes/No field into a form will create a check box or other choice 
control, depending on the field’s settings in the underlying table. 

 

Additional information 

For more information about the Field List pane, go to: Learn more 
about the Field List pane 

For more information about adding fields to forms, go to: Add a field 
to a form or report 

For more information about inserting checkboxes, go to: Add a check 
box control to show Yes/No values 

For more information about adding list or combo boxes to forms, go 
to: Add a list box or combo box 

For more information about modifying your form using the Design 
View, go to: Fine-tune your form in Design view 

Add images 
You can add images to a form in Design view or Layout view. To insert an image: 

1. Open the form in Design view. 

o You can insert an image in Layout view, but it will either become an object in an 
existing layout or create a new layout. To add an image to a form without a 
layout, work in Design view. 

2. If you are inserting the image on a Form Header or Form Footer, be sure these are 
displaying on the form. 

3. On the Design tab, select Insert Image, select Browse, navigate to the image you 
want to use, select it, and then select OK. 

4. Drag the area on the form where you want the image, which creates an image 
control that is the size of the box you create by dragging. Alternatively, you can click 
or tap on the form, or select Enter, which inserts the image at its actual size. You can 
then resize the image by adjusting the Height and Width properties in the Property 
Sheet pane. 

https://aka.ms/Add-a-field-to-a-form-or-report-Field-List-pane
https://aka.ms/Add-a-field-to-a-form-or-report-Field-List-pane
https://aka.ms/Add-a-field-to-a-form-or-report
https://aka.ms/Add-a-field-to-a-form-or-report
https://aka.ms/Add-a-check-box-control-to-show-Yes-No-values
https://aka.ms/Add-a-check-box-control-to-show-Yes-No-values
https://aka.ms/Add-a-list-box-or-combo-box
https://aka.ms/Introduction-to-forms-fine-tune-in-design-view
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Figure 70: To control the size of the image on the form, insert an image by dragging 

5. If necessary, resize the image by dragging a corner handle toward the middle of the 
picture. Alternatively, select the image and then adjust the Size Mode, Height, and 
Width properties in the Property Sheet pane. 

An alternative method to insert an image is: 

1. With the form open in Design view, on the Design tab, select Insert Image. This 
inserts an image. 

2. Select F4 to open the Properties Sheet pane. 

3. With the Image control still selected, on the Property Sheet pane, on the Format 
tab, position the cursor in the Picture property box and then select Build. 

4. Browse to the picture you want to use, select it, and then select OK. 

 

Did you know? 

If the image is much larger than the section of the form where you 
place it, the size of the form section where you placed it will increase. 
This might mean you’ll need to resize that section of the form after 
resizing the image. 

A best practice is to use an app that resizes images to size the picture 
to approximately the correct size before you insert it on your form. 

  



Enhancing data interaction 
 

 
59 

Use the Size Mode property 
You can find the Size Mode property on the Format and All tabs in the Property Sheet 
pane. The following screenshot highlights this property on the Format pane. 

 
Figure 71: The Format tab in the Property Sheet for an image and the Size Mode 
choices 

Images have the following three possible Size Mode property settings: 

• Clip will “cut off” part of the picture if its container, such as a layout, is smaller than 
the image. The following screenshot depicts an image with this setting. 

 
Figure 72: Image in a layout with the Size Mode property of Clip 

• Stretch will stretch and probably distort the picture if the container is a different size 
or dimension than the image. The following screenshot depicts an image with this 
setting. 

 
Figure 73: Image in a layout with the Size Mode property of Stretch 
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• Zoom will resize the image to fit within the container without distorting it, which 
often makes it your best choice. The following screenshot depicts an image with this 
setting. 

 
Figure 74: Image in a layout with the Size Mode property of Zoom 

Delete controls and labels 
When you delete a control from a form, if it has an associated label, the label will also be 
deleted. However, when you delete a label, the control is not deleted. If you want to 
delete both the control and the label, delete the control. 

Use resizing and aligning techniques and tools 
In layouts, controls are already aligned, and you can resize multiple controls at the same 
time by resizing the layout. In Design view, however, aligning or resizing controls on a 
form can be tedious. The following list includes a few of the techniques and tools in 
Access that can save you time and frustration when you are formatting your form. 

Before you begin, if the ruler is not visible, on the Arrange tab, under Size/Space, under 
Grid, select Ruler. 

Snap to Grid 
Snap to Grid is a setting that when on, will cause your objects to line up to a visible or 
invisible grid. To turn Snap to Grid on or off, on the Form Design Tools contextual tab, 
in the Arrange tab, go to the Sizing & Ordering group, select Size/Space, and then 
select Snap to Grid. To display (or hide) the grid, on the Form Design Tools contextual 
tab, in the Arrange tab, go to the Sizing & Ordering group, select Size/Space, and 
then select Grid. The following screenshot highlights the Snap to Grid option in the 
Size/Space drop-down list. 
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Figure 75: Snap to Grid 

Align multiple controls 
Select multiple controls and then in the Arrange tab, in the Sizing & Ordering group, 
select the Align drop-down list, and then select the alignment option you want. The 
selected controls will move to align to the control that is farthest in that direction. 

 
Figure 76: The Align drop-down list 

In the following screenshot, three controls are selected. 

 
Figure 77: Controls selected 
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When you apply left-align, all the controls move to align their left edges to the edge of 
the control that is farthest left, as the following screenshot depicts. 

 
Figure 78: Left-align applied, all controls move to align with the left-most control's left 
edge 

 

 

Additional information 

For more information on form controls, go to: Introduction to controls 

Use anchoring to make controls resize or move with your form 
The Anchoring command changes the default behavior of form controls when a form is 
resized. Controls will, by default, stay anchored to the upper-left corner of the form and 
do not resize when you resize the form. When you apply anchoring options, you can 
configure controls to anchor to different corners of the form and stretch vertically, 
horizontally, or both to fill the available space. 

The following table lists the anchoring options available for controls that are not in a 
layout. 

Anchoring option Control is anchored to 
this corner of the form 

Resize / stretch behavior 
when the form is resized 

Top Left (default) Upper-left corner  Does not change size 

Stretch Down Upper-left corner  Stretches vertically and fills 
the available space 

Bottom Left Lower-left corner  Does not change size 

Stretch Across Top Upper-left corner  Stretches horizontally and 
fills the available space 

Stretch Down and Across Upper-left corner  Stretches vertically and 
horizontally to fill the 
available space 

https://aka.ms/Introduction-to-controls
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Anchoring option Control is anchored to 
this corner of the form 

Resize / stretch behavior 
when the form is resized 

Stretch Across Bottom Lower-left corner  Stretches horizontally and 
fills the available space 

Top Right Upper-right corner  Does not change size 

Stretch Down and Right Upper-right corner Stretches vertically and fills 
the available space 

Bottom Right Lower-right corner Does not change size 

Table 2: Anchoring options for controls that are not in a layout 

Use anchoring controls in a layout 
When you’re using a layout to organize your controls, if you specify the anchoring for 
one control in each layout, the anchoring of the other controls in the layout is set 
automatically, depending on whether the layout is Stacked or Tabular. The following 
table lists the anchoring options available for controls in a layout. 

Anchoring option Other controls in a Stacked 
layout 

Other controls in a Tabular 
layout 

Top Left (default) Top Left Top Left 
Stretch Down Controls above: Top Left 

Controls below: Bottom Left 
Stretch Down 

Bottom Left Bottom Left Bottom Left 
Stretch Across Top Stretch Across Top Controls to the left: Top Left 

Controls to the right: Top 
Right 

Stretch Down and 
Across 

Controls above:  Stretch 
Across Top  
Controls below:  Stretch 
Across Bottom 

Controls to the left: Stretch 
Down  
Controls to the right: Stretch 
Down and Right 

Stretch Across 
Bottom 

Stretch Across Bottom Controls to the left: Bottom 
Left  
Controls to the right: 
Bottom Right 

Top Right Top Right Top Right 
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Anchoring option Other controls in a Stacked 
layout 

Other controls in a Tabular 
layout 

Stretch Down and 
Right 

Controls above: Top Right 
Controls below: Bottom 
Right 

Stretch Down and Right 

Bottom Right Bottom Right Bottom Right 

Table 3: Anchoring options for controls that are in a layout 

Anchor a control 
The procedure to anchor a control is the same for controls that are in a layout as well as 
not in a layout. Perform the following steps: 

1. In the Navigation Pane, right-click or access the context menu for the form that you 
want to change, and then select Layout View. 

2. Open the form you want to change in Layout View. 

3. Select the control to which you want to apply anchoring. 

4. On the Arrange tab, in the Position group, select Anchoring. 

5. Select the option that you want. 

 

Additional information 

For more information on anchoring controls, go to: Make controls 
stretch, shrink, or move as you resize a form 

For more information on using anchoring with controls in a layout, go 
to: Special considerations when you use layouts 

Set document window options 
You can review the results of control anchoring when you resize: 

• The Access window, if the database is set to display objects as document tabs, which 
is the default setting. 

• The form window, if the database is set to display objects as overlapping windows. 

  

https://aka.ms/make-controls-stretch-shrink-or-move-as-you-resize-a-form
https://aka.ms/make-controls-stretch-shrink-or-move-as-you-resize-a-form
https://aka.ms/make-controls-stretch-shrink-or-move-as-you-resize-a-form-when-using-layouts
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To change the document window options for the current database: 

1. On the File tab, select Options and then select Current Database. 

2. In the Application Options section, for Document Window Options, select 
Overlapping Windows or Tabbed Documents. 

3. Close and reopen the database to review the change. 

When in Form view, drag the right or bottom edge of the window to resize it. 

 
Figure 79: Resizing a window by dragging the edge of a form 

Resize a form and controls when anchored 
You should resize the form and controls in Design view to the smallest possible size, 
while still ensuring that the label text or information in the underlying table are legible. 
There should be a minimum of empty design grid space below and to the right of the 
controls. Periodically switch to Layout view and check to ensure that the data is still 
legible. To resize a form: 

1. Switch to Design view. 

2. Resize controls in the form, especially those in the header and footer. The form 
cannot be narrower than the width of the controls. In other words, if one control is 6 
inches wide, you won’t be able to resize the form any narrower than 6 inches. 
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3. To resize the form itself, select and drag the right and bottom edge of the form. If 
you have a footer, drag the bottom edge of the Detail section of the form (just 
above the Form Footer band), as the following screenshot depicts. 

 
Figure 80: Resize the height of a form by dragging the bottom of the Detail section 

Alternatively, you can change the form’s size in the Property Sheet pane. In Design 
view, select the small box between the horizontal and vertical ruler, as the following 
screenshot depicts. Double-click this box to open the Property Sheet pane to edit 
Form properties. You can also select F4 to open the Property Sheet pane, and then 
select Form from the list. 

  
Figure 81: Selecting the box to open the Property Sheet pane 

Change the tab order on a form 
In Form view, you can select each field or use the Tab or Enter key to move from field to 
field. To make a form easier to use with a keyboard, you should make sure the order of 
fields, called the tab order, is intuitive. Usually, this is top-to-bottom, left-to-right. 

If the form controls are in a layout, this is the default tab order. When you manually 
create forms from a blank form or move controls on a form without a layout, you might 
create a tab order that is no longer logical and makes the form harder to use. 
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You can change the tab order in the Tab Order dialog box by selecting Auto Order, 
which creates an order based on the physical location of the controls (top-to-bottom, 
left-to-right). You can also select and then drag fields to create a custom order or 
change the Tab Index property for each control on the form. To change the tab order 
on a form: 

1. In the Navigation Pane, right-click the form or access its context menu and select 
Design View, or open the form and switch to Design View by using the View drop-
down list on the Home tab. 

2. On the Design tab, in the Tools group, select Tab Order. 

3. In the Tab Order dialog box, in the Section box, select the section you want to 
change: Form Header, Detail, or Form Footer. 

4. Do one of the following: 

o To create an automatic tab order that creates an order based on the physical 
location of the controls (top-to-bottom, left-to-right), select Auto Order. 

o To create a custom tab order, in the Custom Order box, select the control box 
for the control you want to move and then drag it to the desired location on the 
list. You can also select and drag the cursor to select multiple controls and then 
drag them to the desired location on the list. 

5. Select OK to apply the tab order change. The following screenshot depicts this 
procedure. 

 
Figure 82: Reordering controls in the Tab Order dialog box 
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An alternative way to change the tab order on a form is: 

1. Open the form in Design view and then select F4 to open the Property Sheet pane. 

2. On the form, select the control or, in the Property Sheet pane, choose the control 
from the list. 

3. On the Other tab, change the Tab Index property number to a value of 0 or more. 
Note that the Tab Index property numbering starts at zero, so the first control in the 
tab sequence is 0, the second is 1, the third is 2, and so on. The following screenshot 
depicts the Tab Index property number on the Other tab of the Property Sheet 
pane. 

 
Figure 83: The Tab Index property on the Other tab on the Property Sheet pane 

 

Additional information 

For more information on setting the tab order in forms, go to: Set the 
tab order for controls 

Activity: Show me how 
In this activity, observe your teacher briefly demonstrate the skills you’ll need in the 
upcoming try-it. 

Resources  
You’ll need the following resources for this activity: 

• None 

https://aka.ms/set-the-tab-order-for-controls
https://aka.ms/set-the-tab-order-for-controls
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Instructions 
To participate in this activity: 

• Pay attention to the methods that your teacher uses to work with controls on forms 
and anchor controls. 

• Be prepared to repeat these actions in the upcoming try-it. 
• Ask questions to clarify anything that isn't clear to you. 

Try-it: Add, modify, and position controls 
 In this leveled try-it, you’ll add, delete, and modify form controls, including adding 

and deleting controls, resizing and aligning controls, changing control properties, and 
anchoring controls. 

Try-it 1 
In this try-it, you’ll customize forms by adding text and images. You’ll then modify the 
components of the form by formatting, aligning, moving, and resizing controls. Finally, 
you’ll anchor the form elements so they remain anchored to various parts of the form 
when it is resized. 

Resources 
You’ll need the following resources for this try-it: 

• Open L2_T1_try1_csa_program_starter.accdb in this lesson’s Learning Activity 
Resources folder. 

• The following image from Media folder under Student Materials: 
o Farm_no_people_aerial_illustration.png 

Instructions 
The following are the general tasks that you need to perform during this try-it: 

1. Open L2_T1_try1_csa_program_starter.accdb. 

2. Open the frmMembers_PhoneList form in Design view. 

3. Resize the form to 8 inches wide, and resize the Detail section to be 1.5 inches in 
height. 

4. Add the Memo field at the 5.625 inch mark on the horizontal ruler. Move the label 
control so it is above the field control (Top property at .125”). 
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5. Align the left edge of the label with the field control at 5.625”. 

6. Select the label control and the field control, and then change the font formatting to 
Verdana (Header), Black, and 11 points. 

7. If necessary, widen the label so all the text is legible. If necessary, adjust the height of 
the Memo field control to .75 inches. 

8. Change the following Form properties: 

o Caption: Members Phone List 
o Default View: Continuous Forms 

9. Resize all the labels so they are all the same width as the First Name label, and then 
resize all the field controls so they are all the same width as the FirstName field. 

10. Align all the field controls on their left edges. 

11. Vertically align the labels with their associated controls and adjust them so they are 
equally spaced vertically. 

12. Add an image on the left side of the form and then size it so it is between 1 and 1.7 
inches wide. Set Top and Left properties to 0 (zero). Choose an image from the 
following: 

o Farm_no_people_aerial_illustration.png 
o Farm_girl_basket_of_produce_illustration.png 
o Munsons_Pickles_and_Preserves_Farm_sign_illustration.png 
o Food_farm_box_summer_illustration.png 
o Munsons_logo_square_illustration.png 

13. Anchor the Memo field control Stretch Across Top, anchor the Memo label control 
at Top Left, and leave all other controls anchored with the default of Top Left. Refer 
to the following screenshot to review how your form should appear. Note that there 
are multiple records, the picture and data controls repeat for each record, and the 
memo field appears slightly enlarged due to the anchoring property. 
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Figure 84: An example of the finished form 

14. Save the form. 

15. Examine the form in Form view and resize the form window to review how the 
anchoring works. 

16. Close the form and the database. 

Try-it 2 
In this try-it, you’ll format a form by adjusting a form layout, adding text and images, 
changing the size and properties of the form, and anchoring controls. 

Resources 
You’ll need the following resources for this try-it: 

• Open L2_T1_try2_csa_program_starter.accdb in this lesson’s Learning Activity 
Resources folder. 

• The following images from Media folder under Student Materials: 
o Food_strawberry_jam_illustration.png 
o Food_strawberry_whole_illustration.png 

Instructions 
The following are the general tasks that you need to perform during this try-it: 

1. Open frmPreserves in Layout view. 

2. Change the font for all controls to Verdana, 11pt, Black. 
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3. Change the labels to the following: 

o Preserves ID 
o Preserves Name 
o Preserves Description 
o Wholesale Cost/Jar 

4. Increase the width of column 1 so all the label text is legible. 

5. Decrease the width of column 2 to 3.5". 

6. Remove blank rows in the layout and then change the height of rows 1, 2, and 4 so 
they are the same height as row 1, which is approximately .25". 

7. In Design view, move the layout so the left top edge is at .5" on the vertical ruler 
and 2" on the horizontal ruler. 

8. Add an image to the left of the layout (at .2 inches vertically and 0 to .2 inches 
horizontally). Size it so the width fits in the space provided, with a width between 1.5 
inches and 2 inches). Choose from the following images: 

o Food_apricot_jam_illustration.png 
o Food_grape_jam_illustration.png 
o Food_strawberry_jam_illustration.png 
o Food_honey_jar_illustration.png 
o Munsons_Pickles_and_Preserves_Farm_sign_illustration.png 

9. Add a Label control at 2 inches on the horizontal ruler and then add the text 
Preserves Form. 

10. Format the text as Verdana, between 20 and 30 points, and a dark color from the 
Themes colors that complements the image you chose. Optionally, bold the text. 

11. Resize the label control so the text is legible. 

12. Change the Caption property of the form to Munson's Preserves. 

13. Add a smaller image on the bottom-right corner of the form, approximately 0.25 
inches square. The right edge of the image should align with the right edge of the 
layout, and it should not be behind or in front of any of the fields. 
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14. Resize the form to remove excess white space, view the form in Form view, save the 
form, and then close it. Refer to the following screenshot to review how your form 
should appear. Note the two images of different sizes on opposite corners of the 
form; the Preserves ID, Preserves Name, Preserves Description; and Wholesale 
Cost/Jar labels. 

 
Figure 85: An example of the finished Preserves form 

15. Add Anchoring to the four elements of your form as follows: 

a. The image in the top-left corner: Top Left 

b. The “Preserves Form” label: Top Right 

c. The layout: Stretch Across Top 

d. The image in the bottom-right corner: Bottom Right 

Topic 2: Add information to form 
headers and footers 

 In this topic, you’ll learn different ways to add form headers and footers. You’ll also 
learn how to format form headers and footers, including changing their height and 
properties, and adding titles and logos. 
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Add form headers and footers 
If you have used Microsoft Word or Microsoft Excel, you might be familiar with headers 
and footers as the content at the beginning and end of the page. However, unlike other 
programs, Access forms have two sets of headers and footers: 

• The page header and footer, which contain information such as page numbers, are 
used primarily for printing the form. 

• The form header and footer are used primarily when you’re using the form, on the 
screen. 

Information on a form header or footer might include: 

• Pictures, such as logos. 
• Buttons to navigate records. 
• Text, such as instructions or the phone number or email address for the person or 

department to contact for help with the data or form. 
• The title of the form. 
• Copyright information. 
• Controls that depict information about the record or set of records, such as a total. 

Forms that you review in Datasheet view will not have a header or footer. When you 
add a header to a form, the form footer is added at the same time. Access adds form 
headers and footers when you: 

• Create the form with the Form Wizard or the Form tool. 
• Add a title to the form by using the Title option. 
• Add a logo to the form by using the Logo option. 
• Add a form header or footer in the Design view. 
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To add a form header and footer: 

1. Open the form in Design view. 

2. Right-click or access the context menu for the Detail section of the form and then 
select Form Header/Footer, as the following screenshot depicts. 

 
Figure 86: Form Header/Footer option in the context menu 

Change dimensions of form headers and footers 
To change the height of a form header: 

1. Open the form in Design view. 

2. Position the cursor just above the Detail band until it becomes a double-headed 
arrow, and then select and drag up or down until the desired height is reached, as 
the following screenshot depicts. 

 
Figure 87: Adjusting the height of the Form Header with the mouse 
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Alternatively: 

1. Select F4 to open the Property Sheet pane, and then select FormHeader in the 
Property Sheet drop-down list. 

2. On the Format tab, enter a value in the Height property, and then select Enter. The 
following screenshot depicts FormHeader in the Property Sheet drop-down list and 
the Height property on the Format tab. 

 
Figure 88: FormHeader selected on the Property Sheet pane, and the Height 
property 

If a form has a form header, it will also have a form footer, although if its height 
property is set to zero, you won’t be able to review it or use it until you change the 
height. To change the height of a form footer: 

1. Open the form in Design view. 

2. Position the cursor just below the Form Footer band until it becomes a double-
headed arrow, and then select and drag down until the desired height is reached, as 
the following screenshot depicts. 

 
Figure 89: Adjusting the height of the Form Footer with the mouse 
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3. Alternatively: 

a. Select F4 to open the Property Sheet pane, and then select FormFooter in the 
Property Sheet drop-down list. 

b. On the Format tab, enter a value in the Height property, and then select Enter. 
The following screenshot depicts FormFooter in the Property Sheet drop-down 
list and the Height property on the Format tab. 

 
Figure 90: FormFooter selected on the Property Sheet pane, and its Height property 

Select form sections 
To change the properties for a form section (for example, to change the background 
color of the Form Header), select the band above the section you want to format, as the 
following screenshot depicts. 

 
Figure 91: Select the band labelled Form Header to select the Form Header section of the 
form 

Format a form section with properties 
You can format properties for sections on your form. As an example, you can format the 
background color of a section on a form by performing the following steps: 

1. Open the form in Design view and then select F4 to open the Property Sheet pane. 

2. In the Property Sheet pane, select the Format tab. 

3. In the Back Color property box, do one of the following: 

o Select Build and then select a color from Theme Colors, Standard Colors, 
Recent Colors, or More Colors. 

o Open the list and select a defined element color. 
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o Enter a number sign and then a six-digit hexadecimal color number; for example, 
#FFFFFF for white. The following screenshot depicts the process of selecting 
Build and then selecting a theme color for the Back Color property. 

  
Figure 92: Select Build to choose a color for the Back Color property 

Add a title to a form 
You can add a title to a form in Layout view or Design view by using the Title option on 
the Design tab within the Form Design Tools or Form Layout Tools tab. Adding a title 
will add a Form Header if the form doesn’t have one already. If there is a title already, 
the Title option will select the text in the title and allow you to edit it. 

The title is really a label control that is added to the form header in a layout. The layout 
has two columns: the first column contains an empty cell for an image or logo, and the 
second column contains the title label. 

Note that you can add a title to any form, including a datasheet form. However, form 
headers and footers are not available when the form is in Datasheet view. 
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To add a title: 

1. In the Layout view of the form, go to the Design tab within the Form Layout Tools 
tab, and then in the Header/Footer group, select Title. Alternatively, in the Design 
view of the form, go to the Design tab within the Form Design Tools tab, and then 
in the Header/Footer group, select Title. The following screenshot highlights the 
Design tab within the Form Layout Tools tab and the Title option in the 
Header/Footer group. 

 
Figure 93: The Title option on the Design tab in the ribbon 

2. Enter the title text and then select Enter. 

Add a logo to a form header 
You can add a logo to a form in Layout view or Design view by using the Logo option 
on the Design tab within the Form Design Tools or Form Layout Tools tab. Adding a 
logo in this way will add a Form Header to the form if the form doesn’t have one 
already. 

The logo is added to the form header in a layout. The layout has two columns: the first 
column contains the logo, and the second column contains a label in which you can add 
a title. 

 

Did you know? 

Some methods of creating forms automatically add a title and logo in 
a layout. The logo in this case is a default image that is like a form 
icon. Use the Logo option to replace that image with a picture of 
your own. 

Note that you can add a logo to any form, including a datasheet form. However, form 
headers and footers are not available when the form is in Datasheet view. 
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To add a logo: 

1. Open a form in Design view. 

2. In the Layout view of the form, go to the Design tab within the Form Layout Tools 
tab, and then in the Header/Footer group, select Logo. Alternatively, in the Design 
view of the form, go to the Design tab within the Form Design Tools tab, and then 
in the Header/Footer group, select Logo. The following screenshot highlights the 
Design tab within the Form Layout Tools tab and the Logo option in the 
Header/Footer group. 

 
Figure 94: The Logo option on the Design tab 

3. Browse to the picture you want to use, select it, and then select Open. 

4. Optionally, resize the picture by changing the Width and Height values in the 
Property Sheet pane or by resizing the layout with your cursor. 

 
Figure 95: Resizing the layout for a logo image and title 

5. Optionally, select Title to add a title to the same layout. 

 

Did you know? 

Access adds titles and logos to a Form Header in a form layout. If 
your Form Header does not have a layout, adding a title or logo will 
add one. This might interfere with any text or controls you already 
have in the Form Header. 

If you want to use the Title or Logo options, a good practice is to 
remove any labels or content in your header first. Alternatively, you 
can plan on removing the content (the title text or logo picture) from 
the layout after you add it. 
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Activity: Think-pair-share 
In this activity, you’ll brainstorm with a classmate about what information is appropriate 
for a form header or footer. 

Resources 
You’ll need the following resources for this activity: 

• Open L2_T2_act_csa_program_starter.accdb in this lesson’s Learning Activity 
Resources folder. 

Activity instructions 
1. Think about what kind of information you might include in the form header or footer 

for the tblPreserves table, which contains the data about the new line of preserves 
that Munson’s is going to sell. 

2. What information do you want to include in the header? 

 

3. What information do you want to include in the footer? 

 

4. Be prepared to share your ideas with the class. 

5. Follow along as your teacher demonstrates how to add information to a form header 
and footer. 

Try-it: Add information to form headers and 
footers 

 In this leveled try-it, you’ll add headers and footers, add titles and logos to 
headers, and add text to footers. 

Try-it 1 
In this try-it, add a title and a logo to the frmFarmBoxes form, format the form 
sections, and add an image to the footer. 
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Resources 
You’ll need the following resources for this try-it: 

• L2_T2_try1_csa_program_starter.accdb in this lesson’s Learning Activity 
Resources folder. 

• Munsons_Pickles_and_Preserves_Farm_sign_illustration.png and 
Munsons_logo_banner_illustration.png from the Media folder under Student 
Materials. 

Instructions  
1. Open L2_T2_try1_csa_program_starter.accdb. 

2. Add a logo to the frmOrders form. Use the 
Munsons_Pickles_and_Preserves_Farm_sign_illustration.png file. 

3. Resize the logo to 1 inch square and set its Size Mode property to Zoom. 

4. Add a title to the frmFarmBoxes form with this text:  
Munson's Pickles and Preserves 
Farm Boxes Orders 

o Hint: Select Shift+Enter to add an extra line before the text starts and after the 
word Preserves. 

5. Change the form header Back Color to White or, from the Theme Colors, select 
Background 1. 

6. Change the title font to Verdana 18, Bold, Dark Green Accent 1, Darker 25%. 

7. Change the height of the Form Footer to 1 inch. 

8. Add the Munsons_logo_banner_illustration.png image to the Form Footer. 
Change the size of the image control to the width of the footer, and then change its 
height to 1 inch. 

9. Resize the Height of the Form Footer to 1 inch. 

10. Examine the form in Form view, and then save and close the form. 

Try-it 2 
In this try-it, add a title and a logo to the frmPreserves form, format the form sections, 
and add contact information to the footer. 
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Resources 
You’ll need the following resources for this try-it: 

• L2_T2_try2_csa_program_starter.accdb in this lesson’s Learning Activity 
Resources folder. 

• Food_apricot_jam_illustration.png from the Media folder under Student 
Materials. 

Instructions 
1. Open L2_T2_try2_csa_program_starter.accdb. 

2. In the frmPreserves form, right-click or access the context menu for the Detail 
selection band, and then select Form Header/Footer. 

3. Resize the footer to .5 inch tall. 

4. Format the label text so it is a dark theme color such as Dark Green (Fore Color 
property: Accent 1). 

5. Change the form header and form footer Shape Fill (Back Color) to any Theme 
Color at 80% lighter. 

6. Alternatively, enter any of the following colors exactly as follows in the Back Color 
property box: 

o Accent 1, Lighter 80% 
o Accent 2, Lighter 80% 
o Accent 3, Lighter 80% 
o Accent 4, Lighter 80% 
o Accent 5, Lighter 80% 
o Accent 6, Lighter 80% 

7. Add this text to the footer in a Label control: For more information about 
Munson’s Preserves, please contact 
Hilary@Munsonspicklesandpreservesfarm.com. 

8. Format the footer text by changing its color to the darkest version of the theme 
color you chose for the background color of the form footer. 

9. Add the title Preserves Form, and then format the text so it is centered, 26 points, 
bold, and uses a theme color that complements the image you chose. 
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10. Add a logo by using one of the following images: 

o Food_strawberry_jam_illustration.png 
o Food_apple_illustration.png 
o Food_pear_cut_illustration.png 
o Food_grape_jam_illustration.png 
o Food_apricot_jam_illustration.png 
o Food_strawberry_jam_illustration.png 

11. Resize the layout in the form header so the image is approximately 1 inch square. 
The following screenshot depicts how your solution file should appear. Note that the 
form footer is about .5 inch tall. The label text is a dark green color. The form footer 
contains the text For more information about Munson’s Preserves, please 
contact Hilary@Munsonspicklesandpreservesfarm.com; this text uses the darkest 
version of the form footer’s background color. 

 
Figure 96: Completed form 

12. Examine the form in Form view, and then save and close it. 
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Wrap-up 
Use these questions to check what you learned in this lesson:  

1. To change attributes of a form control, you can use the: 

Select all that apply. 

a. Format Pane 

b. Property Sheet pane 

c. Property Pane 

d. Form Design Tools or Form Layout Tools tabs 

2. If you have a field control selected and then select the Delete key, what happens to 
the field control’s label? 

Select the correct option. 

a. Nothing, the label remains unchanged. 

b. The label is also deleted. 

c. The label moves on the form. 

3. If you have a label selected and then select the Delete key, what happens to the 
associated control? 

Select the correct option. 

a. Nothing, the control remains unchanged. 

b. The control is also deleted. 

c. The control moves on the form. 

4. Describe two ways in which you can resize multiple fields at once. 

Fill in the blank spaces. 

o ________________________ 
o ________________________ 
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5. Match the four options with what they add to a form: 

o This will add or edit a label control to the form header. 
o This will add or edit a graphic to the form header. 

Categorize the following items by adding the appropriate group name next to each 
item. 

a. The Title tool ________________________ 

b. The Logo tool ________________________ 

c. Creating a form with the Form Wizard ________________________ 

d. Selecting Insert Image and selecting the form header ________________________ 

Glossary 
Anchoring 
fields 

To anchor a field is to specify how the control will move or stretch if the 
form is resized. 

Associated 
labels 

Field controls by default have a label control that is associated with or 
connected to it. Therefore, when you move or delete a field control, its 
label also moves or is deleted. When you add a Label control to the 
Detail section of a form, the label will display an error and Error 
Checking Options menu that you can use to fix the error by associating 
the label to a field control. You can also ignore the error. 

Band The horizontal bar just before a section that you select to make 
formatting changes and that separates one section from another. 

Child table The table on the “many” side of a one-to-many relationship. The 
subform in a form and/or subform is based on the child table. 

Grid Invisible (optionally visible) equally-spaced vertical and horizontal lines 
to which you drag objects to help align them. 

Index A method of putting things in order. In the Property Sheet pane, you 
use the Tab Index property to change the position of the field controls 
in the tab order. The first field control in the Tab Index is zero (0). 

Layout A table-like structure you can use on forms and reports to help align 
controls. This works well in the Layout view. 
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Parent table The table on the “one” side of a one-to-many relationship. The main, or 
primary, form in a form and/or subform is based on the parent table. 

Subform A form within another primary form. A subform is based on a table that 
is related to the table of the primary form. 

Table 4: Glossary terms and definitions  
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Cornerstone 
Overview 
In this Cornerstone, you’ll enhance forms in an Access database to support a new line of 
Munson’s pickles and preserves. You’ll create a variety of forms to make working with 
the new data easier and faster. You’ll also create forms that use several tables so you 
can simultaneously work with data that is stored in more than one table. 

Objectives 
The following table outlines the Cornerstone objectives and their corresponding MOS 
exam objectives. 

Create datasheet 
forms, split forms, 
and single-table 
forms 

• Not mapped

Create multiple-
table forms 

• Not mapped

Change image’s 
Size Mode 
property to Zoom 

• OD 4.1.2.: Set form control properties

Add titles to form 
headers 

• 4.2.4: Insert information in form headers and footers

Add logos to form 
headers 

• 4.2.4: Insert information in form headers and footers
• 4.2.5: Insert images on forms

Change caption 
property 

• OD 4.1.2.: Set form control properties

Insert a form as a 
subform 

• 4.1.1. Add, move, and remove form controls
• 4.2.3. Modify form positioning

Modify label text • 4.1.3: Add and modify form labels
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Move and align 
controls not in a 
layout 

• OD 4.1.1.: Add, move, and remove form controls 
• 4.2.3. Modify form positioning 

Anchor controls in 
layouts and not in 
layouts 

• OD 4.2.3.: Modify form positioning 

Delete controls and 
labels 

• OD 4.1.3.: Add and modify form labels 

Set control 
properties (size, 
position, color, and 
other attributes) 

• OD 4.1.2.: Set form control properties 

Modify tab order • OD 4.2.1.: Modify tab order on forms 

Add images to 
headers and footers 

• OD 4.2.5.: Insert images on forms 
• OD 4.2.4.: Insert information in form headers and footers 

Add controls to a 
layout 

• OD 4.2.3.: Modify form positioning 

Table 5: Cornerstone objectives 

Duration 
50 minutes 

Instructions 
1. Complete the tasks below for each file. 

2. When saving your file, add your name to the end of the filename; for example, 
cornerstone_csa_program_Dwayne_Espino. Follow your teacher’s directions for 
where to save your files. 
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3. When you’re done with the Cornerstone, assess your completion and then enter the 
points you think you earned within the task lists below. You can use the help of your 
teacher if you need it. 

Tasks 
You’ll work with one file in this Cornerstone. The following are the tasks you need to do 
in the file. 

File: Cornerstone_csa_program_starter.accdb 

Task: Create and modify a single-table form (10 
points) 
1. Use the Form tool or the Form Wizard to create a single-table form based on the 

tblHoney table. Save it as frmHoney. (2 points) (Exam objective: n/a) 

2. Add a Logo to the form that is appropriate to the subject matter of the table and 
resize the logo to 1 inch. (2 points) (Exam objective 4.2.5: Insert images on forms) 

3. Change the Size Mode property to Zoom. (1 point) (Exam objective 4.1.2: Set form 
control properties) 

4. Add a Title to the form with this text: Munson’s Honey. Format the text with font 
size of 18pt or larger, bold, and a dark blue theme color. (4 points) (Exam objective 
4.2.4: Insert information in form headers and footers) 

5. Change the Form Caption to Honey Form. (1 point) (Exam objective 4.1.2: Set form 
control properties) 

Points scored: ________ / 10 
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Task: Create and modify a multiple-table form (11 
points) 
1. Use the Form Wizard to create a form based on the tblPreservesCategories and 

the tblPreserves tables. 

a. The main form should be the tblPreservesCategories table. 

b. The subform should be based on the tblPreserves table and have a datasheet 
layout. 

c. The form title should be frmPreservesCategories. 

d. The subform title should be frmsubPreserves. (8 points) (Exam objective: n/a) 

2. Move the subform so the left edge begins at 0.25", and resize it so that it is 7.5" 
wide. (2 points) (Exam objective 4.1.1: Add, move, and remove form controls) 

3. Modify the label text in the label control in the header to Preserves by Category. (1 
point) (Exam objective 4.1.3: Add and modify form labels) 

Points scored: ________ / 11 

Task: Anchor controls and layouts (5 points) 
1. Open frmOrders_anchored in Design view. Anchor the objects on the form as 

follows: (4 points) (Exam objective 4.2.3: Modify form positioning) 

a. Food_farm_box_spring_illustration.png image control: Top Left 

b. Munson’s Pickles and Preserves Farm Orders Form Label control: Stretch 
Across Top 

c. Any cell in layout: Stretch Across Top 

d. Image in Form Footer: Stretch Across Bottom 

2. Switch to Form view and resize the form window to review the positioning work. (1 
point) (Exam objective: n/a) 

Points scored: ________ / 5 
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Task: Modify the position of controls on a form (31 
points) 
1. Open the form frmsubOrders_and_Farmboxes in Design view. 

2. Change the font color for all the controls on the form to Automatic, or Black. 
(1 point) (Exam objective 4.1.3: Add and modify form labels) 

3. Delete the following field controls and their associated labels: (4 points) (Exam 
objective 4.1.1: Add, move, and remove form controls) 

a. MemberID 

b. tblOrders_FarmBoxID  

c. Price 

d. Weight 

4. Change the label text for all the labels as follows: (8 points) (Exam objective 4.1.3: 
Add and modify form labels) 

a. tblFarmBoxes_FarmBoxID to Farm Box ID 

b. OrderID to Order ID 

c. OrderDate to Order Date 

d. PickupDate to Pickup Date 

e. FarmBoxName to Farm Box Name 

f. FarmBoxDescription to Farm Box Description 

g. FarmBoxPrice to Farm Box Price 

h. OrderTotal to Order Total 
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5. Arrange the controls on the form so they are in the order as in this table, moving the 
Farm Box ID label and control beside the Order ID control. (8 points) (Exam 
objectives 4.1.1: Add, move, and remove form controls; 4.1.2: Set form control 
properties) 

Labels Field controls Labels Field controls 

OrderID  OrderID  Farm Box ID  Farm Box ID  

OrderDate  OrderDate   

PickupDate  PickupDate    

FarmBoxName FarmBoxName   

FarmBoxDescription FarmBoxDescription   

FarmBoxPrice FarmBoxPrice   

Quantity Quantity   

OrderTotal OrderTotal   

Table 6: Order of form controls 

6. Select the OrderID label and control and the Farm Box ID label and control, and 
move them to the top of the Detail section. Resize and adjust spacing between the 
four controls so no control obscures any other control. (4 points) (Exam objective 
4.2.3: Modify form positioning) 

7. Add all the remaining controls and labels to a Stacked layout and set the layout 
Control Margins to Narrow and Control Padding to Narrow. Move the layout so it 
is at the left edge of the Detail section and the top is approximately 0.3” from the 
top of the Detail section, just below the OrderID and Farm Box ID controls. (4 
points) (Exam objective 4.2.3: Modify form positioning) 

8. Resize the Detail section to 6" wide by 2" in height. (2 points) (Exam objective 4.2.3: 
Modify form positioning). 

9. Save and close the form. 

Points scored: ________ / 31 
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Task: Adjust the tab order on a form (9 points) 
1. Open frmsubOrders_and_FarmBoxes-2. 

2. Change the tab order to match the following table. (9 points) (Exam objective 4.2.1: 
Modify tab order on forms) 

Tab Index Control 

0 OrderID 

1 FarmBoxID 

2 OrderDate 

3 PickupDate 

4 FarmBoxName 

5 FarmBoxDescription 

6 FarmBoxPrice 

7 Quantity 

8 OrderTotal 

Table 7: Tab order 

Points scored: ________ / 9 

Task: Add a form as a subform to another form (16 
points) 
1. Open frmMember_Orders_main in Design view and add the 

frmsubOrders_and_FarmBoxes-3 form as a subform in the Detail section of the 
form so that the top of the subform is at 2.25” on the vertical ruler, and the left edge 
is at 0.25” on the horizontal ruler. Delete its Label control. (2 points) (Exam objective 
4.1.1: Add, move, and remove form controls) 

2. Add the Comments field from the Field List pane to the form after the subform. 
Move the label above the control and widen the control to approximately 6.5 inches. 
(2 points) (Exam objective 4.1.1: Add, move, and remove form controls) 
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3. Add a title to the form, using Member Information and Order Form as the Title 
text. Format the text to Green, Verdana, and 22 points. (2 points) (Exam objective 
4.1.1: Add, move, and remove form controls) 

4. Add a logo to the form and resize it to 1" by 1". Image suggestion: 
Farm_girl_basket_of_produce_illustration.png or any of the farm box images from 
the Media folder. (3 points) (Exam objectives 4.2.4: Insert information in form 
headers and footers; 4.2.5: Insert images on forms) 

5. Resize the Form Footer to 1.2” in height. (1 point) (Exam objective 4.1.2: Set form 
control properties) 

6. Add Munsons_logo_square_illustration.png to the left side of the Form Footer, 
sized at 1" by 1". (2 points) (Exam objectives 4.2.4: Insert information in form 
headers and footers; 4.2.5: Insert images on forms) 

7. Add this text to the Form Footer at the 2” mark on the horizontal ruler: At 
Munson’s, we believe in quality: Quality people and quality products. Format 
the font so it is Verdana, 11 points, and a dark grey color or color of your choice. 
(4 points) (Exam objectives 4.1.3: Add and modify form labels; 4.2.4: Insert 
information in form headers and footers) 

Points scored: ________ / 16 

FILE 1 TOTAL POINTS: ________ / 82 
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Module overview 
Description 
You now know how to design and set up the data structure, and add and edit data in a 
Microsoft Access 2019 database. You also know how to ask questions of data, present 
data, define data relationships, and streamline data entry. In this module, you’ll use and 
reinforce these skills while learning to present complex data. 

This module consists of three lessons in which you’ll learn how to use some of the 
reporting features of Access. When you get to the end of this module, you’ll be able to 
create and modify a report for multiple tables, customize reports, and use alternative 
outputs for data. The following table outlines the lesson objectives and their 
corresponding Microsoft Office Specialist (MOS) exam objectives. 

Lesson Learning objective MOS exam 
objective(s) 

Creating and 
modifying a 
report for 
multiple 
tables 

Create a multiple-table report with the 
Report Wizard and modify a report with a 
subreport. 

• 5.1.1 
• 5.1.3 
• 5.2.2 
• 5.2.3 

Customizing 
reports 

Add report controls and work with page and 
report headers and footers. 

• 5.1.2 
• 5.2.5 
• 5.2.6 

Using 
alternative 
outputs for 
data 

Configure print options for records, forms, 
and reports. Export a report to Excel, text, 
XML, and Portable Document Format (PDF).  

• 1.3.1 
• 1.3.2 

Cornerstone: 
Create a 
multiple-
table report 

Create a multiple-table report and edit it, 
configure report print options, and then 
export data to alternative formats. 

All the preceding 
exam objectives in 
this module. 

Table 1: MOS objectives by lesson 
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Scenario 
As winter approaches, it’s turning out to be the busiest time of year for your team. You 
need to present information on all the CSA program activities during the past year. The 
intent is to use this information to find out where some shortcomings occurred, and 
figure out how to avoid those situations the next year by identifying patterns and 
trends. You’ll present this data to Munson’s management in a clear format that is easy 
for them to understand and make comparisons in the future. 

Cornerstone 
This module concludes with a Cornerstone project in which you’ll: 

• Create a multiple-table report with a subreport. 
• Modify the report. 
• Add report controls. 
• Add information in page and report headers and footers. 
• Configure report print options. 
• Export objects to alternative formats. 
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Lesson 1: Creating and 
modifying a report for multiple 
tables 
Overview 
In this lesson, you'll learn how to create a multiple-table report with the Report Wizard 
and then modify that report with a subreport. You'll also learn how to add grouping and 
sorting, add display text with labels, and format report elements and layout. You’ll 
participate in discussions, follow step-by-step demonstrations, and explore where to 
find additional options and tools to put into practice what you learn along the way. 

Warm-up 
Use these questions to find out what you already know about this lesson’s topics: 

1. For a multiple-table report, which of the following statements are true? 

Select all that apply. 

a. You can join the tables logically on a common value. 

b. The Report Wizard uses the relationships between the tables you selected. 

c. Depending on the view you choose, the Report Wizard uses the relationships 
between the tables and groups records in reports, based on these relationships. 

d. All of the above. 

2. A subreport is a ________________________ that you insert in another report. 

Fill in the blank space. 

3. The Report Wizard is best used for: 

Select the correct option. 

a. Generating a report. 

b. Creating a select query. 

c. Opening the Relationships window. 

d. Building tables. 
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4. You use ________________________ controls to display values that come from fields in 
your database. The values can be text, dates, numbers, Yes/No values, pictures, or 
graphs. 

Fill in the blank space. 

5. What are the initial steps to modify a multiple-table report by adding a subreport? 

Indicate the correct sequence by adding numbers 1–4 next to the following items. 

a. Select the report to which you want to add a subreport. ________________________ 

b. Determine how to link the subreport to the main report. ________________________ 

c. On the report, select where you want to place the subreport. 
________________________ 

d. In the menu that appears, ensure that Use Control Wizard is selected, and then 
select the Subreport option from the controls gallery. - ________________________  

Topic 1: Create a multiple-table report 
with the Report Wizard 

 In Access, you can create a multiple-table report by using the Report Wizard. The 
Report Wizard helps you save time by using a series of guiding questions and then 
generating a report based on your answers. One of your first steps is to select your 
report's record source such as a multiple-table query. To create a multiple-table report 
by using the Report Wizard: 

1. On the Create tab, in the Reports group, select Report Wizard, which the following 
screenshot highlights. 

 
Figure 1: Report Wizard option 
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2. In the Report Wizard, on the Which fields do you want on your report? page, 
make the following selections: 

a. In the Tables/Queries drop-down list, select a multiple-table query as your first 
table record source. 

b. In the Available Fields list, select the field you want to include in your report, and 
then select the single arrow (>) button to move the field to the Selected Fields 
list. Alternatively, you can also select the double arrow buttons (>>) to select all 
fields to be displayed in the query results. The following screenshot depicts that 
the user has selected all the available fields to include in the report. After making 
your selections, select Next. 

 
Figure 2: Selecting record source 

3. On the How do you want to view your data? page, select to review by orders, and 
then select Next. 
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4. On the Do you want to add any grouping levels? page, select PickupDate, as 
depicted in the following screenshot. Select Next. 

 
Figure 3: Report Wizard grouping level option 

5. On the What sort order and summary information do you want for detail 
records? page, select to sort by PickupDate in ascending order. Select Next. 
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Figure 4: Report Wizard sorting option 

6. On the How would you like to lay out your report? page, select Layout and 
Orientation options, and then adjust to the field width so that all fields fit on a page. 
Select Next. 

7. Add a report title, select to preview the report, and then select Finish. 

8. Save the database. 

 

Did you know? 

The Report Wizard reviews the relationships between the tables you 
selected and, depending on the view you choose, groups records in 
your reports based on these relationships. 

 

Additional information 
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To review more information on creating Access reports, go to: Create 
a report by using the Report Wizard 

 

Caution 

This course uses database files that follow a general storyline for the 
CSA program at Munson’s Pickles and Preserves Farm. These 
database files are the Learning Activity Resource files that you’ll use 
to work on each module’s activities and try-its. Each Learning Activity 
Resource file contains the data and objects, such as tables, queries, 
forms, and reports, that you need to complete a corresponding 
activity. 

Due to this course’s modular nature, the objects and data in these 
files might vary across activities or try-its. Therefore, it’s important 
that you start your activities or try-its only with the designated files, 
as per applicable instructions. You also should note that screenshots 
in the topic content are for illustration purposes only and might 
appear different than those that are in the Learning Activity Resource 
files. 

Activity: Discuss and learn 
In this activity, you’ll follow the teacher-led group discussion on real-world scenarios for 
creating a multiple-table report. After the discussion, your teacher will demonstrate how 
to create a multiple-table report with the Report Wizard. 

Resources required 
The following optional resource is available for this activity: 

• None 

Activity instructions 
Participate in the activity by following these instructions: 

1. Observe the teacher demonstrate how to create a multiple-table report with the 
Report Wizard. 

2. Ask the teacher clarifying questions. 

3. Participate in the discussion. Remember that there is usually more than one way to 
do something. Share and discuss your ideas. 

https://aka.ms/Create-a-simple-report-using-report-wizard
https://aka.ms/Create-a-simple-report-using-report-wizard
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Try-it: Create a multiple-table report with the 
Report Wizard 

 In this standalone try-it activity, you'll create a multiple-table report. 

Resources 
You’ll need the following resources for this try-it: 

• Open L1_T1_try_background_starter.accdb in this lesson’s Learning Activity 
Resources folder. 

Instructions 
The following are the general tasks that you need to perform during this try-it: 

1. Open the Report Wizard. 

2. Select a multiple-table query. 

3. Select from the following corresponding fields to include in the report: 

o Optional: View the report by orders. 
o Optional: Group the date by pickup date. 
o Optional: Sort the pickup date in ascending order. 
o Optional: Generate a Stepped Layout and Landscape Orientation. 

4. Give your report a title, review your report, and then select Finish.  

5. Save the database. 

Topic 2: Modify a report with a 
subreport 

 Munson's management team wants to review a report of produce orders and 
pickup dates, as well as review information about the members who placed the order. 
You think a subreport is a useful tool to accomplish this task because it helps display in 
a logical way both the produce order information and member information. 
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A subreport is a report that you insert in another report. When you combine reports, 
one of them must serve as the main report that contains the other report. Typically, a 
main report is either bound or unbound. When you modify a report by creating a bound 
subreport, the reports will contain information with related data. This linking of related 
data helps ensure that the records displayed in the subreport correspond correctly to 
the records printed in the main report, as depicted in the following screenshot. 

 
Figure 5: Example of a (1) main report and a (2) subreport that are bound to related record 
sources 

To modify a report with a subreport: 

1. Select an existing multiple-table report to modify, such as rprtOrderPickupbyDate, 
and then from the Home tab, in the Views group, select the View drop-down list, 
and then select Design View. 

a. Decide the placement of your subreport. The report grid depicts the placement of 
each grid in the report. On the main report, select the spot in which you want to 
place the subreport. 

b. After you create additional space in the detail section, on the Design tab, in the 
Controls group, select Subform/Subreport. 

c. Select the spot in the detail grid in which you want to place the report. The 
SubReport Wizard appears. 
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2. On the What data would you like to use for your subform or subreport? page, 
select the subreport record source you’d like to include in the report as depicted in 
the following screenshot, and then select Next. 

 
Figure 6: SubReport Wizard depicting the selection of record data source options 

3. On the Would you like to define which fields link your main form to this 
subform yourself, or choose from the list below? page, select Define my own. 
This gives you the option of selecting the fields that are common to the primary 
report's Form/report fields and Subform/subreport fields, as depicted in the 
following screenshot. Note: If the wizard cannot find suitable fields for linking, it 
does not provide a list of linking suggestions and automatically selects the Define 
my own option. Select Next. 
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Figure 7: SubReport Wizard depicting how to define which fields to link 

4. On the What name would you like for your subform or subreport? page, enter a 
name for your subreport as depicted in the following screenshot, and then select 
Finish. 

 
Figure 8: SubReport Wizard - Subreport name 

5. On the last page of the wizard, enter a name for the subform or subreport, or just 
select Finish to accept the default. 
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Did you know? 

After you add a subreport to an existing report, you can practice more 
of your report formatting skills by modifying your report in Layout 
view. 

 

Additional information 

To learn more about creating and using subreports, go to: Create and 
use subreports. To learn more about modifying your report in Layout 
view, go to: Modify, edit, or change a report. 

  

https://aka.ms/Create-and-use-subreports
https://aka.ms/Create-and-use-subreports
https://aka.ms/Modify-edit-or-change-a-report
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Add grouping and sorting in reports 
When creating reports, you’ll need to consider how you want to display the information; 
for example, by grouping and sorting the data. In this activity, you'll continue to practice 
adding data grouping and sorting options to an existing multiple-table report. To do so: 

1. While in Design view, from the Design tab, select Group & Sort. The Group, Sort, 
and Total section displays, as depicted in the following screenshot. 

 
Figure 9: Group & Sort option in report 

2. In the Group, Sort, and Total section: 

a. Select a Group on option, such as PickupDate. 

b. Select a Sort by option, such as PickupDate. 

3. Save the database. 
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Did you know? 

Information is often easier to understand when you divide it into 
groups. For example, a report that groups produce sales by region can 
highlight trends that otherwise might go unnoticed. In addition, 
placing totals such as sums or averages at the end of each group in 
your report can replace tedious manual calculations. This is especially 
helpful if your reports are designed for highlighting end-of-year sales 
performance and comparisons to the following year's projects. Access 
makes it easier for you to work with grouped reports. 

 

Additional information 

To learn more about grouping or sorting in reports, go to: Create a 
grouped or summary report 

Modify report display text with labels 
When creating reports, you’ll need to consider the report's design and how you want to 
display characteristics such as display text with labels. To make changes, perform the 
following general steps: 

1. In Design view, from the Design tab, open an existing multiple-table report. 

2. Add additional grouping and sorting, if you prefer. 

3. Modify the existing Report Header display text title; for example, you can change it 
to Order Pickup by Date. 

4. Modify existing display text with label headers as you prefer. 

5. To add a new field to the report with display text, on the Design tab, select Add 
Existing Fields in the Tools group.  

6. Review the information contained in the table. To do this, double-click the fields to 
be included in the report or select those fields, and then select Enter. 

7. Go to Reports view to generate the report with the data. 

8. Save the database. 

https://aka.ms/Create-a-grouped-or-summary-report
https://aka.ms/Create-a-grouped-or-summary-report
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Did you know? 

When you view a report in Design view, the report is not actually 
running in Design view, so you cannot review the underlying data 
while working. 

 

Additional information 

To review more information about adding display text to reports, go 
to: Add a text box control to a form or report 

Modify report elements and positioning 
When creating reports, you also need to consider the report's design layout and 
common report modifications that you can perform in Layout view. You can use the 
following steps to modify some report design elements for an existing report. 

1. On the Home tab, in the Views group, select View, and then select Design View. 

2. When the edit grids appear, to modify a column or field in Layout view: 

a. Select an item in a column that you want to adjust. A border appears around the 
item to indicate that the field is selected. 

b. Drag the right or left edge of the border until the column is the width you want. 

  

https://aka.ms/Add-a-text-box-control-to-a-form-or-report
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Alternatively, you can adjust report property values in the Property Sheet pane. To 
open the Property Sheet pane, on the Design tab, in the Tools group, select 
Property Sheet. You can also open the Property Sheet pane by selecting Fn+F4. 
Make edits to the report properties by adjusting the property values for the selected 
item, as depicted in the following screenshot: 

 
Figure 10: Property Sheet pane for a report 
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You can also select the Report drop-down list in the Property Sheet pane and then 
choose the option you want to modify, as depicted in the following screenshot. 

 
Figure 11: Modifying a report option in the Property Sheet pane 

3. Make the required modifications, and then save your report. 

 

Additional information 

To learn more about modifying, editing, or changing a report, go to: 
Modify your report in Layout view 

  

https://aka.ms/Modify-your-report-in-Layout-view
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Activity: Think-pair-share 
In this activity, you’ll follow along as the teacher leads a discussion about why and how 
to add a subreport in a report. 

Resources required 
The following optional resource is available for this activity: 

• None 

Activity instructions 
Participate in the activity by following these instructions: 

1. Partner with a classmate. 

2. Working with your partner, think of at least two report format element features that 
can be useful in customizing your reports. 

3. Participate in the discussion. Remember there is usually more than one way to do 
something. Share and discuss your ideas. 

Try-it: Modify a report with a subreport 
  In this leveled try-it activity, you’ll modify a report by adding a bound subreport 
and adding formatting elements to the report. The existing report doesn't provide 
information about the member who placed the order. You'll add a subreport to display 
that information. 

Try-it 1 
In this try-it activity, you’ll modify a report by adding a bound subreport and editing 
labels. 

Resources 
You’ll need the following resources for this try-it: 

• Open L1_T2_try1_background_starter.accdb in this lesson’s Learning Activity 
Resources folder. 
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Instructions 
The following are the general tasks that you need to perform during this try-it: 

1. Open rptOrderPickupInfo in Design view. 

2. Select the Detail section selector, and in the Property Sheet pane, change the 
Height to 1”. 

3. On the Design tab, select Subform/Subreport. 

4. Select a location in the Details section to open the SubReport Wizard. 

5. In the wizard, select Use an existing report or form and ensure that rptMembers is 
selected. Use the following information to complete the process: 

a. On the Would you like to define which fields link your main form to this 
subform yourself, or choose from the list below? page, select Define my own. 

b. In the first drop-down in Form/report fields, select MemberID. 

c. In the first drop-down in Subform/subreport fields, select MemberID. 

d. On the What name would you like for your subform or subreport? page, edit 
the text to Member. 

e. Save and close rptOrderPickupInfo. 

6. Open rptMembers in Design view. 

7. Delete the header, and then save and close rptMembers. 

8. Open rptOrderPickupInfo in Design view, and then select and delete the Member 
Label label. 

9. Select the Member Subform/Subreport control, in the Property Sheet pane, 
change the Border Style property to Transparent. 

10. In the Property Sheet pane: 

a. Change the Height property to .25”. 

b. Change the Top property to .25”. 

c. Change the Left property to 1.25”. 

11. Select the Detail section selector, and in the Property Sheet pane, set the Height 
property to .75”. 

12. Save the report and open it in Report view. 
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Try-it 2 
In this try-it activity, you’ll modify a report by adding a bound subreport with grouping 
and sorting. You’ll also modify labels. 

Resources 
You’ll need the following resources for this try-it: 

• Open L1_T2_try2_background_starter.accdb in this lesson’s Learning Activity 
Resources folder. 

Instructions 
The following are the general tasks that you need to perform during this try-it: 

1. Open rptOrderPickupInfo in Design view, and on the Design tab, ensure that 
Group & Sort is enabled. 

2. In the Group, Sort, and Total pane, select Add a group and select MemberID. 

3. Select Add a sort and select MemberID. 

4. Select the Detail section selector, and in the Property Sheet pane, change the 
Height to 1”. 

5. On the Design tab, select Subform/Subreport. 

6. Select a location in the Details section to open the SubReport Wizard. 

7. In the wizard, use the following information to complete the process: 

a. On the What data would you like to use for your subform or subreport? 
page, select Use an existing report or form and ensure rptMembers is 
selected. 

b. On the Would you like to define which fields link your main form to this 
subform yourself, or choose from the list below? page, select Define my own. 

c. In Form/report fields, select MemberID. 

d. In Subform/subreport fields, select MemberID. 

e. On the What name would you like for your subform or subreport? page, edit 
the text to Member. 

f. Select Save, and then close rptOrderPickupInfo. 

8. Open rptMembers in Design view. 

9. Right-click or access the Report Header context menu, and delete the header. 

10. Save and close rptMembers. 
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11. Open rptOrderPickupInfo in Design view. Note that the member information is 
displayed, but it includes an unnecessary border, Member displayed before each 
record, and excess space. 

12. Delete the Member Label label. 

13. Select the Member Subform/Subreport control and in the Property Sheet pane, 
change the Border Style property to Transparent. 

14. In the Property Sheet pane: 

a. Change the Height property to .25”. 

b. Change the Top property to .25”. 

c. Change the Left property to 1.25”. 

15. Select the Detail section selector, and in the Property Sheet pane, set the Height 
property to .75”. 

16. Save the report and open it in Report view. 

Wrap-up 
Use these questions to check what you learned in this lesson: 

1. Controls can be: 

Select all that apply. 

a. Bound 

b. Unbound 

c. Rebounded 

d. Calculated 

2. What are some of the display options you should consider when creating a report? 

Select all that apply. 

a. The report's design 

b. The display of the report 

c. Use of text and labels 

d. All the above 
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3. Which of the following are general tasks for formatting reports? 

Select all that apply. 

a. Grouping and sorting data 

b. Adding display text with labels 

c. Formatting report elements 

d. Modifying report positioning 

4. A subreport must contain a ________________________ that you can use to link it to the 
main report. 

Fill in the blank space. 

5. The following are the general steps to modify a report by adding a subreport: 

Indicate the correct sequence by adding numbers 1–4 next to the following items. 

a. Use the Subreport Wizard to create the subreport. ________________________ 

b. Define your own report fields and subreport fields. ________________________ 

c. Select where you want to place the report. ________________________ 

d. Open the main report in Design view. ________________________   
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Lesson 2: Customizing reports 
Overview 
In this lesson, you'll learn to customize reports by adding report controls to an Access 
report and working with page and report headers and footers. You’ll participate in 
discussions, follow step-by-step demonstrations, and have opportunities to put into 
practice what you learn along the way. 

Warm-up 
Use these questions to find out what you already know about this lesson’s topics: 

1. Which of the following options are examples of page and report customizations?

Select all that apply.

a. Edit the report header

b. Edit the report footer

c. Edit the page header

d. Edit the page footer

2. What type of report control should you create to make a calculated control?

Select the correct option.

a. Bound

b. Unbound

c. Calculated

d. Expression

3. When you select More in the Grouping dialog box, which of the following settings
can you use to customize the sorting and grouping of fields in reports?

Select all that apply.

a. Date and Time formatting

b. Font formatting

c. Headers and footers

d. Sorting and grouping intervals
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4. A control whose source of data is an expression, rather than a field, is called a 
________________________ control. 

Fill in the blank space. 

5. What is the procedure to add calculated fields to enhance reports? 

Indicate the correct sequence by adding numbers 1–4 next to the following items. 

a. Select the Build command to use the Expression Builder. ________________________ 

b. Add a text box control. ________________________ 

c. Enter an expression in the Expression Builder. ________________________ 

d. Enter an Expression Builder in its control source property in the property sheet. 
________________________ 

Topic 1: Add report controls 
 Your manager at Munson's asked for a summary of produce orders categorized by 

month. Munson's management also want to include in the report summary the total 
weight of produce that was ordered. You think building an Access report with the help 
of report controls can help with this task. 

Add calculated fields 
By adding a calculated field to a report, you can display many different types of data 
and use them to perform calculations. To do this: 

1. Right-click or access the context menu for the report in the Navigation Pane, and 
then select Design View. 

2. On the Design tab, in the Controls group, select the type of control you want to 
create. 

3. Position the cursor at the point on which you want to place the control on the form 
or report, and then select the report into which to insert the control. 

4. If a control wizard starts, select Cancel to close it. 
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5. Select the control, select F4 on your keyboard to display the property sheet, and 
then enter an expression in the ControlSource property box. 

a. To use the Expression Builder to create the expression, select Builder next to 
the ControlSource property box. 

b. Switch to Report View and verify that the calculated control works as you expect. 

6. Save your modified report. 

 

Did you know? 

A good way to create a calculated control is by first creating a bound 
control. To do so, you can first drag a field from the Field List pane to 
your report, or right-click or access the context menu for the field, and 
then select Add Field to View. You can then edit the bound control's 
ControlSource property to create an expression. This works well if you 
make sure that the name of the control does not conflict with any of 
the field names contained in the expression. If you want to adjust the 
control to suit your needs by changing its property values on the 
Property Sheet, select the F4 key (or Fn+F4). 

 

Additional information 

To learn more about calculated controls, go to: Create a calculated 
control 

Insert images 
1. In the Navigation Pane, right-click or access the context menu for the report, and 

then select Layout View. 

2. On the Design tab, in the Header/Footer group, select Logo. 

3. Browse to the folder that contains your logo file and then double-click the file or 
select it, and then select Enter on your keyboard. The logo is then added to the 
report header. 

 

Additional information 

To learn more about how to insert a logo into a report, go to: Insert a 
logo into a form or report 

https://aka.ms/create-a-calculated-control
https://aka.ms/create-a-calculated-control
https://aka.ms/Insert-a-logo-into-a-form-or-report
https://aka.ms/Insert-a-logo-into-a-form-or-report
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Insert information in page and report headers and 
footers 
1. On the Home tab, select View, and then select Design View. 

2. When the edit grid appears, review the information in the page and report headers 
and footers as you consider appropriate content to include in the design of the 
report, using the following list as reference and as depicted in the screenshot: 

o The report header typically includes the report title, logo, and current date. 
o The report footer typically includes report totals. 
o The page header typically includes a report title. 
o The page footer typically includes a page number. 

 
Figure 12: Sample header and footer in a report 

 

Did you know? 

It is helpful to first make a sketch of a report. You can use this process 
to first consider how to arrange the data, especially if you are 
designing a report for someone else. 
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Additional information 

For more information on designing reports, go to: Guide to designing 
reports 

Activity: Show and tell 
In this activity, your teacher will demonstrate how to add report controls. 

Resources required 
The following optional resource is available for this activity: 

• None 

Activity instructions 
Participate in the activity by following these instructions: 

1. Observe the teacher demonstrate report controls and how to add calculated fields 
and images in the report. 

2. Ask the teacher clarifying questions. 

3. Participate in the discussion. Remember there is usually more than one way to do 
something. If you think of a different way to try doing a task, share and explore your 
ideas with the class. 

Try-it: Add report controls 
 In this leveled try-it activity, you’ll add report controls and modify header and 

footer information. 

Try-it 1 
In this try-it, you'll practice adding report controls and will add a calculated field. 

Resources 
You’ll need the following resources for this try-it: 

• L2_T1_try1_members_starter.accdb in this lesson’s Learning Activity Resources 
folder. 

  

https://aka.ms/Guide-to-designing-reports
https://aka.ms/Guide-to-designing-reports
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Instructions 
The following are the general tasks that you need to perform during this try-it: 

1. Open rptMemberSummary in Design view. 

2. Select an empty location in the Details section to add a Text Box control. Note that 
Access will add a Text Box named Text15 and a corresponding Label named 
Label16. On upcoming steps, take care to select the correct control. 

3. Delete Label16. 

4. Select the new Text Box, which is named Text15 and displays the text Unbound, 
and make the following changes in its Property Sheet pane: 

a. Change the Top property to 0”. 

b. Change the Left property to 5.15”. 

c. Change the Border Style property to select Transparent. 

d. Change the Text Align property to select Center. 

5. Select the Text15 text box again, and enter the following text: 
=[Weight]*[Quantity]. This formula multiplies the weight by the quantity. 

6. To test the formula, on the Design tab, select the View command. Confirm that the 
report displays the days between the two dates for each record. 

7. On the Design tab, select Design View. 

8. On the Design tab, use the Controls gallery to select Label. 

9. Select an empty location in the Details section to place the Label control. Enter the 
text Order Details:, and then, in the Property Sheet pane: 

a. Change the Top property to 0”. 

b. Change the Left property to 1.6”. 

c. Change the Fore Color property to select Text Black. 

10. Select the Design section selector and in the Property Sheet pane, change the 
Height to .25”. 

11. Select Save. 
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Try-it 2 
In this try-it, you’ll review and modify your page and report header and footer 
information. 

Resources 
You’ll need the following resources for this try-it: 

• Open L2_T1_try2_members_starter.accdb in this lesson’s Learning Activity 
Resources folder. 

Instructions 
The following are the general tasks that you need to perform during this try-it: 

1. Open rptMemberSummary in Design view. 

2. On the Design tab, in the Controls group, select Text Box. 

3. Select an empty location in the Details section to place the Text Box. 

Note that Access will add a Text Box named Text12 and a corresponding Label named 
Label13. On upcoming steps, take care to select the correct control. 

4. Delete the new Label that contains the text Text12. 

5. Select the new Text Box, which is named Text12 and displays the text Unbound, 
and make the following changes in its Property Sheet pane: 

a. Change the Top property to 0”. 

b. Change the Left property to 5.15”. 

c. Change the Border Style property to Transparent. 

d. Select the Text Align property and select Center. 

6. Select the Text12 text box again, which will position the cursor in the Text Box to 
input a formula, and input the following text: =[Weight]*[Quantity]. This formula 
multiplies the weight by the quantity. 

7. To test the formula, on the Design tab, select the View command. Confirm that the 
report displays the days between the two dates for each record. 

8. On the Design tab, select Design View. 

9. On the Design tab, in the Controls group, use the Controls gallery to select Link. 

10. In the Insert Hyperlink dialog box, enter 
http://www.munsonspicklesandpreservesfarm.com in the Address box. 
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11. Enter Pickup date subject to change as the Text to display box. Note that Access 
will add the link as a Label in the Page Footer section. 

12. Select the new Label with the link and drag it to an empty location in the Details 
section. In the Property Sheet pane: 

a. Change the Top property to 0.25”. 

b. Change the Left property to 2.6”. 

13. Select the Design section selector, and change the Height property to .5”. 

14. Select Save. 

Topic 2: Work with page and report 
headers and footers 

 Now, suppose you want to add some customizations to ensure the report appears 
professional and in a clear format that is easy for Munson's management to review. You 
think adding information to the report page and report headers and footers of the 
Access report can help. The following table depicts a list of the typical information you’d 
include in page and report headers and footers. 

Section Location Typical contents 

Report 
header 

Appears once, at the beginning of the first 
page of the report 

• Report title 
• Logo 
• Current date 

Report footer Appears after first line of data, before the 
page footer that is on the last page of the 
report 

Report totals, such 
as sums, counts, 
and averages 

Page header Appears at the beginning of each page of the 
report 

• Report title 
• Page number 

Page footer Appears at the end of each page of the 
report 

• Current date 
• Page number 
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Section Location Typical contents 

Group header Appears just before a group of records Field that you are 
grouping on 

Group footer Appears just after a group of records Group totals, such 
as sums, counts, 
and averages 

Table 2: Typical information to include in page and report headers and footers 

Insert information in report headers and footers 
1. On the Home tab, select View, and then select Design View. 

2. When the edit grid appears, review the information in the page and report headers 
and footers as you consider appropriate content to include in the design of the 
report, using the following list as reference and as depicted in the example 
screenshot: 

a. Insert information in page header and footer. 

b. Delete the report date from the page header 

c. Add a report date to the page footer. 

d. Insert information in report header and footer. 

e. Modify the Report Header, for example, "Farm Box Orders Summary". 

f. Add a display label for any calculated fields in the report. 
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Figure 13: Report view 

 

Additional information 

To learn more about adding information in report and page headers 
and footers, go to: Insert the date and time into a report or form, 
PageHeader Property, or: Add or remove report or page header and 
footer sections. 

Activity: Think-pair-share 
In this activity, follow along as your teacher demonstrates how to enhance a report by 
adding information in the page and report headers and footers. 

Resources required 
The following optional resource is available for this activity: 

• None 

Activity instructions 
Participate in the activity by following these instructions: 

1. Observe the teacher demonstrate how to work with page and report headers and 
footers to customize an existing report. 

2. Ask the teacher clarifying questions. 

https://aka.ms/Insert-the-date-and-time-into-a-report-or-form
https://aka.ms/pageheader-property
https://aka.ms/Guide-to-designing-reports-report-page-header-footer
https://aka.ms/Guide-to-designing-reports-report-page-header-footer
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3. Participate in the discussion. Remember there is usually more than one way to do 
something. If you think of a different way to try doing a task, share and explore your 
ideas with your teacher and class. 

Try-it: Work with page and report headers and 
footers 

 In this standalone try-it, you'll insert information in page and report headers and 
footers. 

Resources 
You’ll need the following resources for this try-it: 

• L2_T2_try_members_starter.accdb in this lesson’s Learning Activity Resources 
folder. 

• Munsons_logo_banner_illustration.png in the Media folder under Student 
Materials. 

Instructions 
The following are the general tasks that you need to perform during this try-it: 

1. Open rptMemberSummary in Design view. 

2. On Design tab, in the Header / Footer group, select Logo, and then insert 
Munsons_logo_banner_illustration.png. 

3. In the Property Sheet pane: 

a. Change the Height property to 0.5”. 

b. Change the Width property to 1.75”. 

c. Change the Top property to 0”. 

d. Change the Left property to 2.5”. 

4. Select the Report Header section selector, and in the Property Sheet pane, change 
the Height property to 0.5”. 

5. On the Design tab, select Label from the Controls gallery. 

6. Select an empty location near the Quantity heading in the Page Header section to 
place the Label control. Enter the text Total Weight. 
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7. In the Property Sheet pane: 

a. Change the Top property to 0.05”. 

b. Change the Left property to 5.15”. 

c. Change the Fore Color property to select Text Black. 

8. On the Design tab, in the Header / Footer group, select Date and Time. 

9. In the Date and Time dialog box, in Format, disable the Include Time check box, 
and then select OK. 

Wrap-up 
Use these questions to check what you learned in this lesson: 

1. You can add a calculated field to a report by first adding a ________________________ 
box control and then entering an expression in its ControlSource property in the 
property sheet. 

Fill in the blank space. 

2. Which operators can you enter by using the Expression Builder? 

Select all that apply. 

a. - 

b. + 

c. Almost 

d. Between 

3. Which of the following settings for customizing fields that are grouped in reports is 
not available when you select More in the Grouping dialog box? 

Select the correct option. 

a. Footers and headers 

b. Time and date formatting 

c. Grouping and sorting intervals 

d. Formatting fonts 

4. ________________________ that you insert by using the Image command become part of 
the data and you can reuse them on other Access objects or update them from the 
image gallery. 

Fill in the blank space. 
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5. A good way to change a bound control to a calculated control is to: 

Indicate the correct sequence by adding numbers 1–4 next to the following items. 

a. Drag a field from the Field List pane to your report. ________________________ 

b. Create a calculated control by first creating a bound control. 
________________________ 

c. Edit the bound control's ControlSource property to create an expression. 
________________________ 

d. Switch to Layout view and verify that the calculated control works as you expect. 
________________________ 
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Lesson 3: Using alternative 
outputs for data 
Overview 
In this lesson, you’ll learn how to configure print options for records, forms, and reports. 
You’ll also learn how to use alternative outputs for data and practice how to export a 
query to Microsoft Excel, text, and XML. You’ll also learn how to export a report to PDF. 
You’ll participate in discussions, follow step-by-step demonstrations, and explore where 
to find additional options and tools.  

Warm-up 
Use these questions to find out what you already know about this lesson’s topics: 

1. The XML acronym stands for: 

Select the correct option. 

a. Extreme Markup Language 

b. Extended Markings Language 

c. Extensible Markup Language 

d. None of the above 

2. Which of the following statements about reports are true? 

Select all that apply. 

a. Print Preview is a static view that depicts how the printed pages will appear on 
the report. 

b. Report view is more interactive, and hyperlinks are enabled in it. 

c. The Report Wizard command is part of the Queries group. 

d. You can apply filters in Report view. 
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3. When configuring report page setup options, which of the following print options 
can you select? 

Select all that apply. 

a. Margins 

b. Print data only 

c. Split form 

d. All of the above 

4. When exporting text files from Access, at the end of the operation, Access creates a 
________________________ file. 

Fill in the blank space. 

5. What is the procedure to export a report to PDF? 

Indicate the correct sequence by adding numbers 1–4 next to the following items. 

a. Open the table or report you want to publish as a PDF. ________________________ 

b. In the File name box, enter a name for the document. ________________________ 

c. In the Save as type list, select PDF (*.pdf). ________________________ 

d. On the External Data tab, in the Export group, select PDF or XPS. 
________________________ 

Topic 1: Configure view and print 
options for records, forms, and reports 

 After you create your report, you can set options for the print layout in the Page 
Setup dialog box. These options help you customize the format with options for margin 
settings, using gridlines and columns, or printing only the data from the report without 
the formatting. 

Configure print options 
To set the print page options: 

1. In the Navigation Pane, right-click or access the context menu for the report, and 
then select Print Preview. The print preview for the report appears. 

2. On the Print Preview tab, in the Page Layout group, select Page Setup. 
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3. In the Page Setup dialog box, on the Print Options tab, you can configure the 
settings for the following, as depicted in the screenshot: 

a. Margins by decreasing or increasing the default margins as required. You'll be 
able to preview the changes displayed in a Sample page. 

b. The Print Data Only option, when you don’t want to print the layout features in 
the report such as grids. 

c. Select OK. 

 
Figure 14: Print Page Setup option 

4. In the Page Setup dialog box, on the Page tab, you can configure settings for the 
following, as depicted in the screenshot. 

 
Figure 15: Print Page Setup option for layout 

a. Orientation, by selecting Portrait or Landscape. 

b. Paper Size and Source.  
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c. Printer for customer address. You can select Default Printer for default options. 
You can select Use Specific Printer if you want to set several other printers and 
document format options, as depicted in the following screenshot. Select OK 
after your selection. 

 
Figure 16: Print Page Setup option for printer selection 

5. In the Page Setup dialog box, on the Columns tab, you can configure settings for 
the following. 

a. Grid Settings to select the Number of Columns, Row Spacing, and Column 
Spacing. 

b. Column Size to select the width and height of the columns. Select the Same as 
Detail check box if you want to print the column in the same size as you set in 
the report. To adjust the column width and height, clear the Same as Detail 
check box and enter new values. 

c. Column Layout to select the direction in which you want the columns printed. 
This option is available only when you have more than one column. 
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6. Select OK after your selection. The following screenshot depicts the display you use 
to configure these settings. 

 
Figure 17: Configure Page Setup Option for grid settings 

Note: If the setting is for a single column, the Column Spacing and Column Layout 
options won't be available. 

7. To customize the margins on your report, on the Print Preview tab, in the Page Size 
group, select the Margins drop-down box, and then select a suitable option. A 
preview of the report with the changed margin settings displays. 

 

Additional information 

To learn more about set print options in Access, go to: Set print 
options in Access 

Activity: Think-pair-share 
In this activity, follow along as your teacher demonstrates how to configure view and 
print options for records, forms, and reports. 

Resources required 
You’ll need the following resources for this activity: 

• None 

https://aka.ms/Set-print-options-in-Access
https://aka.ms/Set-print-options-in-Access


Presenting complex data 
 

 
45 

Activity instructions 
Participate in the activity by following these instructions: 

1. Observe the teacher demonstrate how to configure view and print options. 

2. Ask the teacher clarifying questions. 

3. Participate in the discussion. Remember there is usually more than one way to do 
something. If you think of a different way to try doing a task, share and explore your 
ideas with your teacher and classmates. 

Try-it: Configure view and print options for 
records, forms, and reports 

  In this standalone try-it activity, you'll configure view and print options. 

Resources 
You’ll need the following resources for this try-it: 

• Open L3_T1_try_members_starter.accdb in this lesson’s Learning Activity 
Resources folder. 

Instructions 
The following are the general tasks that you need to perform during this try-it: 

1. Open the Print Preview for rptMemberSummary. 

2. On the Print Preview tab, select Portrait for page layout and Letter for size. 

3. On the Print Preview tab, select Page Setup, and in the Page Setup dialog box: 

a. Change Top to 1. 

b. Change Bottom to 1. 

c. Change Left to .25. 

d. Change Right to .25. 

4. Select Close Print Preview. 
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Topic 2: Export a query to Excel, text, 
and XML 

At times, you might have to share your Access reports with other people in different 
file formats. This could be because of personal preference or because some people 
cannot use Access to review your reports. You can export your Access reports to 
different formats such as Excel files, text files, XML files, and PDF files. 

Export a query to an Excel file 
When you export data to Excel, Access creates a copy of the selected data and then 
stores the copied data in a file that you can open in Excel. 

1. If Excel is open, close it before you continue. 

2. In Access, in the Navigation Pane of the source database, select the object that you 
want to export. 

3. On the External Data tab, in the Export group, select Excel, as depicted in the 
following screenshot. 

 
Figure 18: Export data to Excel file option 

4. In the Export - Excel Spreadsheet dialog box, review the suggested File name, the 
Excel File format, and the Specify export options section. To review the file after 
the export operation is complete, be sure to select the Open the destination file 
after the export operation is complete check box. Select OK. The following 
screenshot depicts the Export - Excel Spreadsheet dialog box. 
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Figure 19: Export - Excel File example, select the destination field 

5. When the Export - Excel Spreadsheet dialog box appears, you can choose to save 
the export steps so that you can quickly repeat the operation again in the future. To 
do so, select the Save export steps check box, and then select Close. 
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Did you know? 

When exporting a query to Excel, if you find that just a few values are 
missing, you can fix them in the Excel workbook. Otherwise, you can 
fix the source object in the Access database and then repeat the 
export operation. 

 

Additional information 

To learn more about exporting data to Excel, go to: Export data to 
Excel 

Export a query to a text file 
When you export data to text, Access creates a copy of the selected data and then 
stores the copied data in a file that you can export as a text file that a destination 
program can use. To export data to a text file: 

1. Close the destination program if it is open. 

2. In Access, in the Navigation Pane of the source database, select the object that you 
want to export. 

3. On the External Data tab, in the Export group, select Text File, as depicted in the 
following screenshot. 

 
Figure 20: Export data to text file option 

  

https://aka.ms/Export-data-to-Excel
https://aka.ms/Export-data-to-Excel


Presenting complex data 
 

 
49 

4. In the Export – Text File dialog box, specify the destination file name and format. In 
the Specify export options section, specify the export options. The following 
screenshot depicts the Export – Text File dialog box. 

 
Figure 21: Export - Text File example, select the destination field 

5. If you want to open the destination program after the export operation is complete, 
select the Open the destination file after the export operation is complete check 
box. Select OK. 

6. In the Encode As dialog box, select the file format that you want. By default, 
Windows (default) is selected. Select the appropriate option, and then select OK, as 
depicted in the following screenshot. 
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Figure 22: Encode - Text File format dialog box options example 

7. In the Export – Text File dialog box, you can save the export steps so that you can 
quickly repeat the operation in the future. To do so, select the Save export steps 
check box, and then select Close, as depicted in the following screenshot. 

 
Figure 23: Export TXT file save 
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Did you know? 

You cannot append data to an existing text file. 

 

Additional information 

To learn more about exporting data to a text file, go to: Export data to 
a text file 

Export a query to XML 
When you export data to XML, Access creates a copy of the selected data and then 
stores the copied data in a file that you can export as an XML file. To export data to an 
XML file: 

1. If the destination program is open, close it before you continue. 

2. In Access, in the Navigation Pane of the source database, select the object that you 
want to export. 

3. On the External Data tab, in the Export group, select XML File, as depicted in the 
following screenshot. 

 
Figure 24: Export data to XML file option 

  

https://aka.ms/Export-data-to-a-text-file
https://aka.ms/Export-data-to-a-text-file
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4. In the Export – XML File dialog box, specify the destination file name and format, 
and then select OK, as depicted in the following screenshot. 

 
Figure 25: Export - XML File example, select the destination field 

5. In the Export XML dialog box, which the following screenshot depicts, select the file 
format that you want to use, and then select OK. The default option is Data (XML). 

 
Figure 26: Export XML dialog box 
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6. In the Export – XML File dialog box, you can save the export steps so that you can 
quickly repeat the operation in the future. To do so, select the Save export steps 
check box, and then select Close, as depicted in the following screenshot. 

 
Figure 27: Save export steps 

 

Additional information 

To learn more about exporting data to XML, go to: XML for the 
uninitiated 

Activity: Show me how 
In this activity, follow along as the teacher leads a discussion about alternate options for 
exporting data and demonstrates the steps to export a query to Excel, text, and XML. 

  

https://aka.ms/xml-for-the-uninitiated
https://aka.ms/xml-for-the-uninitiated
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Resources required 
You’ll need the following resources for this activity: 

• None. 

Activity instructions 
Participate in the activity by following these instructions: 

1. Partner with a classmate. Follow along with the teacher’s demonstration steps. 

2. In this activity, collaborate with your partner by sharing your favorite Access options 
for exporting data. 

3. Participate in the discussion. Remember there is usually more than one way to do 
something. 

4. Share and discuss your ideas. 

Try-it: Export a query to Excel, text, and XML 
 In this leveled try-it activity, you'll practice exporting data to Excel, text, and XML 

files. 

Try-it 1 
Resources 
You’ll need the following resources for this try-it: 

• Open L3_T2_try1_background_starter.accdb in this lesson’s Learning Activity 
Resources folder. 

Instructions 
The following are the general tasks that you need to perform during this try-it to export 
data to Excel: 

1. If necessary, close Excel, and then, in L3_T2_try1_background_starter.accdb, select 
rptMembers, and on the External Data tab, select Excel. 

2. In the Export - Excel Spreadsheet dialog box, on the Select the destination for 
the data you want to export page, enter L3_T2_try1_background_solution.xls as 
the destination file and save it as an Excel 97 - Excel 2003 Workbook. 

3. In the Export - Excel Spreadsheet dialog box, review the default options in the 
Specify export options section, and then select OK. 
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4. On the Save Export Steps page, leave the check box clear, but for future reference, 
you can save the export steps by selecting the Save export steps check box. 

5. Select Close. 

Try-it 2 
Resources 
You’ll need the following resources for this try-it: 

• Open L3_T2_try2_background_starter.accdb in this lesson’s Learning Activity 
Resources folder. 

Instructions 
The following are the general tasks that you need to perform during this try-it to export 
data to text: 

1. If necessary, close any destination programs for .txt files, and then in 
L3_T2_try2_background_starter.accdb, select rptMembers, and on the External 
Data tab, select Text File. 

2. In the Export – Text File dialog box, enter L3_T2_try1_background_solution.txt as 
the destination file, and save it using the option Text Files. 

3. On the Select the destination for the data you want to export page, review the 
default options and then select OK. 

4. In the Encode dialog box, review the encoding options, and then select OK. 

5. On the Save Export Steps page, leave the check box clear, but for future reference, 
you can save the export steps if you want by selecting the Save export steps check 
box. 

6. Select Close. 

Try-it 3 
Resources 
You’ll need the following resources for this try-it: 

• Open L3_T2_try3_background_starter.accdb in this lesson’s Learning Activity 
Resources folder. 
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Instructions 
The following are the general tasks that you need to perform during this try-it to export 
data to XML. 

1. If a destination program is open for XML, close it, and then, in 
L3_T2_try3_background_starter.accdb, select rptFarmBoxOrders_L3, and on the 
External Data tab, select XML File. 

2. In the Export – XML File dialog box, select Browse, and enter 
L3_T2_try3_background_solution.xml as the destination file, save it as XML, and 
then select OK. 

3. In the Export XML dialog box, verify that the Data (XML) check box is selected, and 
then select OK. 

4. On the Save Export Steps page, select Close. 

Topic 3: Export a report to PDF 
 PDF is a common format for sharing final versions of files for viewing online or for 

printing reports using commercial printers. This topic explores how to export a report to 
PDF. 

Export a report to PDF 
To export a report to a PDF file: 

1. Close the destination program if it is open. 

2. In the Navigation Pane of the source database, select the object that you want to 
export. 

3. On the External Data tab, in the Export group, select PDF or XPS, as depicted in 
the following screenshot. 

 
Figure 28: Export data to PDF file option 
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4. In the Publish as PDF or XPS dialog box, in the File name field, enter a name for the 
document. 

5. In the Save as type drop-down box, select PDF (*.pdf). 

6. Select Options, and then in the Options dialog box, set the range you want to print, 
choose whether to print markup, and select PDF output options. Select OK, as 
depicted in the following screenshot. 

 
Figure 29: Save as type 

7. Select Publish. Save your database. 

 

Did you know? 

Adding accessibility tags to PDF files makes it easier for screen readers 
and other assistive technologies to read and navigate a document by 
using Tables of Contents, hyperlinks, bookmarks, and alt text. 
Accessibility tags also make it possible to read the information on 
different devices, such as large type displays, personal digital 
assistants (PDAs), and mobile phones. 

 

Additional information 

To learn more about creating accessible PDFs, go to: Create accessible 
PDFs 

Activity: Show me how 
In this activity, follow as the teacher leads a discussion and demonstration about 
alternate options for exporting data to PDF. 

  

https://aka.ms/create-accessible
https://aka.ms/create-accessible
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Resources required 
You’ll need the following resources for this activity: 

• None 

Activity instructions 
Participate in the activity by following these instructions: 

1. Partner with a classmate. 

2. In this activity, collaborate with your partner by sharing your favorite alternative 
outputs for data by exporting a query to Excel, text, XML, and PDF. 

3. Participate in the discussion. Remember there is usually more than one way to do 
something. Share and discuss your ideas. 

Try-it: Export a report to PDF 
  In this standalone try-it activity, you'll practice exporting a report to PDF. 

Resources 
You’ll need the following resources for this try-it: 

• Open L3_T3_try_background_starter.accdb in this lesson’s Learning Activity 
Resources folder. 

Instructions 
The following are the general tasks that you need to perform during this try-it to export 
a report to PDF: 

1. Close any destination programs, and then, in L3_T3_try_background_starter.accdb, 
select rptMembers, and on the External Data tab, select PDF or XPS. 

2. In the Publish as PDF or XPS dialog box, enter 
L3_T3_try_background_solution.pdf, and save as PDF. 

3. Select the options to open the file after publishing is complete, and to use minimum 
size. Select Publish. Review the PDF. 

4. In Access, in the Export – PDF dialog box, leave the Save export steps check box 
clear, and then select Close. 
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Wrap-up 
Use these questions to check what you learned in this lesson: 

1. Alternative object export options for queries and/or reports include: 

Select all that apply. 

a. .TXT 

b. .PSD 

c. Excel 

d. XML 

2. Adding accessibility tags to PDF files makes it easier for: 

Select the correct option. 

a. Screen readers to hide unnecessary data. 

b. Assistive technologies to read and navigate the document. 

c. Non-mobile devices to read and navigate the document. 

d. You to edit screen reader files for ease of use. 

3. If Access does not include a Save As command for an alternative object format, you 
must use the commands in the __________________________ group to copy the data.  

Fill in the blank space. 

4. Access creates a ________________________ file when you don’t need formatting to 
create a delimited or fixed-width file. 

Fill in the blank space. 

5. What is the procedure for exporting reports to a PDF format? 

Indicate the correct sequence by adding numbers 1–4 next to the following items. 

a. Follow the prompts in the Export dialog box. ________________________ 

b. Select the destination for the data you want to export. ________________________ 

c. Select PDF as your export type. ________________________ 

d. Open and review the source database. ________________________  
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Glossary 
Bound control A control whose source of data is a field in a table or query is 

called a bound control. You use bound controls to display 
values that come from field records in your database. The 
values can be text, dates, numbers, Yes/No values, pictures, 
or graphs. For example, a text box that displays a member's 
last name might get this information from the Last Name 
field in the Members table. 

Bound report A report is either bound or unbound. A bound report is one 
that can display data and has a table, query, or SQL 
statement specified in its Record Source property. 

Calculated control A control whose source of data is an expression rather than a 
field is called a calculated control. You specify the value that 
you want to use as the source of data in the control by 
defining an expression. 

Controls Controls are the parts of a form or report that you use to 
enter, edit, or display data. 

Expression An expression can be a combination of operators, such as 
"=" and/or "+", control names, field names, functions that 
return a single value, and constant values. 

.PDF Portable Document Format (PDF) is a common format for 
sharing final versions of files. A PDF format preserves 
document formatting and enables file sharing. When the PDF 
format file is viewed online or printed, it retains the format 
that is intended. The PDF format is also useful for documents 
that will be reproduced using commercial printing methods. 
PDF is accepted as a valid format by many agencies and 
organizations, and viewers are available on a wider variety of 
platforms than XPS. 
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Report Wizard The Report Wizard guides users through a series of 
questions and then generates a report based on users' 
responses. 

.txt Access creates a text file (*.txt) when you don’t need 
formatting to create a delimited text file where each record 
appears on its own line and the fields are separated by a 
single character (called a delimiter). The same applies for a 
fixed-width text file where each record appears on a separate 
line, and the width of each field remains consistent across 
records. 

Unbound control A control that doesn't have a source of data (such as a field 
or expression) is called an unbound control. You use 
unbound controls to display information, pictures, lines, or 
rectangles. For example, a label that displays the title of a 
form is an unbound control. 

Unbound report An unbound report is not based on a table, query, or SQL 
statement; that is, the Record Source property of the report 
is empty. 

XML Extensible Markup Language (XML) in documents contains 
data that is surrounded with tags where the tags define the 
structure and meaning of the data. 

Table 3: Glossary terms and definitions 
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Cornerstone 
Overview 
In this Cornerstone, you’ll create and modify reports, add report controls, and add 
information in page and report headers and footers. You’ll then configure report print 
options and then export queries to alternative formats. 

Objectives 
The following table outlines the Cornerstone objectives and their corresponding MOS 
exam objectives. 

Create and modify 
reports with 
complex data. 

• 5.1.1: Group and sort fields on reports 
• 5.1.2: Add report controls 
• 5.1.3: Add and modify labels on reports 

Add report 
controls. 

• 5.1.2: Add report controls 
• 5.2.2: Modify report positioning 
• 5.2.3: Format report elements 
• 5.2.6: Insert images on reports 

Work with page 
and report headers 
and footers. 

• 5.2.3: Format report elements 
• 5.2.5: Insert information in report header and footer 

Configure print 
options. 

• 1.3.1: Configure print options for records, forms, and 
reports 

• 5.2.4 Change report orientation 

Export a query to 
various file formats. 

• 1.3.2: Exports objects to alternative formats 

Export a report to 
PDF format. 

• 1.3.2: Exports objects to alternative formats 

Table 4: Cornerstone objectives 
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Duration 
50 minutes 

Instructions 
1. Complete the tasks for each file. 

2. When saving your file, add your name to the end of the filename, for example: 
“Background_Espino”. Follow your teacher’s directions for where to save your files. 

3. When you’re done with the Cornerstone, assess your completion and enter the 
points you think you earned within the task lists. You can accept the help of your 
teacher if required. 

Tasks 
You'll work with one file in this Cornerstone. The following are the tasks you need to do 
within that file: 

File 1: Cornerstone_harvest_starter.accdb 
Task: Create and modify reports with complex data (10 points) 
1. Add a subreport control to rptEmployees. (3 points) (Exam objective 5.1.2) 

2. Reposition the subreport control and modify a label. (2 points) (Exam objective 5.1.3) 

3. Use Report Wizard to create a multi-table report. (3 points) 

4. Add grouping and sorting to new report. (2 points) (Exam objective 5.1.1) 

Points scored: _________ / 10 

Task: Add report controls (6 points) 
1. Add a logo to rptHarvestDates. (1 point) (Exam objective 5.2.6) 

2. Resize and reposition the logo. (1 point) (Exam objective 5.2.2) 

3. Add calculated control to rptCropHarvesting_subreport. (3 points) (Exam objective 
5.1.2) 

4. Format the calculated control. (1 point) (Exam objective 5.2.3) 

Points scored: _________ / 6 
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Task: Work with page and report headers and footers (4 points)  
1. Add a label to the Report Header in rptEmployees. (1 point) (Exam objective: 5.2.5) 

2. Format the label. (1 point) (Exam objective: 5.2.3) 

3. Add page numbers to the footer. (2 points) (Exam objective: 5.2.5) 

Points scored: _________ / 4 

Task: Configure print options (2 points) 
1. Change report orientation. (1 point) (Exam objective: 5.2.4) 

2. Set report margins. (1 point) (Exam objective 1.3.1) 

Points scored: _________ / 2 

Task: Export a query to various file formats (4 points) 
1. Export qryHarvestingDates to Excel. (2 points) (Exam objective: 1.3.2) 

2. Export qryCropHarvesting to a text file. (1 point) (Exam objective: 1.3.2) 

3. Export qryCropHarvesting to an xml file. (1 points) (Exam objective: 1.3.2) 

Points scored: _________ / 4 

Task: Export to PDF format (2 points) 
• Export the Employee Harvesting report to PDF format. (2 points) (Exam objective: 

1.3.2) 

Points scored: _________ / 2 

FILE 1 TOTAL POINTS: _________ /28 
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